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Para P-40B z 47 Pursuit Squadron USAAC, której udało się wystartować 7 grudnia 1941r do walki z japońskim nalotem na Pearl Harbor. Pilotują je porucznicy: Kenneth Taylor i George Welch.
47 PS był w tym czasie oddelegowany na ćwiczenia strzeleckie w ustronny, północny zakątek wyspy Oahu, na polowe lądowisko Haleiwa. To obszar nie był blokowany przez japońskie samoloty. (Pearl Harbor leżało na przeciwnym brzegu wyspy). Pas startowy biegł wzdłuż brzegu morza. Tak ta para samolotów mogła wyglądać zaraz po starcie. Fotografia tła przypomina autentyczny fragment brzegu w pobliżu lotniska Haleiwa
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Bo zawsze chciałem stworzyć model samolotu w komputerze. A gdy już to zrobiłem — stwierdziłem, że to dobra zabawa, i że warto tym doświadczeniem podzielić się z innymi.
Dawno temu byłem zwykłym modelarzem i robiłem redukcyjne modele samolotów. To hobby dość specyficzne. Ślęczymy miesiącami nad naszym dziełem, starając się nanieść na kawałek materiału maleńkie nity, złącza blach, czy drobne detale tablic przyrządów. Sądzę, że postronnym obserwatorom zajęcia wędkarzy wydadzą w porównaniu z modelarzami mniej męczące, choć podobnie monotonne. W dodatku, zamiast tworzyć ładne, błyszczące miniaturki, nanosimy na ich powierzchnię (o zgrozo!) zabrudzenia i przetarcia, jakie powstawały podczas intensywnego używania. Szpecimy je, aby wyglądały jak rzeczywiste, zużyte i gdzieniegdzie pordzewiałe maszyny. Całą naszą nagrodą jest pokazanie naszych dzieł komuś, kto potrafi docenić ich finezję. Zdarza się to raz na jakiś czas. Mówiąc szczerze, dziwnym trafem są to zazwyczaj inni modelarze. A może ukrytą nagrodą jest możliwość nawiązania dyskusji na tak ezoteryczne tematy, jak wyższość Spitfire’a IX nad FW 190 A4? Albo paląca kwestia, jak był pomalowany P-40, na którym Witold Urbanowicz latał nad Chinami w 1943r?
Otóż chciałbym teraz zaoferować kolegom modelarzom (i nielicznych koleżankom – jakoś tak się te proporcje układają) zupełnie nowy materiał i narzędzia. Zamiast własnego, czasami nieco pobrudzonego aerografem biurka — okno na inny świat, w głębi ekranu.
Jest tu niezwykle plastyczny materiał, który można „wytłaczać” w dowolne powłoki, bez obawy że go zabraknie. Są tu farby, dla których można dokładnie ustalić odcień i zasady nakładania. Jest tu możliwa do osiągnięcia dokładność, której nie uzyskasz nigdzie indziej, ani w skali 1:24, ani w 1:18. Tu, gdy stwierdzisz, że okapotowanie silnika samolotu, który zrobiłeś rok temu, powinno mieć inny kształt, zawsze możesz ten błąd poprawić. I to nie raz! Tu nigdy Twój model nie obrośnie kurzem. Nie będziesz wysłuchiwał narzekań domowników na to, że nie ma już gdzie zmieścić Twojej kolekcji. Możesz tu powielić swoje dzieło – choćby po to, by odwzorować je w kilku różnych wersjach malowania. I możesz przesłać swój model innym hobbystom, takim jak Ty, bez obawy że coś się z nim stanie podczas transportu. Z obiektów, które w ten sposób stworzysz, można szybko budować całe sceny.
Jedyne, do czego trzeba się przyzwyczaić, to to, że niczego w tym świecie nie można dotknąć. Możesz tylko patrzeć, i łapać wszystko myszką. Przynajmniej na obecnym etapie rozwoju technologii, urządzenia dotykowe (ang. haptic devices) są nadal drogie i prymitywne. Za to możemy obserwować szybki rozwój drukarek 3D. Przypuszczam że za dwa — trzy lata będziemy mogli na nich „drukować” np. dokładne części modeli.
Ten świat wirtualnego modelarstwa stał niepostrzeżenie dostępny. W istocie każdy komputer, kupiony po 2005r, to silna stacja graficzna, o której w latach 90-tych można było tylko pomarzyć. Około 15 lat temu „ruszył z miejsca” nowy model matematyczny, służący do odwzorowania powierzchni. Mam na myśli powierzchnie podziałowe (ang. subdivision surfaces). Pozwoliły stworzyć Shreka i dziesiątki innych postaci z filmów animowanych za pomocą komputera. Ten nowy model matematyczny skierował do lamusa powierzchnie NURBS, wykorzystywane od lat 70-tych. Powierzchnie podziałowe pozwalają łatwo uzyskiwać naprawdę złożone kształty. W miarę dobrze radzą sobie ze zmorą NURBS – otworami i wycięciami.
Co więcej – odpowiednie programy, które potrafią to wszystko wykorzystać, stały się dostępne za darmo! Stworzyły je dziesiątki programistów Open Source. Ludzie ci chcą pokazać, że stać ich co najmniej na to samo, co twórców najlepszych programów komercyjnych. I to zaczęło im się udawać! Być może, trochę w tym zdrowej ambicji („ja to zrobię lepiej!”), oraz innego rytmu powstawania takich produktów. Podczas pracy nad nimi nie ma, typowego dla komercyjnych projektów pośpiechu, związanego z napiętymi terminami. (A pośpiech rodzi błędy). W efekcie pracy odpowiednio dużej grupy entuzjastów powstaje dobry, stabilny program.
Podsumowując – kupując do domu komputer do gier, kupiłeś wszystko, co potrzeba do wejścia w świat wirtualnego modelarstwa. Nie będę oszukiwał, że nie ma tu tego, co jest nieodłączną cechą pracy każdego modelarza: wielotygodniowego wysiłku. Mam jednak nadzieję, że ta książka ułatwi Ci, drogi Czytelniku, jak najszybsze osiągnięcie pożądanych rezultatów. Potem możesz pójść dalej i zrobić to samo jeszcze lepiej, niż tu proponuję. Przeczytanie dalszych stron, oszczędzi Ci dużo czasu i – niekiedy – frustracji. Ta ostatnia bywa nieodłącznym składnikiem pracy z „tą głupią maszyną” – komputerem. Postaram się nie zanudzać i pokazywać dużo obrazków, więc mam nadzieję, że „Wirtualne modelarstwo” Cię zainteresuje.
Witold Jaworski
„Wirtualne Modelarstwo” uczy „od zera”, jak tworzyć takie modele samolotów, jak pokazany na okładce. Aby szybciej udostępniać Czytelnikom uaktualnione fragmenty tej książki, zdecydowałem się stworzyć i opublikować wyciągi z jej tekstu, związane z określoną dziedziną. Są to: „Tom I: Przygotowania”, „Tom II: Modelowanie”, „Tom III: Materiały i tekstury”, oraz „Tom IV: Detale i renderowanie”. Przebieg pracy prezentuję na przykładzie modelu myśliwca Curtiss P-40B. Maszyna ta zawiera klasyczne rozwiązania, stosowane w większości samolotów tego okresu. Z całym rozmysłem nie wybrałem Spitfire, Mustanga, Thunerbolta, Focke-Wulfa czy Messerschmita. Nie chciałem zabierać Ci przyjemności samodzielnego odwzorowania tych słynnych samolotów.
Możesz tworzyć model każdego myśliwca z okresu II wojny światowej1, czytając jednocześnie kolejne rozdziały z tej książki. To wcale nie musi być P-40. Wszystkie te samoloty wykonuje się podobnie. W trakcie pracy na pewno zetkniesz się ze wszystkimi zagadnieniami, które są tu opisane.
Ta książka ma służyć zarówno tym, którzy dopiero zaczynają swoją przygodę „w 3D”, jak i tym, którzy mają już w tej dziedzinie pewne doświadczenie. W związku z tym zdecydowałem się ją podzielić na dwie części:
część pierwsza ("Budowa modelu") to tekst podstawowy, który koncentruje się na tym, co trzeba zrobić;
część druga ("Szczegóły obsługi programów") to szczegółowe opisy, jak posłużyć się odpowiednim programem, by osiągnąć efekt, pokazany w części pierwszej.
Cały tekst ma dużo stron, z czego "Szczegóły obsługi programów" zajmują ok. 40%. Układ tej części przypomina tekst systemu pomocy (Help) do programu. To krótkie (na jedną lub dwie strony), nie zawierające więcej niż kilka ilustracji, opisy pojedynczych poleceń.
Dzieląc materiał na część podstawową i „szczegółową”, starałem się uniknąć niepotrzebnych, wydłużających niezmiernie tekst, wskazówek w rodzaju „kliknij tu, a potem naciśnij tamto”. W odpowiednich miejscach części pierwszej umieściłem odnośniki do części drugiej. Jeżeli nie znasz programu, o którym akurat piszę, korzystaj z tych odnośników i czytaj umieszczone w nich informacje szczegółowe2. Przygotowałem je tak, abyś nauczył się posługiwać wszystkimi narzędziami "od zera", w trakcie czytania głównego tekstu. Gdy już będziesz wiedział, jak zrobić to, co opisuję — po prostu przestaniesz do nich zaglądać.
Książka zawiera jeszcze jedną część: „Dodatki”. To materiały, które mogą być ciekawe dla co dociekliwszych Czytelników. Tematyka „Dodatków” przypomina trochę "groch z kapustą": od pewnych zagadnień optyki (deformacja obrazu na fotografii), do odwzorowania profili lotniczych. A oprócz tego: metody zaawansowanej weryfikacja rysunków samolotu (na poziomie tworzenia planów modelarskich), oraz szczegółowy opis właściwości powierzchni podziałowych. Nie musisz do „Dodatków” zaglądać, choć sądzę, że niektórzy mogą w tych materiałach znaleźć dla siebie coś interesującego.
Wskazówki dotyczące klawiatury i myszki oparłem na założeniu, że masz standardowe:
klawiaturę — w normalnym układzie amerykańskim, 102 klawisze (dodam także parę uwag o klawiaturze notebooka, bo sam na takiej pracuję);
myszkę — wyposażoną w dwa przyciski i kółko przewijania (które daje się także naciskać: wtedy działa jak trzeci, środkowy przycisk).
Wywołanie polecenia programu będę zaznaczał następująco:
| Menu→Polecenie | taki zapis oznacza wywołanie z menu „Menu” polecenia „Polecenie”. W przypadku bardziej zagnieżdżonych menu może wystąpić więcej strzałek! |
| Panel:Przycisk | taki zapis oznacza naciśnięcie w oknie dialogowym lub panelu "Panel" przycisku „Przycisk”. Czasami mogę także w ten sposób napisać o przełączniku lub liście rozwijalnej. ("Panel" to pojęcie związane z ekranem Blendera, wyjaśnienia — patrz „Tom II: Modelowanie”) |
Naciśnięcie klawisza na klawiaturze:
| Alt-K | myślnik pomiędzy znakami klawiszy oznacza jednoczesne naciśnięcie obydwu klawiszy na klawiaturze. W tym przykładzie trzymając wciśnięty Alt, naciskasz K; |
| G, X | przecinek pomiędzy znakami klawiszy oznacza, że je naciskasz (i zwalniasz!) po kolei. W tym przykładzie najpierw G, a potem X (tak, jak gdybyś chciał napisać wyraz „gx”). |
Naciśnięcie klawisza myszki:
| LPM | lewy przycisk myszy |
| PPM | prawy przycisk myszy |
| SPM | środkowy przycisk myszy (naciśnięte kółko przewijania) |
| KM | kółko przewijania (pełni tę rolę, gdy jest obracane) |
Na koniec — „w kwestii formalnej”: jak mam się do Ciebie zwracać? Zazwyczaj w poradnikach używa się formy bezosobowej („teraz należy zrobić”). To jednak, mówiąc szczerze, czyni czytany tekst mniej zrozumiałym. Aby ta książka była jak najbardziej czytelna, zwracam się do Czytelnika w krótkiej, drugiej osobie („teraz zrób”). Czasami używam także osoby pierwszej („teraz zrobiłem”, „teraz zrobimy”). Tak jest mi łatwiej1.
„Wirtualne modelarstwo” najlepiej jest czytać na możliwie dużym, kolorowym tablecie, takim jak Kindle Fire 8.9”, lub na komputerze stacjonarnym, w aplikacji Kindle for PC. Ze względu na kolorowe ilustracje o dużej rozdzielczości, zdecydowanie odradzam próby użycia mniejszych czytników wykorzystujących technologię e-ink, takich jak Kindle Touch czy Kindle Paperwhite1.
Ta książka jest dostępna w kilku popularnych formatch. Użyj tej matrycy format/platforma aby lepiej zorientować się we właściwościach każdego z nich dla każdego z najpopularniejszych czytników/komputerów. To pozwoli zdecydować, który z tych formatów będzie najlepiej pasować do Twoich potrzeb. Każdą wersję tej książki możesz pobrać ze strony tego projektu.
Na stosunkowo dużym ekranie Kindle Fire 8.9” książkę można czytać w układzie pionowym (Rysunek i.3.1). Ilustracje „Wirtualnego modelarstwa” dostosowują się dynamicznie do szerokości ekranu:
Rysunek 0.3.1 Strony książki na Kindle Fire 8.9”
W tym poradniku chciałem, aby tekst i powiązane z nim ilustracje pojawiały się jak najbliżej siebie. W tym celu musiałem połączyć je w jedną, ciągłą zawartość i pozwolić czytnikowi dzielić ją na strony. Dlatego czasami może się zdarzyć, że ilustracja znajdzie się na jednej stronie, a jej podpis — już na następnej. Wynika to z niedoskonałości obecnie używanych formatów książek elektronicznych. (Nie mogłem zastosować żadnego rozwiązania które wymusiłoby na czytniku pozostawianie ilustracji i jej podpisu razem).
W ustawieniach czytnika dla tej książki proponuję wybrać niezbyt duży rozmiar czcionki (Settings: Font Size: 3 lub 4). W ten sposób podstawowy tekst będzie miał wysokość dopasowaną do odsyłaczy na ilustracjach (tekst podstawowy powinien być o około 50% wyższy od tekstu na ilustracjach). Ustaw także wąskie marginesy (Margins:Narrow), aby ilustracje były jak największe (Rysunek i.3.2):
Tło wszystkich ilustracji jest białe, stąd książka najlepiej wygląda z białym tłem (Color Mode). Odstęp pomiędzy liniami tekstu (Line Spacing) można ustawić na szeroki, a domyślną czcionkę (Font) — na szeryfową Georgia.
Gdy ustawisz tablet poziomo, czytnik podzieli treść książki na dwie „rozłożone” strony (Rysunek i.3.3):
Rysunek i.3.3 Domyślny sposób wyświetlania przy poziomym układzie tabletu
Uważam, że w takim układzie jest mniej czytelna, przede wszystkim ze względu na zmniejszone ilustracje.
Na szczęście możemy taki tryb wyłączyć. W opcjach programu (Settings) naciśnij More Options, aby przejść na drugi ekran. Przełącz tam tryb Two Column na Off (Rysunek i.3.4):
Rysunek i.3.4 Wyłączenie trybu „rozłożonych stron”
Rysunek i.3.5 Powiększanie ilustracji poprzez obrót tabletu
Rozmiar wszystkich ilustracji w tej książce zależy od rozmiaru ekranu: ich szerokość jest ustawiona jako % aktualnej szerokości ekranu. Stąd w ustawieniu poziomym wszystkie ilustracje są proporcjonalnie większe gdyż ekran tabletu jest szerszy.
Gdy wyłączysz tryb Two Column, możesz szybko powiększać ilustracje z bieżącej strony poprzez obrót tabletu, jak na Rysunku i.3.5:
Rozmiar czcionki każdego tekstu spoza ilustracji pozostaje taki sam w obydwu położeniach: pionowym i poziomym. Położenie poziome wydłuża linie tekstu do więcej niż 72 znaków na linię. (Optymalną długość linii tekstu to 66-72 znaki. Linie dłuższe lub krótsze czyta nieco trudniej). Co więcej, ekran Kindle Fire w położeniu poziomym nie jest zbyt wysoki, i potrafi wyświetlic tylko jedną ilustrację i kilka linii tekstu. Stąd proponuję używać ustawienia poziomego do szybkich powiększeń, a pionowego — do normalnego czytania.
Kindle Fire wyświetla przełącznik Two Column tylko wtedy, gdy tablet jest ustawiony poziomo!
Ta książka zawiera mnóstwo hipertekstowych odsyłaczy. Są wyróżnione cienkim podkreśleniem. W głównym tekście te hipertekstowe skróty sa przypisane do symboli nagłówków, sekcji, czy numerów stron (Rysunek i.3.6):
Rysunek i.3.6 Użycie skrótów hipertekstowych
Używaj przycisku Back (Rysunek i.3.6) do powrotu z takiego „hipertekstowego skoku” w poprzednie położenie w książce. (Gdy tablet jest ustawiony poziomo, znajdziesz ten przycisk z prawej strony ekranu).
Wyjątkiem w użyciu przycisku Back jest powrót z przypisu na Kindle Fire: użyj w tym celu numeru fizycznej strony, umieszczonego za numerem przypisu (Rysunek i.3.6). (Rób tak, dopóki Amazon nie usunie błędu z oprogramowania dla tego tabletu. W przeciwnym razie po jakimś kolejnym naciśnięciu Back zamknie się książka i trzeba ją ponownie otworzyć).
W tej książce referencją jest każdy numer fizycznej strony. Numery te pochodzą z książki formacie PDF, i choć nie odpowiadają stosowanym przez Kindle „lokalizacjom” (loc)to pozostawiłem je aby tekst tej publikacji był we wszystkich formatach taki sam. (No, może poza tą sekcją wproadzenia, która jest specyficzna dla każdego z zastosowanych formatów).
Starając się by ta publikacja elektroniczna była bardziej czytelna niż typowe papierowe poradniki, przesunąłem większość szczegółowych opisów z tekstu głównego do podrozdziałów. W ich miejscu pozostawiłem hipertekstowe odsyłacze. Skorzystaj z tych skrótów aby poznać wszystkie niuanse opisywanych operacji. W ten sposób główny wątek książki pozostaje wolny od rozpraszających uwagę detali.
* * *
Przypuszczam że często będziesz czytał ten poradnik pracując jednocześnie na komputerze. I choć sądzę, że najlepiej się taką książkę czyta na tablecie, to możesz czasami możesz nie mieć żadnego „pod ręką”. Wtedy użyj darmowego programu Kindle for PC, dostarczanego przez Amazon na komputery z systemami Windows (Rysunek i.3.7). (Istnieją jeszcze Kindle for Mac i Kindle for Android. Wszystkie wyglądają bardzo podobnie):
Rysunek i.3.7 Przeglądanie tej książki w programie Kindle for PC
Zauważ że ta aplikacja ma pod menu rozwijalnym pasek narzędzi. Kliknij w jedną z jego ikon (Rysunek i.3.7) aby otworzyć panel ustawień (Settings — Rysunek i.3.8):
Rysunek i.3.8 Ustawienia Kindle for PC
Podobnie jak na Kindle Fire możesz ustawić tu rozmiar podstawowego tekstu, szerokość marginesów czy barwę tła (białą).
W Kindle for PC nie ma możliwości zmiany kroju czcionki podstawowego tekstu — niezależnie od oryginalnych ustawień, wszystko jest wyświetlane w jednolitej czcionce szeryfowej (prawdopodobnie to Georgia).
Kursor myszki zmienia się ponad każdym hipertekstowym linkiem we „wskazującą dłoń” (Rysunek i.3.8). Gdy w takim miejscu klikniesz myszką — przejdziesz do odpowiedniej strony (Rysunek i.3.9):
Rysunek i.3.9 Powrót do poprzedniego położenia w książce
Aby powrócić z takiego „skoku” do poprzedniego miejsca w książce, naciśnij przycisk Back, umieszczony w pasku ponad tekstem (Rysunek i.3.9).
Wersja tej aplikacji Amazon na tablety firmy Apple — Kindle for iOS — nie otwiera poprawnie tej książki. Dopóki Amazon nie usunie tego błędu2, najlepszym rozwiązaniem dla tabletów IPad jest pobrać tę książkę w formacie EPUB i czytać ją w darmowej aplikacji iBooks.
W tej części stworzymy model P-40B. Zakładam, że dla wielu Czytelników będzie to wprowadzenie w świat grafiki komputerowej. Nie znaczy to jednak, że nasz samolot będzie jakiś uproszczony! (Choć, przyznam, gdy zaczynałem pisanie tej książki, chciałem parę zagadnień pominąć). Wykonamy go „w pełnej wersji”: z chowanym podwoziem i większością detali kabiny pilota. W trakcie pracy postaram się przekazać Wam całą wiedzę, jaką do tej pory na ten temat zgromadziłem.
W tym rozdziale omówimy pokrótce instalację oprogramowania, z którego będziemy korzystać. W tym tomie to:
Blender: program podstawowy;
To oprogramowanie jest udostępniane w zasadach licencji GPL. Oznacza to m.in., że nie można pobierać za nie żadnych opłat. (Oczywiście, jeżeli masz gest, a program Ci się bardzo spodoba, możesz wspomóc twórców dotacją — ale na zasadzie zupełnej dobrowolności. Szczegółowy opis, jak to zrobić, znajdziesz na stronie internetowej każdego z tych projektów.)
Przypuszczam, że większość czytelników tej książki używa komputera z Windows. Podczas opisu instalacji koncentruję się wyłącznie na tym środowisku. Sam go używam. Nie mam żadnych doświadczeń z Linuksem, ani z Mac OS, więc nie będę pisał o instalacjach, których nie wykonałem. Jeżeli używasz systemów innych niż Windows — poszukaj wskazówek na stronach tych programów (ich adresy są w kolejnych sekcjach rozdziału).
Przygotowałem także trochę materiałów dodatkowych, i udostępniłem je jako spakowane pliki zip:
Pliki towarzyszące tej książce możesz pobrać ze strony: http://samoloty3d.pl/wm3_p.xml . Utrzymuję tam ich aktualne wersje1.
Następujące pliki są ważną częścią tej książki:
source.zip: zawiera skrypty Pythona, plany P-40B, udostępnione przez producenta fragmenty rysunków technicznych (P-40E), i inne pomocnicze materiały;
la5.zip: Zawiera model, który wykorzystuje Rozdział 2;
p40.zip, p40w.zip: Zawierają historię zmian (pliki *.blend) modelu P-40, oraz kilka obrazów tła, wykorzystanych w tej książce. Każdej sekcji tej książki odpowiada plik ze spakowanego folderu history\;
Rozpakuj wszystkie pobrane pliki *.zip do tego samego folderu. W trakcie ich rozpakowania stworzą odpowiednie podkatalogii (pliki nie wymienione powyżej należą do innych części tej publikacji):
Ta książka opisuje Blendera w wersji 2.7. Jednak wszystkie poprzednie wersje tego programu także można instalować w sposób opisany poniżej.
Najpierw pobierz pliki programu ze strony Fundacji Blendera: — http://www.blender.org . Pliki do pobrania są obecnie dostępne pod adresem: http://www.blender.org/download/ (Rysunek 1.1.1). Za jakiś czas (trzy, cztery lata) może to się trochę zmienić przy okazji kolejnej przebudowy tego portalu, więc w razie czego zacznij od strony głównej1.
Rysunek 1.1.1 Strona, z której możesz pobrać pliki Blendera
Pod wskazanym adresem znajdziesz skróty do wersji programu skompilowanych dla różnych systemów operacyjnych (Windows, Linux, Max OSX, …). Na ilustracji widać, że wybrałem wersję dla Windows, 64 bity. Zdecydowanie doradzam użycie 64-bitową wersję Blendera2. Wersja 32-bitowa jest przeznaczona dla tych, którzy ze względu na 32-bitowy system operacyjny (XP, Vista) nie mogą użyć innej.
Jak pokazuje Rysunek 1.1.1, każda z wersji dla Windows jest udostępniona w dwóch postaciach: programu instalacyjnego i spakowanego pliku *.zip.
Jeżeli jesteś bardzo przyzwyczajony do programów instalacyjnych Windows, pobierz go i uruchom. Po wskazaniu folderu, w którym należy umieścić Blendera, będziesz miał po chwili zainstalowany program.
Ja jednak należę do ludzi, którzy wolą dokładnie wiedzieć, co się dzieje z ich komputerem3. Rzecz w tym, że Blender prawie „nie dotyka” reszty systemu. Dlatego najlepszym (jak uważam) sposobem instalacji Blendera jest rozpakowanie pliku *.zip. W ten sposób po prostu wiesz dokładnie, co robisz. Wystarczy:
pobrać ze strony BF plik *.zip (Rysunek 1.1.1), zawierający spakowany folder z jego plikami;
rozpakować zawartość tego pliku na lokalny dysk, np. jako folder C:\Program Files\Blender;
dodać skrót do C:\Program Files\Blender\blender.exe na pulpit i/lub do menu Start;
opcjonalnie: skojarzyć rozszerzenie *.blend z tym programem (np. przy okazji otwierania przykładowego pliku);
Jeżeli masz jakiekolwiek wątpliwości co do przebiegu tej nieskomplikowanej procedury, na str. 253 znajdziesz szczegółowy opis, jak to robię.
Gdy już używasz Blendera, i chcesz wgrać nową wersję — nie musisz wcale po raz kolejny uruchamiać programu instalacyjnego. (Choć, oczywiście, możesz to zrobić). Moja metoda na uaktualnienie do nowej wersji polega na:
zmianie nazwy aktualnego folderu Blender na „Blender-XX.X”, gdzie XX.X to numer starej wersji. Na przykład: przed wgraniem wersji 2.70a zmieniłem nazwę dotychczasowego folderu z Blender na Blender-2.69;
pobraniu ze strony BF pliku *.zip z nową wersją Blendera;
rozpakowaniu plików Blendera do folderu o takiej samej nazwie, jaką zmieniliśmy w pkt 1 (Blender).
(W ten sposób wszystkie skróty do Blendera w menu Start i skojarzenie rozszerzenia plików *.blend samoczynnie przechodzą na nową wersję — nie musisz niczego więcej zmieniać).
Przy pierwszym uruchomieniu Blender sam zaproponuje mi przeniesienie konfiguracji ze starej wersji (Rysunek 1.1.2) — wystarczy nie przeoczyć tego momentu i kliknąć przycisk Copy Previous Settings:
Rysunek 1.1.2 Okno powitalne (splash screen) przy pierwszym uruchomieniu nowej wersji Blendera
Dzięki zachowywaniu poprzednich wersji Blendera w folderze o zmienionej nazwie, możesz zawsze z niej skorzystać. Wystarczy uruchomić plik blender.exe z jej katalogu.
Możesz mieć na swoim komputerze równocześnie używać wielu różnych wersji Blendera. Wystarczy, że każda z nich znajduje się w innym katalogu.
Do poprawnego działania Blender nie potrzebuje żadnej instalacji Pythona. (Możesz o niej napotkać w wzmianki w Internecie. Interpreter Pythona był opcjonalnym dodatkiem do jego wcześniejszych wersji — np. 2.4). Blender od wersji 2.5 korzysta z własnego, wbudowanego interpretera tego języka. Jest on używany np. w obsłudze interfejsu użytkownika (okienek, przycisków, i menu programu).
W tym rozdziale zapoznasz się z Blenderem. Złamałem tu zasadę, przyjętą w tej książce1, i opisuję, jak się nim posługiwać. Zrobiłem tak, gdyż pojęcia i polecenia przedstawione w tym rozdziale są niezbędne do płynnej pracy w Blenderze. Są to podstawy, które będziesz później wykorzystywał na każdym kroku. Nawet nie zauważysz, jak szybko je zapamiętasz.
Aby gdzieś dojść, trzeba wykonać pierwszy krok. Niektórzy mówią, że ten pierwszy jest najtrudniejszy. Na forach internetowych często czytuję głosy „chciałbym się pobawić Blenderem, ale przy pierwszej próbie dałem sobie spokój”. Ja też chciałem się nim pobawić. I szybko się wciągnąłem.
Myślę, że mit o tym, że jest to program trudny, wyolbrzymiają ci, którzy chcieliby się nauczyć wszystkiego od razu. Moi drodzy, tak się nie da. Czasami trzeba ciężko westchnąć i siąść, i przeczytać.2 Na razie nie wymyślono takich pigułek, jak w Matrix-ie – aby połknąć całą książkę i od razu wiedzieć wszystko. Dokonywałem kiedyś studiów porównawczych interfejsu użytkownika różnych systemów 3D. Mogę uczciwie powiedzieć, że Blender ma naprawdę fajny, spójny interfejs. Tyle, że trochę niekonwencjonalny. Zresztą w wersji 2.5 został przepisany od nowa, przez co stał się łatwiejszy. W dalszych sekcjach powolutku wyjaśnię, jakie są te konwencje ekranów Blendera. Gdy je poznasz, przekonasz się, że jest to nie tak trudna do opanowania całość. Wyrabia dobre nawyki – pracy z komputerem „na dwie ręce” (lewa na klawiaturze, prawa na myszce).
Większość tej nauki przeprowadzimy na modelu myśliwca Ła-5. Otworzysz ten plik, obejrzysz jego zawartość, nauczysz się podstawowych metod edycji (transformacji) obiektów. Zrobimy to, przestawiając i obracając kamerę tej sceny. (Tak! Podobnie jak w prawdziwym studio fotograficznym, mamy tu kamery!). W sumie – po przeczytaniu tego rozdziału będziesz już umiał „pozować” model. Na koniec rozdziału wygenerujesz finalną scenę z tym samolotem. (O takim obrazie będę często mówił, że jest wyrenderowany 3.)
W tym rozdziale będziemy wykorzystywać materiały z plików source.zip i la5.zip, towarzyszących tej książce (adres, z którego można je pobrać, znajdziesz na. str. 18)
Rysunek 2.1.1 pokazuje, jak wygląda Twój ekran, gdy po raz pierwszy uruchomisz Blender:
Rysunek 2.1.1 Blender – domyślny wygląd programu
Nie wygląda jak typowa aplikacja Windows, prawda? Przyznam się: gdy miałem zacząć pracować z tą przepisaną od nowa wersją 2.5, to po pierwszym uruchomieniu przez 15 minut siedziałem i po prostu gapiłem się w ekran. Tak wszystko na nim „przemeblowano”, że był dla mnie zupełnie nowy! Nie ruszałem nawet myszką — nie byłem pewien, jak zacząć. Stało się tak, choć przez cztery lata pracowałem w kolejnych wersjach Blendera 2.4, i wcześniej nawet trochę zaglądałem do wersji testowych 2.5. Jednak po tych pierwszych 15 minutach kontemplacji zacząłem od powtórki najprostszych czynności, zajrzenia do kilku samouczków — i jakoś poszło. Mam nadzieję, że pamięć o tym „drugim początku” pomoże mi lepiej napisać to wprowadzenie.
Rozmieszczenie elementów na ekranie Blendera 2.5 lepiej pasuje do nowszych monitorów o proporcji 8x5. (Poprzednie wersje dobrze pasowały do monitorów o starych proporcjach — 4x3). Blender jest napisany dla kilku systemów operacyjnych: Linux, Mac OS, Windows. W każdym z nich wygląda i działa w identyczny sposób1. Siłą rzeczy ten program ma specyficzny styl, który go wyróżnia. Jest to przemyślany interfejs użytkownika. Zacznijmy od omówienia jego podstawowych założeń.
Ekran Blendera jest podzielony na prostokątne obszary. Nazywane są oknami (ang. window, a czasami także ”obszarem”: area)2. W odróżnieniu od typowych systemów „okienkowych”, okna Blendera nigdy się na siebie nie „nakładają". Osobiście uważam to za zaletę, a nie wadę. W edytorach nakładające się okienka dobrze wyglądają jedynie na materiałach reklamowych. Gdy przychodzi do realnej pracy nad projektem, każdy ustawia je sobie tak, aby widzieć wszystkie naraz. Na domyślnym ekranie Blendera widzisz pięć okien3 (Rysunek 2.1.2):
Rysunek 2.1.2 Blender – obszary okien
Okno widoku (View 3D): pokazuje trójwymiarową „scenę”, a na niej model (tutaj: sześcian);
Okno struktury (Outliner): struktura sceny, przedstawiona w postaci symbolicznej;
Okno właściwości (Properties): obszar na wszelkie przyciski, pola numeryczne, przełączniki, za pomocą których zmieniamy właściwości elementów sceny;
Okno informacyjne (Info): menu główne programu oraz miejsce na komunikaty (np. o błędach).
Okno osi czasu (Timeline) (Timeline): potrzebne do animacji;
Granicę każdego z okien Blendera można „złapać” myszką i przesunąć (Rysunek 2.1.3):
Rysunek 2.1.3 Przesuwanie granic okien Blendera
Usuńmy z ekranu niepotrzebne nam obecnie okno Timeline. Można je wyeliminować, łącząc z jednym z sąsiednich obszarów. Umieść kursor na krawędzi okna, która ma zniknąć, i naciśnij PPM. Spowoduje to otwarcie menu Area Options, z którego wybieramy polecenie Join Areas (Rysunek 2.1.4a) :
Rysunek 2.1.4 Scalanie okien na ekranie Blendera
Po wybraniu tego polecenia Blender na bieżąco pokazuje za pomocą strzałki okno, które zostanie wyeliminowane (Rysunek 2.1.4b). Jest to zawsze okno w którym znajduje się kursor myszki.
Okno Blendera, znajdujące się pod kursorem myszy, nazywamy oknem aktywnym. (Spośród innych okien jest sygnalizowane odrobinę jaśniejszym nagłówkiem, ale nie widać tego na ilustracjach).
Kliknięcie LPM kończy operację — powinieneś uzyskać taki ekran, jaki pokazuje Rysunek 2.1.5:
Rysunek 2.1.5 Ekran po scaleniu okna Timeline z oknem 3D View
Dopóki nie wykonasz końcowego kliknięcia, zawsze możesz przerwać łączenie okien naciskając Esc. (W Blenderze naciśnięcie tego klawisza zawsze oznacza rezygnację z aktualnie wykonywanego polecenia).
Analogicznie, do podziału okna możesz użyć polecenia Area Options→Split Area. Można to także zrobić w inny sposób — wykorzystując uchwyt, umieszczony w lewym górnym i prawym dolnym narożniku każdego okna. Wygląda jak „karbowany” trójkąt (Rysunek 2.1.6):
Rysunek 2.1.6 Podział okna Blendera za pomocą uchwytu
„Złap” myszką (LPM) za uchwyt okna i przesuń go do wnętrza obszaru. Gdy przesuniesz go bardziej pionowo — przeciągniesz w dół poziomą granicę nowego okna (Rysunek 2.1.6). Gdy zrobisz to bardziej poziomo — podzielisz okno w pionie.
Nowe okno, uzyskane w wyniku podziału, jest zawsze dokładną kopią okna dzielonego
Uchwyt może także służyć do łączenia okien. Wystarczy go przeciągnąć na obszar, który ma zostać wyeliminowany (Rysunek 2.1.7):
Rysunek 2.1.7 Łączenie okien za pomocą uchwytu
Blender zaznacza takie okno odpowiednią strzałką (Rysunek 2.1.7). Wystarczy zwolnić LPM, by wskazane okno uległo scaleniu.
W ramach ćwiczenia spróbuj za pomocą podziałów uzyskać taki układ ekranu, jaki pokazuje Rysunek 2.1.8:
Rysunek 2.1.8 Zmieniony układ okien Blendera
Zajmijmy się teraz podstawowymi elementami wnętrza pojedynczego okna (Rysunek 2.1.9):
Rysunek 2.1.9 Elementy okna Blendera
Każde okno Blendera ma nagłówek. Na ilustracji umieszczony jest akurat nie u góry, jak sugerowałby jego nazwa, a u dołu. Nagłówek zawiera menu rozwijalne i inne pomocnicze kontrolki.
Z lewej strony nagłówka okna znajduje się lista rozwijalna, z której można wybrać typu edytora. Wybierasz z niej to, co ma być aktualnie wyświetlane. Na przykład — struktura sceny w oknie Outliner (Rysunek 2.1.10):
Rysunek 2.1.10 Zmiana typu (zawartości) okna
Kilka typów edytorów Blendera (3D View, UV/Image Editor, Text Editor) ma także „wysuwany przybornik”, z narzędziami, umieszczony z lewej strony okna. Można go przywołać poleceniem menu (View→Tool Shelf), ale o wiele łatwiej jest po prostu nacisnąć na klawiaturze przycisk T (Rysunek 2.1.11):
Rysunek 2.1.11 Ukrywanie i wysuwanie przybornika z narzędziami (Tool Shelf) za pomocą klawiatury
W podobny sposób możesz wyświetlać/chować umieszczony z prawej strony przybornik właściwości (Properties, np. obiektu lub widoku): za pomocą klawisza N, lub polecenia z menu (Rysunek 2.1.12):
Rysunek 2.1.12 Przybornik z właściwościami — różne metody „wysunięcia” i ukrycia.
Gdy kursor myszki znajduje się ponad nagłówkiem okna, kliknij PPM, by otworzyć menu kontekstowe. W zależności od tego w co kliknąłeś, Blender otworzy mniejsze lub większe menu (Rysunek 2.1.13):
Rysunek 2.1.13 Różne menu kontekstowe kontrolek Blendera
Najwięcej poleceń znajduje się na menu kontekstowym kontrolki (Rysunek 2.1.13c). Polecenie Reset to Default Value może być czasami przydatne, gdy nie wiesz jaka jest ta wartość domyślna. Polecenie Online Manual otwiera odpowiedni fragment instrukcji Blendera (artykuł z wiki.blender.org ), o ile oczywiście masz w tym momencie dostęp do Internetu. Polecenia Edit Source i Edit Translation są przydatne tylko dla programistów lub tłumaczy programu. Krótsza wersja tego menu (Rysunek 2.1.13a) pojawi się, gdy klikniesz PPM w jedno z menu rozwijalnych. W każdym z tych menu znajdziesz przejście do menu Header, sterującego nagłówkiem okna (Rysunek 2.1.13b). Choć w menu a) i c) występuje jako submenu, Blender otwiera je od razu gdy klikniesz PPM gdzieś na „tle” nagłówka okna, omijając wszystkie kontrolki.
Polecenia z menu Header są przydatne przy modyfikowaniu układu ekranu. Jeżeli wywołasz polecenie Header→Flip to Top, nagłówek okna zostanie wyświetlony u góry (Rysunek 2.1.14):
Rysunek 2.1.14 Przesunięcie nagłówka na górę okna
Po przeniesieniu nagłówka do góry okna Blender zmienia jego menu Header. Zastępuje w nim polecenie Flip to Top poleceniem Flip to Bottom. Gdy je wywołasz, nagłówek znajdzie się z powrotem na dole.
Od wersji 2.70 w menu Header znalazł się także przełącznik Collapse Menus. Gdy go włączysz, menu rozwijalne zostanie „ściśnięte” (Rysunek 2.1.15). Może to być przydatne dla węższych okien:
Rysunek 2.1.15 „Zwijanie” menu okna
Kolejne polecenie z menu Header — Maximize Area — służy do rozciągnięcia aktywnego okna na cały ekran Blendera. Wygodniej jest jednak to zrobić za pomocą skrótu klawiatury: Ctrl-↑ (Rysunek 2.1.16):
Rysunek 2.1.16 Przełączanie rozmiaru okna: na cały ekran i z powrotem
Operację odwrotną — zmniejszenie okna do oryginalnego miejsca na ekranie — uzyskasz naciskając Ctrl-↓ (albo wywołując polecenie Header→Tile Area — ale po co tyle klikać?).
Zwróć uwagę, że do tej pory poznaliśmy trzy skróty klawiaturowe Blendera: T, N, i Ctrl-↓ / ↑. Każdemu z nich podałem także odpowiednie polecenie z menu. Która droga wywołania jest lepsza: wybór z menu czy skrót z klawiatury ? Skróty są oczywiście szybsze. Jednak nie warto uczyć się każdego z nich, bo każda ludzka głowa ma skończoną pojemność. (Wiele poradników Blendera koncentruje się właśnie na skrótach. Sądzę, że przez to właśnie program ma opinię trudnego do opanowania). Rzadziej używane polecenia łatwiej jest wybierać z menu. (Bo wystarczy wtedy pamiętać “mniej więcej”, gdzie to polecenie się znajduje). Gdy zauważysz, że niektórych komend używasz bardzo często — zwróć uwagę na prawą stronę ich menu. Jeżeli polecenie ma swój skrót klawiaturowy — jest tam wyświetlany. Opisując ten program, zawsze będę się starał określić, gdzie i w jakim menu jest dostępne omawiane polecenie. W przypadku częściej używanych operacji podam także ich skróty4.
W Blenderze masz dostępnych wiele różnych układów ekranu, abyś nie musiał za każdym razem mozolnie przestawiać granic okien. Służy do tego lista Screen lay-out, umieszczona w nagłówku okna Info (Rysunek 2.1.17):
Rysunek 2.1.17 Wybór jednego z zapamiętanych układów ekranu
To, co zmienialiśmy do tej pory, to układ zapamiętywany pod nazwą Default. Będziesz go używał przez większość czasu pracy nad modelem. Układy UV Editing i Animation przydadzą się później. Przyjrzyj się oknom każdego z tych zestawów (Rysunek 2.1.18):
Rysunek 2.1.18 Inne, predefiniowane układy ekranów: UV Editing i Animation
Oczywiście, to tylko propozycja autorów programu. Możesz je kompletnie pozmieniać. Kontrolka Screen lay-out pozwala użytkownikowi tworzyć kolejne układy ekranu — służy do tego przycisk
, umieszczony z prawej strony listy. Tuż obok znajduje się przycisk
, którym możesz usunąć (wymazać z rysunku) aktualny układ ekranów. Więcej na temat tej kontrolki i zarządzania układami ekranów znajdziesz na str. 283.
Edytor konfiguracji programu — User Preferences — możesz otworzyć w każdym z jego okien, bo jest dostępny na liście, tuż powyżej edytora Outliner (por. str. 28, Rysunek 2.1.10). Ja jednak wolę je wywoływać z poleceniem z głównego menu Blendera (File→User Preferences… — Rysunek 2.1.19):
Rysunek 2.1.19 Wywołanie okna konfiguracji programu
U góry okna konfiguracji Blendera można się przełączyć na odpowiednią sekcję (Interface, Editing, Input…) (Rysunek 2.1.20):
Rysunek 2.1.20 Okno konfiguracji (User Preferences)
Szczegółowe omówienie, co warto przestawić w tej konfiguracji znajdziesz na str. 261. Tutaj chciałbym tylko zasygnalizować opcję, która będzie potrzebna już w następnej sekcji. Jeżeli używasz laptopa, który nie ma klawiatury numerycznej — koniecznie w sekcji Input zaznacz opcję Emulate Numpad, jak to pokazuje Rysunek 2.1.20. Następnie zapisz tę zmianę przyciskiem Save User Settings, umieszczonym u dołu, w nagłówku okna.
Począwszy od wersji 2.665 Blender przechowuje konfigurację w specjalnym pliku o nazwie userpref.blend. Ten plik znajduje się w specjalnym folderze z konfiguracją Blendera, w katalogu użytkownika.
Więcej na temat tego, jakie ustawienia co Blender przechowuje w każdym rysunku, a co tylko w pliku konfiguracji, i gdzie dokładnie ten plik jest przechowywany, znajdziesz na str. 261.
Inną ciekawą właściwością Blendera są krótkie podpowiedzi, pojawiające się przy każdym elemencie ekranu. (Aby się tak się działo, w sekcji Interface musi być włączona opcja Tooltips — Rysunek 2.1.21a). Wystarczy wtedy zatrzymać kursor nieco dłużej ponad czymś, czego nie znamy — i zobaczymy podpowiedź (Rysunek 2.1.21b):
Rysunek 2.1.21 Podpowiedzi do każdej kontrolki, widocznej na ekranie
Dolna linia podpowiedzi jest zapisana czymś, co nie jest zrozumiałe dla zwykłego użytkownika: to nazwy tzw. właściwości klas — rzecz tylko dla programistów! Jeżeli ta informacja nie jest Ci potrzebna, możesz wyłączyć opcję Show Python Tooltips (Rysunek 2.1.21a), a znikną.
A swoją drogą — zwróciłeś uwagę, że teraz na monitorze masz dwa ekrany Blendera (Rysunek 2.1.22)?:
Rysunek 2.1.22 Dwa ekrany Blendera
Ten drugi ekran ma takie same właściwości jak pierwszy — możesz zmienić w nim typ edytora (np. na 3D View), możesz go także podzielić na kilka okien. Jeżeli Twój komputer ma dwa monitory, pracujące w trybie tzw. „rozszerzonego pulpitu”6 — możesz na nich rozmieścić ekrany Blendera. Każdy z tych ekranów będzie na bieżąco pokazywał ten sam model (Rysunek 2.1.23):
Rysunek 2.1.23 Jeden z możliwych układów ekranów przy pracy na dwóch monitorach
W praktyce zwiększa to co najmniej dwukrotnie dostępną przestrzeń ekranu, znacznie poprawiając komfort pracy.
Inna metoda otworzenia drugiego ekranu Blendera: W oknie 3D View, menu View, jest polecenie kopiujące je w nowe okno: Duplicate Area into New Window.
Dla porządku, na końcu tego wprowadzenia podaję jak zamknąć program.
Tak, dobrze się domyślasz: jak każdą aplikację Windows, Blender można zakończyć klikając przycisk
w prawym górnym narożniku jego okna. Można to także zrobić inaczej: wybierając z menu polecenie File→Quit (Rysunek 2.1.24), lub naciskając na klawiaturze skrót Ctrl-Q.
Po wybraniu polecenia Quit Blender nie ostrzega użytkownika, że aktualny plik zawiera nie zapisane zmiany!
Być może takie zachowanie polecenia Quit wynika z faktu, że w istocie zapisuje ono aktualny stan do specjalnego pliku, który możesz odtworzyć poleceniem File→Recover Last Session. Za to gdy włączysz odpowiednią opcję konfiguracji (por. str. 262), Blender będzie wyświetlał odpowiednie ostrzeżenie podczas zamykania jego okna przyciskiem
.
Zwróć także uwagę, że w menu File masz polecenie zapisujące aktualny plik jako „startowy” (Save Startup File). A gdybyś już sam nie wiedział, co pozmieniałeś w konfiguracji, zawsze możesz skorzystać z polecenia Load Factory Settings.
Podsumowanie
Interfejs użytkownika Blendera różni się od innych aplikacji Windows. Jednak „inny” nie znaczy wcale „gorszy” — sam się o tym przekonasz;
Ekran Blendera jest podzielony na obszary (ang. area, używane jest także określenie „okna”). Każdy z nich może zawierać jeden z kilkunastu typów dostępnych edytorów. W Blenderze możesz przesuwać granice tych okien (por. str. 24), ale nie można ich na siebie nałożyć;
Okna Blendera można dzielić i łączyć (wtedy eliminujesz jedno z nich). Możesz użyć do tych operacji poleceń z menu kontekstowego Area Options (str. 25). Ten sam efekt możesz uzyskać przesuwając uchwyty, umieszczone w lewym dolnym i prawym górnym narożniku każdego obszaru (str. 26);
Każde okno Blendera ma nagłówek i obszar roboczy, a niektóre z nich — umieszczone po bokach przyborniki (str. 27);
Pomocnicze okna przyborników można „wsuwać” i „wysuwać” z boków ekranu klawiszami T (narzędzia) i N (właściwości). Jeżeli nie pamiętasz tych skrótów, możesz posłużyć się poleceniami z menu View (str. 28);
Aby zmienić typ edytora (zawartość okna), należy użyć menu rozwijalnego, umieszczonego zawsze z lewej strony nagłówka (str. 28);
Blender posiada wiele gotowych układów ekranu, odpowiednich do różnych etapów prac nad modelem czy animacją (str. 31). Każdy z tych układów możesz zmodyfikować. Możesz także stworzyć własny układ;
Oknem aktywnym nazywamy w Blenderze okno, w którym obecnie znajduje się kursor myszki (por. str. 25).
Aktywne okno można powiększyć na cały ekran skrótem klawiatury Ctrl-↑; Powtórne naciśnięcie tych klawiszy powoduje powrót do oryginalnego układu ekranu (str. 30);
Okna Blendera mogą być wyświetlane na wielu ekranach. Gdy masz do dyspozycji dwa monitory, możesz wykorzystać ich całą powierzchnię (str. 34). Większa przestrzeń ekranu bardzo ułatwia pracę!
Okno konfiguracji programu najwygodniej jest otworzyć poleceniem File→User Preferences (str. 32).
Aby zachować zmiany w konfiguracji na stałe (tzn. tak, by obowiązywały przy następnym uruchomieniu programu), należy użyć przycisku User Preferences:Save User Settings (str. 33). Blender przechowuje swoją konfigurację w specjalnym pliku o nazwie userpref.blend. (Więcej na ten temat — patrz str. 261);
Podczas zamykania programu poleceniem File→Quit Blender nie ostrzega użytkownika, że aktualny plik posiada nie zapisane zmiany. Zamiast tego zapisuje jego aktualny stan do tymczasowego pliku, którego zawartość można otworzyć poleceniem File→Recover Last Session (str. 34). Zwróć jednak uwagę, że możesz w ten sposób odtworzyć tylko stan z końca ostatniej (Last) sesji, którą zamknąłeś poleceniem Quit!
Jak długo można podziwiać na ekranie domyślne „pudełko” Blendera, przewijające się przez ilustracje w poprzedniej sekcji? Wczytajmy jakiś bardziej interesujący model!
Najpierw otwórz (File→Open — szczegóły znajdziesz na. str. 256) spakowany w source.zip (por. str. 18) plik source\config\startup.blend z konfiguracją Blendera, którą przygotowałem dla tej książki. Aby ją zapisać, w oknie User Preferences naciśnij przycisk Save User Settings, a potem wywołaj File→Save Startup File (szczegóły — str. 261). Zmienisz w ten sposób m.in. kolorystykę ekranu na taką, jaką wykorzystuję w dalszym tekście. Następnie otwórz rysunek model\la5\la5.blend. (Znajdziesz go w pliku la5.zip, towarzyszącym tej książce). Rysunek 2.2.1 pokazuje, jak powinien wyglądać rezultat. Tym Ła-5F posłużymy w dalszej części tego rozdziału, byś mógł pracować na jakimś prawdziwym modelu.
Rysunek 2.2.1 Załadowany plik z modelem myśliwca Ła-5F (nowa kolorystyka ekranu pochodzi z pliku startup.blend)
Mamy wczytany model, czas pomówić o tym, jak obejrzeć go dokładniej. Zaczniemy od szybkiego powiększenia jednego z okien (Rysunek 2.2.2):
Rysunek 2.2.2 Wywołanie powiększenia aktywnego okna
Pamiętasz z poprzedniej sekcji? Ustaw kursor myszy wewnątrz jednego z okien 3D View (Rysunek 2.2.2). Naciśnij kombinację klawiszy Ctrl - ↑. Spowoduje to rozciągnięcie aktywnego okna na cały ekran. (Wolę to polecenie przypomnieć, bo będziesz je często wykorzystywał — podczas modelownia ekranu zawsze brakuje!).
Teraz zobaczysz model o wiele dokładniej (Rysunek 2.2.3):
Rysunek 2.2.3 Powiększone okno aktywne
Naciśnięcie Ctrl - ↓ (albo przycisku Back to Previous w nagłówku okna Info) powoduje pomniejszenie okna do poprzedniego rozmiaru. Pozostańmy jednak na razie z tym powiększonym widokiem z boku.
Załadowany model składa się z wielu niewielkich ścian. Można to odczytać na informacji o stanie, w prawej części nagłówka okna Info (Rysunek 2.2.3). Te informacje widać teraz lepiej, gdyż w trybie powiększenia pojedynczego okna znikają listy układów ekranu i scen (porównaj: Rysunek 2.2.3 i Rysunek 2.2.1). Co oznaczają dokładnie skróty i liczby, wyświetlone na ekranie? Już wyjaśniam:
v2.70.5 : to numer wersji Blendera (w tym przypadku: Blender 2.70, edycja 5);
Verts: liczba wierzchołków (vertices), użytych w modelu widocznym w aktywnym oknie widoku. Ten samolot składa się z 446 319 wierzchołków. Jest to stosunkowo duży model;
Faces: liczba elementarnych ścian, użytych w modelu widocznym w aktywnym oknie widoku. Załadowany samolot składa się z 436 176 ścian;
Tris: liczba elementarnych trójkątów, użytych w ścianach modelu. Zazwyczaj każda elementarna czworokątna ściana (face) składa się z dwóch elementarnych trójkątów. Jeżeli elementarna ściana ma więcej niż 4 boki (zdarzają się takie) wówczas jest zbudowana z więcej niż 2 trójkatów;
Objects: liczba wybranych obiektów, oraz (po kresce) wszystkich widocznych obiektów. W przypadku tego samolotu jest ich aktualnie 357, przy czym żaden nie jest wybrany („0”);
Lamps: liczba „lamp” (źródeł światła) — wybranych/aktualnie widocznych na scenie;
Mem: ilość użytej przez program ciągłej pamięci RAM1. W tym przypadku – nieco ponad 347 MB. Na pewno ta wartość powinna być mniejsza od rozmiaru pamięci RAM fizycznie dostępnej na Twoim komputerze. Jeżeli używasz 32-bitowej wersji Blendera, musisz pamiętać o innym ograniczeniu: w systemie Windows 32-bitowa aplikacja może co najwyżej uzyskać dostęp do 1.3 GB RAM, niezależnie od tego jaka ilość jest zainstalowana. W innych systemach (Linux, OSX) wygląda to podobnie. Właśnie aby takie ograniczenia przezwyciężyć powstały systemy i aplikacje 64-bitowe;
012.Body: nazwa tzw. aktywnego obiektu (por. str. 48, Rysunek 2.3.3);
Obawiam się, że Blender z tym modelem Ła-5 może wolno odświeżać okna widoku na komputerach wielu z Czytelników. Aby temu zaradzić, proponuję ukryć niektóre warstwy, jak pokazuje to Rysunek 2.2.4:
Rysunek 2.2.4 “Odchudzony” widok La-5 - część obiektów jest na niewidocznych warstwach
Klikając LPM w „komórki” kontrolki obsługi warstw (p. Rysunek 2.2.4), włączamy lub wyłączamy ich widoczność (jasne = niewidoczne). Koniecznie rób to trzymając wciśnięty klawisz Shift. Jeżeli o tym zapomnisz, kliknięcie w jakąś warstwę wyłączy widoczność wszystkich pozostałych2.
Co to właściwie są warstwy (layers) w takim programie jak Blender? Ich nazwa pochodzi z systemów 2D. Spotkałeś je już w Gimpie (np. w Tomie I). W programach 3D warstwy straciły swoją analogię do powierzchni, które można nakładać jedna na drugą3. Pozostały w roli grup obiektów, które można szybko ukryć lub pokazać. Stosuję je bardzo często, umieszczając na różnych warstwach różne elementy samolotu. Zazwyczaj podczas formowania nowego fragmentu pracuję na jednej – dwóch warstwach, na których mam wszystko, co potrzebne. Na przykład – modelując owiewkę pomiędzy skrzydłem i kadłubem, mam włączone tylko 3 warstwy: skrzydła, kadłuba, i samej owiewki. (Czyli to, co zmieniam, i to, do czego mam się dopasować).
Blender oferuje nam do wykorzystania 20 warstw. Traktuj je jak „segregatory”, w które możesz wkładać obiekty tak, jak Ci wygodnie (a jak – opiszę dalej na str. 242)4.
Czas pooglądać nasz model z różnych stron. Naciśnij klawisz numeryczny 1 (lub wybierz z menu polecenie: View→Front). Zobaczysz samolot z przodu (Rysunek 2.2.5):
Rysunek 2.2.5 Widok z przodu (ZX) - efekt naciśnięcia klawisza 1
Gdy naciśniesz na klawiaturze numerycznej klawisz 3 (z menu: View→Left) — zobaczysz widok z lewej (ZY — Rysunek 2.2.4). Gdy naciśniesz klawisz numeryczny 7 (z menu: View→Top) — zobaczysz widok z góry (XY — Rysunek 2.2.6):
Rysunek 2.2.6 Widok z góry (XY) - efekt naciśnięcia klawisza 7
Aby zobaczyć model ze strony przeciwnej (prawej, spodu, tyłu) użyj tych samych klawiszy skrótów, ale dodatkowo trzymaj wciśnięty Ctrl:
Rysunek 2.2.6 nie obejmuje całego samolotu. Aby zmienić powiększenie, naciśnij dwa – trzy razy na klawiaturze numerycznej przycisk - (View→Navigation→Zoom In) :
Rysunek 2.2.7 Zmiana powiększenia
Analogicznie, naciśnięcie klawisza +(View→View Navigation→Zoom Out) powiększa obraz. Naciśnięcie Home – przełącza na takie powiększenie, że na ekranie widoczne są wszystkie obiekty.
Powiększenie można także zmieniać za pomocą myszki. Zgrubnie (skokowo) — obracając kółko KM. (Odpowiada to dokładnie naciśnięciom klawiszy +/-). Dokładnie (płynnie) — trzymając wciśnięte: klawisz Ctrl i SPM przesuwaj myszkę do góry lub do dołu.
A jak przesunąć widok w bok? Zgrubnie – klawisze Ctrl-8 lub Ctrl-2 (góra lub dół), Ctrl-4 lubCtrl-6 (lewo lub prawo). To można zapamiętać – zwróć uwagę, że na klawiaturze numerycznej klawisze 8, 6, 2 i 4 mają nawet narysowane odpowiednie strzałki! Mówiąc jednak szczerze — zawsze używam tego celu myszki. Trzymając wciśnięty klawisz Shift i SPM przesuwam myszką, a ekran podąża za tym ruchem5 (Rysunek 2.2.8):
Rysunek 2.2.8 Przesuwanie obrazu
Wreszcie – obracanie. Naciskamy SPM i przesuwamy myszkę w oknie 3D View. Model zaczyna się obracać. Popatrz na Rysunek 2.2.9 – narysowałem tam zasady, obowiązujące przy obrotach:
Rysunek 2.2.9 Obracanie widoku — różne osie obrotu w zależności od położenia kursora myszy
W Blenderze rodzaj obrotu widoku zależy od miejsca, w którym znajduje się kursor myszy. Gdy przesuwasz go po obszarach bliskich krawędzi okna — wywołuje to obrót wokół osi prostopadłej do płaszczyzny ekranu. Gdy przesuwasz kursor w centrum okna — następuje obrót po wyimaginowanej kuli, w środku której znajduje się aktywny obiekt. Przesunięcie poziome powoduje wzdłuż jej „równoleżnika”, a przesuniecie pionowe — wzdłuż „południka”.
Brzmi to trochę skomplikowanie, ale proponuję potrenować obroty przez chwilę lub dwie, aby „wyczuć” jak to działa. W praktyce obrót co chwilę przeplata się przesunięciem obrazu (Shift–SPM, patrz Rysunek 2.2.8), gdyż zdarza się, że obracany model „ucieka” z pola widzenia.
Popatrzmy krytycznie na Rysunek 2.2.10. Czy ten samolot jest proporcjonalny? Bliższe skrzydło wydaje się być mniejsze od dalszego... Nic dziwnego, oglądamy widok w projekcji aksonometrycznej! (To taka projekcja, gdzie dwie równoległe linie w przestrzeni są także równoległe).
Fotografie przyzwyczaiły nas do projekcji perspektywicznej — więc włączmy ją. Naciśnij klawisz 5 (View→Persp/Ortho — Rysunek 2.2.11):
Rysunek 2.2.11 Włączona perspektywa - silny efekt “rybiego oka”
Uff, wygląda na to, że zniekształcenie perspektywiczne jest zbyt silne (Rysunek 2.2.11) – tak wygląda samolot przez obiektyw baaardzo szerokokątny! Czy można coś z tym zrobić?
Oczywiście! Naciśnij N lub wybierz polecenie View→Properties, by otworzyć przybornik po prawej stronie okna (Rysunek 2.2.12a). Jeżeli kontrolki w tym oknie wydają się Ci jakieś dziwne – zerknij na str. 64, tam są opisane.
Rysunek 2.2.12 Przybornik Properties i jego panel View
U góry przybornika znajduje się obecnie sekcja (panel) Transform, z właściwościami tzw. aktywnego obiektu (o tym, co to jest „obiekt aktywny” dowiesz się w następnej sekcji). To nie jest to, czego w tej chwili potrzebujemy. Poniżej są jednak inne, niewidoczne w tej chwili kontrolki. Przesuń suwak przybornika tak, by zobaczyć niewidoczną przy otwarciu panel View (Rysunek 2.2.12b). (W razie potrzeby możesz zmienić kolejność paneli w przyborniku, na przykład tak, by View wyświetlała się jako pierwsza — por. str. 61).
W panelu View widzisz właściwości projekcji widoku. Zmień jego wartość Lens (ogniskowa) z 35 jednostek do 70. (Pole Lens to pole numeryczne – w razie wątpliwości, jak się nim posługiwać zerknij na str. 66). Widać zmianę, tylko że teraz samolot stał się zbyt bliski, i ekran obejmuje tylko jego fragment. Oddalmy się trochę – klawiszem - lub obrotem KM. Ostateczny efekt pokazuje Rysunek 2.2.13:
Rysunek 2.2.13 Widok perspektywiczny — skorygowana ogniskowa
Na powierzchni modelu pojawiły się „przebicia” powierzchni wewnętrznych, które w realnym świecie leżałyby 1-2mm poniżej. (To grubość blachy lub sklejki poszycia). Nie było ich widać w projekcji aksonometrycznej, a także znikają przy zbliżaniu się kamery do obiektu. Są jednak bardzo brzydkie. Jak się ich pozbyć?
Okazuje się, że wystarczy w zmienić inną właściwość na panelu View: zwiększ Clip:Start np. na 0.1, aby te wszystkie przebicia zniknęły (Rysunek 2.2.14):
Rysunek 2.2.14 Widok perspektywiczny — zwiększona wartość Clip:Start
(Poprzednio była wpisana wartość Clip:Start była dziesięć razy mniejsza — por. Rysunek 2.2.13).
Jeżeli chciałbyś z powrotem przełączyć się na projekcję aksonometryczną – naciśnij jeszcze raz 5 (ten przycisk działa jak przełącznik). Możesz także wybrać z menu: View→Persp/Ortho.
W widoku perspektywicznym możesz się spotkać ze zjawiskiem, które nazywam „niewidzialną ścianą”. Aby przekonać się o czym mówię, spróbuj np. powiększyć fragment zawierający kabinę pilota (Rysunek 2.2.15):
Rysunek 2.2.15 Efekt „niewidzialnej ściany” podczas powiększania w widoku perspektywicznym
Ustaw ten fragment w środku okna 3D View i zacznij obracać do przodu KM (Rysunek 2.2.15a). Początkowo będziesz miał wrażenie jakbyś zbliżał się szybko do modelu. Stopniowo jednak ruch staje się coraz bardziej powolny. Ostatecznie osiągniesz takie zbliżenie, w którym mimo dalszego obracania KM nic już się nie będzie zmieniać (Rysunek 2.2.15c). W dodatku w tym powiększeniu przestało także działać przesuwanie obrazu na boki (Shift-SPM)!
Co to za dziwny efekt? No cóż, widok w projekcji perspektywicznej koncentruje się na swoim „fouksie” — punkcie umieszczonym w pewnej odległości od płaszczyzny ekranu. Powiększenie w widoku perspektywicznym oznacza zmniejszenie odległości od tego punktu (Rysunek 2.2.16):
Rysunek 2.2.16 Przyczyny blokady powiększania w widoku prespektywicznym
Gdy obrócisz KM do przodu (lub naciśniesz + na klawiaturze numerycznej) Blender zmniejsza odległość obserwatora od fokusa o 1 / 6 aktualnego dystansu. Oznacza to, że im bliżej jesteś tego punktu, tym wolniej będziesz się poruszał, aż wreszcie utkniesz w odległości bliskiej zera. I to właśnie pokazuje Rysunek 2.2.15. Niestety, w Blenderze nie masz bezpośredniej możliwości przesunięcia fokusa w nowe miejsce!
Na szczęście możemy przesunąć fokus w sposób pośredni. Gdy napotkasz podczas powiększania „niewidzialną ścianę”, cofnij się trochę (tzn. zmniejsz powiększenie) tak, by zwiększyć z powrotem bieżącą odległość od fokusa. Gdy stwierdzisz, że znów możesz wygodnie przesuwać ekranem do góry i na boki, naciśnij Shift-F (View→Navigation→Walk Navigation — Rysunek 2.2.17a):
Rysunek 2.2.17 Wykorzystanie polecenia Walk Navigation do przesunięcia kamery wraz z fokusem
W tym trybie możesz poruszać się po scenie Blendera jak w grach: klawiszem W do przodu, S do tyłu, A w lewo, D w prawo, a myszką zmieniasz kierunek w którym patrzysz. W centrum ekranu pojawią niewielki „celownik”. Aby zbliżyć się do obiektu w kierunku prostopadłym do ekranu, trzymaj wciśnięty klawisz W. (Aby przyśpieszyć ruch, możesz kilka razy obrócić KM do przodu). Gdy zbliżysz się już na tyle, ile potrzeba — kliknij LPM, by zakończyć tę operację (potwierdzić zmianę projekcji). Jeżeli coś pójdzie nie tak — zawsze możesz nacisnąć Esc, by z niej zrezygnować. Polecenie Walk Navigation przesuwa widok wraz z fokusem, dzięki czemu jest najszybszą metodą pokonania efektu „niewidzialnej ściany”. (Dlatego przed jego wywołaniem musisz się trochę cofnąć — by dysponować odpowiednim dystansem po zakończeniu operacji).
Wszystkie omówione w tej sekcji polecenia znajdziesz w submenu View→Navigationokna widoku. Jeżeli początkowo nie będziesz pamiętał jakiegoś klawisza skrótu — użyj go jak podpowiedzi (Rysunek 2.2.18):
Rysunek 2.2.18 Menu View okna widoku
Duży model jest podzielony pomiędzy różne warstwy. Zmieniając widoczność warstw, możesz wybierać te elementy, z którymi chcesz w tym momencie pracować (str. 38);
Do szybkiego przywołanie podstawowych widoków ortogonalnych służą klawisze: 1 (przód), 3 (bok), 7 (góra). Aby zobaczyć obiekt z kierunku przeciwnego – należy dodatkowo nacisnąć Ctrl. Czyli: Ctrl-1 (tył), Ctrl-3 (prawy bok), Ctrl-7 (dół) (str. 39)
Obrót wokół modelu: przesunięcie myszki z wciśniętym przyciskiem środkowym SPM (str. 41)
Przesuwanie ekranu: przesunięcie myszki z wciśniętym SPM i Shift (str. 40);
Powiększenie lub pomniejszenie: przesunięcie myszki do góry lub dołu z wciśniętym SPM i Ctrl (str. 40);
Przełączenie pomiędzy widokiem perspektywicznym i aksonometrycznym: 5 (str. 42);
Parametry widoku (np. ogniskową) możesz zmieniać w przyborniku Properties (N), panel View (str. 43);
Podczas powiększania fragmentu modelu w trybie perspektywicznym możesz natknąć się na efekt „niewidzialnej ściany” (str. 44). Aby go przezwyciężyć, użyj do powiększenia obrazu polecenia Fly Navigation (Shift-F, str. 45).
W poprzednim paragrafie nie powiedzieliśmy jeszcze wszystkiego o możliwych sposobach oglądania modelu. Aby się o tym przekonać, naciśnij klawisz 0 (View→Camera):
Rysunek 2.3.1 Widok z kamery
To, co widzimy powyżej (Rysunek 2.3.1), to widok z kamery. Jest to projekcja, jaką Blender użyje do stworzenia ostatecznego obrazka lub animacji.
A co to są same kamery? To pewien rodzaj obiektu, który możesz wstawić w scenę. W tej umieściłem dwie kamery. Naciśnij 1 i zmień nieco powiększenie, aby je zobaczyć (Rysunek 2.3.2):
Rysunek 2.3.2 Dwie kamery w scenie z Ła-5
Kamery można przesuwać — zupełnie tak, jak w rzeczywistym studio. Nim do tego przejdziemy (str. 51), nauczymy się zaznaczać obiekty. Od tego zaczyna się w Blenderze każda operacja. Kliknij w prawą kamerę PPM. Powinna się podświetlić (Rysunek 2.3.3):
Rysunek 2.3.3 Zaznaczony obiekt – kamera
Zaznaczony obiekt zmienił kolor na bladoróżowy. Tak właśnie w Blenderze zaznacza się pojedynczy element. Jednocześnie w lewym dolnym narożniku okna została wyświetlona jego nazwa. Ta nazwa jest nazwą aktualnego obiektu aktywnego. Obiekt aktywny to obiekt, który ostatnio został zaznaczony przez kliknięcie myszką.
Naciśnij teraz A (Select→Select/Deselect All), aby wyłączyć selekcję. (To polecenie „czyści” listę wybranych obiektów, gdy coś jest wybrane, lub zaznacza wszystko, gdy nic nie było zaznaczone). Zwróć uwagę, że nazwa obiektu aktywnego pozostanie na ekranie (Rysunek 2.3.4):
Rysunek 2.3.4 Ten sam obiekt wciąż aktywny - mimo, że wyłączyliśmy zaznaczenie
Zawsze warto zwracać uwagę, jaki jest aktualny obiekt aktywny. Zobaczysz później, że Blender zawsze traktuje taki obiekt w sposób szczególny.
Aby po kolei dołączać obiekty do grupy wybranych, wystarczy podczas klikania PPM trzymać wciśnięty klawisz Shift. Aby lepiej „wyczuć”, jak to działa, proponuję, abyś wykonał kilka szybkich doświadczeń.
Zacznij od sytuacji, gdy nic nie jest zaznaczone. Trzymaj wciśnięty klawisz Shift i wykonuj po kolei operacje, które wylicza Tabela 2.3.1. (Przypisania nazw do kamer znajdziesz na str. 47, Rysunek 2.3.2). :
| Trzymając wciśnięty Shift: | Rezultat | |
| Obiekty wybrane i ich kolory | Obiekt aktywny | |
| Kliknij PPM w obiekt Camera.Static | Camera.Static (bladoróżowy) | Camera.Static |
| Kliknij PPM w obiekt Camera.Tracked | Camera.Static (różowy) Camera.Tracked (bladoróżowy) | Camera.Tracked |
| Kliknij PPM w obiekt Camera.Static | Camera.Static (bladoróżowy) Camera.Tracked (różowy) | Camera.Static |
| Kliknij PPM w obiekt Camera.Static | Camera.Tracked (różowy) | Camera.Static |
Tabela 2.3.1 Obiekty wybrane a obiekt aktywny - kilka doświadczeń z operacjami grupowymi
Nie będę pokazywał rezultatów operacji, jakie podaje Tabela 2.3.1, na oddzielnych ilustracjach. To ułomność poligrafii, że nie pokazuje delikatnej różnicy pomiędzy dwoma barwami zaznaczeń: bladoróżową (obiekt aktywny) i różową (pozostałe obiekty wybrane). Wnioski z wykonanego doświadczenia:
Modyfikator w postaci klawisza Shift służy nie tylko do włączania, ale i wyłączania obiektu spośród wyboru. (Gdy klikniesz w obiekt powtórnie, stanie się obiektem aktywnym, a gdy klikniesz jeszcze raz – przestanie być wybranym);
Obiekt aktywny nie musi być w ogóle obiektem wybranym (patrz Tabela 2.3.1, ostatni wiersz);
Możliwe jest także zaznaczanie grupy obiektów obszarem prostokątnym. Naciśnij na klawiaturze klawisz B (Select→Border Select). Przy kursorze myszy pojawią się dwie kreskowane linie. Przesuń kursor w miejsce, gdzie chciałbyś umieścić jeden z narożników obszaru. Naciśnij lewy klawisz myszki LPM, i nie zwalniaj. Na ekranie pojawi się prostokątny obszar (por. Rysunek 2.3.5). Nieruchomy narożnik tego obszaru jest w miejscu, w którym wcisnąłeś LPM. Ruchomy narożnik podąża za ruchem myszki. Gdy ustawisz właściwy obszar, zwolnij LPM. Zaznaczeniu ulegają wszystkie obiekty, które znalazły się wewnątrz obszaru, lub przecięły jego krawędź. Zaznaczenie obszarem nie zmienia aktualnego obiektu aktywnego.
Rysunek 2.3.5 Zaznaczenie obszarem (Border Select)
Aby wykluczyć z zaznaczenia objęte obszarem przedmioty, po naciśnięciu B użyj SPM (zamiast LPM).
Menu selekcji zawiera jeszcze kilka innych możliwości wyboru, m. in. wybór wg warstw, lub typu obiektu (Rysunek 2.3.6):
Rysunek 2.3.6 Przykład innych możliwości wyboru, dostępnych z menu Select.
Na str. 322 znajdziesz opis kilku innych przydatnych metod selekcji obiektów.
Podsumowanie
Aby zobaczyć podgląd widoku z kamery – naciśnij klawisz 0 (View→Camera) (str. 47);
Zaznaczanie obiektu – kliknięcie PPM. Z wciśniętym dodatkowo Shift – dołącza obiekt do wybranych poprzednio (str. 48);
Zaznaczanie grupy obiektów prostokątnym obszarem – naciśnij B (lub Select→Border Select). Potem wciśnij LPM w jednym narożniku i przeciągnij kursor z wciśniętym LPM do przeciwległego narożnika obszaru. Wykluczenie z zaznaczenia prostokątnym obszarem — zaczynasz tak samo (B), tylko zamiast LPM używasz SPM (str. 49);
Blender wyróżnia, oprócz zaznaczenia, obiekt ostatnio „kliknięty” PPM. Taki obiekt jest nazywany aktywnym, a jego nazwa pojawia się w lewym dolnym narożniku okna (str. 48);
Zaczniemy od przesunięcia kamery (to też obiekt). Wcześniej jednak:
upewnij się, że po zaznaczaniu kamery, w lewym dolnym narożniku okna pojawiła się nazwa Camera.Tracked. Jest to kamera, którą przesuniemy;
naciśnij Ctrl – ↓ (Area Options→Tile Window), by powrócić do układu wielu okien. W jednym z nich ustaw widok kamery, a w drugim – widok z przodu (por. Rysunek 2.4.1). W ten sposób będziemy w stanie obserwować obraz z kamery:
Rysunek 2.4.1 Proponowany układ ekranu
Naciśnij klawisz G (Object→Transform→Grab/Move). Od tej chwili każdy ruch myszką powoduje przemieszczenie kamery. Zwróć uwagę, że zmienia się także projekcja w oknie kamery (Rysunek 2.4.2):
Rysunek 2.4.2 Przemieszczanie obiektu
Podczas przesuwania Blender pokazuje w nagłówku aktywnego okna zmianę współrzędnych X,Y,Z, oraz zmianę odległości (w nawiasie) od oryginalnego położenia obiektu. Kliknięciem LPM kończysz tę operację, zatwierdzając nowe położenie. (W razie czego: naciśnięcie Esc także ją kończy, anulując przesunięcie).
Jak to się stało, że podczas przesuwania kamera nie straciła samolotu z centrum widzenia? Otóż ten obiekt ma włączony tryb „śledzenia” (ang. track). W dalszej części tej książki opiszę, jak tworzyć takie powiązanie. Teraz chciałbym zademonstrować, co właściwe śledzi kamera.
Abym mógł pokazać ten obiekt, musimy wyłączyć pewne warstwy, i włączyć inne. Ale gdzie się podziała kontrolka z warstwami? Każde z okienek widoków jest na tyle wąskie, że ukryła się gdzieś za krawędzią ekranu (por. Rysunek 2.4.1)!
Mały sekret: w Blenderze możesz przesuwać zawartość nagłówków okien, jak gdyby były płaskim rysunkiem. Ustaw kursor ponad tym, który chcesz przesunąć, i wciśnij SPM. Trzymając wciśnięty klawisz, przesuwaj kursor. Widzisz, że cały nagłówek się porusza? Przesuń go w lewo, abyśmy zobaczyli kontrolkę z warstwami (Rysunek 2.4.3).
Teraz wyłącz warstwę 11 i włącz 10. Ach, prawda, muszę wprowadzić pojęcie numeracji warstw! Aby w dalszym tekście nie tłumaczyć długo i zawile, o jaką warstwę chodzi, na potrzeby tej książki przypisałem warstwom numery:
Rysunek 2.4.4 Numeracja warstw – konwencja przyjęta na potrzeby tej książki
Tak więc wyłączenie warstwy 11 i włączenie 10 oznacza uzyskanie dla tego modelu następującego układu:
. Wraz z warstwą 11 została ukryta środkowa i tylna część kadłuba, oraz skrzydła. Warstwa 10 jest jedną z dwóch warstw zawierających obiekty „sterujące”, nie przeznaczone do pokazywania na ostatecznym obrazie. (Drugą taką warstwą w tym modelu jest warstwa 9). Teraz miejsce niewidocznych skrzydeł na naszym modelu wyznaczają sloty, klapy i lotki, a usterzenia – stery kierunku i wysokości (Rysunek 2.4.5):
Rysunek 2.4.5 Obiekt Camera.Target- cel naszej kamery
Gdzieś w okolicy kabiny pilota znajduje się stosunkowo duży, czerwony walec. Nazywa się Camera.Target. Zaznacz go (por. Rysunek 2.4.5).
Powiedzmy, że chcielibyśmy, aby punkt, na który „patrzy” kamera znajdował się w okolicy silnika, a nie kabiny pilota. W tym celu należy przesunąć obiekt Camera.Target wzdłuż osi Y. Jest to możliwe w każdym widoku, nawet perspektywicznym (jak widok z kamery).
Naciśnij znów klawisz G, aby rozpocząć przesuwanie. Zaraz potem naciśnij Y – oznacza to, że ograniczamy przesunięcie tylko do tej osi. Oś Y stała się biała, i zmienił się tekst u dołu okna – pokazuje wyłącznie zmianę odległości wzdłuż tej osi. Teraz, wraz z każdym przesunięciem myszki, obiekt „jeździ” po osi Y jak po drucie (Rysunek 2.4.6).
Rysunek 2.4.6 Przesuwanie obiektu wzdłuż osi Y
Jak widać, kamera przez cały czas „trzyma” Camera.Targetw centrum obrazu. Nie kończ jeszcze przesunięcia. Pokażę teraz inny efekt: w czasie ruchu myszki naciśnij, i trzymaj wciśnięty, klawisz Ctrl. Wykonaj stosunkowo daleki ruch. Zobaczysz, że przesunięcie następuje teraz skokowo, co 10 jednostek (Rysunek 2.4.7):
Rysunek 2.4.7 Przesunięcie skokowe (wciśnięty klawisz Ctrl)
Warto zapamiętać: klawisz Ctrl podczas każdej transformacji (przesunięcia, obrotu, zmiany skali) wymusza skokowe zmiany, o jakieś „zaokrąglone” wartości.
(To, że pokazuję działanie klawisza Ctrl akurat na przesuwaniu wzdłuż osi Y to przypadek. Możesz go używać w każdej transformacji).
Dlaczego rozmiar „skoku” dla przesunięcia w oknie kamery wynosił akurat 10 jednostek? To zależy od dwóch czynników: aktualnego powiększenia, oraz projekcji. Przerwij aktualne przesunięcie (Esc) i zacznij je jeszcze raz, ale w oknie z widokiem z boku (lewe dolne - por. Rysunek 2.4.7). Gdy będziesz trzymał wciśnięty klawisz Ctrl, obiekt będzie się przemieszczał co 5 jednostek — dwa razy mniej, niż w przypadku widoku perspektywicznego. To jakaś ogólna zasada — w oknach z projekcją „prostopadłą” (z góry, z boku, z przodu..), te odległości są najmniejsze. Wynoszą mniej więcej tyle, ile odległości pomiędzy węzłami pomocniczej siatki, którą widać na ekranie. Gdy powiększymy obraz, siatka robi się coraz gęstsza. Odpowiednio maleje skok, jaki uzyskujemy w czasie przesunięć z klawiszem Ctrl — z 5 jednostek do 1.
A teraz inny efekt: podczas przesuwania obiektu trzymaj wciśnięty klawisz Shift. Co się dzieje? Ten sam ruch myszki wywołuje mniejsze przesunięcia!
Warto zapamiętać: klawisz Shift podczas każdej transformacji (przesunięcia, obrotu, zmiany skali) zwiększa „przełożenie” ruchu myszki. (Większe ruchy myszką odpowiadają mniejszym przesunięciom na ekranie). Ułatwia to dokładniejsze ustalanie końcowej pozycji
A gdy wciśniesz jednocześnie Ctrl i Shift? Uzyskujemy nadal skokowe przesunięcia, ale o jednostki o rząd mniejsze. W widoku perspektywicznym kamery przesunięcie z samym Ctrl zmieniało położenie obiektu co 10 jednostek, a z wciśniętym Shift-Ctrl – co 1 jednostkę.
Obrót obiektu chciałbym pokazać w oknie z widokiem z boku. Tylko jest mały problem – obracany obiekt jest zasłonięty przez klapę. Powiedzmy, że nie chcę wyłączać widoczności warstwy, która zawiera ten element, bo przestałbym widzieć zarys skrzydła. Zamiast tego zmienię sposób rysowania zawartości tego okna na liniowy (ang. wireframe). Służy do tego lista rozwijalna Viewport Shading w nagłówku każdego okna 3D View (Rysunek 2.4.8):
Rysunek 2.4.8 Wybór sposobu rysowania (Viewport shading) zawartości okna
Rysunek 2.4.9 pokazuje, jak wygląda rezultat przełączenia. Jak widać, sposób rysowania można ustalać niezależnie dla każdego okna. (Pozostałe są nadal w trybie Solid).
W praktyce tryby Solid i Wireframe wykorzystuje się najczęściej. O trzecim sposobie cieniowania (Textured) opowiem przy okazji pracy z teksturami.
Jak się obraca obiekt? Bardzo podobnie do przesuwania: naciskasz klawisz R (Object→Transform→Rotate), i zaczynasz obrót (Rysunek 2.4.9):
Rysunek 2.4.9 Obrót (dookoła środka aktywnego obiektu)
Domyślną płaszczyzną obrotu jest aktualna płaszczyzna ekranu. Możesz także dokonywać obrotu wokół wybranych osi X,Y, Z, naciskając jedną z tych klawiszy klawiatury. Podobnie jak w przypadku przesunięcia, nagłówek okna pokazuje aktualny kąt obrotu.
Wraz z obrotem Camera.Target, obraca się kamera (patrz okno po prawej). Wynika to z faktu, że kamera ma włączone “śledzenie” tego obiektu, więc orientacja osi Z kamery także podąża za orientacją Camera.Target.
Podczas obrotu można także stosować klawisze Shift (dokładny obrót, o ułamki stopnia), Ctrl (obrót co 5 stopni), Shift-Ctrl (obrót co 1 stopień).
Jeżeli chcesz użyć innego środka transformacji niż środek obiektu, musisz się posłużyć tzw. „kursorem 3D” (3D cursor).
Wiesz zapewne, jak działa w każdym edytorze tekstów mrugający znak „karetki” (caret). Pokazuje, w którym miejscu będzie teraz wstawiony tekst, gdybyś zaczął go pisać. Tę koncepcję przeniesiono w trzy wymiary. W Blenderze istnieje taki specjalny punkt, który możesz umieścić w dowolnym miejscu w przestrzeni. Nazywa się także kursorem (ale, dla odróżnienia, „3D”). Pokazuje, gdzie zostałby umieszczony nowy obiekt, gdybyś go chciał w tym momencie stworzyć. Może także służyć jako punkt odniesienia w takich operacjach jak obrót czy skalowanie.
Kursor 3D jest rysowany jako niewielki krzyż, otoczony czerwono-białym okręgiem (Rysunek 2.4.10). Możesz go umieścić w dowolnym miejscu, klikając w tym punkcieLMB. Można zmusić go, aby przesunął się do najbliższego punktu siatki – w tym celu naciśnij Shift-S (Object to Snap) i z menu kontekstowego, które się pojawi, wybierz opcję Cursor to Grid (Rysunek 2.4.10). (Ten drugi krok – wybór pozycji z menu – możesz to zrobić lewą ręką, naciskając na klawiaturze klawisz 6. Jest to numer pozycji Cursor to Grid w menu Snap)
Aby wykonać obrót Camera.Target wokół dowolnego punktu przestrzeni, umieść w tym miejscu (kliknięcie LPM) kursor 3D. (Często musisz wskazać jego położenie na dwóch rzutach. Przydaje się tu także możliwość “skoku do węzła siatki”).
Następnie przełącz Blender w tryb, który wykorzystuje kursor jako punkt odniesienia dla wywoływanych transformacji. Służy do tego lista rozwijalna Pivot, umieszczona w nagłówku okna 3D View (Rysunek 2.4.11). Wybierz z niej pozycję 3D Cursor (lub . z klawiatury):
Rysunek 2.4.11 Zmiana trybu odniesienia transformacji — na kursor sceny
Upewnij się także, że obiekt Camera.Target jest nadal zaznaczony.
Reszta przebiega tak samo, jak poprzednio – naciśnij R i zacznij obracać obiekt (Rysunek 2.4.12):
Rysunek 2.4.12 Obrót obiektu dookoła kursora 3D
Po zakończeniu operacji przestaw menu Pivot Point z powrotem na opcję Bounding Box Center (,). Alternatywnie możesz się przełączyć na tryb Individual Centers (Ctrl-.).
Ostatniej z trzech podstawowych operacji — skalowania — nie będę tu szczegółowo opisywał. Starałem się do tej pory omawiać każdy temat w ten sposób, abyś mógł, Czytelniku, zdobytą wiedzę zaraz wykorzystać. Na przykład za pomocą obrotu obiektu Camera.Target i zmiany położenia Camera.Tracked możesz zaaranżować do renderowania zupełnie nowy widok modelu Ła-5. (Renderowania pokażę w następnej sekcji). Jak na złość, nie znalazłem, w tym momencie i w tym rysunku, żadnego „użytecznego” zastosowania dla zmiany skali. W skrócie wspomnę tylko, że zmiana rozmiaru obiektu przebiega bardzo podobnie do obrotu. Tak samo ważny jest wybór punktu odniesienia: środka obiektu lub kursora 3D. Skalowanie wywołujemy poprzez naciśnięcie klawisza S (Object→Transform→Scale). Więcej na temat tego polecenia znajdziesz w opisie szczegółów, na str. 300.
Do tej pory określaliśmy wektor przesunięcia czy kąt obrotu „interaktywnie” — za pomocą myszki. Jeżeli chcesz po prostu wpisać dokładną wartość numeryczną transformacji obiektu, naciśnij klawisz N, by otworzyć prawy przybornik okna (View→Properties). W panelu Transform(Rysunek 2.4.12) znajdziesz numeryczne wartości położenia (Location), obrotu (Rotation) i skali (Scale) aktywnego obiektu. Gdybyś w tej chwili zaczął go obracać za pomocą myszki, wartości, Blender „na bieżąco” uaktualniałby wartości w przyborniku. To działa także na odwrót: gdy wpiszesz w jedno z pól panelu Transform nową wartość, to efekt od razu zobaczysz na scenie.
Zwróć uwagę, że przy każdym z pól transformacji znajduje się ikona „kłódki” (
). Jeżeli zostanie wciśnięta — współrzędna z tego pola jest wyłączona ze zmian podczas jakichkolwiek przekształceń. To się może przydać, aby np. przeskalować obiekt wyłącznie w płaszczyźnie XZ – wystarczy zablokować Scale:Y. Gdy potem wywołasz operację zmianę skali we wszystkich kierunkach jednocześnie (S) – kierunek Y pozostanie niezmienny.
W trakcie transformacji (obrotu, przesunięcia, zmiany skali…) można także wprowadzić dokładne wartości przesunięć za pomocą klawiatury. Wystarczy po wywołaniu transformacji nacisnąć klawisz = (Rysunek 2.4.14):
Rysunek 2.4.14 Przełączenie w tryb ręcznego wpisywanie wartości transformacji
Przełącza to Blendera w tryb, w którym w miejscu pierwszej współrzędnej pojawia się linia karetki — i możesz wpisać nową wartość z klawiatury). Aby przejść do następnego pola, naciśnij Tab (Rysunek 2.4.15b). Aby zaakceptować wprowadzone zmiany naciśnij Enter, a aby z nich zrezygnować — Esc.
Rysunek 2.4.15 Wpisywanie dokładnych wartości przesunięć
W przyborniku Properties możesz także sprawdzić lub wpisać dokładne współrzędne kursora 3D. Wystarczy że przesuniesz jego zawartość nieco w górę, by odsłonić panel 3D Cursor. Nowe wartości położenia kursora możesz wpisać w sekcję Location (Rysunek 2.4.16):
Po tylu operacjach edycji warto powiedzieć, co zrobić gdy się pomyliliśmy i chcemy wycofać dokonane zmiany. Jak większość edytorów, Blender umożliwia wielokrotne wycofanie (Undo) i powtórzenia (Redo) ostatnio wykonanych poleceń. Są to operacje na tyle ważne, że ich skróty od razu umieszczę w ramkach, aby w krytycznej chwili zaraz wpadły Ci w oko:
Operacja Undo – wycofanie ostatniego polecenia: naciśnij Ctrl-Z (albo wybierz z menu polecenie Object→Undo).
Operacja Redo – wycofanie wycofania ostatniego polecenia: naciśnij Ctrl-Shift-Z (albo wybierz z menu polecenie Object→Redo)
Trochę wyprzedzając kolejność wprowadzania zagadnień przyjętą w tej książce, wspomnę że menu Object jest dostępne w 3D View tylko w tzw. trybie obiektu (Object Mode). W innych trybach, (np. edycji siatki pojedynczego obiektu — Edit Mode), jego miejsce zajmują inne menu (np. Mesh). W każdym z nich są dostępne polecenia Undo i Redo. Wydaje mi się jednak, że te dwa skróty lepiej jest zapamiętać. W innych oknach, np. UV/Edit Image takich poleceń nie ma ani w menu Image, ani żadnym innym. Tam polecenia Undo i Redo są jednak nadal dostępne — poprzez podane powyżej kombinacje klawiszy klawiatury.
Na skalowaniu zakończymy omawianie podstawowych transformacji w Blenderze. Jest ich oczywiście o wiele więcej – jak sam się możesz przekonać, otwierając menu Object. (Rysunek 2.4.17):
Rysunek 2.4.17 Menu transformacji obiektu
Nie przerażaj się rozmiarem tego menu. Wielu z tych poleceń nie będziesz używał, a te, które są potrzebne, omówię powoli w dalszych rozdziałach tej książki.
Przesuwanie obiektu – klawisz G (Grab/Move — str. 51);
Skalowanie obiektu – klawisz S (Scale — str. 57);
Wciśnięcie Ctrl podczas transformacji włącza zmiany skokowe, o zaokrąglone wartości (str. 53);
Wciśnięcie Shift podczas transformacji włącza zmiany dokładne, ułatwiając końcowe ustalanie pozycji (str. 54);
Wszystkie transformacje można ograniczać do pojedynczej osi, naciskając w ich trakcie X, Y, lub Z (str. 53);
Przełączanie punktu odniesienia (wykorzystywany podczas obrotu i skalowania): . = 3D Cursor, , = Bounding Box (str. 56)
Rezygnacja z aktualnie wykonywanego polecenia – klawisz Esc (str. 51, 54)
Wycofanie ostatniego polecenia – Ctrl-Z (Undo — str. 58).
Odtworzenie wycofanego polecenia – Shift-Ctrl-Z (Redo — str. 58);
Na koniec tego rozdziału chciałbym pokazać, jak otrzymać produkt końcowy – wyrenderowany obraz modelu Ła-5. W tym celu trzeba będzie coś kliknąć i coś przestawić w oknie właściwości (Properties). To okno jest domyślnie umieszczone z prawej strony ekranu Blendera (Rysunek 2.5.1):
Rysunek 2.5.1 Elementy okna właściwości (Properties)
W tym oknie są wyeksponowane wewnętrzne właściwości sceny, modelu, pojedynczej części, materiału, tekstury... Na pierwszy rzut oka roi się w niej od kontrolek. Zacznę więc od wyjaśnienia jego wewnętrznej struktury i sposobu obsługi. W nagłówku okna znajduje się pole wyboru sekcji (zestawu paneli). Poniżej widać tzw. kontekst — czyli rzecz, której dotyczą wyświetlane właściwości. (W przykładzie, który pokazuje Rysunek 2.5.1, jest to aktualna scena, o nazwie Airborne). Poniżej są umieszczone panele, grupujące kontrolki związane z jakimś zagadnieniem (Render, Layers, Dimensions, … — Rysunek 2.5.1).
Każda panel ma nagłówek. Jest w nim wyświetlana nazwa panelu. Z lewej strony nazwy umieszczono przycisk umożliwiający zwijanie i rozwijanie (Rysunek 2.5.2):
Rysunek 2.5.2 Obsługa panelu — zwijanie i rozwijanie
Po prawej stronie nagłówka panelu znajduje się „uchwyt” . Możesz go „złapać” LPM i przesunąć panel w nowe miejsce (Rysunek 2.5.5):
Rysunek 2.5.3 Obsługa panelu — przesuwanie
Pozycje wszystkich paneli (i w ogóle — cały stan interfejsu użytkownika) jest zachowywany w pliku Blendera. (Gdy otworzysz plik, wszystko na ekranie Blendera będzie wyglądać dokładnie tak, jak w momencie wywołania polecenia File→Save. To bardzo wygodne)
Często panele wybranej sekcji nie mieszczą się na ekranie. Wtedy musisz przesuwać zawartość okna Properties. Możesz to zrobić używając suwaka (Rysunek 2.5.4a), umieszczonego przy krawędzi okna, lub po prostu przesuwając myszkę z wciśniętym SPM (Rysunek 2.5.4b):
Rysunek 2.5.4 Okno Properties — dwie metody przesuwanie zawartości
Blender posiada tak dużo różnorodnych paneli, że korzystanie z nich wszystkich jednocześnie jest właściwie niemożliwe. (Za dużo byłoby przewijania w górę i w dół okna). Na szczęście nawet nie ma takiej potrzeby. Innych kontrolek potrzebujesz przy modelowania geometrii, innych do pracy nad materiałami i oświetleniem, a jeszcze innych – do renderowania ostatecznego rezultatu: pojedynczego obrazu lub animacji. Dlatego panele w oknie Properties są podzielone na kilkanaście zestawów (sekcji), odpowiadających typowym operacjom. Przełączanie się pomiędzy zestawami odbywa się za pomocą przycisków z ikonami umieszczonych w nagłówku okna (Rysunek 2.5.5):
Rysunek 2.5.5 Typowe zestawy paneli okna Properties
Rysunek 2.5.5 przedstawia najczęściej występujący układ sekcji. Tak wygląda nagłówek okna Properties dla typowego obiektu „geometrycznego”, z których buduje się modele. Rysunek 2.5.5a) podaje krótki opis zestawów, które zawsze są w nagłówku okna Properties, niezależnie od rodzaju aktywnego obiektu. To pięć pierwszych sekcji z lewej: Render, Scene, Word, Object, Object Constraints, i jedna z prawej: Phisics. Rysunek 2.5.5b) wylicza sekcje wyświetlane dla obiektu zawierającego tzw. „siatkę” (mesh) — czyli jakieś ściany, krawędzie, wierzchołki.
Przy okazji — zwróć uwagę, że Rysunek 2.5.5a) pokazuje inny kontekst (scenę o nazwie Airborne) niż Rysunek 2.5.5b). Dzieje się tak, mimo że na scenie aktywnym obiektem był przez cały czas kadłub samolotu (obiekt 012.Body). Spróbuj wybrać jeszcze inne sekcje, a zauważysz dalsze różnice (Rysunek 2.5.6):
Rysunek 2.5.6 Wyświetlany kontekst zależy od wybranej sekcji
Gdy przełączysz się na zestaw Object, Blender wyświetli jako kontekst aktywny obiekt (Rysunek 2.5.6a) — tym razem już bez siatki (por. Rysunek 2.5.5b). Gdy wybierzesz sekcję World, w polu kontekstu pojawi się definicja otoczenia w którym znajduje sięobiekt aktywny. Z tego samego powodu po wybraniu sekcji Render w kontekście pojawia się już tylko scena, w której znajduje się wybrany obiekt (por. z Rysunek 2.5.5a).
Wyświetlany tuż pod nagłówkiem okna Properties kontekst zawsze wskazuje przedmiot, którego właściwości są udostępnione w panelach poniżej.
Jeżeli nie chcesz, by kontekst zmieniał się wraz ze zmianą aktualnego obiektu aktywnego, można go “przypiąć” do nagłówka umieszczoną z boku “szpilką” (Rysunek 2.5.7). W nagłówku okna pozostaną wówczas wyłącznie te sekcje, które dotyczą tego “przypiętego” kontekstu.
W Blenderze istnieją także inne rodzaje obiektów, które nie przechowują siatek: np. źródła światła (Lamp), albo kamery. Rysunek 2.5.8a) przedstawia sekcje, które są wyświetlane dla obiektów typu Lamp, a Rysunek 2.5.8b) — dla obiektów typu Camera:
Rysunek 2.5.8 Warianty zestawów dla różnych typów Object Data
Jak widać, w sekcji Object Data, która dla siatek miała ikonę „trójkąta” (por. Rysunek 2.5.5b), dla źródła światła jest „słoneczko” (Rysunek 2.5.8a). Ikona kamery mówi sama za siebie Rysunek 2.5.8b). Zauważ, że ani kamery, ani lampy, nie mogą mieć przypisanych sekcji cząsteczek (Particles) ani materiałów (Material), a kamery nie mają także sekcji tekstur (bo nie jest to im do niczego potrzebne).
Tabela 2.5.1 podaje zestawienie zestawów jakich przyjdzie nam używać w dalszych rozdziałach tej książki:
| Zestaw | Opis |
| | Obsługa tworzenia ostatecznego obrazu lub animacji (renderowania). Na koniec tej sekcji pokażę, o co chodzi. |
| | Właściwości sceny, np. wybór aktywnej kamery, ustawienie jakiejś drugiej sceny w charakterze tła. Jeden z dodatków do „pozowania” samolotu (wysuwanie u chowanie podwozia, ruchy sterów, itp.), który będziemy używać (Handle Panel) umieszcza swoje panele w tej sekcji. |
| | Sterowanie parametrami otoczenia sceny (np. kolor i/lub obraz tła, światło rozproszone, itp.) |
| | Właściwości obiektu: aktualne położenie, orientacja, nazwa, i inne (np. warstwy, na których się znajduje). |
| | Zarządzanie ewentualnymi ograniczeniami obiektu. (Na przykład — kamera Camera.Tracked jest zawsze jest skierowana na model Ła-5, bo ma przypisane ograniczenie Track To. To ograniczenie zawsze kieruje wybraną oś kamery na obiekt Camera.Target). |
| | Sekcja wyświetlana tylko dla obiektów „geometrycznych” — czyli zawierających siatki (mesh). Pozwala w sposób „odwracalny” wzbogacić siatkę o dodatkowe efekty, np. wygładzania powierzchni (powierzchniami podziałowymi Catmull-Clarka), albo wygiąć ją wzdłuż wskazanej krzywej. |
| Object Data | Właściwości „zawartości” obiektu: siatki (obiekt typu Mesh), albo źródła światła (Lamp), albo kamery (Camera), albo jeszcze innych typów obiektów (np. linii krzywej — Curve). |
| | Ustalanie ogólnych właściwości materiału obiektu (kolor i połyskliwość powierzchni, przejrzystość, rzucanie cieni, i wiele innych aspektów) |
| | Zarządzanie teksturami. Są to obrazy rastrowe, za pomocą których odwzorowane są drobne nierówności powierzchni (łączenia blach poszycia, nity). Służą także do lokalnych zmiany właściwości materiału — np. koloru (kamuflaż samolotu, zabrudzenia), czy nawet przejrzystości (odwzorowują drobne otwory). |
| | Z tej sekcji skorzystamy pod koniec książki do zamodelowania trawy lotniska, na którym postawimy nasz model. |
Tabela 2.5.1 Zestawienie wybranych zestawów i podzestawów paneli
Jeżeli takie pojęcia jak „materiał” czy „tekstura” są dla Ciebie dalej abstrakcyjne — nie przejmuj się, wyjaśnię to w dalszych rozdziałach. Tabela 2.5.1 została tutaj umieszczona, abyś wiedział, co należy wybrać, gdy napiszę: „w oknie właściwości przełącz się na zestaw Material”.
Wybacz, jeżeli dotychczasowe wprowadzenie było trochę przydługie. Chciałem przybliżyć szczegóły posługiwania się systemem paneli i ich zestawów. W istocie wygenerowanie ostatecznego obrazu lub animacji w Blender możne się sprowadzić do naciśnięcia pojedynczego przycisku. (Za chwilę podam, który to jest). Nim to jednak zrobię, omówię kilka opcji, określających postać obrazu, jaki uzyskamy. Przy tej okazji wyjaśnię pokrótce nietypowe szczegóły kontrolek Blendera.
Przełącz się na zestaw Render. Rysunek 2.5.9 przedstawia podstawowe rodzaje kontrolek, wykorzystywanych przez GUI Blendera na przykładzie paneli z tej sekcji:
Rysunek 2.5.9 Podstawowe rodzaje kontrolek Blendera
Przyciski (operation buttons), umieszczone w panelach, służą do wywołania jakiegoś polecenia (jak np. Render:Image lub Render:Animation). Tak w ogóle to w oryginalnej terminologii Blendera każda kontrolka jest określana jako jakiegoś rodzaju „przycisk” (button). To tradycja, której początki giną w mrokach historii programu. Pewnie dlatego indywidualne etykiety są tu umieszczane wewnątrz list, pól numerycznych, czy przełączników (por. Rysunek 2.5.9a). Trzeba się do tej konwencji przyzwyczaić. Wyłamują się z niej tylko pola opcji (wszędzie indziej określane jako checkbox, ale tutaj — jako toggle button). To jest jednak stosunkowo świeża modyfikacja, które pojawiła się w wersji 2.5 (we wcześniejszych wersjach tę rolę pełniły przyciski o dwóch stanach: „wciśnięty” i „zwolniony”). Obecne pola opcji są dla nowego użytkownika bardziej czytelne, bo nawiązują do konwencji używanej w popularnych systemach okienkowych.
Tuż pod nagłówkiem panelu Dimensions jest umieszczona lista rozwijalna (menu button) o nazwie Render Presets. Możesz w nią kliknąć (oczywiście LPM) i wybrać jeden z typowych wymiarów obrazu lub animacji (Rysunek 2.5.9b)1. Na innych panelach widzisz jeszcze kilka innych list rozwijalnych, służących np. do wyboru jednej z możliwych opcji (np. lista Render:Display). Gdy nazwy alternatywnych opcji są krótkie, zamiast listy może być użyty przełącznik (radio button) — taki, jak w panelu Anti-Aliasing (Rysunek 2.5.9).
Czasami lista rozwijalna może mieć kilka kolumn. Pokażę to na przykładzie innej listy. Przesuń panele sekcji Render nieco do góry, abyś mógł zobaczyć umieszczony na jej końcu panel Output. Znajduje się na nim lista rozwijalna, w której możesz ustalić domyślny format zapisu wyrenderowanego obrazu (Rysunek 2.5.10):
Rysunek 2.5.10 Wybór domyślnego formatu pliku obrazu/animacji — inna postać listy rozwijanej
Format, ustalony w tym miejscu, dotyczy nie tylko obrazu renderowanego. Nawet zwykły „zrzut” aktualnego ekranu Blendera (Ctrl-F3) jest zapisywany w postaci ustalonej właśnie w tym polu!
Gdy wybierzemy jako format zapisu Jpeg, warto sprawdzić wartość w polu numerycznym Quality (Rysunek 2.5.10). Format Jpeg jest jednym z tzw. formatów degradujących (jakość obrazu) za cenę mniejszego rozmiaru. Za pomocą wartości Quality (wyrażonej w procentach) można sterować kompromisem pomiędzy rozmiarem a jakością. Jeżeli Quality = 100%, to żadna degradacja nie zachodzi (każdy piksel obrazu jest pamiętany oddzielnie). Takie pliki będą miały oczywiście największy rozmiar. Osobiście radzę ustalić wartość Quality do 85% – daje to jeszcze nie za duży plik, i w miarę dobrą jakość rezultatu.
A jak to wpisać? Zapewne dla większości Czytelników jest to oczywiste, ale opiszę tu to w paru słowach. Być może przy okazji dowiesz się jakiegoś przydatnego szczegółu.
Pole Output:Quality jest tzw. „suwakiem” (slider) , czyli polem o ustalonym zakresie dopuszczalnych wartości (w tym przypadku to 0% i 100%). Blender wypełnia suwak dwoma barwami, przy czym granica tych kolorów odpowiada aktualnej wartości kontrolki. Wartość suwaka możesz zmienić, przesuwając ponad nim myszką z wciśniętym LPM (Rysunek 2.5.11):
Rysunek 2.5.11 Zmiana wartości pola numerycznego za pomocą myszki
Jeżeli tylko raz klikniesz w pole numeryczne LPM (lub naciśniesz na nim Enter), przełączysz je w stan edycji, w którym możesz po prostu wpisać dokładną wartość (Rysunek 2.5.12):
Rysunek 2.5.12 Zmiana wartości pola numerycznego poprzez wpisanie
Co ciekawe – można tu także wpisać wyrażenie arytmetyczne: np. „100/3”, a nawet coś z nawiasami! To działa jak kalkulator, podstawiając wynik operacji jako nową wartość pola numerycznego.
Częściej spotykaną postacią pola numerycznego jest wersja „ze strzałkami” . Takie pole może nie mieć ograniczeń na wpisywane wartości. W sekcji Dimensions:Resolution możesz znaleźć zespół trzech pól numerycznych, sterujących rozmiarem renderowanego obrazu. Dwa górne — X i Y — są polami „ze strzałkami”, określającymi szerokość i wysokość rezultatu (w pikselach)2 (Rysunek 2.5.13):
Rysunek 2.5.13 Dwie metody zmiany wartości zwykłego pola numerycznego
Klikając LPM w „strzałki”, umieszczone po lewej i prawej stronie pola, możesz zmniejszać i zwiększać wyświetlaną wartość (Rysunek 2.5.13a). Każde kliknięcie oznacza zmianę o ustaloną „krok” (w tym przypadku — o 1 piksel). To dobre dla jakiś małych poprawek, ale jeżeli to pole ma zawierać zupełnie inną wartość — najlepiej ją bezpośrednio wpisać (jak to pokazuje Rysunek 2.5.13b i Rysunek 2.5.12).
Naciśnięcie Esc podczas edycji wartości (w sytuacji, jaką pokazuje Rysunek 2.5.13b) oznacza rezygnację ze zmiany.
Każdym polem numerycznym możesz się posługiwać jak suwakiem — przeciągając ponad jego obszarem myszką z wciśniętym LPM (por. Rysunek 2.5.11). Jeżeli będziesz dodatkowo trzymał wciśnięty klawisz Ctrl, wyświetlana wartość będzie się zmieniać o zaokrąglone wartości. To podobna konwencja jak podczas przesuwania obiektów — por. str. 53, Rysunek 2.4.7. Za pomocą myszki możesz take zaznaczyć i zmieniać wartości powiązanych pól (takich, które są umieszczone jedno nad drugim: Rysunek 2.5.15):
Rysunek 2.5.14 Jednoczesna zmiana dwóch powiązanych pól numerycznych
Wróćmy jeszcze na chwilę do panelu Render:Output, gdyż zawiera jeszcze jeden rodzaj kontrolki: pole tekstowe (Rysunek 2.5.15).
W pole tekstowe wpisujesz nową wartość tak samo jak to robisz w polu numerycznym — klikasz LPM, wpisujesz, a na koniec naciskasz Enter. Podczas wpisywania są dostępne typowe operacje na tekście: możesz zaznaczyć i usunąć fragment, możesz także go skopiować (Ctrl-C) lub wkleić (Ctrl-V) ze schowka.
Zauważ, że pole w tym przykładzie, jest przykładem kontrolki „wyspecjalizowanej” do wybierania ścieżek do plików. Z prawej strony ma niewielką ikonę otwartego folderu. Gdy klikniesz w nią, na ekranie pojawi się okno wyboru plików (podobne do opisanego na str. 256). Możesz w nim wskazać odpowiednią ścieżkę. Oczywiście, możesz także wprost wpisać całą ścieżkę w to pole. Zwróć uwagę, że domyślnie zaczyna się ono od podwójnego ukośnika: „//”. To tak zwany „znacznik ścieżki względnej” (Relative path). Czytając ten wpis, Blender zastępuje „//” odpowiednią ścieżką początkową – zazwyczaj miejscem, gdzie znajduje się aktualny plik z rysunkiem. Dzięki temu można przesuwać folder z rysunkiem i wszystkimi plikami towarzyszącymi z jednego miejsca na dysku na drugie. Przy konsekwentnym stosowaniu znacznika „//” na początku ścieżek nie ma niebezpieczeństwa, że Blender nie będzie mógł czegoś znaleźć po takim przeniesieniu.
Myślę, że na tym zakończymy nasze wprowadzenie do okna Properties i kontrolek Blendera. (Niektóre panele z okna Properties zawierają jeszcze jeden rodzaj formantu: listy. Jednak obsługę takiej złożonej kontrolki GUI zdecydowałem się opisać w oddzielnej sekcji, na stronie 288). Przy okazji zmieniliśmy w panelu Output domyślny format zapisu obrazu na Jpeg (por. str. 65, Rysunek 2.5.10). Zwiększyliśmy także w panelu Dimensions wysokość renderowanego obrazu, na 1024 px (por. str. 66, Rysunek 2.5.13). Czy zwróciłeś uwagę, że od razu zmieniło to proporcje okna kamery, wyświetlanej w jednym z widoków 3D?
W Blenderze nie ma prawie wcale przycisków „OK.”, czy „Akceptuj”. Wszystko, co ustawisz za pomocą jakiejkolwiek kontrolki w oknie przycisków lub przybornikach, natychmiast jest odwzorowane na scenie.
Ta „natychmiastowość” efektu jest w zasadzie bardzo wygodna. Bazuje na założeniu, że czas odświeżenia ekranu (wszystkich okien Blendera!) jest bardzo krótki. Gorzej, gdy Twój komputer nie ma żadnego specjalnego akceleratora grafiki. Gdy w trzech różnych oknach 3D masz wyświetlone kilkaset tysięcy ścian takiego modelu jak ten Ła-5, i zaczynasz przesuwać myszką jakiś suwak, możesz zauważyć jego „opór” — wyświetlane w kontrolce wartości nie będą się zmieniać natychmiast. Dzieje się tak dlatego, że każda zmiana tej kontrolki wymaga ponownego narysowania modelu w każdym z okien programu! To nie jest jakaś wielka niedogodność, ale można zmniejszyć takie opóźnienia pracując tylko na warstwach, które są w danym momencie potrzebne (por. str. 38, Rysunek 2.2.4).
Ustawienia w sekcji Render poprawiliśmy, by wygenerować obraz tego modelu Ła-5. Nim jednak naciśniesz ostateczny przycisk, upewnij się, że w oknie widoku są włączone co najmniej następujące warstwy: . (Jeżeli zapomnisz włączyć warstwy nr 11, nie zobaczysz ani skrzydeł, ani kadłuba.)
Blender renderuje się zawsze tylko to, co jest na widocznych warstwach
Wreszcie – zróbmy to! Naciśnij ten duży przycisk Render:Image (Rysunek 2.5.16). Możesz także nacisnąć skrót tego polecenia: klawisz F12. Blender wyświetli wówczas na całym ekranie nowe okno, typu UV/Image Editor. (Tak działa, gdy masz ustawione Render:Display na Full Screen — por. Rysunek 2.5.16. W razie czego sprawdź, jak działają pozostałe możliwości z tej listy!). Na początku pole obrazu jest zupełnie czarne, potem coś zaczyna się na nim pojawiać (Rysunek 2.5.17):
Rysunek 2.5.17 Okno UV/Image Editor w trakcie renderowania
Blender generuje obraz w tle (a dokładniej rzecz biorąc: jest obliczany w oddzielnych wątkach programu). Dzięki temu ekran nadal reaguje na polecenia użytkownika. Na przykład — możesz w dowolnym momencie przerwać ten proces, korzystając z przycisku umieszczonego u góry ekranu, w nagłówku okna Info (Rysunek 2.5.17).
Ostatecznie powinieneś uzyskać taki rezultat, jaki przedstawia Rysunek 2.5.18:
Rysunek 2.5.18 Okno obrazu po zakończeniu renderowania
Aby zapisać uzyskany obraz na dysku – naciśnij F3 (lub wybierz z menu polecenie Image→Save a Copy). Spowoduje to otwarcie okna wyboru pliku. Możesz tam ustalić, pod jaką nazwą i gdzie obraz będzie zachowany. (W tym oknie możesz także zmienić domyślny format zapisu na inny — na przykład z Jpeg na PNG).
Gdybyś chciał uzyskać efekt rozmycia ruchu wirujących łopat śmigła — włącz w sekcji Render panel Motion Blur (Rysunek 2.5.19a), po czym ponownie uruchom renderowanie i uzbrój się w cierpliwość:
Rysunek 2.5.19 Ten sam obraz, ale z rozmytymi łopatami wirującego śmigła
Dlaczego piszę o cierpliwości? Bo w przypadku tego modelu efekt rozmycia ruchu został uzyskany najprostszą, lecz najbardziej kosztowną obliczeniowo metodą: Sampled Motion Blur. W tym trybie Blender tworzy tyle oddzielnych obrazów modelu, ile jest wpisane polu Sampled Motion Blur:Motion Samples (w tym przypadku to 16 — por. Rysunek 2.5.19a). Każdy z nich odpowiada kolejnej klatce (frame) animacji. Potem rezultat jest łączony, i powstaje efekt rozmycia.
Jeżeli pojedynczy obraz, taki jaki pokazuje Rysunek 2.5.18, generował się na moim komputerze przez 34s, to po włączeniu Sampled Motion Blur będzie generowany 16 x 34s, czyli 9 minut. Ten czas wydłuży się proporcjonalnie do liczby pikseli (tzn. powierzchni) obrazu, gdy ustawię jego większe rozmiary. Bardziej optymalne czasowo metody uzyskania rozmycia ruchu dla wirującego śmigła opisałem w rozdziale o kompozycji, pod koniec książki (por. Tom IV).
Podsumowanie
Kontrolki w oknie właściwości są pogrupowane w tematyczne „zasobniki” – panele (str. 60);
Panele są pogrupowane w zestawy (sekcje), odpowiednie dla różnych etapów pracy nad sceną lub animacją (str. 60, 63);
Przełącznik, umieszczony w nagłówku okna Properties, pozwala na szybki wybór odpowiedniego zestawu. (str. 60, 62);
Okno Properties dobiera wyświetlany w nagłówku zestaw paneli do aktualnego kontekstu (obiektu aktywnego) (str. 62)
Zawartość okna Properties można swobodnie przesuwać w górę i w dół (str. 61). Dzięki temu każda sekcja może zawierać więcej paneli, niż te które są widoczne na ekranie;
Panele okna przycisków można przesuwać (tzn. zmieniać kolejność w zestawie — str. 61) i zwijać „w pasek” (str. 60). Te ustawienia są zapamiętywane przy zapisaniu pliku rysunku;
Poznałeś podstawowe kontrolki Blendera, takie jak przycisk (operation button – str. 64), lista rozwijalna (menu button — str. 64, 65), pole opcji (checkbox albo toggle button — str. 64), przełącznik (radio button — str. 64) oraz pole numeryczne (numeric button — str. 65, 66) i tekstowe (text button — str. 66);
Wszystko co zmienisz w oknie Properties jest natychmiast widoczne na modelu lub scenie. Stąd w Blenderze prawie w ogóle nie spotyka się przycisków OK. lub Accept, znanych Ci z okien dialogowych innych programów;
Aby wygenerować ostateczny obraz sceny, należy nacisnąć przycisk Render:Image (str. 67);
Rezultat renderowania można zapisać do pliku na dysku poleceniem Image→Save (skrót: F3 — str. 68);
Efekty specjalne, jak rozmycie ruchu, wydłużają czas renderowania (str. 68);
W tym rozdziale zaczynamy “regularną” pracę z Blenderem. Z własnego doświadczenia radziłbym zapisywać stan pracy, osiągnięty na koniec każdego dnia, do oddzielnego pliku. (Więcej na ten temat znajdziesz na str. 259).
Na wszelki wypadek zapoznaj się także ze sposobem odzyskiwania danych — na str. 270. (Choć na tym etapie nie spodziewam się żadnych kłopotów z Blenderem — to naprawdę stabilny program)
Pierwsze sekcje tego rozdziału będą bardzo szczegółowo opisywać poszczególne kroki w formowaniu coraz bardziej złożonych elementów. Chcę w ten sposób zaznajomić Czytelników, którzy to robią po raz pierwszy, z typowymi sposobami pracy z siatkami Blendera. Zaczniemy więc od nieskomplikowanej bryły obrotowej — kołpaka śmigła. Potem do tego dodamy coś bardziej skomplikowanego — łopatę (śmigła, oczywiście). Następnie zajmiemy się formowaniem płata. Skrzydło ma w zasadzie obrys (w rzucie z góry) trapezu, któremu zaokrąglono końcówkę. Końcówka płata w P-40 jest dość trudna do prawidłowego uformowania1, więc omówiłem ją w oddzielnej sekcji. Stosuję tam m.in. odcinanie powierzchni inną powierzchnią (stworzyłem specjalny dodatek Blendera, który do tego służy). Sądzę, że po ukończeniu skrzydła będziesz już dobrze znał większość “tricków” pozwalających uzyskać w Blenderze taki kształt, jaki jest potrzebny. Stateczniki to właściwie powtórzenie w uproszczonej wersji formowania płata, więc nie poświęcam im wiele miejsca. Potem uformujemy najbardziej złożony element — kadłub.
W tym rozdziale będziemy wykorzystywać materiały z towarzyszącego tej książce pliku source.zip. Rysunki *.blend, odpowiadające rezultatom poszczególnych sekcji rozdziału znajdziesz w pliku p40.zip. (Po rozpakowaniu tego pliku — w jego folderze model\p40\history. Adres internetowy, z którego można je pobrać, znajdziesz na. str. 18).
Nazwa każdego z towarzyszących temu rozdziałowi plików *.blend składa się z przedrostka „P40B-„ i numeru sekcji, której dotyczy. (Np. plik z rezultatem sekcji 3.1 nosi nazwę P40B-4.01.blend, a z rezultatem sekcji 3.2 — P40B-4.02.blend). Aby podstawić jakieś rysunki referencyjne i nie naruszyć praw innych autorów, w plikach P40B-*.blend używam własnych planów P-40, które opracowałem w 2011r. Te rysunki powstały na podstawie ukończonego w Blenderze P-40, więc w pewnych miejscach mogą nie być zgodne z prezentowanym kształtem siatki samolotu. To dlatego, że model tworzyłem w oparciu o zmodyfikowane (por. Tom I) plany Jacka Jackiewicza i Mariusza Łukasika, które przedstawiam na ilustracjach. Czasami te rysunki także zawierały błędy, co opisuję w poszczególnych sekcjach tego rozdziału. Plany, podstawione pod modelem w opublikowanych plikach przedstawiają zawsze ostateczny kształt, po wszystkich poprawkach — i stąd różnice.
Skonfiguruj środowisko Blendera tak, jak jest to podane na str. 261. Do odtworzenia geometrii samolotu, wykorzystamy rysunki przygotowane we wcześniejszych rozdziałach. Na początek scal wszystkie okna 3D View w jedno. Wykorzystując panel Background Images z przybornika Properties umieść w tle widoku plany samolotu1 (Rysunek 3.1.1):
Rysunek 3.1.1 Ustawianie planów samolotu w tle okna 3D View
Podczas wstawiania rysunków tła, musisz zdecydować, jaką długość “w świecie rzeczywistym” ma reprezentować 1 jednostka długości w Blenderze.
Przyjąłem, że 1 jednostka Blendera odpowiada 10 cm na prawdziwym samolocie.
Dlaczego akurat taka skala? Obraz tła w Blenderze można maksymalnie powiększyć do prostokąta, w którym dłuższy bok ma rozmiar 500 jednostek. To za mało, by dla 10-metrowego samolotu zastosować np. skalę 1 jednostka = 1cm. (Obraz tła musiałby mieć wtedy rozmiar dwa razy większy, niż dopuszcza Blender: 1000 jednostek)2. Szczegółowy opis ustawiania rysunków z planami w oknach 3DView znajdziesz na str. 275.
Rysunek 3.1.2 przedstawia szczegóły ustawień trzech podstawowych rzutów naszego P-40:
Rysunek 3.1.2 Przykład ustawienia podstawowych rzutów samolotu w panelu Background Images
Zwróć uwagę że każdy z obrazów jest przypisany do odpowiedniej osi (Axis— Rysunek 3.1.2). Dzięki temu ustawieniu rzut z boku będzie się podstawiał tylko wtedy, gdy naciśniesz 3, rzut z góry — 7, a rzut z przodu — 1. Uważam, że tak jest wygodniej, bo w ten sposób plany nie przeszkadzają w oglądaniu modelu w rzucie perspektywicznym.
Obrazy, podstawione na wszystkich rzutach, muszą być umieszczone w przestrzeni w sposób spójny. Jaki punkt przyjąć jako środek sceny (punkt o współrzędnych 0,0,0)?. Z osią Y nie ma problemu — leży w osi śmigła (kadłuba). W jakim jednak punkcie kadłuba umieścić “bazową” płaszczyznę XZ ? To zależy od konstrukcji modelowanego samolotu. W przypadku innych samolotów często jako powierzchnię bazową przyjmowałem płaszczyznę podstawy kołpaka śmigła. Dla tej konstrukcji wolę jednak ustalić “bazę” w takim miejscu kadłuba, które nie ulegało zmianie pomiędzy kolejnymi wersjami. (Nosy P-40 uległy zmianie trzy razy, a licząc to z P-36 — aż pięć). Proponuję ustawić rysunki tak, by punkt (0,0,0) sceny leżał na pierwszej wrędze kadłuba (Rysunek 3.1.1). Na rysunkach fabrycznych widać, że ta płaszczyzna była także wykorzystana jako baza do wymiarowania płata (i leżał na niej przedni dźwigar skrzydła). W obszarze za wręgą, w której umieściłem środek układu współrzędnych, zmiana kształtu kadłuba zaszła tylko dwa razy. (Mam na myśli przebudowę górnej części kadłuba w P-40D i wydłużenie ogona w P-40L). Kształt skrzydeł P-36/P-40, i kształt usterzenia poziomego, oraz ich wzajemne położenie, nie uległo zmianie przez całą historię konstrukcji3.
Gdy uzgodniłeś położenie planów we wzorcowym oknie 3D View, możesz je podzielić na trzy lub cztery okna (Rysunek 3.1.3):
Rysunek 3.1.3 Przykład ustawienia podstawowych rzutów samolotu
To układ ekranu w którym będziemy formować nasz model. Każde ze „sklonowanych” w ten sposób okien dziedziczy po pierwowzorze przypisane obrazy tła. Dzięki temu w po wybraniu odpowiedniej projekcji — z boku, z przodu lub z góry — w każdym widoku 3D podstawi Ci się odpowiedni rysunek referencyjny.
Niestety, nie mogłem do tej publikacji dołączyć oryginalnych rysunków, których użyłem do budowy modelu (bo byłoby to naruszenie praw ich Autorów). Zamiast tego opracowałem własne plany, które zobaczysz w przykładowych plikach *.blend, towarzyszących każdej z sekcji tego rozdziału (Rysunek 3.1.4):
Rysunek 3.1.4 Zawartość pliku P40B-4.01.blend, towarzyszącego tej książce
Te obrazy to rendery ukończonego modelu P-40B, wykonane z wykorzystaniem specjalnej „kamery ortogonalnej” i cieniowania „z konturem”, jak dla kreskówek. W chwili obecnej to chyba jedyne rysunki P-40 stworzone na podstawie trójwymiarowego modelu. Dzięki tej technice uzyskałem na nich wysoką zgodność pomiędzy poszczególnymi rzutami samolotu, która jest praktycznie niemożliwa do osiągnięcia na planach kreślonych metodami tradycyjnymi.
Przykładowe pliki *.blend dla tego i następnych rozdziałów znajdziesz w folderze model\p40\history\ (por. str. 18). Nazwa każdego z nich składa się z przedrostka „P40B-„ i numer sekcji, której dotyczy. (Np. plik dla tej sekcji nosi nazwę P40B-4.01.blend, a dla następnej — P40B-4.02.blend).
Choć w przykładowych danych wykorzystuję moje rysunki, to na ilustracjach w tej książce pokazuję oryginalne plany (których przygotowanie opisuje Tom I). Sądzę, że w ten sposób lepiej zaprezentuję typowe niezgodności, z jakimi możesz się zetknąć podczas pracy ze zwykłymi (tzn. zeskanowanymi) rysunkami referencyjnymi!
Podsumowanie
Na poczatku określić „skalę” modelu — tzn przelicznik rzeczywistych wymiarów samolotu na Jednostkę Blendera. Dla samolotów jednosilnikowych proponuję przyjąć że 1 Jednostka = 10 cm (str. 71);
W Blenderze możesz podstawić rysunki referencyjne samolotu jako tło okna 3D View. Służy do tego panel Background Image, umieszczona w panelu właściwości takiego okna (str. 71). Takie rysunki znacznie ułatwiają modelowanie;
Najlepiej przypisać wszystkie rysunki referencyjne do poszczególnych osi pojedynczego okna 3D View. Każdy obraz z rzutem samolotu trzeba dopasować do pozostałych obrazów i do założonego rozmiaru sceny. Po uzgodnieniu można powielić takie okno w 3 lub 4 obszary (str. 72);
Każdej sekcji tego rozdziału towarzyszy przykładowy plik Blendera (o nazwie P40B-<nr sekcji>.blend);
Modelowanie zaczniemy od kołpaka śmigła. Specjalnie wybrałem na początek tak nieskomplikowany kształt. Opiszę jego formowanie trochę dokładniej, abyś, jeżeli jest to Twoja pierwsza praca w Blenderze, miał okazję poznać podstawowe techniki kształtowania powierzchni. Obowiązkowo korzystaj w takim przypadku z odsyłaczy do szczegółowych opisów czynności!
Kołpak śmigła zacznij od umieszczenia kursora 3D tam, gdzie ma się znaleźć środek jego podstawy (jak — str. 272). (Pamiętaj, że to miejsce stanie się środkiem nowo utworzonego obiektu). Następnie, w rzucie z przodu, utwórz okrąg o promieniu nieco większym od podstawy kołpaka (można użyć polecenia Add→Mesh→Circle, ale lepiej to zrobić tak, jak opisałem na str. 292). Liczba wierzchołków nie musi być zbyt duża — uważam że po wygładzeniu modyfikatorem Subdivision Surface 8 krawędzi zupełnie dobrze odwzoruje okrąg. Rysunek 3.2.1 pokazuje, jak powinien wyglądać efekt tych dwóch czynności:
Rysunek 3.2.1 Początkowy okrąg, z którego powstanie kołpak śmigła
Przełącz się w Edit Mode (Tab) i wytłocz utworzony okrąg na całą długość kołpaka wzdłuż osi Y (E,Y lub Mesh→Extrude — str. 339). Zatrzymaj się przed jego czubkiem. Rysunek 3.2.2 pokazuje przebieg operacji:
Rysunek 3.2.2 Wytłoczenie (Extrude) okręgu w powierzchnię
Po wytłoczeniu warto poprawić metodę cieniowania, aby powierzchnia wydawała się doskonale gładka (Mesh→Faces→Shade Smooth, patrz str. 342) .
Ustaw tryb środka transformacji na Bounding Box Center (,, Rysunek 3.2.3) . Następnie zaznacz przednią krawędź powierzchni. i zdecydowanie zmniejsz ją poprzez zmianę skali (S, albo Mesh→Transform→Scale — str. 334) . Rysunek 3.2.3 pokazuje przebieg operacji:
Rysunek 3.2.3 Uformowanie zarysów kształtu kołpaka
Rozmiar końca stożka dobierz tak, by był zbliżony do zaokrąglenia końcówki kołpaka (skorzystaj z rysunków widocznych na rzucie z boku).
Zaokrąglenie noska formujemy poprzez “wytłoczenie” (str. 339) z końcówki powierzchni jej kolejnego segmentu (Rysunek 3.2.4). Przesuń nową krawędź do przodu o promień nosa kołpaka. Zmniejsz ją (poprzez zmianę skali) do mniejszej średnicy. Aby zamknąć siatkę, wygeneruj jeszcze jedną krawędź, poprzez kolejne wytłoczenie. Potem jej nie przesuwaj, tylko “zsuń” wszystkie wierzchołki (poprzez zmianę skali do 0) w jeden punkt. Zamień je w pojedynczy wierzchołek poprzez scalenie (Mesh→Vertices→Remove Doubles, str. 344) . Rysunek 3.2.4 pokazuje rezultat tej operacji:
Rysunek 3.2.4 Formowanie zaokrąglonego noska
Zaokrąglenie, jakie uzyskaliśmy, warto jeszcze zestawić z rzutem z boku (sylwetką narysowaną czerwoną linią — poprawialiśmy plany w tym miejscu). W przypadku naszej siatki konieczne okazało się dodatkowe zmniejszenie ostatniej (nie licząc końcowego wierzchołka) sekcji (Rysunek 3.2.5):
Rysunek 3.2.5 Dopasowywanie zaokrąglenia do zadanego obrysu
Zwróć uwagę, że ostatnia sekcja i wierzchołek zamykający cały stożek leżą na tej samej płaszczyźnie. Taką “tarczkę” najlepiej jest umieszczać jako zakończenie wszelkich kulistych zaokrągleń.
Gdy uporządkowaliśmy końcówkę stożka, warto poprawić także ściany boczne. Wstaw mniej więcej pośrodku nową sekcję (tzn. nowy rząd wierzchołków — poleceniem Loop Cut, por. str. 351) . Po wstawieniu zwiększ odrobinę jej średnicę poprzez zmianę skali, by dopasować wygięcie ścian stożka do obrysu widocznego na planach (Rysunek 3.2.6):
Rysunek 3.2.6 Lekkie wygięcie ścian kołpaka — poprzez dodatkową linię siatki
Czas przejść do ostatniej fazy formowania kształtu — dokładnego uzgodnienia z planami. Najłatwiej jest to robić po przełączeniu sposobu reprezentacji (Draw Type) siatek z Solid na Wireframe (por. str. 54). Dodatkowo można także włączyć w modyfikatorze Subsurf opcję Apply during Edit (por. Rysunek 3.2.7).
Rysunek 3.2.7 przedstawia siatkę kołpaka w trybie Wireframe, nałożoną na rzut z boku.
Rysunek 3.2.7 Wstępne porównanie z obrysem na planach (czerwona linia)
Jak widać, zarys siatki wymaga drobnych korekt, w celu uzgodnienia z kształtem na rysunku. Pierwsza modyfikacja jest jednak związana z przystosowaniem do późniejszej pracy. Dopóki nie jest to zbyt kłopotliwe, warto by linie siatki znajdowały się w miejscu, gdy przebiegało łączenie blach na prawdziwym samolocie. W związku z tym przesunąłem (poleceniem Edge Slide — por. str. 349) centralną sekcję w takie miejsce, narysowane na planach.
Następnie próbowałem skorygować obrys nosa kołpaka poprzez zmianę średnicy (poleceniem Scale) i przesuwanie (Edge Slide) jego przednich sekcji. Ostatecznie jednak do uzyskania założonego kształtu trzeba było dodać do tej siatki (Loop Cut) jeszcze jeden rząd wierzchołków (Rysunek 3.2.8):
Rysunek 3.2.8 Ostateczne dopasowanie siatki do zadanego obrysu
Gdy kształt obiektu jest już zgodny z planami, pozostał do utworzenia ostatni szczegół: zamknięcie podstawy tego kołpaka. W prawdziwej konstrukcji było umieszczone w tym miejscu okrągłe żebro. Nie będziemy go teraz dokładnie modelować (zresztą — brak jest jakichkolwiek zdjęć tego elementu, więc nie wiadomo, jak wyglądał). Zadowolimy się prostym “wytłoczeniem” kolejnej sekcji z dotychczasowej podstawy stożka (Rysunek 3.2.9). Krawędź, dodaną w wyniku wytłoczenia, nie przesuwaj, tylko zmniejsz (poprzez zmianę skali).
Rysunek 3.2.9 Wstawienie dodatkowej powierzchni u podstawy stożka
W rezultacie wydłużenia siatki podstawowej o dodatkową sekcję, krawędź podstawy stożka uległa zaokrągleniu (Rysunek 3.2.9). Pamiętaj, powierzchnia podziałowa stara się wygładzić każdą nierówność1!
W P-40 krawędź podstawy kołpaka była ostra, więc musisz ją “przywołać do porządku”. Zmień ostrość krawędzi, którą pokazuje Rysunek 3.2.10, z 0.0 do 1.0 (Mesh→Edges→Edge Crease — patrz str. 353). Wraz ze zmianą sposobu cieniowania ścian podstawy na „płaski” (Mesh→Faces→Shade Flat) bryła uzyska właściwy kształt (Rysunek 3.2.10):
Rysunek 3.2.10 Usunięcie niepożądanego zaokrąglenia krawędzi kołpaka
Rysunek 3.2.11 pokazuje efekt — uformowany kołpak śmigła. Nie będziemy wycinać w tej siatce otworów na łopaty. Zrobimy to w o wiele łatwiejszy sposób później, za pomocą tekstury (por. Tom III).
Rysunek 3.2.11 Uformowany kołpak
Zwróć uwagę na dziwne cienie, które pojawiły się wzdłuż ostrej krawędzi. Aby je zlikwidować, włącz we właściwościach tej siatki opcję Auto Smooth (na panelu Normals) lub dodaj kolejny modyfikator o nazwie Edge Split. Więcej na ten temat znajdziesz na str. 383.
Na koniec pozostało nadać nowej części nazwę. W oknie Properties wpisz identyczną nazwę w kontekście obiektu (Rysunek 3.2.12a) i jego siatki (Rysunek 3.2.12b):
Rysunek 3.2.12 Nadanie nazwy obiektowi i jego siatce
Zgodnie z przyjętymi dla tego modelu regułami (patrz str. 304), nadałem kołpakowi nazwę B.005.Hub.
Model z tej sekcji znajdziesz w pliku model\p40\history\P40B-4.02.blend (por. str. 18).
Podsumowanie
Model samolotu formujemy z siatek wygładzonych za pomocą powierzchni podziałowych Catmulla-Clarka (Subdivison Surfaces);
Metoda formowania, którą przedstawiam w tej książce, polega na osiągnięciu zamierzonego kształtu poprzez koleje deformacje prostej siatki początkowej. Uważam, że ta droga jest wygodniejsza i bardziej elastyczna, od formowania “wszystkiego od razu” opartą na krzywych NURBS. (Ten tradycyjny sposób, oparty o powierzchnie NURBS, jest często preferowany przez użytkowników którzy wcześniej mieli co czynienia z systemami CAD). Siatki uzyskane poprzez stopniową deformację zawierają mniej błędów — gdyż znasz ich wszelkie “ukryte zakamarki”;
Ostateczny kształt obiektu uzyskujemy poprzez dodawanie i formowanie kolejnych linii wierzchołków siatki. Dodawanie odbywa się poprzez wytłoczenie nowych krawędzi (Extrude — str. 74) lub wstawienianie w środek siatki nowych sekcji (Loop Cut — str. 76). Dalsze zmiany kształtu powierzchni realizuje się przekształcając poszczególne linie wierzchołków — zazwyczaj za pomocą przesunięcia lub zmiany skali. (W następnej sekcji pokażę jeszcze: obrót i przesunięcie);
Mimo wygładzenia powierzchniami podziałowymi, wybrane krawędzie mogą pozostać ostre, jeżeli zwiększymy wartość ich współczynnika Crease (str. 78). Będzie to potrzebne, bo nawet opływowe kształty samolotów mają mnóstwo ostrych krawędzi;
Każdy obiekt i jego siatka musi mieć unikalny identyfikator — nazwę. Proponuję stosować tu regułę:
<przedrostek>.<numer kolejny>.<nazwa opisowa>[.strona (P lub L) albo numer kolejny],
np. B.005.Hub (szczegóły — str. 304);
Zacznijmy od ukształtowania pojedynczej łopaty śmigła. Będzie skierowana w dół, wzdłuż osi Z. Następnie powielimy ten obiekt dwa razy, tworząc zespół trzech łopat. Podobnie jak w przypadku kołpaka, na podstawie zdjęć naniosłem na plany zmodyfikowane kształt i położenie śmigła. Wśród fotografii wyszukałem ujęcie, w którym łopata była ustawiona (przynajmniej w przybliżeniu) prostopadle do obiektywu. Jej obrys naniosłem na rzut z przodu. Obrys łopaty w rzucie z boku, oraz określenie położenia jej osi względem kołpaka pochodzi ze zdjęcia z boku1.
Zmień widoczną warstwę z 1 na 2 (p. str. 52). Ustaw kursor 3D w miejscu, które odpowiada końcówce łopaty. Następnie w przyborniku Properties wyzeruj współrzędne kursora: X i Z (w ten sposób najłatwiej jest rzutować kursor na odpowiednie miejsce na osi Y — Rysunek 3.3.1) :
Rysunek 3.3.1 Ustalenie środka łopaty śmigła — poprzez wyzerowanie wybranych wspł.
Po ustaleniu pozycji kursora 3D wstaw w scenę początek łopaty — okrąg o promieniu 0.5 jednostki. Wystarczy, jeżeli będzie miał 8 wierzchołków. Okrąg wstaw w rzucie z góry (Rysunek 3.3.2), a potem wygładź modyfikatorem Subdivision Surface (por. str. 293):
Rysunek 3.3.2 Wstawienie początkowego okręgu
Przejdź do Edit Mode i wytłocz (E — Extrude) okrąg w dół osi Z, na odległość 2 jedn. Potem wytłocz kolejną krawędź wzdłuż osi Z, na odległość ok. 4 jednostek, tworząc następny segment łopaty (Rysunek 3.3.3a). Następnie:
rozciągnij ostatnią sekcję (poprzez zmianę skali) w kierunku X tak, by jej prawa krawędź pokryła się z prawą krawędzią łopaty w tym miejscu rysunku (Rysunek 3.3.3a);
spłaszcz tę sekcję w kierunku Y, tak by osiągnęła 30% szerokości (Rysunek 3.3.3b);
przesuń trzy wierzchołki (G — por. str. 332) z lewej, by dopasować rozmiar tej sekcji do lewej krawędzi obrysu łopaty śmigła (Rysunek 3.3.3).
Powinieneś uzyskać niesymetryczny kształt, przypominający końcówkę odkurzacza (Rysunek 3.3.3):
Rysunek 3.3.3 Początek formowania łopaty — pierwszy przekrój poprzeczny (nie licząc osi).
Teraz przekształcimy kształt sekcji w coś, co będzie przypominać gruby profil lotniczy. W tym celu:
zaznacz krawędzie wychodzące z punktu, który na profilu jest ostrym wierzchołkiem (Rysunek 3.3.4a), i zwiększ ich ostrość (Shift-E) do 1.0;
zaznacz trzy dolne wierzchołki sekcji i spłaszcz je za pomocą zmiany skali (Rysunek 3.3.4b);
Rysunek 3.3.4 Przekształcanie elipsy w profil lotniczy
Nie wiem, jaki profil miało śmigło P-40. Zakładam, że był to, najczęściej spotykany w śmigłach, profil płasko - wypukły. (Tylna powierzchnia łopaty z takim profilem jest płaska)2.
Rysunek 3.3.5 pokazuje ostateczny kształt przekroju łopaty śmigła. To profil, jaki występuje w okolicach 30% promienia (mierząc od osi obrotu). Możesz ten zarys traktować jako wzór dla innych śmigieł, których dokładna geometria nie jest Ci znana. Spód profilu tworzy linię prostą. Punkt, w którym przekrój jest najgrubszy, znajduje się w odległości ok. 30% od krawędzi natarcia.
Ostateczny kształt uzyskałem za pomocą kilku przesunięć wierzchołków siatki. Przesunięcia w kierunku X wykonałem parami — razem wierzchołki: górny i dolny3. Przedni, górny wierzchołek przesunąłem do góry (wzdłuż osi Y), aby przemieścić największe wybrzuszenie przekroju z 50% do 30% szerokości łopaty.
Rysunek 3.3.5 Uformowany profil przekroju łopaty
Wytłocz tak przygotowany profil do końca łopaty. Jej grubość wzdłuż osi Z powinna się szybko zmniejszać. Spłaszcz więc profil końcówki (poprzez zmianę skali w kierunku Y) do 5-8% jej szerokości (Rysunek 3.3.6):
Rysunek 3.3.6 Wytłoczenie łopaty śmigła
Po rozciągnięciu profili łopaty na pełną długość, skoryguj oznaczenia ostrych krawędzi (Rysunek 3.3.7a) Należy zwiększyć wartość Crease dla krawędzi spływu do 1.0 i zmniejszyć ją dla końcowych krawędzi profili (por. Rysunek 3.3.4a, str. 82 — nie jest w tym miejscu już potrzebna). Następnie wstaw w tę siatkę dwie dodatkowe sekcje (Rysunek 3.3.7b). Potem zacznij dopasowywać kształt łopaty do obrysu na planach. Najłatwiej to robić zmieniając skalę w kierunku X połówek poszczególnych sekcji łopaty (Rysunek 3.3.7c). Punktem odniesienia skalowania musi być koniecznie kursor 3D, umieszczony na osi Z! (Przełącz Pivot na 3D Cursor — Rysunek 3.3.7c) . Dodatkowo niektóre sekcje można także nieco przesuwać wzdłuż osi Z.
Rysunek 3.3.7 Kształtowanie obrysu łopaty z przodu
Dalsze formowanie najwygodniej jest przeprowadzić w trybie wyświetlania Wireframe. Dodatkowo można także włączyć opcję Apply during Edit w panelu modyfikatora Subdivison Surface (por. str. 77). W tym trybie dobrze widać kontur, do którego mamy dopasować krawędzie siatki (Rysunek 3.3.8a):
Rysunek 3.3.8 Szczegóły kształtowania obrysu łopaty
Obiekt zaczyna już przypominać swój pierwowzór. Gdy obejrzysz go ze wszystkich stron, znajdziesz miejsca, gdzie są potrzebne drobne korekty. Popatrz, na przykład, na początek krawędzi spływu (Rysunek 3.3.9). W naszym modelu krawędź spływu zachowuje ostrość niemal do końca — do osi obrotu. W oryginalnym samolocie przy kołpaku śmigła rozchodziła się bardziej płynnie, przechodząc w coraz większy promień krzywizny. Należy to poprawić, poprzez zmianę ostrości (crease) jednej z krawędzi siatki:
Rysunek 3.3.9 Zaokrąglanie początku krawędzi spływu łopaty śmigła
Pora na uformowanie zaokrąglonej końcówki. Metod uzyskania takiego kształtu jest wiele, tu zaproponuję jedną z nich. Uważam, że jest dobra, gdyż nie wymaga dodania zbyt dużej liczby nowych wierzchołków.
Zaczynamy od umieszczenia punktu odniesienia — kursora 3D — w nosku profilu końcówki (Rysunek 3.3.10). Następnie wytłocz końcówkę w nową sekcję. Tym razem jednak nie przesuwaj nowego rzędu wierzchołków w jakieś inne położenie: zaraz po wytłoczeniu naciśnij Esc (Rysunek 3.3.11):
Rysunek 3.3.10 Ustawienie kursora 3D w nosku profilu końcówki łopaty | Rysunek 3.3.11 Dodanie nowej sekcji — wytłoczenie i pozostawienie jej w tym samym miejscu |
Zaraz potem (nowa sekcja jest nadal zaznaczona) włącz zmianę skali w kierunku Y (S,Y) względem kursora 3D, i zmniejsz grubość końcowej sekcji do zera (Rysunek 3.3.12a):
Rysunek 3.3.12 Przekształcenie ostatniej sekcji z pętli w pojedynczą linię
W tej chwili w każdym miejscu “ściśniętej” linii znajdują się dwa wierzchołki. Scalmy je ze sobą (W, Remove Doubles — Rysunek 3.3.12b) .
Rysunek 3.3.13 Kształtowanie sekcji końcówki łopaty — c.d.
W ten sposób przekształciliśmy ostatnią sekcję z “pętli” w pojedynczą “linię” wierzchołków. Następnie:
Przesuń końce krańcowej linii tak, by znalazły się w tym samym miejscu, co końce poprzedniej sekcji (Rysunek 3.3.13a);
Scal te wierzchołki (Remove Doubles), aby krańcowa linia stała się przedłużeniem krawędzi natarcia i krawędzi spływu;
Zwiększ ostrość (crease) tej linii do 1.0 (Rysunek 3.3.13a);
Zmniejsz grubość poprzedniej sekcji, aby zmniejszyć promień zaokrąglenia końcówki (Rysunek 3.3.13b).
Zamknęliśmy w ten sposób siatkę łopaty śmigła, uzyskując na końcu odpowiednią grubość.
Pozostaje tylko poprzesuwać odpowiednie grupy wierzchołków w rzucie z przodu, by dopasować się do obrysu z planów (Rysunek 3.3.14):
Rysunek 3.3.14 Zaokrąglanie końcówki łopaty. | Rysunek 3.3.15 Uformowana łopata śmigła. |
Na tym etapie uzyskaliśmy już właściwie uformowaną łopatę śmigła (Rysunek 3.3.15).
Teraz skręcimy ją wzdłuż osi Z . Końcówkę łopaty pozostawimy nie skręconą — to będzie nasza “baza”. Całkowity kąt skręcenia łopaty śmigła — od końca do nasady — to zazwyczaj 30-40º. Rośnie w miarę równomiernie wzdłuż osi Z, choć nieco szybciej w pobliżu osi obrotu śmigła. Zwróć uwagę na położenie kolejnych sekcji na naszej łopacie: taże są bliżej siebie przy osi obrotu. (Zazwyczaj uzyskasz takie taki układ krawędzi dla łopaty o typowym kształcie). Dzięki temu można łatwo uzyskać efekt narastającego skręcenia metodą kolejnych obrotów o stały kąt. Na początek zaznacz prawie wszystkie sekcje poza końcówką (Rysunek 3.3.16a):
Rysunek 3.3.16 Skręcanie łopaty śmigła — początek
Ustaw jako środek tej transformacji (Pivot) kursor 3D, umieszczony w środku łopaty4. Następnie obróć (R, szczegóły — str. 337) zaznaczone sekcje o 10º (Rysunek 3.3.16b).
Teraz wyklucz z zaznaczenia krańcową sekcję (Rysunek 3.3.17a), i powtórnie wykonaj obrót zaznaczenia o kolejne 10º (Rysunek 3.3.17b):
Rysunek 3.3.17 Skręcanie łopaty śmigła — następny krok
Powtarzaj tę operację, za każdym razem zmniejszając obszar selekcji o kolejną sekcję. Rysunek 3.3.18 pokazuje ostateczny efekt skręcenia (osiągnięty po obróceniu ostatniej sekcji)
Rysunek 3.3.18 Ostateczny efekt skręcenia łopaty śmigła
Skręcenie łopaty nie spowodowało zaburzeń w większej części obrysu łopaty z przodu. Problemy tego typu wystąpią w pobliżu nasady śmigła, gdzie kat obrotu sekcji jest już duży (waha się pomiędzy 30 i 45º). To spowodowało pewne zmiany w obrysie łopaty, która przestała pasować do planów (Rysunek 3.3.19a).
Najprościej jest to poprawić, zmieniając wzdłuż osi X skalę sekcji, które znajdują się w tym obszarze (Rysunek 3.3.19b). Podczas skalowania punktem odniesienia musi być oczywiście kursor 3D (Pivot: 3DCursor). Aby nie naruszyć osi łopaty, upewnij się wcześniej, że nadal znajduje się osi Z. Takie skalowanie wzdłuż jednej osi zmienia kształt i kąt pochylenia modyfikowanych profili łopaty, ale są to bardzo nieznaczne różnice. W praktyce trudno nawet je zauważyć.
Rysunek 3.3.19 Poprawianie obrysu w miejscu, gdzie łopata wyraźnie zmieniła kształt (w wyniku skręcenia)
Pierwsza łopata śmigła jest gotowa! Przełącz się z trybu edycji w tryb obiektu (Object Mode, Tab). Włącz dodatkowo widoczność warstwy 1, na której umieściliśmy kołpak śmigła, aby zobaczyć rezultat.
P-40 miał śmigło o zmiennym skoku. Oznacza to, że podczas lotu łopata mogła się obracać wokół osi Z 5. W jakim zakresie kątów? Na pewno była bardziej skręcona — na razie kąt natarcia końcówki wynosi 0º. W niektórych źródłach można się doczytać, że w użytym w P-40 śmigle Curtiss Electric kąt zaklinowania łopaty można było zmieniać od 24 do 49º. Obróćmy więc nasz obiekt o 24º wokół osi Z (R, Z) — w “położenie startowe” (Rysunek 3.3.20):
Rysunek 3.3.20 Ustawianie kąta natarcia łopaty
Jak zwykle po wykonaniu jakiegoś detalu warto go obejrzeć z różnych stron. W wyniku porównań ze zdjęciami, stwierdziłem że łopata śmigła w P-40B/C miała, w okolicy kołpaka śmigła, przekrój niemal okrągły.
Musiałem więc dodać (Loop Cut) dodatkową sekcję tuż za dotychczasową. W ten sposób przyśpieszyłem w tym miejscu przejście kształtu z “profilu lotniczego” w okrąg (Rysunek 3.3.21).
Czas nazwać nasz obiekt — niech to będzie B.010.A.Blade. Litera “A” w nazwie wynika stąd, że śmigło miało trzy łopaty: rozróżnimy je literami A, B, C. Siatka będzie się nazywać B.010.Blade (bez „A”,”B”,”C”) bo drugą i trzecią łopatę stworzymy kopie powiązane (Alt-D: Duplicate Linked — str. 302) obiektu A (Rysunek 3.3.22):
Rysunek 3.3.22 Powielanie łopaty śmigła
Nowo stworzony obiekt obracamy (względem kursora 3D, umieszczonego w osi śmigła) o 120º. Nadaj mu nazwę B.010.B.Blade. Podobnie utwórz trzecią łopatę — B.010.C.Blade.
Każda z łopat jest połączoną kopią pierwowzoru (tzn. wykorzystuje tę samą siatkę). Dzięki temu zmiana kształtu jednej z nich zmieni natychmiast kształt pozostałych. Jeżeli jesteś ciekaw, dlaczego — patrz “Struktura danych modelu i sceny w Blenderze”, str. 393. Pewnym mankamentem takiego “klonowania” jest brak możliwości przypisania każdej z łopat indywidualnych tekstur czy współrzędnych UV. Na ostatecznym renderingu będą musiały wyglądać identycznie6.
Od razu po stworzeniu nowego elementu, należy wskazać mu jego miejsce w hierarchii części. Przypisz wszystkie trzy łopaty do kołpaka (Ctrl-P: Make Parent — str. 306) .
Na zakończenie warto wspomnieć o zaskakującym (przynajmniej dla mnie) efekcie geometrycznym. Na wszystkich rzutach z boku samolotów, jakie widziałem, jedna z łopat śmigła zawsze zasłaniała drugą. Gdy po raz pierwszy stworzyłem trójłopatowe śmigło w Blenderze, i obejrzałem je w widoku z boku (jak Rysunek 3.3.23), byłem zaskoczony, że łopaty nie do końca się zasłaniają. Czy to miałoby znaczyć, że się gdzieś pomyliłem?
Rysunek 3.3.23 Zaskakujący efekt geometryczny — odsunięcie końcówek łopat!
Sprawdziłem wówczas wszystkie kąty skręcenia, położenia, środki — i nic! Potem zacząłem dokładnie analizować sprawę. Rysunek 3.3.23 pokazuje rezultat tej analizy — jest to zupełnie poprawny efekt skręcenia łopat śmigła. Nie występuje tylko wtedy, gdy skok śmigła jest równy zeru. Wygląda na to, że nikt z autorów planów modelarskich nie uświadomił sobie wcześniej, że trójłopatowe śmigło w rzucie z boku właśnie tak wygląda!
Model z tej sekcji znajdziesz w pliku model\p40\history\P40B-4.03.blend (por. str. 18).
Podsumowanie
Nawet najbardziej skomplikowane kształty — jak łopata śmigła — można uzyskać drogą stopniowego przekształcania bardzo prostego kształtu “wyjściowego”.
Na razie poznałeś dwie metody dodawania nowych wierzchołków: na krawędzi siatki — wytłaczanie (Extrude — str. 83). W środku siatki — wstawianie (Loop Cut. — str. 84).
Podstawowymi metodami edycji wierzchołków są: przesunięcie (Grab — str. 82), zmiana skali (Scale — str. 86), obrót (Rotate — str. 87). Dodatkowo często stosuję zmianę ostrości krawędzi (crease), oraz scalanie (Remove Doubles).
Elementy, których kształt się powtarza (jak łopata śmigła) opłaca się tworzyć jako kopie powiązane (Duplicate Linked — str. 90). W ten sposób łatwiej będzie w przyszłości modyfikować ich kształt, gdyż zmiana jednej powoduje zmianę pozostałych.
Ważnym elementem formowania modelu jest tworzenie hierarchii obiektów, poprzez przypisanie nowo utworzonego obiektu do obiektu nadrzędnego (Parent) (str. 90).
Końcówki łopat śmigła w rzucie z boku mogą się nie pokrywać — i to nie jest błąd (str. 91).
Nim rozpoczniesz formować skrzydło, warto sprawdzić jaki jest jego wznios w rzucie z przodu. Kąt wzniosu skrzydeł naszego P-40 był stosunkowo duży i wynosił 6º (Rysunek 3.4.1):
Rysunek 3.4.1 Wpływ kąta wzniosu na deformację skrzydła w rzucie z góry
Tak duży wznios powoduje widoczne deformacje skrzydła w rzucie z góry. Dlatego do formowania siatki przygotowałem dodatkowy rysunek skrzydła bez wzniosu („położonego płasko” na płaszczyźnie XY). Opracowałem go w oparciu o dostępną dokumentację fabryczną (Rysunek 3.4.2):
Rysunek 3.4.2 Przygotowanie roboczego rysunku skrzydła
Oczywiście, jeżeli nie dysponujesz oryginalnymi rysunkami, można uzyskać taki rzut np. rozciągając w poziomie oryginalny rzut płata o 1/cos(kąta wzniosu). Zazwyczaj autorzy planów nie odwzorowują w rzucie z góry delikatnego wygięcia linii żeber, co tym przypadku zdecydowanie ułatwia w sprawę.
W każdym razie takie „położone” skrzydło i skrzydło na rzucie z góry powinny mieć taką samą cięciwę (por. Rysunek 3.4.2 — pomijam tu wpływ ewentualnego kąta natarcia).
W przypadku P-40 wykorzystanie pomocniczego rysunku skrzydła jest niezbędne do poprawnego wykonania modelu, gdyż deformacja w rzucie z góry jest dość znaczna (Rysunek 3.4.3).
Taki pomocniczy rysunek jest dołączony do tej książki, jako plik source\plans\p40b-highres\wing.png (por. str. 18). W przykładach pokazanych na ilustracjach w dalszych sekcjach książki wykorzystuję jednak jako referencję inny obraz, który uzyskałem w wyniku nieznacznego rozciągnięcia płatów z planów Jacka Jackiewicza.
Skrzydło można by w zasadzie uformować w sposób podobny do tego, który zastosowaliśmy do stworzenia łopaty śmigła. Zaczniemy od stworzenia profilu początkowego, który później wytłoczymy (Extrude) w podstawowy kształt płata — trapez. Zazwyczaj w opisach konstrukcji samolotu można znaleźć szczegółowe informacje, jaki profil lotniczy został w niej zastosowany. W przypadku P-40 był to: NACA-2215 u nasady i NACA-2209 na końcówkach. Obrys NACA-2215 centropłata naniosłem na plany (por. Tom I). NACA-2209 to w istocie “spłaszczony” o 40% NACA-2215 (więcej na ten temat znajdziesz na str. 416, w dodatku “Kształt profili lotniczych (metody odwzorowania)”, a o rodzinie profili NACA — na str. 418).
Kształt profilu płata można odwzorować za pomocą linii podziałowej, opartej na siatce złożonej z niewielu (nawet kilkunastu) punktów. Czy należy się koncentrować na uzyskaniu siatki o jak najmniejszej liczbie wierzchołków? Można do tego dążyć. Tylko, mimo pozorów, taki efekt nie będzie najwygodniejszy na dalszych etapach pracy. Najlepiej jest, gdy jak najwięcej linii siatki skrzydła pokrywa się z głównymi liniami konstrukcyjnymi, widocznymi na planach. To ułatwi w przyszłości rysowanie tekstury nierówności (z paneli i nitów), a także wykonywanie otworów — lotek, klap, czy podwozia. Formowanie płata zaczniemy więc od narysowania płaskiego, “testowego” trapezu, który pozwoli nam “przymierzyć” położenie wierzchołków wzdłuż profilu płata.
Sądzę, że najlepszym miejscem na środek (punkt odniesienia) płata będzie punkt o współrzędnych X=0, Y=01. Umieść tam kursor 3D. Następnie wstaw w tym punkcie, w rzucie z góry, kwadrat (Add→Mesh→Plane — str. 295). Przełącz się w tryb edycji (Rysunek 3.4.4a) i powiększ go do szerokości skrzydła (Rysunek 3.4.4b):
Rysunek 3.4.4 Początek formowania płata — kwadrat
Najpierw przesuń kwadrat ponad płat, aby jego lewy górny narożnik znalazł się na krawędzi spływu. Zrób to w Edit Mode (aby środek obiektu ma pozostać w tym samym miejscu). Umieść tam kursor 3D (zaznacz tylko ten wierzchołek, a następnie wywołaj Shift-S, Cursor to Selected). Potem powiększ (Scale) cały kwadrat tak, by jeden z jego boków stał się cięciwą płata w pobliżu kadłuba (Rysunek 3.4.4b).
przesuń prawy boku kwadratu do końca rozpiętości płata (tzn. w kierunku X, w prawo);
przesuń jego wierzchołki w pionie (wzdłuż osi Y) tak, by przekształcić ten kwadrat w trapez, którego górna i dolna krawędź pokrywają się się z krawędziami płata (Rysunek 3.4.5a);
Rysunek 3.4.5 Nanoszenie linii, odpowiadających podłużnicom płata
Wstaw (za pomocą polecenia Loop Cut) dodatkowe krwędzie wewnątrz trapezu. Umieść je wszędzie tam, gdzie na planach są narysowane istotne linie konstrukcyjne. Rysunek 3.4.5b) pokazuje pierwsze z nich.
Potem:
dosuń lewy bok trapezu do osi kadłuba (ustw kursor 3D w punkcie 0,0,0, przełącz Pivot Point na 3D Cursor, zaznacz wierzchołki lewej krawędzi i zmniejsz ich skalę do 0 w kierunku osi X);
zwiększ jego rozmiar w kierunku Y tak, by po tej zmianie uzgodnić górną i dolną krawędź trapezu z krawędziami płata;
Rysunek 3.4.6 pokazuje efekt tych operacji:
Rysunek 3.4.6 Trapez “testowy” — w celu dopasowania się do układu podłużnic płata
Wierzchołki, połączone liniami siatki, są umieszczone w tej samej proporcji (% cięciwy płata) na obydwu krańcach trapezu. Rysunek 3.4.6 pokazuje, że te “południki” niemal idealnie pasują do odpowiednich linii konstrukcyjnych. Ten efekt nie jest przypadkowy. Każdy inny kierunek na wypukłej powierzchni płata nie jest linią prostą. Podłużnica, która nie biegnie w kierunku “południkowym” jest w prawdziwym samolocie o wiele trudniejsza do wykonania. Co prawda tam, gdzie wypukłość płata jest niewielka — w pobliżu krawędzi spływu — mogą się zdarzyć podłużnice biegnące w innym kierunku. Rysunek 3.4.6 pokazuje, że w P-40 były to krawędzie klap.
Jedynym elementem stworzonego trapezu, którego potrzebujemy do dalszej pracy, jest linia biegnąca wzdłuż postawy płata (Rysunek 3.4.6). Przekształcimy ją w profil poczatkowy. Usuń wszystkie pozostałe wierzchołki siatki, by pozostały z niej tylko krawędzie leżące na osi samolotu. Jako rysunek referencyjny rzutu z boku załaduj source\plans\p40b-highres\Left (gear).png. Następnie:
przesuń tę linię wierzchołków o jedną jednostkę do góry;
skopiuj wierzchołki pozostawionej linii w nową linię (Shift-D, Mesh→Duplicate, str. 347) , i przesuń o 2 jednostki do dołu (by każda z linii leżała po przeciwnych stronach środka obiektu — Rysunek 3.4.7);
połącz obydwa krańce tych linii krawędziami (F, Mesh→Edges→Make Edge/Face, str. 361) ;
podziel te nowo utworzone krawędzie za pomocą dodatkowych wierzchołków (W, Mesh→Edges→Subdivide, str. 348): jednego na przedniej i dwóch na tylnej krawędzi;
Rysunek 3.4.7 Obrys, przygotowany do przekształcenia w profil
Rysunek 3.4.7 przedstawia obrys, który powinieneś przygotować . Przednia krawędź ma wierzchołek dokładnie w połowie długości, czyli dla Z = 0. Powstanie z niego linia krawędzi natarcia. Tylne połączenie obrysów: górnego i dolnego, składa się aż z 4 wierzchołków. Powstanie z nich krawędź spływu. Te cztery wierzchołki ustaw tak, jak na ilustracji — ich wysokość nie powinna przekroczyć 0.05 jednostki Blendera (czyli 5 mm na “prawdziwym” samolocie). Po włączeniu wygładzenia powierzchni, utworzą zaokrąglenie o promieniu ok. 0.03 jednostek Blendera (czyli 3 mm na “prawdziwym” samolocie)2.
Rysunek 3.4.8 Ustawienie obrysu w pozycji właściwej dla płata
Teraz przekształcimy obrys w poprawny profil płata. Przełącz się w tryb obiektu (Object Mode). Obróć obrys wokół osi X o -1º. Następnie przesuń go do dołu, aby znalazł się w osi płata (Rysunek 3.4.8).
Najłatwiej jest to zrobić, ustawiając krawędź spływu w punkcie, gdzie na planach jest krawędź spływu profilu centropłata (Rysunek 3.4.8).
Przełącz się z powrotem w tryb edycji (Edit Mode). Włącz wygładzenie linii (dodając modyfikator Subdivision Surface) i ustaw jego poziom (Subdivisions) na 2. Włącz tryb wyświetlania Wireframe (Z), by oprócz linii siatki, zobaczyć na ekranie także cienką, wygładzony kontur efektywnego kształtu. Spróbuj najpierw odwzorować profil płata, przesuwając tylko istniejące wierzchołki. Nie zmieniaj ich pozycji względem cięciwy profilu (lokalnej osi Y), gdyż pod tym względem zostały już “ustawione”. Możesz je jedynie przesuwać wzdłuż lokalnej osi Z (kombinacja G,Z,Z — Rysunek 3.4.9):
Rysunek 3.4.9 Formowanie profilu — przesuwanie wierzchołka wzdłuż lokalnej osi Z
Czasami do uzyskania ostatecznego kształtu okaże się konieczne dodanie do obrysu dodatkowego wierzchołka. Najłatwiej to zrobić poprzez podział odpowiedniej krawędzi (Subdivide). Te dodatkowe wierzchołki nie mają odwzorować żadnej konkretnej linii konstrukcyjnej. Możesz więc je swobodnie przesuwać, zarówno wzdłuż lokalnej osi Z, jak i osi Y.
Oryginalne wierzchołki, które możesz tylko przesuwać w kierunku Z, poznasz po tym, że występują “parami”. Każdemu takiemu wierzchołkowi na dolnym obrysie profilu odpowiada wierzchołek na górnym obrysie profilu. Obydwa leżą w tym samym miejscu lokalnej osi Y (Rysunek 3.4.9).
Rysunek 3.4.10 przedstawia fragment obrysu profilu płata, w trakcie dopasowywania do zadanego konturu. Jako pomoc w uzyskaniu odpowiedniego kształtu, umieściłem w nosie profilu pomocniczy okrąg (usunę go, gdy skończę). Podczas formowania okazało się, że niezbędne jest dodanie dodatkowego wierzchołka, pokazanego na ilustracji.
Rysunek 3.4.10 Formowanie nosa profilu — przykład wstawienia dodatkowego wierzchołka
Ustawiając kolejne wierzchołki od krawędzi natarcia do krawędzi spływu profilu, szybko dopasujesz obrys do założonego konturu (Rysunek 3.4.11) :
Rysunek 3.4.11 Uformowany profil płata
W tym przykładzie udało nam się odwzorować dokładnie profil płata za pomocą 32 wierzchołków. To dość typowy rezultat.
Większość dalszych prac będzie nam łatwiej wykonywać, gdy płat nie będzie pochylony o -1º. W związku z tym przełącz się w Object Mode i zmień kąt pochylenia na 0º. Przesuń ten obiekt z powrotem do środka układu współrzędnych. To ułatwi odczyt współrzędnych góry i dołu płata (jedne będą dodatnie, a drugie — ujemne). Dalsze przekształcenia siatki będą wykonywane w oparciu o rzut z góry i z przodu. Dopiero po ostatecznym uformowaniu umieścimy płat w docelowym miejscu konstrukcji i tam go “zaklinujemy” pod katem -1º.
Zgodnie z dokumentacją, profilem końcówki płata był NACA-2209. Ten symbol oznacza taki sam kształt, jak NACA-2215, tylko “spłaszczony” o 40%. Podczas ustalania grubości płata przyda nam się jakiś dokładny wzór, aby sprawdzić, czy osiągnęliśmy właściwą grubość. Na plany nie ma w tym przypadku co liczyć — rzuty z przodu zazwyczaj pokazują grubość płata niepoprawnie. Zresztą, nawet gdyby autor starał się być dokładny, to powinien narysować kształt skrzydła pochylonego o 1º. Zróbmy więc nasz własny wzorzec grubości skrzydła. Będzie to kopia obrysu, który właśnie ukończyliśmy:
skopiuj (Shift-D) profil podstawy w nowy obiekt;
otwórz przybornik Properties (N) i w panelu Transform zmień jego rozmiar (Dimensions): w kierunku Y do 10.0, a Z — do 0.9 (w ten sposób uzyskujemy profil końcówki o grubości 9%: NACA-2209).
Rysunek 3.4.12 pokazuje, jak na tym etapie powinien wyglądać nowy profil:
Rysunek 3.4.12 Pomocniczy wzorzec profilu końcówki płata
O jakim konkretnie miejscu myślał autor opisu technicznego P-40, pisząc że grubość profilu na końcu płata wynosiła 9%? Proponuję założyć, że chodzi tu o ostatnie żebro przed obszarem zaokrąglonej końcówki. Przesuń wzorzec końcówki w to miejsce (współrzędne Y i Z środka mają pozostać = 0,0). Następnie powiększ cały obiekt — we wszystkich kierunkach, względem środka obiektu — aby dopasować krańce profilu do obrysu płata. Najprościej to zrobić poprzez zmianę skali (S — Rysunek 3.4.13, por także str. 300):
Rysunek 3.4.13 Ustalenie położenia i rozmiaru wzorca końcówki
Dzięki proporcjonalnemu powiększeniu profilu we wszystkich kierunkach, masz pewność, że jego grubość względna nadal wynosi 9%.
Stwórz podstawowy obrys skrzydła, wytłaczając profil centropłata wzdłuż osi X (E,X). Sekcję końcową pozostaw nieco poza konturem skrzydła, przedstawionym na planach (Rysunek 3.4.14). (Ten nadmiar zostanie usunięty przy okazji odcinania końcówek płata).
Następnie upewnij się, że kursor 3D jest w środku układu współrzędnych (Rysunek 3.4.14). Zmniejsz skalę końcówki w kierunku Y tak, by pasowała do konturu płata w rzucie z góry. Potem zacznij zmieniać skalę końcówki w kierunku osi Z. W rzucie z przodu obserwuj położenie końców szablonu i linii siatki:
Rysunek 3.4.14 Wytłoczenie (Extrude) podstawowego kształtu płata
Dochodzenie do właściwej grubości końcówki można wykonać stopniowo, w kilku krokach. Podczas ostatniej fazy śledź jedną z końcówek wzorca w możliwie dużym powiększeniu (Rysunek 3.4.15). Aby lepiej widzieć kontur siatki i profilu końcówki, włącz w modyfikatorze Subsurf skrzydła opcję Apply during Edit (por. str. 77). W połączeniu z trybem wyświetlania Wireframe (Z) pozwoli to precyzyjnie dopasować skalę w rzucie z przodu.
Rysunek 3.4.15 Dopasowanie grubości końcówki płata do zadanego wzorca
Ten etap formowania skrzydła jest zakończony, gdy powierzchnia płata pokryje się z tymczasowym 9% profilem, który umieściliśmy przy końcówce. Gdy to osiągniesz, usuń ten pomocniczy obiekt. Wykonał już swoje zadanie, i nie jest nam dłużej potrzebny.
Pozostało uporządkować jeszcze sprawę kształtu krawędzi spływu. Obróć aktualną projekcję i ustaw ją tak, by krawędź spływu stała się niemal prostopadła do płaszczyzny widoku. Zobaczysz wówczas to, co pokazuje Rysunek 3.4.16a: promień zaokrąglenia na końcówce jest kilka razy mniejszy od analogicznego zaokrąglenia u nasady płata. Technologicznie jest to niemożliwe — krawędź spływu jest zazwyczaj uformowana przez wygięcie blachy pokrycia, z jakimś stałym promieniem. Powiększ wszystkie cztery punkty końcówki względem ich naturalnego środka (Pivot: Bounding Box Center) w kierunku osi Z. Dodatkowo przesuń odrobinę dwa zewnętrzne wierzchołki do przodu wzdłuż osi Y. Utworzą w ten sposób identyczny obrys, jak na początkowym profilu skrzydła (Rysunek 3.4.16b):
Rysunek 3.4.16 Ujednolicenie promienia na krawędzi spływu
W efekcie uzyskałeś wzdłuż krawędzi spływu stały promień zaokrąglenia — w realnym samolocie miałby średnicę ok. 3mm. To bardzo mały promień - nie jestem pewien, czy można aż tak zagiąć blachę pokrycia (zazwyczaj ok. 1mm grubości) bez ryzyka pęknięcia duralu. Mimo ogromnej liczby zdjęć konstrukcji nie byłem w stanie określić, czy krawędź spływu była uzyskana poprzez zagięcie, czy też znitowanie górnej i dolnej powłoki płata. Zresztą nawet taką “kanciastą”, znitowaną krawędź często poddaje się oszlifowaniu, uzyskując koniec końców zaokrąglenie.
Czy powiększenie promienia krawędzi spływu bardzo zaburzyło profil tylnej części końcówki? Gdy zmniejszysz nieco powiększenie, zobaczysz że na szczęście nic takiego się nie stało (Rysunek 3.4.17). Tylna, dolna krawędź przekroju płata z lekko wypukłej linii stała się linią prostą — ot, i wszystko:
Rysunek 3.4.17 Rozmiar zaokrąglenia końcówki — ujęcie, pozwalające ocenić skalę.
Model z tej sekcji znajdziesz w pliku model\p40\history\P40B-4.04.blend (por. str. 18).
Podsumowanie
Jeżeli skrzydła modelowanego samolotu mają wznios większy niż 2-3º, przygotuj dla nich odrębny rysunek referencyjny. Możesz go stworzyć z rysunków fabrycznych (o ile je masz), lub rozciągając wzdłuż rozpiętości o odpowiedni współczynnik (1/cos(kąt wzniosu)) oryginalne plany (str. 92);
Warto się postarać, by jak najwięcej linii siatki skrzydła — “żeber” i “podłużnic” — pokrywało się krawędziami paneli i liniami nitów, widocznymi na planach. To ułatwi w przyszłości przygotowanie tekstur, odwzorowujących te detale.
Zaczęliśmy się od “testowego”, płaskiego obrysu skrzydła. Posłużył nam do podjęcia decyzji o rozłożeniu wierzchołków wzdłuż profilu płata (str. 94). Efektem tej “przymiarki” było przygotowanie odpowiedniego rozkładu podłużnic dla siatki skrzydła.
Właściwe formowanie skrzydła zaczynamy od uformowania profilu jego podstawy (zazwyczaj podstawa płata leży w osi samolotu). Profil to linia zamknięta, wygładzona modyfikatorem Subsurf. Podczas kształtowania tej linii dodajemy do jej obrysu dodatkowe wierzchołki, aby uzyskać odpowiedni kształt krzywej (por. str. 97).
Po stworzeniu profilu podstawy płata należy przygotować profil końcówki (str. 97)
Podstawowy kształt płata — trapez — uzyskujemy poprzez wytłoczenie (Extrude) profilu podstawy, rozciągając go na całą rozpiętość skrzydła. Potem dopasowujemy koniec (poprzez zmianę skali) do zadanych rozmiarów profilu końcówki (str. 98).
Na krawędzi spływu skrzydła lepiej pozostawić małe, “technologiczne” zaokrąglenie. Powinno mieć promień rzędu milimetrów (wyrażając to w jednostkach rzeczywistego samolotu).
Do powielenia wierzchołków służy polecenia Duplicate (Shift-D, str. 95). Powielane są także zaznaczone krawędzie i ściany.
Podczas pracy z linią wierzchołków przydatne są operacje: stworzenia nowej krawędzi (F, Make Edge, str. 95), wstawienia nowego wierzchołka (W, Subdivide odpowiedniej krawędzi — str. 96).
Końcówki płata P-40 nie da się uformować tak łatwo, jak końcówki łopaty śmigła. Po pierwsze, jest o wiele większa. Drobne nieścisłości kształtu, które “uchodzą” w przypadku małej końcówki łopaty, tu stałyby się zbyt widoczne. Po drugie, końcówka płata P-40 jest lekko wygięta do góry. Zrobiono to jednak w taki sposób, że linia górnej powierzchni płata pozostaje prosta (Rysunek 3.5.1):
Rysunek 3.5.1 Specyficzny, wygięty do góry kształt końcówki płata P-40
Przyjrzałem się temu fragmentowi na wielu zdjęciach. Doszedłem do wniosku, że najbezpieczniej będzie uzyskać ten obrys poprzez odcięcie nadmiaru siatki, tak, by górna krawędź płata pozostała nie zdeformowana. Potem wygnę dolną krawędź końcówki do góry, tworząc w rzucie z przodu charakterystyczne, lekkie wybrzuszenie.
Nim odetniemy końcówkę, nanieśmy na ten obszar siatki kilka dodatkowych sekcji (“żeber”) — za pomocą polecenia Loop Cut (Rysunek 3.5.2):
Rysunek 3.5.2 Dodatkowe sekcje, dodane do siatki płata
Sekcję A naniosłem z myślą o przyszłości — przyda się przy formowaniu lotki, a B — tam, gdzie się zaczynają zaokrąglenia. Sekcję C wstawiłem u podstawy końcówki płata, a D — tam, gdzie się później przyda do kształtowania obrysu.
Patrząc na ten rzut z góry nie dziw się, że widzisz dwie linie obrysu końcówki. Czarna linia pochodzi z oryginalnych planów, które okazały się niedokładne (por. Tom I). Ten drugi obrys w kolorze czerwonym — to moja poprawka, do której będziemy dopasowywać końcówkę.
W ramach dalszych przygotowań krawędź spływu zmodyfikujemy końcówki tych żeber, by stworzyć na niej jeszcze jeden punkt, i rozłożyć pozostałe punkty bardziej równomiernie. (Inaczej trudno byłoby uzyskać odpowiedni kształt konturu płata). Utwórz przy sekcjach C i D trzy dodatkowe, lokalne linie wierzchołków — poprzez nacięcie (Shift-K, Knife — str. 345). Wszystkie powinny być równoległe do widocznej na planie krawędzi lotki (Rysunek 3.5.3a):
Rysunek 3.5.3 Pochylenie żeber w tylnej części skrzydła
Potem zaznacz i usuń (X, Delete→Limited Dissolve, str. 355) końcówki oryginalnych sekcji D i C, aby włączyć w nie nowe krawędzie (Rysunek 3.5.3b). Zwróć uwagę, że żadna z tych modyfikacji nie zmieniła kształtu górnej powierzchni płata!
Teraz przygotuj pomocniczy “nóż” do odcięcia końcówki. Siatkę tego obiektu utwórz poprzez złożenie fragmentów kilku okręgów (o środkach jak na planach) (Rysunek 3.5.4a):
Rysunek 3.5.4 Przygotowanie obiektu odcinającego końcówkę płata
Uzyskaną linię wytłocz (Extrude). Obiekt umieść w odpowiednim położeniu (Rysunek 3.5.4b).
Krawędź przecięcia powierzchni płata z tą pomocniczą powłoką uzyskamy za pomocą dodatku do Blendera o nazwie Intersection. Jest dostarczony wraz z tą książką (source\scripts\addons\object_intersection.py — por. str. 18). Powinieneś go znaleźć w sekcji Addons: Object (por. str. 264) i aktywować.
Krawędź przenikania pomocniczego obiektu z powierzchnią płata wyznaczymy używając polecenia Intersection (z menu Specials — por. str. 308). Opcje skryptu ustaw tak, by uzyskać wyłącznie punkty przecięcia z krawędzi skrzydła (Rysunek 3.5.5):
Rysunek 3.5.5 Rezultat przecięcia - nowa krawędź
Po wyznaczeniu krawędzi przecięcia, możesz już usunąć obiekt, którego użyliśmy jako “noża”. Uzyskana krawędź nie należy na razie do żadnej ściany siatki skrzydła. Aby ją do niej włączyć:
Zaznacz i usuń ostatnią sekcję płata (Rysunek 3.5.5);
Usuń także niepotrzebne, krańcowe wierzchołki z linii przecięcia (Rysunek 3.5.5);
Złącz linię przecięcia z odpowiednimi podłużnicami skrzydła za pomocą czterech nowych krawędzi (Rysunek 3.5.6a)
Utwórz z poszczególnych wierzchołków nowe ściany (zaznaczając po trzy lub cztery i naciskając F — str. 359). Wkomponuj w ten sposób krawędź w płat (Rysunek 3.5.6b);
Rysunek 3.5.6 Scalenie nowej krawędzi z resztą siatki
Rysunek 3.5.6b) przedstawia efekt operacji. Mówiąc szczerze, wtyczkę Intersection napisałem, ponieważ nigdy nie lubiłem efektów operacji Boolean w Blenderze. Zawsze lepiej mieć pełną kontrolę nad siatką, i nadać jej dokładnie taki układ wierzchołków, jaki sobie życzymy.
Teraz dopasujemy krawędź spływu końcówki do obrysu w rzucie z góry. Zaczniemy od dwóch nie naruszonych sekcji z oryginalnej siatki. Należy przemieścić ostatnie wierzchołki tych żeber tak, by znalazły się tylko odrobinę poza obrysem (Rysunek 3.5.7a).
Pamiętaj, że każdy z węzłów siatki, widoczny w rzucie z góry, to dwa wierzchołki — na górnej i dolnej powierzchni płata. Zaznaczaj je więc jako grupę, np. używając C (Circle select — por. str. 329). Należy przesunąć je tak, by wygięcie siatki było płynne. Wierzchołki po przesunięciu powinny leżeć na tej samej linii żebra, tylko bliżej środka. Można to zrobić poprzez przesunięcie (G) — zaznaczając oddzielnie każdy z węzłów. To najbardziej oczywista, ale trudniejsza droga (trudno zachować dokładną współliniowość z linią żebra). Znam szybszą metodę:
umieść w pierwszym z wierzchołków linii żebra, który nie jest przesuwany, kursor 3D (zaznacz go, a następnie wywołaj Shift-S, Cursor to Selected);
zaznacz wierzchołki końcówki żebra, które mają być przesunięte (por. Rysunek 3.5.7a);
przełącz aktualny środek transformacji (Pivot Point) na 3D Cursor;
zmień skalę zaznaczonych wierzchołków by znalazły się w nowym miejscu. (Po wywołaniu polecena Resize klawiszem S, naciśnij Shift-Z aby zablokować zmiany wzdłuż osi Z). Rezultat powinien wyglądać tak jak to pokazuje Rysunek 3.5.7a);
Szczegóły tej metody „przesuwania poprzez skalowanie” i ograniczenia zmiany skali do płaszczyzny znajdziesz na str. 335.
Tą metodą dopasuj po kolei każde z żeber (zacznij od zewnętrznego). Rysunek 3.5.7b) pokazuje rezultat, który powinieneś osiągnąć:
Rysunek 3.5.7 Dopasowanie tylnej krawędzi końcówki do obrysu w rzucie z góry
Potem pozostają doszlifowanie szczegółów (Rysunek 3.5.7b):
stwórz dwie brakujące, trójkątne ściany (na górnej i dolnej powierzchni płata);
poprzesuwaj wierzchołki krawędzi spływu tak, by dokładnie dopasować obrys wygładzonej siatki do rysunku;
Pamiętaj, że krawędź spływu każdego żebra to cztery leżące blisko siebie wierzchołki! Zaznaczaj je jako grupę i razem poddawaj każdej transformacji.
Czas dodać ściany, z których (w rzucie z przodu) za chwilę powstanie zaokrąglenie końcówki płata. Zaokrąglenie to było niewielkie — miało promień rzędu centymetra. Stwórz dwie nowe krawędzie wytłaczając (Extrude) krawędź końca płata do dołu, wzdłuż osi Z. Zachowaj niewielką odległość pomiędzy tymi liniami — około 0.1 jednostki Blendera (Rysunek 3.5.8a):
Rysunek 3.5.8 Łączenie krawędzi — natarcia i spływu
Z przodu i z tyłu pozostały w siatce luki, które aż się proszą o uzupełnienie. Utwórz w tych miejscach nowe ściany (Rysunek 3.5.8b, c).
Dodaj teraz do górnej powierzchni płata nową sekcję (Rysunek 3.5.9). Użyj w tym celu polecenia Loop Cut, by nie zmienić kształtu górnej powierzchni skrzydła. Nową sekcję umieść w pobliżu końcówki — będzie wyznaczała granicę zaokrąglenia. Aby wyrównać jej odległość od końcówki, przesuń trochę jej krańcówe wierzchołki (Shift-V — Vertex Slide, p. str. 350):
Rysunek 3.5.9 Dodatkowa sekcja na powierzchni górnej
Rysunek 3.5.9 pokazuje linię po scaleniu trójkątnych ścian w okolicach jej końcówek (Alt-J — Tris to Quads, p. str. 362). Dzięki tej operacji ta sekcja jest połączona z “podłużnicami”.
Podobną operację wykonamy także na dolnej powierzchni: wstaw nową sekcję za pomocą polecenia Loop Cut. Uzyskaną linię umieść jednak w połowie odległości pomiędzy sąsiednimi sekcjami — posłuży nam do sterowania wygięciem tej powłoki (Rysunek 3.5.10):
Rysunek 3.5.10 Dodatkowa sekcja na powierzchni dolnej
Tak, jak w przypadku sekcji z powierzchni górnej, scal trójkątne ściany na jej końcach w czworokąty (Alt-J, p. str. 362) . Usuniemy w ten sposób z siatki wierzchołki, z których wychodzą więcej niż 4 krawędzie. (Takie punkty zazwyczaj odrobinę zaburzają kształt wygiętej powłoki podziałowej).
Powoli zbliżamy się do uzyskania ostatecznego kształtu. Teraz wygniemy dolną powierzchnię końcówki, zbliżając ją do górnej. Przełącz się na rzut z przodu (ZX). Umieść kursor 3D na krawędzi natarcia (Rysunek 3.5.11). Obróć wokół tego punktu taki “pas” ścian dolnej powierzchni, jak ten podświetlony na ilustracji poniżej (Rysunek 3.5.11):
Rysunek 3.5.11 Wyginanie powierzchni dolnej (poprzez obrót wybranych sekcji)
(W tym rzucie wygląda to trochę jak zamykanie szczęk krokodyla). Najpierw obróć obydwie zaznaczone krawędzi o kilka stopni (2º - 3º), potem samą końcówkę o kolejnych 10-12º. Nie “domykaj” jej jednak do końca — pozostaw pomiędzy górną i dolną krawędzią odstęp rzędu 0.1 jednostki Blendera.
Szczelinę, która pozostała, wypełnij rzędem nowych ścian, zamykając w ten sposób siatkę (Rysunek 3.5.12).
Teraz możemy przesunąć wzdłuż osi X górną i dolną krawędź obrysu (nie więcej niż o 0.1 - 0.2 jedn.) (Rysunek 3.5.12). Uzyskamy w ten sposób zaokrąglenie krawędzi płata.
Rysunek 3.5.12 Ostateczne domknięcie końcówki rzędem ścian wzdłuż obwodu
Przy okazji zdecydowałem się usunąć trójkątną ścianę z krawędzi natarcia. Po przemyśleniu udało mi się dobrać w tym miejscu układ ścian czworokątnych (Rysunek 3.5.12).
Pozostało dokonać ostatnich dopasowań do obrysu z góry (Rysunek 3.5.13). W ich trakcie:
oznaczyłem całą sekcję C, biegnącą jako podstawa końcówki, jako “ostrą” (crease = 1.0). W ten sposób wszelkie zmiany końcówki nie zmienią kształtu reszty skrzydła;
wygiąłem końce sekcji D, aby uzyskać lepsze dopasowanie do konturu płata, przedstawionego na planach (uzyskać punkt sterujący w odpowiednim miejscu);
dodałem małą krawędź na krawędzi spływu lotki. (W wyniku wyostrzenia krawędzi C potrzebny był dodatkowy punkt sterujący wzdłuż otworu lotki, aby dopasować znów powierzchnię do obrysu płata);
Rysunek 3.5.13 Ostateczne dopasowanie krawędzi końcówki do obrysu z góry
Wybrzuszeniem dolnej powierzchni końcówki można sterować za pomocą skalowania (wzdłuż osi Z) krawędzi, pokazanych na ilustracji (Rysunek 3.5.14):
Rysunek 3.5.14 Możliwe kształtu wybrzuszenia powierzchni dolnej
Na koniec obejrzyj ze wszystkich stron uzyskany kształt. Nie sugeruj się tu planami samolotu, bo akurat w tym miejscu są błędne. Porównuj raczej ten fragment ze zdjęciami.
Rysunek 3.5.15 przedstawia ostateczny efekt — końcówkę w widoku przodu:
Rysunek 3.5.15 Rezultat — uformowana końcówka (widok z przodu)
Model z tej sekcji znajdziesz w pliku model\p40\history\P40B-4.05.blend (por. str. 18).
Końcówka płata P-40 jest dość trudna do uformowania, ponieważ jej górna powierzchnia jest prostą kontynuacją górnej powierzchni. Większość zakończeń skrzydeł w innych samolotach ma mniej skomplikowany kształt.
Zawsze należy umieścić nowe sekcje siatki (“żebra”) tam, gdzie znajdują się ważne miejsca konstrukcji. (Ważne zarówno pod względem budowy płatowca — np. krawędź lotki, jak i geometrycznym — np. początek zaokrąglenia). Czasami także dodajemy żebro dla uzyskania równomiernego rozkładu wierzchołków wzdłuż krzywizny (str. 101).
Niektóre krawędzie (sekcje) siatki mogą być lokalne (tzn. istnieć tylko na obszarze kilku sąsiednich ścian). Niezastąpionym narzędziem do ich tworzenia jest Knife (Shift-K, str. 102). Często “przy okazji” usuwamy fragmenty innych sekcji (Erase→Edgeloop).
Zasadniczy kształt końcówki uzyskaliśmy przez odcięcie części siatki pomocniczym obiektem o kształcie założonego obrysu (str. 102). Wykonane to zostało w trzech krokach. Najpierw wyznaczyliśmy krawędź przecięcia za pomocą skryptu Intersection (str. 103). Potem usunęliśmy niepotrzebne wierzchołki (Delete→Vertices). Na koniec połączyliśmy krawędź przecięcia z resztą siatki, tworząc nowe ściany (F, Make Face — str. 103)
Ostateczne “zamknięcie” siatki końcówki nastąpiło w wyniku dosunięciu kilku dolnych sekcji do górnych (str. 106) i uzupełnieniu brakujących ścian.
Podczas pracy z siatką w dużym zakresie używaliśmy ograniczenia transformacji (przesunięcia, skalowania) do pojedynczej osi X, Y, Z. Taka technika pozwala “pracować w przestrzeni” bez konieczności ciągłego korzystania z rzutów z góry, przodu czy boku.
Zwróć uwagę, że można bezpiecznie podzielić kształtowanie powierzchni podziałowych na oddzielne płaszczyzny. Najpierw uformowaliśmy obrys z góry końcówki (płaszczyzna XY). Potem ukształtowaliśmy ten sam element w rzucie z przodu (ZX). Kształt w rzucie z góry, nie ulegał żadnej zmianie, dopóki przesuwaliśmy wierzchołki obrysu wyłącznie wzdłuż osi Z. To żaden przypadek, tylko reguła, której znajomość może Ci bardzo ułatwić modelowanie (szczegóły — str. 414).
Lotkę warto wydzielić z płata jako oddzielny obiekt. Dlaczego? Po pierwsze — zazwyczaj jest w ruchu. Model będzie wyglądać bardziej realistycznie z nieco poruszonymi lotkami. Po drugie — w samolotach opracowanych w po roku 1930 (a do nich zalicza się P-40) stosowane były tzw. lotki szczelinowe. Ich nazwa wzięła się od dużej szczeliny pomiędzy krawędzią lotki i płatem1. Szczelina lotki ma dość znaczne rozmiary na dolnej powierzchni płata, i pominięcie jej w modelowaniu byłoby poważną niedokładnością. Na pewno to zbyt duża “dziura”, aby ją zbyć w uproszczony sposób, np. linią na teksturze.
Już prędzej można byłoby w ten sposób uprościć inny element mechanizacji płata — klapy2. Aby można było je dodać w ramach uszczegóławiania modelu umieszczę na siatce dodatkową krawędź, biegnącą wzdłuż ich osi.
Przygotowując lotkę, dodamy do siatki płata dwie następne sekcje, pełniące rolę żeber, i jedną podłużnicę (Rysunek 3.6.1):
Rysunek 3.6.1 Dodatkowe sekcje, związane z przygotowaniem lotki
Żebro A już istnieje (utworzone w poprzedniej sekcji — p. str. 101, Rysunek 3.5.2). Wstaw teraz (Loop Cut) żebro C — tylko po to, aby następne żebra wstawiane od strony osi samolotu były proste. Przy końcówce żebra A natnij (Knife) dodatkową, pochyloną krawędź lotki. Na koniec usuń prostą końcówkę żebra A (por. Rysunek 3.6.1) — tak jak to zrobiliśmy poprzednio, na str. 102. Istnieją już także podłużnice 1, 2, biegnące wzdłuż dolnej i górnej krawędzi lotki. Krawędź klap (krawędź b)to przekątna pomiędzy tymi podłużnicami (por. Rysunek 3.6.1). Zaznacz dwa przeciwległe wierzchołki pomiędzy podłużnicą 1 i żebrem A oraz podłużnicą 2 i żebrem początkowym na dolnej powierzchni skrzydła. Połącz je poleceniem Vertex Connect (J). Powstawnie w ten sposób nowa krawędź b. (Przy okazji Blender wstawi nowy wierzchołek we wręgę C — por. str. 361).
Teraz zaznacz obszar siatki, zajmowany przez lotkę (Rysunek 3.6.2). (Zwróć uwagę, że na dolnej powierzchni jest to “o podłużnicę” więcej, niż na górnej):
Rysunek 3.6.2 Obszar lotki — do wydzielenia w nowy obiekt
Zaznaczony obszar wydziel w nowy obiekt (P, Separate — szczegóły na str. 363). W efekcie w płacie powstanie “otwór po lotce”. Wyostrz (crease = 1.0) krawędzie na jego narożnikach, aby nabrały właściwego wyglądu (Rysunek 3.6.3):
Rysunek 3.6.3 Skrzydło po wydzieleniu lotki — “wyostrzenie” (crease) narożników
Fragment, który znikł z siatki skrzydła, stał się nowym obiektem (Rysunek 3.6.4), o nazwie B.100.L.Wing.001. Znajduje się nadal w tym samym miejscu. Zaznacz go i czym prędzej zmień jego nazwę na odpowiednią dla lewej lotki: B.105.L.Aileron (jak i dlaczego— str. 304).
Rysunek 3.6.4 Lotka, po oddzieleniu od skrzydła
Na razie siatka lotki wygląda jak „uchylony zeszyt” (por. Rysunek 3.6.6a). Dodajmy do niej krawędź natarcia. Szczegóły tego fragmentu znajdziesz na obrazie source\plans\highres\wing.png(plik source.zip — por. str. 18). Wykorzystaliśmy w nim fragment oryginalnych rysunków konstrukcyjnych skrzydła (source\blueprints\P-40E-Wing-Details.png). W rzucie z dołu (Bottom) ponad krawędzią spływu modelu znajdziesz szczegółowy rysunek przekroju poprzecznego lotki i współpracującego z nią fragmentu płata. Traktując go jako wzór, stwórz linię profilu przedniej krawędzi lotki (Rysunek 3.6.5):
Rysunek 3.6.5 Przygotowanie profilu krawędzi natarcia lotki (rysunek w orientacji naturalnej)
Blender nie ma specjalnego polecenia do rysowania dowolnych linii. Możesz jednak łatwo “obejść” to ograniczenie, wstawiając w tym miejscu nowy okrąg (Circle) , złożony z dziesięciu wierzchołków. Potem go “rozerwij”, usuwając jedną krawędź, poprzesuwaj w odpowiednie miejsce wierzchołki — i profil gotowy (Rysunek 3.6.5).
Z siatki lotki usuń najbardziej wysuniętą do przodu dolną krawędź (Rysunek 3.6.6b) (to miejsce m. in. zajmie szczelina). Następnie dosuń do jej wewnętrznego krańca przygotowany profil, i odpowiednio przeskaluj, dopasowując rozmiarem do reszty siatki (Rysunek 3.6.6a). Zorientuj go tak, by leżał w płaszczyźnie ostatniego żebra lotki, i aby dotykał jej przedniej krawędzi (Rysunek 3.6.6b):
Rysunek 3.6.6 Ustawienie obrysu przodu lotki na wewnętrznej krawędzi
Podczas operacji przedstawianej przez Rysunek 3.6.6 wykorzystałem jako obraz referencyjny kolejny fragment oryginalnej dokumentacji fabrycznej. Znajdziesz go w pliku source\plans\highres\aileron.png (z source.zip — por. str. 18). Jest przygotowany do wstawienia na miejsce obrazu dla rzutu Bottom.
Zwróć także uwagę, że poprawiłem nieco układ ścian na końcówce lotki (Rysunek 3.6.6b). Usunąłem jeden wierzchołek i utworzyłem w tym miejscu nowe, trójkątne ściany. W ten sposób z krawędzią natarcia styka się czworokąt, a nie trójkąt (por. Rysunek 3.6.4).
Takie czworokątne ściany są w tym miejscu potrzebne, gdyż teraz odetniemy (Knife) ich przednie części (Rysunek 3.6.7, krok 1). W ten sposób przygotowaliśmy tylną powierzchnię lotki do połączenia.
Teraz wytłocz (Extrude) profil wzdłuż lotki. Po wytłoczeniu zmniejsz (Scale) jego końcówkę, aby dopasować ją do rozmiaru lotki (Rysunek 3.6.7, kroki 2,3) .
Rysunek 3.6.7 “Wytłoczenie” (Extrude) przedniej powierzchni lotki
Na koniec wstaw (Loop Cut) w nowo powstałe ściany dwie dodatkowe sekcje. Umieść je tak, by były przedłużeniem dwóch linii wierzchołków biegnących przez tylną część siatki (Rysunek 3.6.7, krok 4).
Po takim przygotowaniu przedniej i tylnej krawędzi lotki nie pozostaje nic innego, jak je połączyć. Wystarczy utworzyć sześć brakujących ścian (trzy z góry i trzy z dołu) (Rysunek 3.6.8):
Rysunek 3.6.8 Scalenie przedniej powierzchni lotki z resztą siatki
Musimy jeszcze zamknąć powłokę lotki za pomocą dwóch żeber — zewnętrznego i wewnętrznego. Nim je stworzymy, zwiększ ostrość (crease) odpowiednich krawędzi do 1.0. Dzięki temu nie wystąpią na nich żadne przypadkowe zaokrąglenia.
Formowanie żebra końcowego zaczynamy od stworzenia pojedynczych krawędzi (F, Make Edge/Face), łączących odpowiednie wierzchołki górnej i dolnej powierzchni (Rysunek 3.6.9). Następnie podziel każdą z nich na dwie równe połówki (poleceniem Subdivide). Uzyskałeś w ten sposób wierzchołki, na których możesz “rozpiąć” kolejne ściany (Rysunek 3.6.9):
Rysunek 3.6.9 Przygotowanie płaszczyzny żebra, zamykającego lotkę
Rysunek 3.6.10 pokazuje ukończoną ścianę lotki:
Rysunek 3.6.10 Domknięcie żebra lotki
Lotka jest gotowa, teraz warto dodać jej oś obrotu. Taki obiekt będzie “rodzicem” lotki. Obracając oś, będziemy obracać lotkę3. Na początek stwórz gdzieś w pobliżu, w rzucie z boku (ZY), niewielki walec (Cylinder — str. 296) (Rysunek 3.6.11):
Rysunek 3.6.11 Stworzenie osi lotki
Po stworzeniu przesuń środek walca (jak — str. 314) na ścianę wewnętrzną. Potem rozciągnij ten obiekt wzdłuż osi X. Oś nabrała kształtu pręta (Rysunek 3.6.11). Nadaj temu obiektowi nazwę B.106.L.Aileron Axis.
W rzucie z góry, przesuń ten “pręt” i obróć tak, by biegł wzdłuż osi lotki (widocznej na rysunkach fabrycznych) (Rysunek 3.6.12):
Rysunek 3.6.12 Ustawienie osi lotki (widok z góry)
Z rysunków fabrycznych wynika, że oś obrotu biegła równolegle do dolnej powierzchni lotki. Aby osiągnąć ten efekt, w rzucie z przodu (ZX) przesuń ją nieco do dołu i odpowiednio pochyl (Rysunek 3.6.13):
Rysunek 3.6.13 Ustawienie osi lotki (widok z przodu i wzdłuż osi obrotu)
Jak wysoko umieścić oś obrotu ponad dolną powierzchnią lotki? Ustaw ją tak, jak pokazują z rysunki fabryczne (por. Rysunek 3.6.5, str. 112). Wynika z nich, że w rzeczywistej konstrukcji oś obrotu lotki była rurką o średnicy ok. 1cm. Jej końce widać było w szczelinach na krańcach lotki. Dopasuj średnicę naszego obiektu do tego rozmiaru. Co prawda to maleńki detal, który prawie nigdy nie będzie widoczny, ale w końcu nie jest to specjalnie trudne. Z odwzorowania nawet takich właśnie szczegółów składa się końcowy efekt modelu.
Pora teraz ustalić, co do czego należy:
przypisz lotce (B.105.L.Aileron) jako “rodzica” (Parent — str. 306) przygotowaną przed chwilą oś (B.106.L.Aileron Axis);
przypisz osi (B.106.L.Aileron Axis) jako “rodzica” skrzydło (B.100.L.Wing);
Rysunek 3.6.14a) pokazuje, jaką hierarchię części powinieneś uzyskać:
Rysunek 3.6.14 Hierarchia — lotka, oś, skrzydło, i jej efekty
Czy wiesz, jak to działa? Zaznacz w oknie hierarchii (Outliner, Rysunek 3.6.14a) oś lotki. (W oknie widoku jest zasłonięta, więc nie ma co klikać na oślep). Teraz w oknie 3D View włącz jej obrót dookoła lokalnej osi Z (R,Z,Z — Rysunek 3.6.14b) — i możesz ruszać lotką! Przyznasz, że obraca się całkiem realistycznie. Muszę przyznać, że zawsze lubiłem zabawki, a później modele, z dużą liczbą ruchomych części ☺. W dalszych rozdziałach pokażę, jak wygodniej sterować o wiele bardziej złożonymi efektami: różnicowym wychylaniem lotek, składaniem i rozkładaniem podwozia.
Lotka jest gotowa i zamontowana. Wróćmy teraz do siatki płata: trzeba oprofilować wewnętrzne ściany wycięcia na lotkę. Zrobimy to w ten sam sposób, co krawędź natarcia lotki. Zaczynamy od przygotowania profilu ściany, wykorzystując rysunki fabryczne (Rysunek 3.6.15):
Rysunek 3.6.15 Przygotowanie obrysu szczeliny lotki
Następnie ustaw ją w płaszczyźnie wewnętrznego żebra, i dopasuj rozmiar do reszty siatki (Rysunek 3.6.16):
Rysunek 3.6.16 Dopasowanie obrysu szczeliny lotki
Kolejnym krokiem jest wytłoczenie tego obrysu wzdłuż krawędzi otworu lotki, oraz dopasowanie (zmniejszenie) rozmiaru końcówki (Rysunek 3.6.17):
Rysunek 3.6.17 Wytłoczenie powierzchni w szczelinie lotki
Przy okazji usuń (Delete→Edge Loop) dwa żebra, wskazane na ilustracji (Rysunek 3.6.17). Pozostały z czasów sprzed oddzielenia lotki, i teraz już tylko przeszkadzają.
Po usunięciu niepotrzebnych żeber scal (Remove Doubles) wytłoczoną powierzchnię z resztą siatki. Wypełnij także boczne ściany (Rysunek 3.6.17) — w ten sam sposób, jak boczne ściany lotki.
Rysunek 3.6.18 Zamknięcie wycięcia na lotkę
W konstrukcji tego fragmentu jest pewien szczegół, na który chciałbym zwrócić uwagę. Aby uzyskać ładną, ostrą krawędź ściany, o kształcie spłaszczonego “S”, ułożyłem w tym miejscu krawędzie w dość specyficzny sposób. Gdy popatrzysz na ilustrację poniżej (Rysunek 3.6.19a), możesz odnieść wrażenie, że wierzchołki 1, 2, 3 leżą na wspólnej krawędzi.
Rysunek 3.6.19 Szczegóły ściany żebra
Tak jednak wcale nie jest. To są dwie oddzielne krawędzie: |1-3| i |2-3|. Zbliżenie pokazuje, że w istocie wierzchołki 1, 2, 3 tworzą bardzo płaski trójkąt, leżący w płaszczyźnie żebra (Rysunek 3.6.19b). Taki układ siatki pozwala uzyskać na powierzchni podziałowej dwie ostre krzywe, zbiegające się ładnym łukiem w jednym punkcie.
(Nie zdecydowałem się umieścić punktów 1, 2, 3 w jednej linii. Żaden program renderujący “nie lubi” takich “zdegradowanych” ścian. Nie chciałem ryzykować jakichś lokalnych problemów z barwą czy teksturą).
Model z tej sekcji znajdziesz w pliku model\p40\history\P40B-4.06.blend (por. str. 18).
Podsumowanie
Lotki w konstrukcjach z okresu II WŚ miały konstrukcję szczelinową. Z tego powodu warto je modelować jako oddzielny element skrzydła.
Siatkę lotki najprościej jest uzyskać poprzez wydzielenie z siatki płata. Służy do tego polecenie Separate (str. 111).
Przednią krawędź lotki i tylną krawędź skrzydła modelujemy poprzez wytłoczenie profilu wzdłuż osi lotki.
Oś obrotu lotki warto jest stworzyć jako oddzielny obiekt. Zorientowanie samej lotki wzdłuż takiej osi stwarza dużo problemów.
Skrzydło, oś lotki i samą lotkę łączymy więzami Parent (str. 116) w hierarchię. Dzięki temu będziesz mógł przesuwać i obracać cały płat bez martwienia się o położenie jego komponentów. Lotkę można obracać poprzez obrót jej osi (brzmi to jak oczywistość, ale ten efekt jest możliwy dzięki hierarchii).
Rysunek 3.7.1 pokazuje układ siatki skrzydła, jaki do tej pory uzyskaliśmy (por. str. 110):
Rysunek 3.7.1 Obecny układ siatki skrzydła
Pozostało jeszcze do dodania kilka drobiazgów, z których największym jest otwór na koła podwozia głównego. Przygotowałem obrys jego krawędzi jako oddzielny obiekt (Rysunek 3.7.2) :
Rysunek 3.7.2 Narzędzie do wycięcia otworu podwozia głównego: ośmioboczna “rura”
W ramach przygotowania siatki płata wstawiłem trzy nowe żebra. Jedno z nich dokładnie w środku otworu, a pozostałe dwa — na zewnątrz (Rysunek 3.7.3):
Rysunek 3.7.3 Dodatkowe sekcje siatki płata — przygotowanie do wykonania otworu
Dlaczego do odwzorowania okręgu posługuję się ośmiobokiem? Dlatego, że więcej krawędzi tu nie trzeba. Dwukrotna powierzchnia podziałowa (Subdivisions = 2), wytworzy na takim obrysie w miarę gładki 32-kąt. Największe odchylenie wierzchołków tej linii od “idealnego” okręgu wynosi zaledwie 0.71% (więcej na ten temat — str. 404). Na pewno blacha na prawdziwym samolocie była wycinana z podobną, a być może nawet większą tolerancją.
Po tych przygotowaniach czas na cięcie. Podobnie jak w przypadku końcówki płata, użyj do tego polecenia Intersection. Tym razem skorzystaj wyłącznie z ośmiu punktów krawędzi przecięcia tego pomocniczego cylindra z powierzchnią płata (Rysunek 3.7.4):
Rysunek 3.7.4 Wyznaczenie krawędzi otworu koła podwozia
Siatka ośmiobocznego graniastosłupa zyskała dodatkową linię wierzchołków — krawędź przecięcia. Następnie zaznacz najpierw ten cylinder, potem skrzydło, o scal te dwie siatki (Ctrl-J — Join, str. 312). Po scaleniu usuń wszystkie niepotrzebne wierzchołki. Z pomocniczego graniastosłupa pozostaw z tylko samą krawędź przecięcia (Rysunek 3.7.5a):
Rysunek 3.7.5 Wyznaczenie krawędzi otworu na koło podwozia
Teraz ze środkowego żebra płata usuń cztery wierzchołki, leżące wewnątrz i na granicy krawędzi przecięcia (Rysunek 3.7.5b).
W rezultacie zrobiło się pusto wokół krawędzi otworu w skrzydle (Rysunek 3.7.6a):
Rysunek 3.7.6 Wkomponowanie nowej krawędzi w siatkę płata
Wystarczy zabudować tę przestrzeń, tworząc nowe ściany łączące krawędź przecięcia z resztą siatki. I w ten sposób uzyskasz ładny, okrągły otwór (Rysunek 3.7.6b)!
Aby nie “straszyć” pokryciem o zerowej grubości, wytłocz krawędź tego otworu wzdłuż lokalnej osi Z do wnętrza skrzydła o ok. 0.1 jednostki (Rysunek 3.7.7). (W rzeczywistym samolocie był to kołnierz o szerokości ok. 1 cm):
Rysunek 3.7.7 Wygięcie krawędzi otworu do wnętrza skrzydła
Możesz sprawdzić, że kształt otworu w rzucie z góry nadal jest okręgiem. Skąd wiedziałem, że tak się zachowa powierzchnia skrzydła? W końcu jest wygładzoną powłoką podziałową (Subsurf)... Otóż wynika to właśnie z właściwości powierzchni podziałowych. Jedna z nich brzmi ona: “kształt rzutu powierzchni podziałowej na dowolną płaszczyznę zależy tylko od rzutu na tę płaszczyznę jej siatki”. Jeżeli rzut z góry wygładzonego modyfikatorem Subsurf ośmioboku był okręgiem, to okręgiem w rzucie z góry jest także jego krawędź przecięcia ze skrzydłem. (Dlatego podczas operacji przecinania użyliśmy wyłącznie punktów leżących na krawędziach pomocniczego cylindra). Gdy połączymy uzyskaną krawędź przecięcia z siatką skrzydła nowymi ścianami — rzut z góry tego otworu także pozostanie okręgiem. (Nie zmieniliśmy przecież w żaden sposób położenia jego wierzchołków). Więcej na temat właściwości specyficznego “materiału”, jakim są linie i krzywe podziałowe, znajdziesz w sekcji 8.2, na str. 399.
Zbliżamy się już do końca prac nad kształtem płata. Pozostaje jeszcze tylko pochylić początkowe żebro o 6º. (Płat P-40 miał wznios 6º i składał się z dwóch połówek, złączonych śrubami. Aby do siebie pasowały, pierwsze żebro musi być o ten kąt pochylone).
Obróć cały obiekt w rzucie z przodu (ZX) o 6º do góry (Rysunek 3.7.8):
Rysunek 3.7.8 Pochylenie płata (6º)
Potem przełącz się w tryb edycji. Wstaw (Loop Cut) dodatkowe żebro w obszarze, który będzie w całości zasłonięty przez kadłub (Rysunek 3.7.9). Potem obróć żebro początkowe tak, by było pionowe. Na koniec “rozciągnij” (Scale) je trochę w kierunku Z, aby obrys dolnej i górnej krawędzi płata nie był załamany (Rysunek 3.7.9):
Rysunek 3.7.9 Pochylenie pierwszego żebra
I to wszystko! Pozostaje teraz jeszcze pochylić płat w rzucie z boku (ZY) o kąt zaklinowania (1º), i umieścić w docelowym położeniu (Rysunek 3.7.10):
Rysunek 3.7.10 Ustawienie płata w położeniu docelowym
Gdy siatka jest już gotowa, sprawdź jeszcze czy nie zawiera jakichś utworzonych przypadkiem ścian o liczbie boków większej niż 4 (tzw. n-gonów — por. str. 371). Jeżeli znalazłeś taki n-gon — podziel go zaraz na czworokąty i/lub trójkąty!
Model z tej sekcji znajdziesz w pliku model\p40\history\P40B-4.07.blend (por. str. 18).
Podsumowanie
Otwór na podwozie można wyciąć w powierzchni płata. Zazwyczaj otwory takie mają kształt będący pochodną okręgu.
Do zamodelowania całkiem dokładnego okręgu za pomocą linii/powierzchni podziałowych wystarczy ośmiokąt.
Obiekty (a dokładniej - ich siatki) można scalać. Służy do tego polecenie Join (str. 120).
Usterzenie poziome naszego modelu będzie się składać ze statecznika, steru wysokości i jego osi obrotu. Podobnie jak w przypadku płata, na plany samolotu naniosłem skorygowany (na podstawie zdjęć i rysunków fabrycznych) obrys kształtu tego zespołu. Miejscami różni się w dość dużym stopniu od oryginalnych rysunków — zarówno J. Jackowskiego jak i M. Łukasika (por. Tom I).
Usterzenie poziome wygląda jak małe skrzydło, i tworzymy je w ten sam sposób. Będzie łatwiejsze do uformowania niż płat, gdyż profil statecznika jest symetryczny, a końcówka ma konwencjonalny kształt. (Bez takich udziwnień, jakie wystąpiły w skrzydle).
Zaczynamy tak samo jak poprzednio — od przymiarki płaskiego trapezu do położenia podłużnic (Rysunek 3.8.1) :
Rysunek 3.8.1 Przymiarka położenia podłużnic na stateczniku
Środkiem nowego obiektu jest punkt przecięcia osi obrotu steru wysokości z osią symetrii kadłuba. Z trapezu pozostawiamy tylko profil początkowy (Rysunek 3.8.2a), dla którego włączamy odbicie lustrzane (modyfikator Mirror — p. Rysunek 3.8.2b, szczegóły: str. 365) :
Rysunek 3.8.2 Początkowa postać profilu (modyfikator Mirror włączony)
Nim przełączysz się do trybu edycji, ustaw cały obiekt wzdłuż osi usterzenia pod kątem -2º. Następnie, w trybie edycji, przekształć początkowy prostokąt w kształt obrysu górnej powierzchni usterzenia, zgodnie z rysunkiem. (Na plany naniosłem profil z rodziny NACA 00xxT, o zmniejszonym promieniu noska — taką “ostrą” krawędź natarcia widać na zdjęciach). Dolna połówka obrysu jest zawsze odbiciem górnej, dzięki modyfikatorowi Mirror (Rysunek 3.8.3). Aby uniknąć szczelin na krawędzi natarcia i spływu, te linie powinny leżeć na płaszczyźne XY lokalnego układu współrzędnych (współrzędne Z ich wierzchołków powinny być = 0):
Rysunek 3.8.3 Przygotowany profil statecznika
Pamiętaj, aby podczas formowania profilu przesuwać wierzchołki odpowiadające podłużnicom tylko wzdłuż lokalnej osi Z. W ten sposób zachowasz położenie podłużnic tam, gdzie je zaplanowałeś. Nowe wierzchołki, które dodałeś później, możesz przesuwać w sposób dowolny. Podobnie jak na płacie, zastosuj niewielkie zaokrąglenie na krawędzi spływu (Rysunek 3.8.3).
Po uformowaniu profilu wyprostuj z powrotem cały obiekt (zmień obrót dookoła osi X z -2º na 0º). Następnie wróć do trybu edycji i wytłocz (Extrude) jego profil wzdłuż osi X (Rysunek 3.8.4a). Upewnij się, czy kursor znajduje się w środku obiektu. (Mam na myśli punkt odniesienia — por. Rysunek 3.8.4b — a nie geometryczny środek siatki!) Ustaw tryb środka obrotu — Pivot — na 3D Cursor. Potem “ściśnij” końcówkę, zmieniając jej skalę wzdłuż osi Y (Rysunek 3.8.4b) :
Rysunek 3.8.4 Wytłoczenie profilu (a) i zmiana rozmiaru końcówki (b)
Przy formowaniu usterzenia nie jestem już tak dokładny, jak w przypadku skrzydła: nie przygotowałem pomocniczego profilu końcówki. Zamiast tego naniosłem na obrys z góry zarys przedniej krawędzi steru wysokości, uzyskany z rysunków fabrycznych tego elementu. Ster wysokości P-40 nie miał wyważenia krawędziowego, więc zakładam, że jego przednia krawędź miała okrągły przekrój (por. Rysunek 3.8.18, str. 131). Przy takim założeniu odległość przedniej krawędzi steru od osi obrotu określa także grubość usterzenia w tym miejscu.
Potraktowałem więc obrys przedniej krawędzi steru w rzucie z góry jak ekwiwalent obrysu w rzucie z przodu. Dopasowałem do niego grubość końcówki usterzenia poziomego, zmieniając skalę jej wierzchołków wzdłuż osi Z (Rysunek 3.8.5):
Rysunek 3.8.5 “Spłaszczenie” końcówki usterzenia (obiekt w rzucie z przodu, rysunek w tle to rzut z góry)
Czy nie popełniliśmy jakiejś poważnej pomyłki? Ustawiłem elementy, samolotu, które stworzyliśmy do tej pory, w odpowiednich miejscach na rzucie z boku (YZ). Potem porównałem je z planami Jacka Jackiewicza, których używałem przy tworzeniu tego modelu (Rysunek 3.8.6):
Rysunek 3.8.6 Mała weryfikacja rzutu z przodu — różnice w porównaniu z planami (narysowanymi ręcznie)
Wygląda na to, że grubości statecznika i skrzydła są podobne do tych, na planach modelarskich. Widać jest za to, że obydwa te elementy są w stosunku do rzutu z przodu przesunięte do dołu. (Kołpak śmigła jest we właściwym miejscu). Czy ta różnica wynikała z przyjęcia przez autora planów innego przebiegu osi samolotu? W takim przypadku statecznik byłby dwa razy bardziej odległy od swojego pierwowzoru na rysunku, niż skrzydło. Tak jednak nie jest. To raczej błąd rysunków — niewłaściwe położenie śmigła, wraz z kołpakiem, w płaszczyźnie ZX.
Rzuty z przodu mogą zawierać więcej błędów niż pozostałe, i należy traktować je z dużą rezerwą. Często będziesz się spotykał z podobnymi niespójnościami na planach. Należy wówczas przyjąć, że w pierwszej kolejności “rację ma” rzut z boku, później — rzut z dołu lub góry. Rysunki w pozostałych projekcjach i przekroje poprzeczne są mniej ważne. Traktuj je raczej jako poglądowe szkice, a nie dokładne odwzorowanie kształtu.
Plany które towarzyszą tej książce (z folderu source/plans/p40b-highres) są wolne od takich błędów (Rysunek 3.8.7) — ponieważ nie zostały narysowane „ludzką ręką”:
Rysunek 3.8.7 Weryfikacja rzutu z przodu (plany wygwnerowane z modelu 3D)
Czas stworzyć zaokrągloną końcówkę usterzenia. Na początek dodaj przy końcu siatki dodatkowe “żebro” (Rysunek 3.8.8). Według rysunków, obrys końcówki był fragmentem łuku. Dołącz więc do siatki, na lokalnej płaszczyźnie XY statecznika, pojedynczy łuk (uzyskany z 12 - wierzchołkowego Circle). Połącz jego końce z siatką, dokonując drobnych przemieszczeń wierzchołków, aby zneutralizować odchylenia linii od wzorcowego okręgu (Rysunek 3.8.8):
Rysunek 3.8.8 Końcówka usterzenia — naniesienie obrysu z góry
Następnie wytłocz wierzchołki łuku w pierścień (zmieniając skalę względem środka okręgu) (Rysunek 3.8.8). Wytłoczoną krawędź unieś nieco do góry (tzn. przesuń wzdłuż osi Z) (Rysunek 3.8.9):
Rysunek 3.8.9 Końcówka usterzenia — szczegóły zaokrąglenia
Potem dodaj do pierścienia kolejne linie wierzchołków (poleceniem Loop Cut). Ustawiam je tak, by każda z nich odpowiadała jednej z podłużnic z trapezowej cześci siatki (Rysunek 3.8.9).
W prawdziwym P-40 na końcu statecznika był zamocowany wygięty pierścień z blachy, o takim samym kształcie i rozmiarze jak nasz. Przyznam się, że zdjęcia z dwóch rekonstrukcji P-40 różnią się promieniem zaokrąglenia przekroju końcówki. Rekonstrukcja z Nowej Zelandii ma stosunkowo ostre końce, a inna, z USA — bardziej zaokrąglone. Wybrałem wersję z Nowej Zelandii, bo uważam ją za bardziej prawdopodobną (bardziej mi pasowała do promienia nosa profilu statecznika).
Od razu warto się przygotować do podziału usterzenia na statecznik i ster. Jeżeli zaznaczysz wcześniej krawędź podziału jako “ostrą” (crease = 1.0), to późniejszy podział siatki nie wpłynie na kształt żadnej z tych części. Oznaczyłem ją jako “ostrą”, w tym także odcinek na pierścieniu końcówki usterzenia. Oczywiście, zmieniło to obrys powierzchni podziałowej w tym obszarze. Przywracając w tym miejscu z powrotem kształt łuku, dodaj w pobliżu granicy steru i statecznika dwie dodatkowe krawędzie (Rysunek 3.8.10a). (Łatwiej je dodać na tym etapie — poleceniem Loop Cut — niż po wypełnieniu końcówki ścianami).
Rysunek 3.8.10 Końcówka usterzenia — dodatkowe krawędzie
Aby zapełnić pustą przestrzeń wewnątrz końcówki, wytłocz trzy wierzchołki siatki w “wypustkę”, lekko zaginiętą do dołu (Rysunek 3.8.10b,a). Już widzisz o co chodzi? Teraz wystarczy “rozpiąć” ściany na sąsiednich wierzchołkach, i końcówka jest zbudowana (Rysunek 3.8.11):
Rysunek 3.8.11 Siatka usterzenia — gotowa do wydzielenia steru
Zaznacz obszar siatki, z którego powstanie ster (Rysunek 3.8.11), i wydziel z niej nowy obiekt — B.205.R.Elevator. Jednocześnie nadaj nazwę statecznikowi: B.200.R.Stabilizer.
Podział siatek otwiera nowe możliwości uporządkowania każdej z nich. Chodzi tu przede wszystkim o wyeliminowanie wszystkich, lub prawie wszystkich ścian trójkątnych. (Powierzchnie podziałowe Catmull-Clarka generują się najlepiej w oparciu o ściany czworokątne).
Po oddzieleniu steru użyłem Knife i scalania ścian trójkątnych, aby zmienić wszystkie ściany statecznika w czworokątne (Rysunek 3.8.12) :
Rysunek 3.8.12 Uzupełniona i poprawiona siatka statecznika
Pozostało jeszcze dobudować tylną ścianę statecznika. Zacznij od wytłoczenia tylnej krawędzi wzdłuż lokalnej osi Z “na grubość blachy” — powiedzmy że będzie to 0.01 jedn. Blendera. Potem tę nową krawędź wytłocz jeszcze raz — tym razem aż do płaszczyzny symetrii (poprzez zmianę skali wzdłuż osi Z — Rysunek 3.8.13):
Rysunek 3.8.13 Przygotowanie tylnej ścianki statecznika
Ściany, zaznaczone jak na ilustracji (Rysunek 3.8.13), wytłocz jako region (E — Extrude), ale nie przesuwaj. Odsuń je “w głąb statecznika” poleceniem Alt-S (Toolshelf:Mesh Tools:Shrink/Fatten, str. 367) , na odległość ok. 0.2 jedn. Blendera. Bezpośredni rezultat operacji nie wygląda jeszcze olśniewająco (Rysunek 3.8.14):
Rysunek 3.8.14 “Surowy” efekt wytłoczenie wewnętrznych ścianek
Przed wywołaniem polecenia Shrink/Fatten uporządkuj kierunki normalnych siatki (por. str. 381) — np. skieruj je wszystkie na zewnątrz poleceniem Recalculate Outside (Ctrl-N).
Wystarczy jednak tylko usunąć niepotrzebne wierzchołki oraz wyprostować nieco “pokrzywione” ścianki, by rezultat wyglądał tak, jak powinien (Rysunek 3.8.15):
Rysunek 3.8.15 Efekt po poprawkach
Aby szybko wyprostować ścianki:
przełącz tryb Pivot na Bounding Box Center;
zaznacz wierzchołki ściany;
zmień ich skalę względem osi prostopadłej (X lub Y) do 0.
Na koniec przesuń lewą ścianę do samej krawędzi wycięcia (Rysunek 3.8.16). Z fotografii wynika, że do tego żebra było przymocowany jeden z zawiasów steru wysokości. Stąd ta powierzchnia nie była “schowana” we wnętrzu statecznika, tak jak pozostałe ściany:
Rysunek 3.8.16 Uwzględnienie wewnętrznego żebra
Rysunek 3.8.17 pokazuje, jak powinien wyglądać gotowy statecznik:
Rysunek 3.8.17 Gotowy statecznik poziomy
Pora się zabrać za formowanie steru. Praca nad nim bardzo przypomina tworzenie lotki. Zacznij od przygotowania profilu przedniej krawędzi (Rysunek 3.8.18) :
Rysunek 3.8.18 Ster wysokości — przygotowanie profilu przedniej krawędzi
Potem wytłocz ten profil wzdłuż osi X steru, zmniejsz na końcu, i połącz z resztą siatki (Rysunek 3.8.19):
Rysunek 3.8.19 Dodana przednia krawędź
Przy okazji, podobnie jak w przypadku statecznika, zmień układ krawędzi, by wyeliminować jak najwięcej ścian trójkątnych. Jest to wstęp do ukształtowania wyważenia masowego i aerodynamicznego, zlokalizowanego na końcówce steru (Rysunek 3.8.20a,b) :
Rysunek 3.8.20 Wyważenie steru — szczegóły siatki
W okolicy wyważenia odsuń od siebie krawędzie, tworząc otwór na zawias steru (Rysunek 3.8.20a). (Same okucia zawiasów dodamy później, przy okazji uzupełniania szczegółów). Ten “rozstęp” pozwoli zastosować inny układ “podłużnic” na końcówce steru (Rysunek 3.8.20b). Wykorzystaj tę możliwość, formując wystające wyważenie, i dodając dodatkowe podłużnice na końcówce. Nie zapomnij także o wytłoczeniu wzdłuż krawędzi otworu okucia małej fazki “na grubość blachy” (0.01 jedn).
Takie małe otwory jak te które pokazuje Rysunek 3.8.20 o wiele wygodniej wykonuje się za pomocą specjalnej tekstury (por. Tom III). W tej sekcji uległem pokusie modelowania wszystkiego „w siatce”!
Pozostało jeszcze tylko uformować krawędź spływu steru. Jest to krzywa, więc dodaj do siatki kolejne żebra, oraz odetnij (Knife) niepotrzebny narożnik (Rysunek 3.8.21) :
Rysunek 3.8.21 Przygotowanie do ukształtowania krawędzi spływu
Wykorzystując nowe żebra, wygnij krawędź spływu tak, by pasowała do obrysu na rysunku (Rysunek 3.8.22a):
Rysunek 3.8.22 Formowanie “wcięcia” steru wysokości
Musimy jeszcze zamknąć siatkę steru od strony kadłuba. Zdjęcia pokazują, że przekrój poprzeczny tego fragmentu był zaokrąglony. Dodaj (Knife) do tego obszaru kolejną krawędź (Rysunek 3.8.22a). Umożliwi nam uzyskanie zaokrąglenia. Wytłocz także końcową krawędź tak, by zamknąć siatkę (Rysunek 3.8.22b). (Nową krawędź najłatwiej dosunąć do płaszczyzny symetrii, zmieniając skalę wierzchołków względem osi Z do zera). Skopiuj także wierzchołki łuku z przedniej krawędzi siatki, aby uzyskać u nasady steru okrąg (Rysunek 3.8.22c). Stwórz wzdłuż tych nowo powstałych krawędzi ściany, które połączą je z resztą siatki. Dodaj (Loop Cut) jeszcze jedną krawędź wewnętrzną (Rysunek 3.8.23a) — aby wszystkie krawędzie zaokrąglenia były kontynuacją odpowiednich podłużnic siatki.
Rysunek 3.8.23 “Zamknięcie” powłoki steru
Na koniec wytłocz i zmień skalę ścianek wokół otworu na oś obrotu (ustawiając wcześniej kursor 3D w środku tego okręgu). Nasz ster jest już niemal skończony (Rysunek 3.8.23b).
Pozostał jeszcze drobiazg — szczelina na drugi zawias1. Utwórz ją, nacinając (Knife) przód steru— najpierw pośrodku szczeliny, później, o jedną podłużnicę “płyciej”, wzdłuż krawędzi (Rysunek 3.8.24a). Potem pozostało uporządkować ściany (wewnętrzne usunąć, inne zamienić na trójkąty) :
Rysunek 3.8.24 Wycięcie szczeliny na drugi zawias
Wytłoczyłem także wokół tego otworu zawiasu dodatkową krawędź “na grubość blachy” (Rysunek 3.8.24b).
Statecznik i ster są już uformowane. Teraz trzeba je ze sobą połączyć. Podobnie jak w przypadku lotki i skrzydła, posłuży nam do tego obiekt pomocniczy — oś steru. Utwórz odpowiednią “rurkę”, i nadaj jej nazwę B.210.R.Elevator Axis (Rysunek 3.8.25a). W odróżnieniu od osi lotki, część osi steru będzie widoczna, więc powinna mieć średnicę jak na planach. Warto ją także wygładzić modyfikatorem Subsurf.
Rysunek 3.8.25 Dodanie osi obrotu i połączenie w jeden zespół
Uczyń oś “rodzicem” steru głębokości (Ctrl-P, Make Parent, str. 306). “Rodzicem” osi ma być z kolei statecznik. Rysunek 3.8.25b) pokazuje hierarchię części, jaką powinieneś uzyskać. Potem pozostaje już tylko umieścić statecznik (B.200.R.Stabilizer) w docelowym miejscu modelu. Nadaj mu kąt zaklinowania (X) -2º, jak w oryginalnej konstrukcji (Rysunek 3.8.26):
Rysunek 3.8.26 Umieszczenie usterzenia w docelowym miejscu modelu
Model z tej sekcji znajdziesz w pliku model\p40\history\P40B-4.08.blend (por. str. 18).
Podsumowanie
Usterzenie wykonujemy według tego samego wzorca postępowania, co skrzydło.
Tak jak skrzydło ma wydzieloną, ruchomą lotkę, tak usterzenie dzieli się na statecznik, ster, i łączącą je oś (str. 133).
Usterzenia mają zazwyczaj profil symetryczny, stąd wystarcza uformować tylko jedną z dwóch powierzchni obrysu — górną lub dolną. Drugą “załatwia” modyfikator Mirror (str. 124)
Do formowania wewnętrznych ścianek przydatne jest polecenie “odsunięcia” od powierzchni o zadaną odległość. W Blenderze jest to komenda Alt-S (Toolshelf:Mesh Tools:Shrink/Fatten, str. 129).
Rzut z przodu na planach modelarskich może zawierać więcej błędów niż inne rzuty (por. str. 126). Należy więc traktować go z rezerwą. Najlepiej przyjąć zasadę, że w przypadku stwierdzenia różnic najważniejszy jest rzut z boku, a potem rzut z góry.
Warto zorientować się (na podstawie opisów konstrukcji, planów), jaki rodzaj kompensacji aerodynamicznej miało usterzenie samolotu. W przypadku P-40 wychylenie steru wysokości było kompensowane tylko przez prostokątny występ na jego końcu. W takiej sytuacji można założyć, że przekrój przedniej krawędzi steru jest okrągły. To z kolei pozwoliło użyć obrysu z góry tej linii także w charakterze obrysu z przodu (por. str. 126). To zawsze lepsza alternatywa niż ślepe zawierzenie pod tym względem rzutowi z przodu z planów.
Usterzenie pionowe, składające się ze statecznika, steru kierunku i jego osi, wykonujemy tak samo jak usterzenie poziome. Dlatego w tej sekcji opiszę ten proces z pewnymi skrótami.
Miałem pewne problemy z ustaleniem poprawnego profilu usterzenia. Profil na planach modelarskich Mariusza Łukasika nie wyglądał zbyt poprawnie. Od razu zwróciłem uwagę na zbyt duży (w porównaniu ze zdjęciami) promień noska. Wśród rysunków fabrycznych, jakimi dysponowałem, znalazłem rysunek oprofilowania połączenia usterzenia i kadłuba. Pozwoliło mi to nanieść na plany poprawiony profil podstawy, wyznaczony na podstawie narysowanej na nim krawędzi blachy oprofilowania podstawy statecznika. Jest w tym oczywiście także trochę moich domysłów. Zdecydowałem się użyć profil NACA-0008T , gdyż pasował do fragmentu obrysu z rysunków fabrycznych. (Nieco grubszy profil tego samego typu zastosowałem w usterzeniu poziomym).
Także grubość końcówki statecznika pionowego na planach Mariusza Łukasika jest zdecydowanie przesadzona (por. str. 140). Na rysunkach Jacka Jackowskiego statecznik pionowy jest o wiele cieńszy, ale autor przerysował z kolei efekt jego zaklinowania pod kątem 1.5º od osi samolotu. W tej sytuacji pozostało mi już tylko wzorować się na zdjęciach i tym, co wynikało z fragmentów oryginalnej dokumentacji, jakie zgromadziłem.
Rysunek 3.9.1a) pokazuje pierwsze “przymiarki” do ułożenia podłużnic siatki wzdłuż podłużnic rzeczywistej konstrukcji. Pionowa “linia neutralna” (krawędź, która nie zmienia się w żaden sposób gdy skalujesz „żebra”) biegnie wzdłuż przedniej krawędzi steru.
Rysunek 3.9.1 Początkowe fazy budowy usterzenia pionowego
Krawędź spływu steru kierunku okazała się zbyt “fantazyjna”, by dać się przybliżyć jakimkolwiek regularnym trapezem. Proponuję się na tym etapie nie zawracać nią głowy, koncentrując się na fragmencie odwzorowującym przednią część usterzenia — stateczniku pionowym.
Po ustaleniu położenia początków podłużnic wzdłuż cięciwy profilu, pozostaw z trapezu tylko dolną linię wierzchołków. W trybie obiektu (Object Mode) obróć obiekt o 1.5º wokół osi Z (usterzenie pionowe było tak zaklinowane, by równoważyć efekt wirowania śmigła). Włącz do obiektu modyfikatory Mirror i Subsurf, i wygnij linię wierzchołków w profil usterzenia (Rysunek 3.9.1b) . Potem usuń skręcenie tego obiektu o 1.5º (utrudniałoby dalszą pracę).
Uzyskany profil wytłocz wzdłuż osi Z. Zmniejsz także rozmiar żeber końcowych (Rysunek 3.9.2a). Zacznij formować końcówkę usterzenia pionowego. Najpierw stwórz cienki pierścień ścian, tak samo jak to robiliśmy w usterzeniu poziomym (Rysunek 3.9.2b):
Rysunek 3.9.2 Wytłoczenie profilu i przygotowanie obrysu końcówki
Wytłocz teraz “w górę”, wzdłuż osi Z, kilka środkowych wierzchołków żebra. Przesuń je nieco względem osi X, aby nie odstawały na boki od reszty powierzchni statecznika (Rysunek 3.9.3):
Rysunek 3.9.3 Zbudowanie ścian końcówki
W oparciu o wierzchołki wytłoczonej krawędzi zbuduj nowe ściany (Rysunek 3.9.3). Dla uzyskania odpowiedniego kształtu okazuje się konieczne dodanie pomiędzy paskiem ścian końcówki a resztą siatki jeszcze jednej linii wierzchołków (Loop Cut). Rysunek 3.9.4 pokazuje układ ścian uformowanej końcówki. Taką powierzchnię podziel (P, Separate) na ster i statecznik.
Rysunek 3.9.4 Podział na ster i statecznik
Statecznikowi pionowemu nadaj nazwę B.250.Fin, a sterowi kierunku — B.255.Rudder. Sam statecznik jest prawie gotowy. Do wykończenia pozostało tylko dodanie tylnej ścianki (Rysunek 3.9.5a). Uzyskasz ją w ten sam sposób, co w stateczniku poziomym (por. str. 129).
Rysunek 3.9.5 Szczegóły tylnej ścianki statecznika (a) i gotowy element (b)
W P-40 statecznik poziomy był wykonany jako jedna całość. Trzy dźwigary statecznika pionowego były do niego przymocowane śrubami, ukrytymi pod oprofilowaniem. Ostatni z dźwigarów był jednocześnie tylną ścianą statecznika. Stąd odpowiednio wydłużyłem dół tylnej ściany na naszej siatce, by po złożeniu z resztą modelu dotykała powierzchni statecznika poziomego (Rysunek 3.9.5b).
Statecznik jest gotowy, przejdźmy więc do formowania steru kierunku. Zacznijmy od górnej części jego przedniej krawędzi. Jest tu zastosowana kompensacja masowa (bardzo wysunięta do przodu końcówka), jaki i aerodynamiczna (pozostała część przedniej krawędzi jest także nieco wysunięta).
Dodaj dodatkowe żebro, separujące uskok krawędzi. Następnie usuń w miejscu uskoku rząd ścian, by dodać (poleceniem Loop Cut) nowe podłużnice (odrębnie do każdego z tych dwóch obszarów). Dodaj nowe ściany z przodu, zaokrąglając oddzielnie górną i dolną część krawędzi natarcia. Potem z powrotem “zabuduj” tę przerwę, tworząc za pomocą dwóch “ostrych” krawędzi (crease = 1) uskok (Rysunek 3.9.6):
Rysunek 3.9.6 Szczegóły przedniej krawędzi steru kierunku (część górna)
Ze względu na zastosowanie kompensacji aerodynamicznej, zawias steru kierunku był zamocowany inaczej niż zawias steru wysokości. Zastosowano tu rodzaj “wysięgnika”, po lewej stronie steru (dodamy go później). Na razie przygotuj tylko otwór w miejscu, gdzie to ramię przenikało przez powierzchnię1 (Rysunek 3.9.7) :
Rysunek 3.9.7 Szczegóły przedniej krawędzi steru kierunku
Oczywiście, wokół tego otworu także nanieś fazkę “na grubość blachy” (0.01 jedn.).
Czas przejść do formowania dolnej części steru kierunku. Po dodaniu kilku dodatkowych żeber uformuj krawędź spływu (Rysunek 3.9.8a). Zrób to tak, by krawędzie siatki były ułożone ponad obrysem klapki trymera. (To nam pomoże nanieść ją na teksturę, przyda się także, gdybyś w przyszłości chciał ją wydzielić) . Przód steru kierunku w tym obszarze był schowany w kadłubie i miał przekrój okrągły. Przenieś na plany modelarskie obrys tej krawędzi, skopiowany z rysunków fabrycznych (Rysunek 3.9.8a). Teraz możesz z niego skorzystać: podstaw na chwilę ten obrazu tła także pod rzut z przodu. Następnie pochyl boczne powierzchnie steru, by pokryły się z obrysem (Rysunek 3.9.8b):
Rysunek 3.9.8 Szczegóły przedniej krawędzi steru kierunku (część dolna)
Dodatkowo u dołu dodaj “ćwiartkę” nieco spłaszczonego ośmioboku. To pierwsza z krawędzi, z których w tym miejscu uformujemy coś w rodzaju fragmentu elipsoidy (Rysunek 3.9.8b).
Przednia, dolna część steru ma kształt przypominający końcówkę kija używanego w baseballu: stożek zakończony kulą. Fragment kuli uformuj powielając i obracając wokół osi Z dodaną przed chwilą ćwiartkę ośmiokąta (Rysunek 3.9.9a):
Rysunek 3.9.9 Formowanie przedniej krawędzi steru kierunku (część dolna)
Część stożkową uzyskasz poprzez wytłoczenie i zmniejszenie skali krawędzi stworzonej przed chwilą kuli (Rysunek 3.9.9b). Nie będziemy jej “dociągać” do reszty siatki — P-40 miał w tym miejscu duży otwór. (Obsługa techniczna miała w ten sposób łatwy dostęp do popychaczy sterów).
Scalenie tak przygotowanej przedniej krawędzi z resztą siatki wymaga uprzedniego dodania do niej dwóch dodatkowych “żeber” (Rysunek 3.9.10a). (Są potrzebne, aby można było ją połączyć z odpowiednimi krawędziami na powierzchni steru za pomocą ścian czworokątnych):
Rysunek 3.9.10 Szczegóły przedniej krawędzi steru kierunku (część dolna)
Usuń tylną (schowaną w sterze) część stożka, i scal resztę z powierzchnią steru tworząc nowy rząd ścian (Rysunek 3.9.10b). Zwróć uwagę na układ ścian na powłoce kuli, u dołu siatki. Usuń jedną z jej krawędzi (a), aby wszystkie ściany tej siatki były prostokątne. Uzyskasz dzięki temu ładny, regularny kształt bez wypiętrzenia w okolicach “bieguna” tej sfery. Usuń jeden z rzędów ścian, by dodać w tym miejscu drugi otwór na zawias steru. Obydwa otwory zabuduj “na płasko” dodatkowymi ścianami (Rysunek 3.9.10b).
Ster jest już uformowany, pozostaje tylko dodać mu oś. Wstaw w odpowiednie miejsce “rurkę” o nazwie B.260.Rudder Axis (Rysunek 3.9.11a):
Rysunek 3.9.11 Wykończenie podzespołu — dodanie osi steru, wygląd ostateczny
Połącz cały podzespół w hierarchiczną całość, analogicznie jak usterzenie poziome: oś jest “rodzicem” steru, a “rodzicem” osi jest statecznik. Następnie “zaklinuj” (obrót wokół osi Z) statecznik pionowy pod kątem 1.5º. Rysunek 3.9.11b) przedstawia gotowy zespół usterzenia.
Rysunek 3.9.12 Porównanie szerokości statecznika z planami modelarskimi
Porównamy rezultat naszej pracy z rzutem z przodu z planów Mariusza Łukasika. (Poprawiłem już ich położenie względem modelu, uwzględniając niepoprawną pozycję kołpaka śmigła — por. str. 133). Rysunek 3.9.12 pokazuje, że usterzenie pionowe na planach jest zdecydowanie za grube.
Model z tej sekcji znajdziesz w pliku model\p40\history\P40B-4.09.blend (por. str. 18).
Wobec bardziej “fantazyjnych” kształtów steru kierunku, metoda wstępnego przybliżenia trapezem całego usterzenia może zawieść (str. 135). Warto jednak spróbować użyć jej do przybliżenia kształtu statecznika.
Ster kierunku P-40 jest przykładem powierzchni sterowej, w której zastosowano kompensację aerodynamiczną. (W takim rozwiązaniu przednia krawędź steru jest przesunięta do przodu względem osi obrotu. Przekrój takiej krawędzi nie jest okrągły, a np. eliptyczny).
Czasami warto usunąć na chwilę kilka ścian, gdy otwiera to nowe możliwości wstawiania krawędzi poleceniem Loop Cut (np. przy uskoku przedniej krawędzi — p. str. 137).
Powłokę kuli można dobrze przybliżyć za pomocą czterech ośmiokątów (p. str. 139). Kwadratowe ściany w okolicach “biegunów” takiej powłoki uzyskasz, rezygnując w nich po jednej z przekątnych w każdej. (Scalając po dwie trójkątne ściany w jedną czworokątną).
W tej sekcji wykonamy środkową i tylną część kadłuba (Rysunek 3.10.1):
Rysunek 3.10.1 Fragment kadłuba, który odwzorujemy w tej sekcji
Dlaczego nie cały kadłub? Po pierwsze dlatego, że okapotowanie silnika ma dość złożony kształt. Po drugie — zawsze warto dzielić model na takie zespoły, na jakie była podzielona prawdziwa konstrukcja. W prawdziwych P-40 i P-36 środek i tył kadłuba tworzyły technologiczną całość. Po trzecie — nos P-40 zmieniał się często, od wersji do wersji. Środek i ogon, mimo tych zmian, pozostawał taki sam — i w P-36, i w P-40 (B, C). Będziesz mógł później wykorzystać tę część w innych modelach.
Modelowany fragment zawiera dwa duże otwory — na kabinę pilota i chowane kółko ogonowe. Aby te wycięcia nie zaburzyły kształtu kadłuba, zawczasu poprowadźmy wzdłuż ich krawędzi “ostre” (crease = 1) podłużnice (Rysunek 3.10.1). Gdy połączone taką podłużnicą ściany będą leżały w jednej płaszczyźnie — uzyskamy gładkie i wolne od deformacji krawędzie otworów (por. Rysunek 3.10.4a, a więcej wyjaśnień — str. 412).
Formowanie kadłuba zaczynamy od wstawienia w płaszczyźnie ZX pierwszej wręgi (Rysunek 3.10.2b). To połówka okręgu (Circle), złożna z kilkunastu wierzchołków. W nowym obiekcie od razu włączyłem modyfikatory Mirror (względem osi X) i Subsurf. Dzięki nim druga, symetryczna połowa kadłuba rysuje się “sama” (Rysunek 3.10.2a):
Rysunek 3.10.2 Pierwsza wręga
Po przekształceniu okręgu w pierwszą wręgę, wytłocz ją wzdłuż osi kadłuba, aż za kabinę pilota (Rysunek 3.10.3a) . “Ściśnij” (poprzez zmianę skali w kierunku osi Z) jej dolną połowę tak, by zetknęła się z dolną powierzchnią płata (Rysunek 3.10.3a, Rysunek 3.10.4b). Zmniejsz także jej szerokość wzdłuż osi X — zgodnie z rzutem z góry (Rysunek 3.10.3b):
Rysunek 3.10.3 Wytłoczenie fragmentu kadłuba i zmiana rozmiaru ostatniej wręgi
Na razie nie zmieniaj rozmiaru górnej części powłoki. Dlaczego? Ponieważ zawiera krawędź, po której przesuwa się do tyłu owiewka kabiny pilota. W samolotach z tego okresu owiewka kabiny pilota była zazwyczaj odsuwana na parze małych szyn. Tak też było w P-40. Te szyny muszą mieć taki sam rozstaw na całej długości. Inaczej owiewka nie mogłaby po nich “jeździć”. A to z kolei znaczy, że szerokość kadłuba wzdłuż tych szyn nie może ulegać zmianie. To drobiazg, o którym często zapominają autorzy planów modelarskich. (Nieraz zetknąłem się z sytuacją, gdy nakreślone przekroje w tym obszarze się zawężały). Rysunek 3.10.4a pokazuje, że na kadłubie naszego P-40 krawędź 2 musi zachować wzdłuż toru owiewki kabiny stałą szerokość.
Rysunek 3.10.4 Szczegóły wytłoczenia pierwszej części kadłuba
Aby otwór na kabinę nie miał wzdłuż krawędzi żadnych deformacji krawędź 2 musi być oznaczona jako “ostra” (crease = 1). Jednocześnie ściany |1 2| i |2 3| muszą leżeć na tej samej płaszczyźnie (Rysunek 3.10.4a), aby wzdłuż “ostrej” krawędzi 2 kadłub pozostał gładki.
Ściana |2 4| może być pochylona pod innym kątem, gdyż znajduje się już za kabiną pilota. (Będzie dopasowywana do obrysu za kabiną, który był bardziej pionowy.)
W tak przygotowaną siatkę wstaw dwie kolejne wręgi (najpierw wstaw wręgę 1, dopasuj do szerokości kadłuba, potem wstaw wręgę 2). Następnie usuń wierzchołki z obszaru kabiny (Rysunek 3.10.5):
Rysunek 3.10.5 Przygotowania do formowania górnej części kadłuba
Rysując kształt kadłuba P-40 B, C przed kabiną pilota, obydwaj autorzy planów, z których korzystamy — Jacek Jackiewicz i Mariusz Łukasik — popełnili błąd. Przekroje na ich planach pokazują w tym obszarze regularny, eliptyczny przekrój. W rzeczywistości na zdjęciach widać przed kabiną dwa wyraźnie narożniki (Rysunek 3.10.6a, b) . Te “wypukłości” były spowodowane położeniem zamków nkm Browing (Rysunek 3.10.5, Rysunek 3.10.6b). Końce zamków karabinów znajdowały się po obydwu stronach tablicy przyrządów. Tak było także w P-361. Wydaje się, że P-36 i P-40 B, C miały identyczny kształt tego fragmentu kadłuba.
Rysunek 3.10.6 Uformowanie odcinka kadłuba przed kabiną pilota
Do siatki dodaj także linię konturu kadłuba za kabiną pilota. Na rzucie z przodu Mariusza Łukasika jej szczyt ma przekrój spłaszczonej elipsy. Udało mi się znaleźć kilka zdjęć, dzięki którym zweryfikowałem jej kształt. Grzbiet kadłub za kabiną pilota miał przekrój okrągły, o promieniu nieco mniejszym od owiewki (Rysunek 3.10.6b).
Formując dalej kształt tej części kadłuba, wytłocz wzdłuż osi Y kontur za kabiną pilota (Rysunek 3.10.7). Po wytłoczeniu spłaszczy nową krawędź (poprzez zmianę skali do 0 wzdłuż osi Y). Umieść ją tak, by znalazła się dokładnie ponad końcową wręgą dolnej części kadłuba i scal z resztą obrysu za pomocą dodanej ściany (szczegóły — patrz str. 372):
Rysunek 3.10.7 Dalsze uzupełnianie środkowej sekcji kadłuba
Wytnij w powłoce (używając Knife) wręgi 3 i 4. Zagęść w ten sposób siatkę spodu kadłuba, przygotowując ją do przecięcia powierzchnią płata. Natnij także, tuż przy przedniej krawędzi, wręgę 5. Potem wystarczyło usunąć część dotychczasowej przedniej krawędzi, by uzyskać uskok, jak występował w prawdziwym samolocie. (P-36 miał w tym miejscu rząd szczelin odprowadzających powietrze z silnika chłodzonego powietrzem. W P-40 B, C “tak zostało”, zapewne by nie trzeba było zmieniać oprzyrządowania linii produkcyjnej).
Kolejnym krokiem jest wyznaczenie krawędzi przecięcia kadłuba ze skrzydłem (Rysunek 3.10.8) . Użyj do tego dodatku Intersection (str. 308):
Rysunek 3.10.8 Wyznaczenie krawędzi przecięcia z płatem
Przecięcie wykonaj tak, by jego krawędź została dodana do siatki kadłuba. Następnie usuń dotychczasowe wierzchołki spodu kadłuba i stwórz nowe ściany w oparciu o wierzchołki krawędzi przecięcia:
Rysunek 3.10.9 Wyznaczenie krawędzi przecięcia z płatem
Uzyskałeś w ten sposób kolejny otwór w kadłubie. Prawdziwy samolot także miał taki — w P-40 kadłub “leżał” na skrzydle (był przykręcony do niego śrubami).
Wytłocz teraz dolną i środkową część ostatniej wręgi w kolejny segment ogona (Rysunek 3.10.10):
Rysunek 3.10.10 Wytłoczenie pierwszej części ogona
Po wytłoczeniu, “ściśnij” wszystkie wierzchołki ostatniej wręgi, znajdujące się poniżej osi kadłuba (Rysunek 3.10.10) do rozmiaru obrysu z dołu. Pozostałe wierzchołki możesz “ścisnąć” zupełnie nieznacznie, tak tylko, by górna krawędź pokryła się z narysowaną na planach podłużnicą.
Dolna krawędź kadłuba była w rzucie z boku linią prostą2, więc nie będzie trzeba dodawać z tego powodu kolejnej wręgi pośrodku ogona. (I tak będzie trzeba ją dodać, by “uwypuklić” kształt grzbietu kadłuba).
“Ściśnij” ostatnią wręgę także wzdłuż osi X (Rysunek 3.10.11a). Dopasujesz się w ten sposób do obrysu z góry. (Tu także widać, że trzeba dodać kolejną wręgę pośrodku ogona, by uwypuklić nieco kadłub w tym rzucie).
Przygotowując się do wycięcia w kadłubie otworu na kółko ogonowe, skopiuj fragment ostatniej wręgi. Przysuń tę linię do steru kierunku. To będzie końcowa krawędź kadłuba (por. Rysunek 3.10.11b). Dlaczego nie utworzymy jej przez wytłoczenie dotychczasowej krawędzi? Bo czeka nas na tym odcinku dodatkowa praca, związana z precyzyjnym ukształtowaniem każdej z jego krańcowych wręg. Gdybyśmy wytłoczyli ten fragment, nie widzielibyśmy ich wygładzonych linii odpowiednio dokładnie.
Zacznij od dopasowania wręgi końca kadłuba. Powinna dobrze przylegać do obrysu steru kierunku, więc ustaw jej wierzchołki w odpowiedni sposób. Nie zapomnij o zachowaniu odpowiedniego dystansu od steru (ok. 1 cm w rzeczywistym samolocie — Rysunek 3.10.12b). Na razie połącz obydwie wręgi pojedynczą podłużnicą (|Bb| — Rysunek 3.10.11b). To krawędź otworu kółka ogonowego. Od razu oznacz ją jako ostrą (crease = 1).
Rysunek 3.10.11 Szczegóły formowania pierwszej części ogona
Musisz jeszcze ustawić każdą z trójek wierzchołków: |abc|, |ABC| w ten sposób, by w rzucie z przodu leżały na jednej linii. (To pozwoli uniknąć wybrzuszeń krawędzi otworu). Taka modyfikacja “popsuje” jednak gładki, eliptyczny obrys obydwu wręg. Będzie trzeba nieco poprzesuwać wierzchołki sąsiadujące ze “spłaszczonymi” odcinkami, by kształt tych sekcji kadłuba jak najmniej odbiegał od początkowego. W przypadku tylnej krawędzi, naturalnym wzorcem właściwego obrysu jest kształt steru kierunku. W przypadku wręgi położonej bliżej — przed spłaszczeniem odcinka |ABC| skopiuj wierzchołki tej linii (Shift-D), i odrobinę zmniejsz ich skalę (względem osi kadłuba) (Rysunek 3.10.11b). Uzyskasz w ten sposób “wzorzec”, z którym będziesz mógł porównywać obrys modyfikowanej wręgi. Gdy tylko osiągniesz zamierzony kształt — usuń ten wzorzec, bo już nie będzie do niczego potrzebny.
Podczas dopasowywania do eliptycznego obrysu, musisz manipulować każdą z trójek wierzchołków (|abc| i |ABC|): skracać, obracać, przesuwać. Należy to robić tak, by wszystkie trzy wierzchołki zawsze leżały na jednej linii. Najprościej to osiągnąć, zaznaczając takie trzy punkty i przełączając się na orientację normalną (Alt-Spacja, Orientation→Normal). W tym trybie lokalna oś Y trzech zaznaczonych wierzchołków przebiega wzdłuż wypadkowej odcinków które tworzą (Rysunek 3.10.11b — |AB| i |BC|). Zaczynasz od “spłaszczenia” tej trójki: wystarczy zmienić ich skalę wzdłuż lokalnej osi X do zera. Potem możesz odrobinę ten zespół obrócić, dopasowując z powrotem do wzorcowego obrysu. W trakcie dalszych manipulacji konieczne będzie zmniejszenie długości krawędzi |ABC|. Można je uzyskać przez zmianę skali wzdłuż lokalnej osi Y.
Gdy ostatnia i poprzednia wręga kadłuba są już uformowane — połącz ich odpowiednie wierzchołki ścianami (F, str. 359) (Rysunek 3.10.12a). Następnie wytłocz cztery górne wierzchołki, i dopasuj je do krawędzi steru (Rysunek 3.10.12b) :
Rysunek 3.10.12 Szczegóły formowania tylnej krawędzi kadłuba
Kolejnym krokiem jest wytłoczenie górnej części ogona, aż do przedostatniej wręgi (Rysunek 3.10.13):
Rysunek 3.10.13 Szczegóły formowania grzbietu kadłuba za kabiną
Oczywiście, po wytłoczeniu zmień rozmiar tego fragmentu, aby pasował w tym miejscu do reszty przekroju kadłuba. Następnie połącz go z nim pojedynczą ścianą.
Grzbiet i boki ogona P-40 były nieco wypukłe, więc wstaw pośrodku ogona kolejną wręgę (Rysunek 3.10.14). Poszerz ją nieco (poprzez zmianę skali wzdłuż osi X), aby dopasować krawędź kadłuba do konturu w rzucie z góry (XY). Górny fragment wręgi dopasuj do obrysu z boku (str. 372).
Pozostało jeszcze wstawić (Loop Cut) kolejną wręgę pod statecznikiem pionowym, i “dociągnąć” do niej (poprzez wytłoczenie) kontur grzbietu (Rysunek 3.10.14). Ten fragment ułatwi formowanie owiewki, zakrywającej połączenie stateczników z kadłubem. Wreszcie, na koniec, uprość układ ścian kadłuba ponad tylną częścią skrzydła. To przygotowanie do zmiany kształtu tego fragmentu. (Zdjęcia wykazują, że miał w tym miejscu nieco inny przekrój, niż wynika to z planów JJ czy ML):
Rysunek 3.10.14 Wstawienie dodatkowych wręg kadłuba
W wyniku analizy zdjęć okazało się, że wzdłuż kabiny pilota, poniżej osi samolotu, ściany kadłuba były niemal pionowe (Rysunek 3.10.15). Wydaje się to uzasadnione, gdyż ta część konstrukcji zawierała kadłubowy zbiornik paliwa. Na pewno w oczach konstruktorów okropnym marnotrawstwem byłaby rezygnacja z kilku galonów paliwa w imię zaokrąglenia przekroju.
Rysunek 3.10.15 Poprawka tylnej części krawędzi łączącej kadłub z płatem
Usuń dolną część wręgi 2 i przedostatni wierzchołek wręgi 1. Potem ukształtuj ten fragment kadłuba na nowo, wytłaczając dolną część wręgi 3. Każdy kolejny z tych segmentów coraz bardziej pochylaj, by ostatni “położyć” na górnej powierzchni płata (Rysunek 3.10.15, Rysunek 3.10.16):
Rysunek 3.10.16 Poprawiony kształt kadłuba
Teraz można wyciąć otwór kółka ogonowego. Przygotuj się do tego, nacinając (Knife) dwie dodatkowe płaskie wręgi wzdłuż linii nitów kadłuba (Rysunek 3.10.17). (To dla zagęszczenia siatki i z myślą o przyszłych teksturach nierówności). Kolejne trzy “częściowe” wręgi umieść tak, by znalazły się w istotnych miejscach zarysu luku na kółko ogonowe. (Jedna z nich wyznacza tylną krawędź otworu, dwie pozostałe — końce zaokrąglonych narożników):
Rysunek 3.10.17 Przygotowania do wycięcia otworu na kółko ogonowe
Po przygotowaniu podłużnic możesz naciąć (za pomocą Knife) przednią i tylną krawędź luku podwozia. Na razie nie będą miały zaokrągleń na narożnikach. Przednią krawędź wytnij w rzucie z boku (w tym rzucie jest ukośną linią prostą). Tylna krawędź w rzucie z dołu ma kształt fragmentu okręgu. Można by było oczywiście wyznaczyć ją za pomocą pomocniczego walca i skryptu Intersection. (Analogicznie, jak wyznaczyliśmy luk podwozia głównego w skrzydle — str. 120). Jeżeli jednak masz w miarę pewną rękę, takie mniej istotne otwory możesz także wykonać za pomocą Knife.
Rysunek 3.10.18 Szczegóły krawędzi otworu kółka ogonowego
Pozostały jeszcze do wykonania zaokrąglenia na krawędziach luku (Rysunek 3.10.18). Aby nadać im właściwy kształt, należy poprzesuwać po powierzchni ściany kilka wierzchołków, by uformowały odpowiednią krzywą. Najprościej to zrobić ustawiając widok w płaszczyźnie wybranej ściany (Shift-7, View→Align View→Align View To Selected→Top — str. 370). Jeżeli masz wątpliwości, na str. 374 znajdziesz szczegółowy opis uformowania takiego narożnika. Narożnik tylnej krawędzi jest prostszy od przedniej. To w istocie jeden dodatkowy wierzchołek, “dopasowujący” przejście łuku w prostą.
Oznacz przednie i tylne krawędzie otworu jako “ostre” (crease = 1). Następnie zaznacz całe jego wnętrze i wydziel je (P, Separate) w oddzielny obiekt — pokrywę luk podwozia. Nadaj mu nazwę B.305.L.Door. (To jest lewa strona luku. Potem skopiujemy ją także w prawą).
Rysunek 3.10.19 pokazuje kształt otworu po wydzieleniu luku. Dzięki dobremu przygotowaniu (por. Rysunek 3.10.11, str. 147) udało się uzyskać bardzo regularną krawędź, bez żadnych wybrzuszeń i innych deformacji:
Rysunek 3.10.19 Otwór kółka ogonowego po wydzieleniu pokryw
Nie zapomnij o dodaniu “fazki” wzdłuż krawędzi luku podwozia (“na grubość blachy”). Wydzielonej pokrywie nadaj podobną grubość, na przykład używając polecenia Solidify (por. str. 377). (Później będzie jeszcze trzeba dodać jej wewnętrzne usztywnienia).
Pierwszy etap formowania kadłuba jest ukończony. Rysunek 3.10.20 pokazuje uzyskany kształt:
Rysunek 3.10.20 Rezultat — uformowany środek i tył kadłuba
Nadaj temu obiektowi nazwę B.300.Fuselage.
Model z tej sekcji znajdziesz w pliku model\p40\history\P40B-4.10.blend (por. str. 18).
Kadłub rozpoczynamy od narysowania połówki pojedynczej wręgi. Najlepiej wybrać jedną z wręg istotnych pod względem konstrukcyjnym — np. w okolicy kabiny pilota (por. str. 142).
Kształt kadłuba tworzymy poprzez wytłoczenia kolejnych fragmentów. Na każdym kroku należy weryfikować ich kontury z planami i zdjęciami (por. str. 143, 144)
Przygotowując otwór w kadłubie, umieść na jego przeciwległych krawędziach “ostre” podłużnice. Ściany połączone za pomocą tych podłużnic, powinny leżeć na tej samej płaszczyźnie (str. 147, 151).
W tej sekcji ukształtujemy górne i boczne osłony silnika (Rysunek 3.11.1). Ze względu na bardzo skomplikowaną geometrię, osłonie chłodnicy cieczy poświęcę całą następna sekcję (3.12, str. 163).
Rysunek 3.11.1 Fragment kadłuba, który odwzorujemy w tej sekcji
Proponuję podzielić przód kadłuba na części, odpowiadające oryginalnym panelom pokrywy silnika. To oznacza na początku trochę więcej pracy. Potem jednak łatwiej będzie odwzorować otwory na rury kolektora spalin, i wypukłości osłony karabinów oraz chwytu powietrza. Uformowanie każdego z tych szczegółów wymaga lokalnego zagęszczenia siatki. Co więcej, dla każdego z tych detali trzeba będzie to zrobić w nieco inny sposób. Próba odwzorowania wszystkiego na jednej powłoce prowadziłaby do nadmiernej komplikacji jej topologii. Dzieląc powłokę na pojedyncze panele, możemy lokalnie dobrać dla każdego z nich odpowiedni układ siatki. Co więcej, może Ci się zamarzyć w przyszłości wykonanie w środku makiety silnika Allison, i stworzenie obraz pokazującego “rozbebeszony” samolot na lotnisku. W ten sposób powłokę silnika będziesz miał już do tego przygotowaną.
Aby podział na panele odbył się bez komplikacji, już na wstępnych etapach formowania należy poprowadzić wzdłuż ich przyszłych granic „ostre” (crease = 1) krawędzie. Rysunek 3.11.1 pokazuje ich układ.
Pracę zacznij od wydzielenia (P, Separate) wierzchołków przedniej wręgi z uformowanej poprzednio części kadłuba (Rysunek 3.11.2). To zalążek osłony silnika:
Rysunek 3.11.2 Wydzielenie przedniej wręgi z uformowanej części kadłuba
Wydziel także z kołpaka śmigła (B.005.Hub) obrys podstawy, i scal go (Ctrl-J, Join Objects) z tworzoną siatką (Rysunek 3.11.3):
Rysunek 3.11.3 Wręga początkowa — skopiowana podstawa kołpaka śmigła
Usuń wierzchołki z z prawej strony wręgi początkowej. Włącz dla tej siatki modyfikator Mirror (względem osi X) i Subsurf (Subdivisions = 2). Przednia wręga ma teraz pięć wierzchołków, a tylna — około 20. Potraktuj tylną (“gęstą”) wręgę jako wzorzec docelowego kształtu. Utwórz w tym samym miejscu nową wręgę końcową, złożoną z tylu wierzchołków, co wręga początkowa (Rysunek 3.11.4a):
Rysunek 3.11.4 Dopasowanie nowej (ośmiokątnej) tylnej wręgi do wzorca obrysu (wręgi “gęstej”)
Najłatwiej nową wręgę końcową utworzyć poprzez skopiowanie wręgi początkowej, i poprzesuwanie jej wierzchołków. Rysunek 3.11.4a pokazuje, że nawet za pomocą pięciu punktów (lub symetrycznie licząc — ośmiu) można całkiem nieźle odwzorować krzywiznę “gęstej” wręgi wzorcowej.
Tak przygotowane wręgi połącz ścianami (Rysunek 3.11.4b) (możesz stworzyć je poleceniem Bridge Edge Loops — por. str. 360). Zwróć uwagę, że gęstość takiej siatki przy dwukrotnym podziale jest zbliżona do gęstości wierzchołków na linii wzorcowej (“gęstej” wrędze). Kształt, który utworzymy za pomocą tej rzadkiej (“ośmiobocznej”) siatki będzie pierwszym przybliżeniem kształtu kadłuba. Potem tę siatkę zagęścimy, “utrwalając” (Apply) modyfikator Subsurf. Dokładne dopasowanie do kształtu wręgi wzorcowej uzyskamy za pomocą ok. 16 wierzchołków.
Wstaw (Loop Cut) w nowo utworzoną powłokę kolejne dwie wręgi. Rozciągnij je wzdłuż osi Z i X tak, by uzyskać właściwy kształt w rzucie z góry i z boku (Rysunek 3.11.5):
Rysunek 3.11.5 Formowanie podstawowego kształtu nosa P-40B
W rzucie z boku skoncentruj się przede wszystkim na właściwym uformowaniu górnej części nosa samolotu. Dolną część ukształtuj tylko pobieżnie, tyle tylko, aby poprawnie uformować boki osłony silnika. Osłona chłodnicy, znajdująca się u dołu, zostanie poddana intensywnej adaptacji w następnej sekcji (str. 163).
Zdjęcia zdają się wykazywać, że górna część osłony silnika nie miała idealnie eliptycznego przekroju. (Taki kształt mają przekroje na planach Jacka Jackiewicza i Mariusza Łukasika). Z przodu, przed kolektorem spalin, grzbiet pokrywy silnika był nieco spłaszczony. Jest to konieczne, by ukryć pod nią cylindry silnika1. Dalej przekrój przechodził płynnie w obrys, jaki nadaliśmy wrędze końcowej. To także nie jest elipsa — jest nieco wypiętrzona tam, gdzie znajdowały się zamki karabinów (por. str. 144).
Aby uzyskać odpowiedni kształt grzbietu osłony silnika, przesuń do góry cztery wierzchołki środkowych wręg (Rysunek 3.11.5, Rysunek 3.11.6a):
Rysunek 3.11.6 Formowanie podstawowego kształtu nosa P-40B
Dodatkowo, poszerz w kierunku X ścianę, którą tworzą te wierzchołki. Rysunek 3.11.6b pokazuje kształt powłoki, który powinieneś przy tym osiągnąć.
Uzyskaliśmy “zgrubny” kształt nosa samolotu. Teraz należy zwiększyć liczbę podłużnic, aby można było dokonać dalszych, drobnych modyfikacji. Nie będziemy na razie zwiększać liczby wręg (to by niepotrzebnie skomplikowało siatkę i utrudniło jej dalsze zmiany).
Aby zwiększyć liczbę podłużnic, zacznij od usunięcia dotychczasowych. Pozostaw tylko cztery krawędzie, po pięć wierzchołków każda (Rysunek 3.11.7):
Rysunek 3.11.7 Przygotowanie do zwielokrotnienia wierzchołków: usunięcie “podłużnic”
Następnie przełącz się w tryb obiektu (Object Mode) i “utrwal” modyfikatory siatki, naciskając przyciski Apply: najpierw dla modyfikatora Mirror, potem dla Subsurf 2. (Naciśnięcie Apply powoduje jednocześnie usunięcie modyfikatora. Wierzchołki, które generował, stały się “realne”, i nie jest już więcej potrzebny). Potem przełącz się z powrotem w tryb edycji (Edit Mode). Rysunek 3.11.8 przedstawia rezultat tej operacji:
Rysunek 3.11.8 “Zagęszczenie” wierzchołków poprzez “utrwalenie” modyfikatorów Subsurf i Mirror
Pozostaje jeszcze “posprzątać”: usuń prawe strony wręg, włącz powtórnie modyfikatory Mirror i Subsurf. Następnie połącz te wręgi ścianami poleceniem Mesh→Edges→Bridge Edge Loops. Rysunek 3.11.9 pokazuje rezultat tej operacji:
Rysunek 3.11.9 Siatka z czterokrotnie zwiększoną liczbą podłużnic
Dodaj także (Loop Cut) jedną dodatkową podłużnicę, umieszczając ją bardzo blisko osi kadłuba. Stworzysz w ten sposób wąski “pasek” ścian, ustawionych zupełnie poziomo (Rysunek 3.11.9). Powinien zapewnić poprawny kształt powłok dodanych poleceniem Solidify. Skopiuj także jeszcze raz z drugiej części kadłuba przednią wręgę, i włącz ją powtórnie do siatki osłony silnika. Teraz już nie wypada nazywać jej “gęstą”, gdy liczba wierzchołków wszystkich pozostałych wręg stała się bardzo zbliżona. Nadal jednak przyda się nam w charakterze wzorca do dopasowywania. (Tym razem do dokładnego uzgodnienia miejsca styku przedniej i tylnej sekcji kadłuba).
Przygotowując się do “pocięcia” przodu samolotu wzdłuż oryginalnych łączeń blach, trzeba nieco poprzesuwać podłużnice (Rysunek 3.11.10):
Rysunek 3.11.10 Dopasowywanie (poleceniem Edge Slide) podłużnic siatki do linii podziału paneli na osłonie silnika
Zacznij od przesunięcia (Ctrl-E, Edge Slide) całej krawędzi |1234| tak, aby jej początek (wierzchołek 1) przy kołpaku śmigła znalazł się we właściwym miejscu. Potem skoryguj położenie kolejnych wierzchołków — 2,3, 4— przesuwając je wzdłuż poprzecznych krawędzi (Shift-V — Vertex Slide) tak jak to pokazuje Rysunek 3.11.11. Oczywiście, aby uzyskać docelowe położenie wierzchołków, trzeba przesunąć w ten sposób nie jedną, a kilka podłużnic, jedną za drugą.
Rysunek 3.11.11 Przesuwanie wierzchołków podłużnicy (dopasowanie krawędzi siatki do linii podziału paneli)
Na koniec należy włączyć ostrość (crease = 1) linii przyszłych podziałów (Rysunek 3.11.12b). W ten sposób nabiorą takiego kształtu, jak krawędzie powłok, na które zamierzamy podzielić nos samolotu. Warto na czas tej operacji włączyć w modyfikatorze Subsurf przełącznik Apply during edit (Rysunek 3.11.12a). W tym trybie zamiast krawędzi oryginalnej siatki Blender rysuje segmenty wygładzonej powłoki. W tej postaci łatwiej można sprawdzić, czy ostra krawędź dokładnie pokrywa się z podziałami oryginalnych paneli. Czasami pojawia się konieczność dodania kolejnych podłużnic, aby zapełnić “puste przestrzenie”, pozostałe po wcześniejszych przesunięciach (Rysunek 3.11.12a):
Rysunek 3.11.12 Przygotowywanie siatki do podziału na panele
Po ustawieniu kluczowych krawędzi, można dopasować dokładnie miejsce połączenia przedniej i tylnej części kadłuba.
Dodaj poprzez wytłoczenie występ, pasujący do uskoku wręgi wzdłuż ściany ogniowej (Rysunek 3.11.13a). Potem powiększ obraz (zoom), i dopasuj poszczególne wierzchołki tej tylnej krawędzi siatki osłony silnika do reszty części kadłuba (Rysunek 3.11.13b) . Najwygodniej jest to zrobić, metodycznie poprawiając kolejne punkty ustawione wzdłuż linii łączącej dwie siatki. Podczas dopasowywania przesuwaj poszczególne wierzchołki wzdłuż osi globalnych: Z i X. Dzięki temu nie jesteś ograniczony do pracy wyłącznie w określonym rzucie (z lewej, góry czy przodu) i możesz je przesuwać w dowolnym widoku.
Rysunek 3.11.13 Dopasowanie połączenia przedniej i tylnej części kadłuba
Dodaj jeszcze jedno żebro tam, gdzie znajduje się tylna ściana osłony chłodnicy i koniec otworu na kolektor rur wydechowych. Aby nie zaburzyć tak pracowicie przygotowanego układu podłużnic, zrób to w takiej kolejności jak przedstawia Rysunek 3.11.14:
Rysunek 3.11.14 Dodanie do nosa samolotu dodatkowej, piątej wręgi
Rysunek 3.11.15 pokazuje kształt osłony silnika, jak osiągnęliśmy na tym etapie:
Rysunek 3.11.15 Osłona silnika — kształt po uformowaniu
Teraz możesz wydzielić (P, Separate) z powłoki poszczególne panele (Rysunek 3.11.16):
Rysunek 3.11.16 Wydzielenie z powłoki poszczególnych paneli osłony silnika
Po rozdzieleniu powłoki można odciąć fragment jej dolnej części, którego nie było w prawdziwym samolocie (Rysunek 3.11.17). (Możemy to zrobić dopiero teraz, gdy nie zaburzy to w żaden sposób układu krawędzi na pozostałej części siatki). Linię cięcia (Knife) poprowadź wzdłuż krawędzi widocznej na planach modelarskich (P-40 miał w tym miejscu ostre zakończenie kadłuba):
Rysunek 3.11.17 Odcięcie niepotrzebnego, dolnego fragmentu powłoki modelu
Nie zapomnij o pogrubieniu każdej z paneli, imitującego grubość blachy (o 0.02 jedn.). Okazuje się, że do takich podłużnych kształtów najlepiej nadaje się polecenie Solidify (str. 377). Po jego wywołaniu musisz tylko usunąć wszystkie wierzchołki drugiej ściany, stworzonej przez tę operację, pozostawiając tylko ściany boczne (Rysunek 3.11.18):
Rysunek 3.11.18 Pogubienie panelu osłony za pomocą polecenia Solidify
Zamiast polecenia Solidify możesz użyć modyfikatora Solidify (szczególnie gdy nie zamierzasz eksportować tego modelu do innych programów
Wzdłuż ostrego załamania gładkich ścian o różnej długości powstają brzydkie “cienie”. Taki efekt przeszkadza w pracy nad modelem. Możesz je wyeliminować, wstawiając (Loop Cut) dodatkowe wręgi bardzo blisko przedniej i tylnej krawędzi każdego panelu (Rysunek 3.11.19):
Rysunek 3.11.19 Pogrubienie blach (0.01 jednostki Blendera)
Zamiast dodawać taką krawędź, możesz także włączyć opcję Normals:Auto Smooth (por. str 383). Ja wolę jednak poprawić najpierw co większe cienie „w siatce”, aby nie pojawiły się przy eksporcie do innych programów (np. do postaci odpowiedniej dla różnych silników gier).
Rysunek 3.11.20 podaje nazwy, jakie nadałem poszczególnym częścią osłony silnika. Panele boczne otrzymały dodatkowy wyróżnik “L” (jak Left) po numerze. To na przyszłość — przed rozpoczęciem teksturowania trzeba będzie zastąpić po prawej stronie samolotu lustrzane odbicia tych części prawdziwymi siatkami. Wyróżnimy je literą “R” (jak Right):
Rysunek 3.11.20 Nazwy, nadane poszczególnym panelom osłony silnika
Fragment, z którego powstanie osłona chłodnicy cieczy zredukuj do niewielkiego odcinka od kołpaka śmigła do chwytu powietrza (B.350.Cowling.005). Resztę tej osłony stworzymy od podstaw w następnej sekcji.
Model z tej sekcji znajdziesz w pliku model\p40\history\P40B-4.11.blend (por. str. 18).
Przekroje, umieszczone na planach modelarskich traktuj z dużą rezerwą. Mogą zawierać wiele błędów. Podczas formowania kształtu zwracaj przede wszystkim uwagę na zdjęcia, oraz na rzuty z boku i góry/dołu;
Formowanie może przebiegać w dwóch etapach. Pierwszy etap to “zgrubne” nadanie kształtu, za pomocą siatki o niewielkiej liczbie krawędzi (str. 155). Drugi etap to drobne poprawki, wykonane na siatce o zwiększonej liczbie krawędzi (str. 157);
Aby zwiększyć siatkę dla jednego typu krawędzi (np. podłużnic), musisz je wszystkie usunąć z pierwotnej siatki pozostawiając np. tylko wręgi (por. str. 156). Potem “utrwal” (przyciskiem Apply) modyfikator Subsurf, zwiększając liczbę wierzchołków na każdej z tych linii (str. 156). Na koniec — odtwórz brakujące ściany i krawędzie.
Dopasowanie krawędzi siatki do zadanej linii najlepiej jest wykonywać za pomocą poleceń Edge Slide i Vertex Slide, metodą “od lewej do prawej” (str. 157);
Do nadania “grubości blachy” poszczególnym panelom można wykorzystać polecenie Solidify (str. 160);
Wszystkie chłodnice cieczy — glikolu i oleju — były w P-40 umieszczone bezpośrednio pod silnikiem (Rysunek 3.12.1a). Ich wlot powietrza był podzielony dwoma ściankami na trzy kanały: środkowy, do chłodnicy oleju i boczne, do chłodnic glikolu. Przed kanałami bocznymi były wytłoczone w kadłubie wgłębienia, zwiększające napływ powietrza (Rysunek 3.12.1b). Zespół wlotów powietrza wraz z tymi wgłębieniami tworzy dość złożony kształt, który odwzorujemy w tej sekcji.
Rysunek 3.12.1 Osłona chłodnicy cieczy
Pracę nad zacznij od zagęszczenia przedniego odcinka siatki (od kołpaka śmigła do wlotu powietrza — element B.350.Cowling.005). Zrób to “utrwalając” (przycisk Modifiers:Apply) modyfikator Subsurf z Subdivisions = 2 (Rysunek 3.12.2a). Gęsta siatka jest w tym miejscu potrzebna do odwzorowania wgłębienia przed wlotem powietrza oraz zaokrąglonych narożników wlotu .
Dodaj, jako niezależne obiekty, dwa pomocnicze okręgi. (Ze zdjęć wynika, że spód osłony chłodnicy miał przekrój okrągły lub bardzo zbliżony). Ich środki przydadzą się nieraz jako “punkt zaczepienia” dla kursora 3D (Cursor to Selected). Jeden z okręgów umieść tam, gdzie będzie się znajdować wlot powietrza do chłodnicy, a drugi — tam, gdzie wylot (Rysunek 3.12.2a). Przy okazji dopasowywania wręg do reszty kadłuba, koniecznym okazało się poszerzenie krawędzi za wylotem powietrza1 (Rysunek 3.12.2b):
Rysunek 3.12.2 Przygotowanie dwóch okrągłych żeber
Dodaj do siatki dwie wręgi w kształcie łuków tam, gdzie umieściłeś okręgi wzorcowe (Rysunek 3.12.2a). Powinny mieć tą samą, umiarkowaną liczbę wierzchołków — ja pozostawiłem po 7 wierzchołków w każdym łuku.
Połącz te dwie dodane wręgi ścianami2 (Mesh→Edges→Bridge Edge Loops — Rysunek 3.12.3a):
Rysunek 3.12.3 Uformowanie podstawowego kształtu osłony chłodnicy
Wstaw w środek osłony dalsze wręgi (Loop Cut), i dopasuj uzyskany kształt do obrysu z boku i z góry (Rysunek 3.12.3b). Dodaj kilka podłużnic przy bocznej krawędzi, i dopasuj dokładnie siatkę do jej obrysu.
Umieść kursor 3D w środku przedniego wzorcowego okręgu. (w Object Mode: zaznacz okrąg, potem naciśnij Shift-S, i wybierz Cursor to Selected). Następnie wytłocz (Extrude, Scale) krawędź wlotu powietrza w płaską ścianę przedniej wręgi. Wstaw do wnętrza tak utworzonej ściany trzy nowe wręgi (Rysunek 3.12.4a):
Rysunek 3.12.4 Utworzenie zaokrąglenia na wlocie
Potem przesuń je do przodu. To wystarczy, by powstała krawędź wlotu, zaokrąglona niewielkim promieniem (Rysunek 3.12.4b, Rysunek 3.12.4c).
Przygotowując się do uformowania obszaru przed wlotem powietrza, umieść wewnątrz osłony dwa pomocnicze elementy. Pierwszym z nich jest kontur chodnicy. Wstaw go jako odrębny obiekt. Jest to okrąg, gdyż wszystkie chłodnice w P-40 miały kształt walca (Rysunek 3.12.5). Drugim pomocniczym elementem jest wzorcowa wręga, dodana do siatki na poziomie wlotu powietrza. Będzie wyznaczać docelowe położenie dla wierzchołków formowanej powłoki. Stwórz ją poprzez skopiowanie aktualnej wręgi wlotu. Potem wstaw w tę linię dodatkowe wierzchołki, i uformuj z niej właściwy kontur wlotu (w rzucie z przodu — Rysunek 3.12.5a). Nie zapomnij także o zarysie ścianek, oddzielających kanał chłodnicy glikolu i oleju:
Rysunek 3.12.5 Nacięcie konturu zagłębienia przed wlotem powietrza
Zarysy obydwu obiektów pomocniczych pozwolą Ci zorientować się co do kierunku zagłębienia przed wlotem powietrza3. (Biegł lekko pochylony do dołu i ukośnie w bok). Teraz w rzucie z przodu natnij (Knife) granice zagłębienia przed wlotem (Rysunek 3.12.5a).
Przesuń teraz do wnętrza kadłuba wierzchołki, znajdujące się wewnątrz tego konturu zagłębienia (Rysunek 3.12.6a) — aż do wręgi wzorcowej. Zrób to tak, by powierzchnia wewnątrz wgłębienia wyglądała jak fragment stożka (Rysunek 3.12.6b).
Rysunek 3.12.6 Ukształtowanie wklęsłych powierzchni przed wlotami — przesuwanie wierzchołków
Aby uzyskać stałe pochylenie ścian wewnątrz tego zagłębienia, zamiast przesuwać pojedyncze wręgi lepiej obróć cały ich zespół. Wcześniej tylko ustaw płaszczyznę aktualnego widoku (obrotu) prostopadle do krawędzi wgłębienia (Rysunek 3.12.6a,b).
Rysunek 3.12.7 pokazuje wierzchołki przed wlotem powietrza po dosunięciu do wręgi wzorcowej. W trakcie pracy uprościłem (poprzez scalanie) układ ścian wzdłuż krawędzi zagłębienia. W okolicy narożnika konieczne okazało się dodanie jeszcze jednej podłużnicy (Rysunek 3.12.7a):
Rysunek 3.12.7 Ukształtowanie wklęsłych powierzchni przed wlotami — końcowe dopasowania
W trakcie pracy nad wlotem często porównywałem model ze zdjęciami. W takich sytuacjach może się zdarzyć, że dostrzeżesz jakieś nie zauważone wcześniej różnice. Tak było i w tym przypadku — ścianki kanału chłodnicy oleju okazały się zbyt szeroko rozstawione. Trzeba było zsunąć nieco kilka centralnych podłużnic i poprawić zarys wzorcowej wręgi wlotu (Rysunek 3.12.7b).
Teraz można połączyć przednią i tylną część osłony, formując zaokrąglony narożnik. To często powtarzający się detal w konstrukcjach lotniczych. Najpierw przygotuj ściany z jednej i drugiej części powłoki tak, by każdy z wierzchołków miał swój odpowiednik “po przeciwnej stronie” (Rysunek 3.12.8a). (W tym przypadku okazało się konieczne dodanie jeszcze jednej podłużnicy, by temu sprostać). Przy okazji możesz już połączyć obydwie powierzchnie tam, gdzie stykają się “na płasko”: z boku, w pobliżu zewnętrznej krawędzi (Rysunek 3.12.8a):
Rysunek 3.12.8 Ukształtowanie narożnika wlotu powietrza
Potem usuń niepotrzebne ściany, przygotowując w ten sposób pole do stworzenia nowych. Muszę przyznać, że najwięcej czasu zajmuje mi przemyślenie, co z czym zostanie połączone, aby uzyskać jak najlepszy układ krawędzi. Potem — pozostaje tylko połączyć przygotowane wierzchołki (Rysunek 3.12.8b). Staraj się unikać ścian trójkątnych, gdyż takie miejsca o dużej krzywiźnie mogą tworzyć nierówności na powierzchni wygładzonej modyfikatorem Subdivision Surface.
Teraz można usunąć pomocniczą wręgę z wlotu powietrza — spełniła już swoje zadanie. Pozostaw z niej tylko kontur ściany dzielącej kanały chłodnic. Wytłocz go w zaokrąglony “słupek” (Rysunek 3.12.9a). Przygotuj także odpowiednie wierzchołki u podstawy “słupka”. Dodaj nową wręgę, biegnącą tuż przed nim. Natnij (Knife) w pobliżu dodatkowe krawędzie, by ograniczyć promień tworzonego zaokrąglenia połączenia (Rysunek 3.12.9a). Na koniec usuń dotychczasowe ściany z tego obszaru i utwórz nowe (Rysunek 3.12.9b):
Rysunek 3.12.9 Wlot powietrza — formowanie początku ściany wewnętrznej
W ten sam sposób ukształtuj połączenie “słupka” z przeciwległą ścianą chłodnicy. Gdy to zrobisz, osłona będzie gotowa (Rysunek 3.12.10):
Rysunek 3.12.10 Gotowa osłona chłodnicy cieczy
Jeżeli obejrzysz model z pliku P40B-4.12.blend, na pewno zauważysz że wlot powietrza do chłodnicy jest cofnięty w stosunku do podstawionych tam planów. Tak był położony na oryginalnym rysunku, według którego budowałem ten model. Skoryguję tę różnicę w ostatnich sekcjach tego rozdziału.
Model z tej sekcji znajdziesz w pliku model\p40\history\P40B-4.12.blend (por. str. 18).
Zaokrąglenie wokół krawędzi wlotu powietrza najłatwiej uzyskać, wstawiając (Loop Cut) w jednej płaszczyźnie trzy wręgi blisko siebie. Potem tylko przesuń je do przodu na odpowiednią odległość (str. 164);
Przy formowaniu wklęsłych fragmentów kadłuba (jak przed wlotem powietrza do chłodnicy w P-40B/C), warto dodać krawędź wzdłuż granicy takiego zagłębienia (str. 165);
Narożniki ścian wlotów należy najpierw starannie przygotować, aby poszczególne wierzchołki miały swoje odpowiedniki “po przeciwnej stronie” (str. 166). Staraj się tak uformować te fragment siatki, by składały się wyłącznie z czworokątów;
Maska silnika P-40 ma wiele dodatkowych szczegółów: chwyt powietrza do sprężarki i osłony luf nkm u góry, otwory na rury wydechowe kolektora spalin po bokach (Rysunek 3.13.1). W tej sekcji pokażę, jak można wkomponować te elementy w siatki poszczególnych paneli, by tworzyły z nimi jedną całość. (Czyli tak, jak w prawdziwym samolocie).
Rysunek 3.13.1 Szczegóły osłony silnika
Najtrudniejszym chyba do wykonania elementem w tej sekcji jest osłona lufy karabinu maszynowego. Wygląda dość niepozornie w porównaniu z chwytem powietrza do silnika, ale to tylko pierwsze wrażenie. Chwyt płynnie “zlewa” się ze swoim panelem. Obudowa karabinu — przeciwnie, do końca zachowuje wyraźną krawędź o drobnym, ale istotnym zaokrągleniu. Jak tu takie zaokrąglenie połączyć z resztą panelu, by nie zaburzyć jego dotychczasowego kształtu? W osłonach silników myśliwców z okresu II Wojny Światowej (Messerschmit, Jak, ŁaGG, Dewoitine) często występuje negatyw tego elementu — zagłębienie na lufę karabinu maszynowego. Obydwie — i wypukłą osłonę, i wklęsłe zagłębienie — wykonuje się w ten sam sposób.
Najpierw zagęść siatkę B.350.Cowling.002 (przycisk Apply na modyfikatorze Subsurf) zwiększając dwukrotnie liczbę wręg i podłużnic (Subsurf:Subdivisions = 1, Rysunek 3.13.2). (Trzeba to zrobić, aby dodanie do siatki krawędzi otworu pod osłonę karabinu spowodowało jak najmniejsze zmiany kształtu. W ten sposób zwiększysz jej liczbę ścian i zbliżysz kształt do wygładzonej powłoki).
Rysunek 3.13.2 Przygotowanie do “wycięcia” otworu — dwukrotne zagęszczenie siatki panelu osłony silnika
Uważaj na krawędzie zewnętrzne panelu. W wyniku utrwalenia modyfikatora Subsurf gubią informację o ostrości (crease), i trzeba ją ponownie przypisywać.
Po dwukrotnym zagęszczeniu siatki możesz do niej ponownie dodać modyfikator Subsurf, ale tym razem z mniejszym poziomem podziału — Subsurf:Subdivisions = 1. Wcześniej, dla rzadkiej siatki, stosowaliśmy dwukrotnie większą liczbę podziałów — Subdivisions = 2. W ten sposób ostateczna liczba ścian wygładzonej powierzchni nie uległa zmianie.
Wykonaj teraz podstawowy kształt osłony karabinu maszynowego poprzez wytłoczenie prostego przekroju o kształcie odwróconego “U”, (Rysunek 3.13.3). Umieść ten obiekt we właściwym miejscu. Nie będziemy mu nadawać specjalnej nazwy, bo za chwilę i tak zostanie scalony z panelem. Na razie jest nam potrzeby jako odrębna siatka, by można było wyznaczyć jego krawędź przecięcia z osłoną silnika:
Rysunek 3.13.3 Wytłoczony kształt osłony (przed odcięciem niepotrzebnych części ścian)
Przejdź z powrotem do edycji panelu pokrywy silnika. Przyjrzyj się, jak układają się linie siatki w względem osłony karabinu. Podłużnice w siatce wydają się być odpowiednio “gęste”, ale wręgi wymagają uzupełnienia. Dodaj (Loop Cut) do panelu dwie nowe krawędzie (Rysunek 3.13.4). Ich wstawienie zmieni nieco kształt najbliższego otoczenia na siatce (w każdą stronę do drugiej wręgi). Dopasuj granice tego panelu do krawędzi sąsiednich osłon za pomocą drobnych zmiany skali wręg w kierunku Y i Z. Środek zmiany skali powinien leżeć na osi samolotu (np. w punkcie 0,0,0):
Rysunek 3.13.4 Wstawienie dwóch nowych wręg do panelu osłony silnika
Dzięki temu, że wcześniej podzieliliśmy maskę silnika na kilka fragmentów, łatwiej jest teraz wykonywać takie lokalne zagęszczenia siatki. Wstawiasz nowe wręgi w jeden panel, i nie musisz się zupełnie przejmować pozostałymi. Mogą mieć inny układ ścian — w zależności od tego, co zawierają.
Do dalszej pracy będziemy potrzebować lepszego sprawdzianu, pokazującego gdzie kształt modyfikowanej powłoki uległ zmianie. Dotychczas stosowaliśmy metodę “na oko”, teraz po każdej operacji będziemy porównywać wynik z oryginalnym kształtem.
Wzorzec, z którym będziesz się porównywać, mogłeś stworzyć jeszcze przed dodaniem nowych wręg. Jeżeli tego nie zrobiłeś wcześniej — zrób to teraz. Skopiuj panel w nowy obiekt (Shift-D, Duplicate — str. 302). Umieść go na innej warstwie (M, szczegóły — str. 317), aby ułatwić wyświetlanie i ukrywanie. Nadaj temu wzorcowi kontrastowy, czerwony kolor. (Utwórz na potrzeby tego i następnych wzorców specjalny materiał i nazwij go Artifical — szczegóły na str. 389). Rysunek 3.13.5 pokazuje przykład wykorzystania “czerwonego wzorca”. Podczas dopasowywania do oryginalnego kształtu, obserwuj uważnie, kiedy szara, modyfikowana powłoka, zniknie pod czerwoną. Staraj się ją ukształtować tak, by była tuż powyżej lub tuż poniżej tego punktu:
Rysunek 3.13.5 Dopasowywanie zmodyfikowanej powłoki panelu do powłoki wzorcowej (wzorzec jest w kolorze czerwonym)
Osłona karabinu była wytłoczona z tego samego kawałka blachy, co okapotowanie silnika. Krawędź łącząca te dwie powłoki musi być zaokrąglona. Przybliżymy ten efekt przekrojem o kształcie 90º łuku za pomocą krzywej podziałowej opartej o przekrój złożony z trzech punktów. Dlatego wyznaczymy (za pomocą skryptu Intersection, str. 308) nie jedną, a trzy krawędzie przenikania:
Rysunek 3.13.6 Zaokrąglona krawędź połączenia wymaga wyznaczenia trzech krawędzi przecięcia
Pierwszą krawędź (1) na osłonie karabinu utwórz jako zwykłą krawędź przecięcia z pokrywą silnika. Aby wyznaczyć kolejną (krawędź 2, Rysunek 3.13.6a) — przesuń na chwilę osłonę karabinu o 0.05 jedn. Blendera do dołu. Wyznacz krawędź (2) tak samo, jak wyznaczyłeś krawędź (1). Potem przesuń osłonę karabinu z powrotem na stare miejsce.
Trzecią krawędź (3) wyznacz jako linię przenikania pokrywy z “pogrubioną” o 0.05 jednostki Blendera osłoną karabinu (Rysunek 3.13.6b,c). Aby ją uzyskać, skopiuj na chwilę osłonę karabinu w nowy obiekt (Shift-D). Pogrub tę kopię we wszystkie strony — np. poprzez zmianą skali względem wskazanego na ilustracji punktu (Rysunek 3.13.6b) o 10%. Wyznacz przecięcie tego obiektu z maską silnika. Przed wywołaniem Intersection wskaż najpierw pogrubioną osłonę, a potem pokrywę silnika. W ten sposób rezultat — krawędź przecięcia — zostanie dodana do siatki okapotowania (Rysunek 3.13.7a). Po wyznaczeniu tej linii usuń pogrubiony duplikat osłony karabinu z rysunku, bo nie będziemy już go więcej potrzebować.
Z krawędzi (3) wyeliminuj kilka wierzchołków, które nie wnoszą nic nowego do jej kształtu, a tylko niepotrzebnie komplikowałyby siatkę. Następnie usuń z siatki wierzchołki położone w środku konturu (3) i zbuduj wokół niego nowe ściany (Rysunek 3.13.7b):
Rysunek 3.13.7 Wycinanie otworu na osłonę karabinu w panelu osłony silnika
Krawędź takiego otworu leży nieco ponad oryginalną powłoką (Rysunek 3.13.7c). Musisz teraz dosunąć jej wierzchołki tak, by różnica kształtu była jak najmniejsza. Sądzę, że najwygodniej jest to zrobić przesuwając je wzdłuż globalnej osi Z (G,Z). Rysunek 3.13.8 pokazuje poprawioną krawędź:
Rysunek 3.13.8 Krawędź otworu po dosunięciu w pobliże powierzchni wzorcowej
Pora teraz włączyć siatkę osłony karabinu w siatkę pokrywy silnika (Ctrl-J, Object→Join). Zaraz po dodaniu są to nadal dwie oddzielne powłoki. Wykorzystaj to, by wstawić (Loop Cut) w osłonę karabinu kolejne wręgi. Umieść je tak, by każda z nich biegła w tym samym miejscu, co odpowiednia wręga pokrywy silnika (Rysunek 3.13.9):
Rysunek 3.13.9 Wstawienie w powłokę osłony karabinu nowych wręg
Następnie usuń wszystkie niepotrzebne ściany z osłony karabinu. Włącz krawędzie 1, 2, 3 w siatkę aby zbudować nowy układ ścian łączący obydwie powłoki (Rysunek 3.13.10a):
Rysunek 3.13.10 Połączenie powłoki osłony karabinu z powłoką pokrywy silnika
Rysunek 3.13.10b) pokazuje osiągnięty rezultat: gładka, zaokrąglona krawędź wokół osłony karabinu, przy zachowaniu oryginalnego kształtu pokrywy silnika wokół tego elementu. I o to chodziło! Gdy będziesz miał wykonać w jakimś innym modelu wgłębienie na lufę karabinu — zrób to w ten sam sposób. Po prostu zamiast wypukłej osłony włączysz w siatkę jej negatyw — wklęsłe “korytko”.
Czas na kolejny element do scalenia z osłoną silnika: chwyt powietrza do sprężarki. Podobnie jak osłony karabinów, element ten stopniowo “zanurza” się w kadłubie. Choć zaczyna się przekrojem kołowym, to szerokość jego krawędzi przenikania z osłoną silnika jest stała (Rysunek 3.13.12b). Aby uzyskać taki efekt, końcowy przekrój chwytu musiał być zbliżony do prostokąta (Rysunek 3.13.12a). Wytłocz więc właśnie taki podstawowy kształt (Rysunek 3.13.11). Na początku będzie to oddzielny obiekt, aby można było wyznaczyć jego krawędź przecięcia z pokrywą silnika.
Rysunek 3.13.11 Podstawowy kształt chwytu powietrza do sprężarki
Gdy dosunąłem wytłoczony chwyt powietrza do kadłuba, zauważyłem błąd, popełniony wcześniej. Krawędź podziału pokryw silnika powinna być o jakieś 2 cm węższa (z obydwu stron — Rysunek 3.13.12b). Takie sytuacje zdarzają się podczas modelowania, więc przerwę na chwilę i opowiem, jak sobie z tym poradzić.
Rysunek 3.13.12 Chwyt powietrza do sprężarki — “przymiarka” do pokrywy silnika
Poprawienie tego błędu wymaga niewielkiego przesunięcia wszystkich podłużnic siatki do wnętrza, połączonego z ich wyprostowaniem (Rysunek 3.13.13a). Następnie zaznacz ściany “do odstąpienia” i wydziel (P, Separate) je na chwilę w odrębny obiekt. Scal go zaraz z sąsiednim panelem (B.350.Cowling.002). Trochę przy tej okazji jest pracy z usuwaniem i powtórnym tworzeniem krawędzi na “grubość blachy”. (Pamiętasz? Umieszczaliśmy je wzdłuż wszystkich krawędzi podziału pokrywy silnika.) Rysunek 3.13.13b przedstawia rezultat operacji:
Rysunek 3.13.13 Poprawianie krawędzi panelu pokrywy silnika
Bardzo pomocna przy tego typu drobnych poprawkach kształtu osłony silnika jest powłoka wzorcowa. Proponuję zachować ją także na przyszłość, bo nigdy nie wiadomo, kiedy jeszcze będziemy jej potrzebować.
Wróćmy do przerwanego na czas poprawki formowania chwytu powietrza. Początkowy kształt wytłoczyliśmy z dwunastoboku (por. Rysunek 3.13.12a). Dzięki niewielkiej liczbie wierzchołków nie mieliśmy zbyt dużo pracy z przekształcaniem okręgu w prostokąt. Aby teraz uzyskać “gładsze” zaokrąglenie wlotu, zagęść tę siatkę dwukrotnie (Subsurf:Apply, dla Subsurf:Subdivisions = 1). Zwiększenie liczby podłużnic ułatwi także jej przyszłe złączenie z pokrywą silnika.
W P-40 chwyt powietrza płynnie “wtapiał” się w górną część pokrywy silnika. Formowanie takiego przypadku jest prostsze, niż wykonanej wcześniej osłony karabinu. Zamiast trzech krawędzi przecięcia wystarczy tu tylko jedna, zamieniona na otwór w oryginalnej powłoce. Przygotuj kopię górnego panelu pokrywy silnika. Nadaj jej nazwę B.350.T.Cowling.001. Posłuży nam jako wzorzec pokrywy przed deformacją. Następnie wyznacz (Intersection) linię przenikania chwytu powietrza i osłony silnika. Zrób to tak, by rezultat stał się częścią siatki panelu, a nie chwytu (Rysunek 3.13.14a):
Rysunek 3.13.14 Wykonanie otworu na chwyt powietrza w górnej części pokrywy silnika
Korzystając z wyznaczonej krawędzi przecięcia, zmień układ ścian panelu, tworząc otwór na chwyt powietrza (Rysunek 3.13.14b). Następnie wstaw siatkę chwytu w pokrywę silnika (Rysunek 3.13.15a):
Rysunek 3.13.15 Wstawienie siatki chwytu powietrza do siatki pokrywy silnika
Zaraz po wstawieniu, dodaj (Loop Cut) do powłoki chwytu powietrza dodatkowe wręgi. Tak samo jak w przypadku osłony karabinu, rozmieść je tak, by “spotkały” się z poszczególnymi wręgami osłony silnika (Rysunek 3.13.15a). Potem usuń niepotrzebne ściany (Rysunek 3.13.15b).
Gdy to zrobiłeś, nie pozostaje nic innego jak tylko zapełnić nowymi ścianami powstałe luki. Zrób to, tylko postaraj się nie umieszczać trójkątnych ścian bezpośrednio przy krawędzi połączenia dwóch siatek. Jeżeli już muszą istnieć, lepiej umieścić je przynajmniej “o jedną ścianę dalej” (Rysunek 3.13.16a):
Rysunek 3.13.16 Połączenie siatki chwytu powietrza z siatką pokrywy silnika
Podstawa wlotu powietrza P-40 miała najniższy punkt na poziomie pokrywy silnika, i charakterystyczne wyoblenia po bokach1. Uzyskasz je za pomocą krótkiej, przekątnej krawędzi w ścianie narożnej (Rysunek 3.13.16b). Środkowy wierzchołek tej krawędzi decyduje w dużej mierze o kształcie zaokrąglenia w tym miejscu. Rysunek 3.13.16b) pokazuje także, że w tym narożniku można użyć dwóch ścian trójkątnych.
Chwyt powietrza jest już ukończony (Rysunek 3.13.17). Zwróć uwagę na płynne przejście w kształt pokrywy silnika, szczególnie na końcu osłony chwytu. Z przodu, przed wlotem, widoczne są charakterystyczne wyoblenia, utrwalone na wielu zdjęciach.
Rysunek 3.13.17 Gotowy chwyt powietrza do sprężarki po scaleniu z górnym panelem osłony silnika
Spośród elementów, które mamy wykonać w tej sekcji, pozostał już ostatni — otwór na kolektor spalin. W porównaniu z osłoną luf karabinów czy chwytem powietrza to naprawdę drobiazg. Wykonuje się go w ten sam sposób, tylko jeszcze prościej.
Zacznij od przygotowania “rury” o kształcie otworu (Rysunek 3.13.18a). To nasz “nóż” do wycięcia “dziury” w panelu B.350.L.Cowling.003. Ustaw go w odpowiednim miejscu i pochyl pod odpowiednim katem. (Patrząc na zdjęcia wydaje się, że rury wydechowe kolektora spalin były w rzucie z przodu zadarte lekko do góry. Najprawdopodobniej także ich otwór leżał na podobnie pochylonej płaszczyźnie, mniej więcej prostopadle do ściany pokrywy silnika). Wyznacz krawędź przecięcia tego obiektu z okapotowaniem silnika (Rysunek 3.13.18b). Potem możesz go usunąć, bo nie będzie już potrzebny.
Rysunek 3.13.18 Wyznaczenie krawędzi otworu kolektora spalin
Przygotuj kopię siatki B.350.L.Cowling.003 jako wzorzec. (Nazwij go B.350.T.Cowling.003 i nadaj mu “tradycyjny, czerwony kolor” materiału Artifical). Wykorzystując ten wzór, zwiększ liczbę wręg na panelu, umieszczając je tam, gdzie znajdą się kluczowe punkty konturu otworu (Rysunek 3.13.18b).
Usuń wierzchołki siatki z wnętrza otworu, i wykorzystując krawędź przecięcia utwórz wokół niego nowy układ ścian (Rysunek 3.13.19a). Powierzchnia tego panelu jest na tyle płaska, że krawędź otworu całkiem dobrze “leży” na wzorcu, i nie wymaga poprawek.
Rysunek 3.13.19 Wykonanie otworu na kolektor spalin, i dodanie pogrubienia (“fazki”) na jego krawędzi
Na koniec zwiększ ostrość (crease) krawędzi otworu do 1.0, i wytłocz ją w głąb kadłuba na głębokość ok. 0.1 jedn. Blendera (1 cm w rzeczywistym samolocie) (Rysunek 3.13.19b). (P-40 miał wokół rur wydechowych coś w rodzaju ekranu, aby te elementy, rozgrzewające się podczas pracy do bardzo wysokich temperatur, nie uszkodziły okapotowania silnika).
I to już wszystko, co mieliśmy wykonać w tej sekcji. Rysunek 3.13.20 przedstawia osłonę silnika wraz ze wszystkimi szczegółami.
Rysunek 3.13.20 Panele osłony silnika wraz ze szczegółami
Model z tej sekcji znajdziesz w pliku model\p40\history\P40B-4.13.blend (por. str. 18).
Podsumowanie
W tej sekcji wkomponowaliśmy w okapotowanie silnika trzy dość trudne elementy: osłony luf nkm, chwyt powietrza do sprężarki oraz otwór na kolektor spalin;
Wszystkie takie elementy zaczyna się od uformowania ich podstawowego kształtu. Zagęszczasz (Subsurf:Apply) także siatkę powłoki, do której chcesz je dodać. Potem wyznaczasz kontur przecięcia (Intersection) ich siatek z powłoką kadłuba. Usuwasz stare ściany z wnętrza uzyskanego konturu i tworzysz ich nowy układ wzdłuż krawędzi przecięcia. W przypadku, gdy chodziło tylko o otwór (np. otwór kolektora spalin), to kończy operację (str. 177);
Przed taką modyfikacją siatki jak wycięcie otworu, warto stworzyć jej kopię. Będziesz mógł później wykorzystać ten obiekt jako referencję, aby „płożyć” ściany siatki wokół brzegów nowo utworzonego otworu na oryginalnej powierzchni (str. 171);
Po wykonaniu otworu należy włączyć w siatkę panelu powłokę wykonywanego szczegółu (osłony lufy karabinu, chwytu powietrza). Bezpośrednio po tym połączeniu zwiększ liczbę wręg w jego powłoce, aby dostosować ją do liczby wręg na panelu (str. 175). Potem usuń niepotrzebne ściany z okolic połączenia, i utwórz nowe, wzdłuż krawędzi przecięcia (str. 176)
Najwięcej kłopotów stwarzają elementy, które w oryginalnej konstrukcji były wytłoczone wraz z panelem z jednego kawałka blachy, z niewielkim promieniem zaokrąglenia wzdłuż krawędzi połączenia. Przykładem takiego detalu jest osłona karabinu maszynowego (str. 171). Zamiast jednej krawędzi przecięcia wymaga wyznaczenia aż trzech. W oparciu o nie utworzysz dwa cienkie paski ścian kontrolnych, połączone wzdłuż właściwej krawędzi przecięcia. Wygładzona powłoka wzdłuż takich ścian utworzy odpowiednie zaokrąglenie (str. 173).
Formowanie oszklenia kabiny pilota proponuję zacząć od tylnych “okien”, umieszczonych za zagłówkiem pilota (Rysunek 3.14.1):
Rysunek 3.14.1 Oszklenie P-40 B/C za głową pilota
Jest to chyba najtrudniejszy fragment z całej osłony kabiny. Po pierwsze, wymaga wkomponowania w kadłub zagłębienia, którego krawędź musi odpowiadać krawędziom oszklenia. Po drugie — oszklenie ponad zagłębieniem ma zachować dotychczasowy kształt kadłuba. Po trzecie, należy na to wszystko nałożyć fragment blachy (ramkę oszklenia), którego kształt także ma być gładką kontynuacją grzbietu kadłuba. Pewną możliwość na ewentualne drobne korekty (poniżej 1mm) pozostawia właśnie ta blacha, a właściwie jej grubość. W końcu na prawdziwym samolocie pokrycie także miewa niewielkie wgłębienia i wypukłości.
Zacznij od stworzenia pomocniczej kopii kadłuba bez wgłębienia. Chodzi tu o referencyjny wzorzec kształtu — podobny do tych, jakie wykorzystywaliśmy do sprawdzania otworów na masce silnika (por. str. 171). Nadaj mu nazwę B.300.T.Fuselage.
Jaki kształt mogło mieć zagłębienie za nagłówkiem pilota ? Spróbowałem zastosować fragment okręgu, którego promień i środek pokazuje Rysunek 3.14.2a). Wytłoczyłem go w fragment walca, i wyznaczyłem krawędź przenikania z grzbietem kadłuba Rysunek 3.14.2b):
Rysunek 3.14.2 Fragment walca — powierzchnia zagłębienia za kabiną pilota
Promień walca (Rysunek 3.14.2) dobrałem “na oko”, na podstawie zdjęć. O dziwo, krawędź przenikania z grzbietem kadłuba już przy pierwszej próbie okazała się całkiem dobra. Leży w odległości mniej więcej 3-4 cm (na oryginalnym samolocie) od zewnętrznego konturu ramki oszklenia (Rysunek 3.14.3):
Rysunek 3.14.3 Krawędź zagłębienia dla walca jest zgodna z rzutem z boku
(Blacha, którą przymocowano oszklenie, była przynitowana wzdłuż krawędzi wgłębienia. Musiała być szersza od konturu zagłębienia o “zakładkę” dla szwu nitów).
Muszę przyznać, że liczyłem się z koniecznością wykonania kilku przybliżeń tego wgłębienia. Odchylenia od krawędzi przenikania dwóch powierzchni zależą od błędów kształtu każdej z nich. Zazwyczaj błędy się sumują, a nie znoszą. Zarys konturu blachy, w rzucie z boku, został zweryfikowany ze zdjęciami (por. Tom I), więc jest całkiem niezłym testem. Poprawna krawędź przecięcia może świadczyć o prawidłowym doborze przekroju poprzecznego grzbietu kadłuba1. Dlaczego zaproponowałem na kształt wgłębienia fragmentu prostego cylindra? To czysta intuicja, wsparta przypuszczeniami2.
Skoro ten potencjalnie trudny fragment pracy udało się nam uzyskać tak łatwo, przejdźmy do następnego etapu. Wkomponuj krawędź przecięcia w siatkę kadłuba, usuwając ściany wewnętrzne (Rysunek 3.14.4):
Rysunek 3.14.4 Włączona w siatkę kadłuba uproszczona krawędź przenikania,
Przy okazji usuń z krawędzi przecięcia nadmiarowe (tzn. umieszczone blisko siebie) wierzchołki.
Następnie włącz (Join Objects) powłokę cylindra w siatkę kadłuba (Rysunek 3.14.5):
Rysunek 3.14.5 Dodanie powierzchni walca do siatki kadłuba
Po włączeniu cylindra wstaw (Loop Cut) w jego siatkę dwie dodatkowe wręgi. Umieść je tam, gdzie się znajdują odpowiednie wręgi powłoki kadłuba (Rysunek 3.14.5). Potem usuń niepotrzebne ściany z powierzchni cylindra (Rysunek 3.14.6):
Rysunek 3.14.6 Usunięcie niepotrzebnych ścian powłoki walca
Teraz pozostaje utworzyć nowe ściany. Przy okazji “optymalizacji siatki” usuń jeszcze kilka mniej potrzebnych wierzchołków na krawędzi wgłębienia (Rysunek 3.14.7a). Samą krawędź pozostaw lekko zaokrągloną (crease = 0.5) — tak, jak było w prawdziwej konstrukcji (Rysunek 3.14.7b):
Rysunek 3.14.7 Powłoka walca po scaleniu z resztą kadłuba
Wgłębienie w kadłubie jest gotowe, teraz uformujemy powierzchnię, z której powstanie oszklenie i jego ramka. Z utworzonego wcześniej (por. str. 179) wzorca B.300.T.Fuselage wydziel (Separate) odpowiedni fragment powłoki (Rysunek 3.14.8):
Rysunek 3.14.8 Początek formowania oszklenia za kabiną pilota: skopiowanie fragmentu oryginalnej powłoki kadłuba
Aby lepiej odwzorować krawędź tego elementu, wstaw (Loop Cut) w odpowiednie miejsca siatki dodatkowe wręgi. Ramka miała na zewnątrz dwie kanciaste “wypustki”, ułatwiające przynitowanie do podłużnic. Dodanie wręg w okolicy tych załamań jest konieczne (Rysunek 3.14.9):
Rysunek 3.14.9 Nacięcie (Knife) zewnętrznej krawędzi oszklenia
Po przygotowaniu siatki wytnij w niej (Knife) krawędź ramki oszklenia (Rysunek 3.14.9). (Nacinamy, a nie np. wyznaczamy przecięcia z nową powłoką walca, gdyż kształt jest tu ściśle określony). Podczas nacinania kieruj się przede wszystkim rzutem z boku. Potem usuń niepotrzebne ściany (Rysunek 3.14.10):
Rysunek 3.14.10 Siatka po usunięcie zbędnych ścian
Uzyskany kształt wymaga jeszcze dalszych poprawek. Po pierwsze — ściany wzdłuż krawędzi odstają nieco od powłoki kadłuba (tak się dzieje zawsze przy wycięciu fragmentu wygładzonej siatki).
Aby temu zaradzić, natnij (Knife) dodatkową podłużnicę wzdłuż górnej krawędzi powłoki (Rysunek 3.14.11a). To pozwoli dopasować poprzeczne wygięcie wygładzonych ścian oszklenia do powierzchni kadłuba (Rysunek 3.14.11b):
Rysunek 3.14.11 Dalsze dopasowywanie siatki — do oryginalnego wzorca (a) i do aktualnej powłoki kadłuba (b)
Dolna krawędź oszklenia nie ma “problemów z odstawaniem”, gdyż w tym obszarze ściany nie mają żadnego wygięcia. Poprzez nacięcie przemodelowałem ten fragment, przesuwając przedostatnią podłużnicę tak, by biegła wzdłuż ramki okna (Rysunek 3.14.11a). To wstęp do odwzorowania za pomocą oddzielnej krawędzi obrysu wewnętrznych otworów ramki (Rysunek 3.14.12):
Rysunek 3.14.12 Nowe krawędzie, wzdłuż wewnętrznych granic ramki oszklenia
Tylna krawędź szyby w P-40 B/C była łukiem. Możesz ją uzyskać wyznaczając przenikanie powłoki szyby z pomocniczym walcem, utworzonym z ośmioboku. Oprócz tego, za pomocą przesuwania krawędzi (Edge Slide) i wierzchołków (Vertex Slide) ułóż drugą od góry podłużnicę wzdłuż górnej granicy oszklenia. Po tych modyfikacjach układ krawędzi uległ pewnym zmianom (Rysunek 3.14.12). Na koniec wstaw dwie dodatkowe wręgi tak, by przechodziły przez środki okrągłych wlewów paliwa. Samych otworów na razie nie wykonamy, gdyż znajdowały się wyłącznie z lewej strony. Poczekaj z tym do momentu, gdy będzie trzeba tworzyć “prawe” kopie wszystkich “lewych” siatek — tak późno, jak tylko to możliwe. (Zawsze może wcześniej pojawić się konieczność poprawienia jakiegoś kształtu. Dopóki pracujemy na powierzchniach z włączonym modyfikatorem Mirror, dopóty taką poprawkę jest łatwiej wprowadzić)
Po co umieszczać w powłoce szyby zarys wycięć, które powinny się znaleźć nie na szybie, a na jej ramce? Dlatego, że ramkę zaraz utworzymy poprzez skopiowanie szyby. Im bardziej podobne ściany na obydwu powłokach, tym mniej będziemy mieli problemów z ich późniejszym dopasowaniem.
Powłoka szyby jest gotowa. Nadaj jej nazwę B.310.L.RearGlass. Powiel (Duplicate) ten obiekt w powłokę, z której utworzymy ramkę: B.315.L.RearFrame (Rysunek 3.14.13a):
Rysunek 3.14.13 Pogrubienie szkła i powielenie w drugi obiekt — ramkę
Nowo utworzoną powłokę ramki odsuń “o grubość blachy” (X: +0.007, Z: +0.007, czyli 1 mm po przekątnej) od powłoki “szkła”. Nie zaszkodzi umieścić jej na osobnej warstwie (M, szczegóły — str. 317), przynajmniej na czas formowania oszklenia kabiny. Samą szybę na koniec pogrub (Solidify) o 0.03 jednostki Blendera (to jest 3 mm — przypuszczam że miała taką grubość). Rysunek 3.14.13b) pokazuje szybę B.310.L.RearGlass po pogrubieniu. (Powłoka ramki jest tu ukryta na niewidocznej warstwie). Zwróć uwagę, że zewnętrzna powierzchnia szyby leży na powłoce kadłuba, o czym świadczą niewielkie “przebicia” powłoki wzdłuż krawędzi wgłębienia. Te “przebicia” zasłoni ramka, którą zaraz uformujemy.
Formowanie ramki zacznij od uzupełnienia o dodatkową wręgę — tak, by powstał “pasek” ścian, biegnący przez środek oszklenia. Potem usuń ściany z wnętrza przygotowanych wcześniej konturów otworu (Rysunek 3.14.14):
Rysunek 3.14.14 Usunięcie z “ramki” niepotrzebnych ścian
Po usunięciu ścian obiekt jest już bardzo zbliżony do ostatecznego kształtu. Pozostało jeszcze tylko trochę popracować nad “fazkami” blachy w narożnikach. Na razie są tu naturalne zaokrąglenia powierzchni podziałowych.
“Fazki” blachy w narożnikach ramek kabin występują w większości samolotów lat 30 i 40-tych (kwestia technologii). Rysunek 3.14.15a, b) pokazuje, jak je odwzorować za pomocą tylko jednej dodatkowej ściany:
Rysunek 3.14.15 Wykonanie fazki w narożniku ramki
Wreszcie — pogrub (Solidify) powłokę ramki “o grubość blachy”, czyli 0.01 jednostki Blendera (1 mm) (Rysunek 3.14.16):
Rysunek 3.14.16 Ramka po pogrubieniu (o “grubość blachy”) i wyostrzeniu krawędzi
Przednia krawędź oszklenia miała w P-40 dodatkowe wzmocnienie (była grubsza). Przy próbie lokalnego pogrubienia przedniej ramki polecenie Solidify pochyla obydwie ściany. W takiej sytuacji lepiej jest pogrubić lokalnie “szkło” (B.310.L.RearGlass), bo tu przynajmniej tylna krawędź wychodziła poprawnie (Rysunek 3.14.17):
Rysunek 3.14.17 Pogrubienie fragmentu “szkła” w początkową wręgę
Modelując początkowe wzmocnienie, pogrubiliśmy obiekt reprezentujący szkło, zamiast ramki. Nie jest to jednak jakaś szczególna komplikacja — potem temu fragmentowi siatki “szkła” przypisze się materiał reprezentujący dural, a nie pleksiglas. (W Blenderze różnym fragmentom tej samej siatki można przypisać różne materiały — por. str. 379).
Wzmocnienie przedniej krawędzi było ostatnim szczegółem, jaki należało wykonać. Rysunek 3.14.18 przedstawia ukończone oszklenie grzbietu kadłuba, wraz z ramką:
Rysunek 3.14.18 Gotowy, tylny fragment oszklenia kabiny
Otwory wlewu paliwa wytniemy po utworzeniu odrębnego obiektu reprezentującego prawą stronę owiewki (B.310.R.RearGlass). Oszklenie na razie pozostaje nieprzejrzyste. Zmienimy ją w prawdziwe szkło organiczne dopiero w sekcjach poświęconych materiałom.
Wydawało mi się, że to już koniec pracy nad tym fragmentem. Zabrałem się więc za przeglądanie zdjęć następnych elementów — owiewki i wiatrochronu. Zdecydowałem się skorzystać także z posiadanych zdjęć P-36, gdyż ten fragment kadłuba był w obydwu konstrukcjach niemal identyczny. (P-36 miał tylko jeden, ale nieco większy otwór w oszkleniu na wlew paliwa, oraz inną szynę po której przesuwała się owiewka). W trakcie tej pracy natknąłem się na następujące zdjęcie (Rysunek 3.14.19):
Rysunek 3.14.19 Fragment jednego ze zdjęć P-36 (USAAF)
Widać na nim wyraźnie, że “wycięcia” w grzbiecie kadłuba miały o wiele mniejszy promień, niż założyłem! Szybkie przejrzenie posiadanych zdjęć P-40 potwierdziło to spostrzeżenie. Skórzany zagłówek pilota, zdemontowana na tym zdjęciu, utrudniał na innych fotografiach dostrzeżenie właściwego kształtu tych wgłębień.
Bądź przygotowany na podobne “odkrycia”. Nikt nie jest nieomylny, więc zdecydowałem się w tej książce także pokazać, gdzie zdarzyło mi się popełnić błąd. Są one w końcu nieodłącznym elementem pracy nad modelem.
Rysunek 3.14.20a) przedstawia zarys poprawionego kształtu (w rzucie z przodu). Jak wykonać niezbędną korektę? Zacznij od krótkiej analizy, co trzeba zmienić. Zewnętrzna krawędź wgłębienia powinna pozostać bez zmian, bo jest zgodna ze zdjęciami. (Gdyby wytłoczyć nowy okrąg wzdłuż osi Y, tak jak to zrobiliśmy poprzednio — por. str. 179 — to wgłębienie byłoby dwa razy dłuższe).
Rysunek 3.14.20 Analiza poprawionej powierzchni wgłębienia
Wytłocz okrąg w walec, i dokonaj kilku “przymiarek”, przesuwając jego tylny przekrój. Okazuje się, że można uzyskać niemal identyczną krawędź przenikania z grzbietem kadłuba, jak dotychczasowa. Wystarczy, by walec był nieco odchylony na zewnątrz (wzdłuż osi X) i do góry (wzdłuż osi Z) (Rysunek 3.14.20b). To bardzo dobra wiadomość — zachowanie tej krawędzi oznacza, że nie trzeba będzie zmieniać ani oszklenia grzbietu kadłuba, a ni jego ramki.
Teraz pozostaje wymienić dotychczasowe ściany wgłębienia na nowe, pochodzące z przygotowanego przed chwilą walca. Zacznij od usunięcia wszystkich starych ścian (Rysunek 3.14.21a). Wstaw także (Loop Cut) w powłokę walca kilka wręg. Umieść je w takich miejscach, by dokładnie odpowiadały wręgom kadłuba.
Rysunek 3.14.21 Poprawka — usunięcie starych ścian i przygotowanie nowych
Potem pozostaje usunąć niepotrzebne ściany walca, pozostawiając tylko te wewnątrz wgłębienia (Rysunek 3.14.21b). Aby uzyskać wzdłuż krawędzi regularny ciąg wąskich ścian czworokątnych, wykonaj w pozostawionych ścianach pomocnicze nacięcia (Knife). Można także przesunąć te wierzchołki poleceniem Vertex Slide.
Rysunek 3.14.22a) pokazuje układ ścian po włączeniu nowej powierzchni do kadłuba. Obyło się bez żadnych “efektów ubocznych” — wgłębienie jest regularne, nie widać żadnych skaz kształtu (Rysunek 3.14.22b):
Rysunek 3.14.22 Rezultat poprawki — głębsze wycięcie za kabiną pilota
W ten sposób zakończyliśmy korektę tego fragmentu. Efekt finalny widziałeś już na str. 179 — jako pierwszą ilustrację umieściłem tam wstępny render ukończonego oszklenia grzbietu kadłuba.
Model z tej sekcji znajdziesz w pliku model\p40\history\P40B-4.14.blend (por. str. 18).
Podsumowanie
W tej sekcji wykonaliśmy wgłębienie inną (nieco dokładniejszą) metodą, niż wgłębienie przed wlotem powietrza do chłodnicy (por. str. 165). Metodą tu zastosowaną posłużyliśmy się wcześniej do wykonania szczegółów (osłony luf km, chwyt powietrza do sprężarki) osłony silnika (por. str. 169);
Poznałeś szybką i prostą metodę uzyskiwania “fazek” na ostrych krawędziach ramek oszklenia (str. 185)
W tej sekcji uformujemy przednią część kabiny. W P-40 zastosowano typowe dla tego okresu rozwiązanie, złożone z wiatrochronu i odsuwanej do tyłu owiewki (Rysunek 3.15.1):
Rysunek 3.15.1 Elementy osłony kabiny pilota
P-40B/C odziedziczył kabinę po P-36. Był więc to dość stary projekt — gdzieś z 1935r. Owiewka kabiny ma typową konstrukcję — to warstwa szkła, wzmocniona od spodu i z wierzchu ramkami z blachy. Wiatrochron P-40 był uformowany z wygiętego kawałka szkła organicznego. U góry przymocowano je do ramy kabiny, z dołu — bezpośrednio do poszycia kadłuba. Wzmocnieniem ramy wiatrochronu były dwa wewnętrzne “pręty” (tak je będę dalej nazywał). Miały dość mały przekrój, więc ich rola mogła być podobna do szprych w kole rowerowym: przenosiły tylko obciążenia rozciągające. (Takie obciążenie powodował np. napór powietrza podczas lotu). Do tych prętów od 1940r. przyłączano szyby pancerne, których konstruktorzy oryginalnie nie przewidzieli. Wydaje mi się, że nie było to dość pewne mocowanie. Najlepiej świadczy o tym fakt, że w kolejnej wersji samolotu (P-40D) cały wiatrochron uległ kompletnej przebudowie.
W naszym modelu wiatrochron i owiewkę utworzymy podobnie jak oszklenie grzbietu kadłuba, z dwóch obiektów: warstwy szkła oraz ramki. Dla uproszczenia nie dzielimy ramki na wewnętrzną i zewnętrzną — jej ściany będą przenikać przez szkło. Oczywiście, wykonamy także pozostałe szczegóły: pręty, szyny, oprofilowanie.
Formowanie zacznij od przygotowania okręgu, który będzie miał taki promień, jak grzbiet owiewki (Rysunek 3.15.2a) . Następnie “rozegnij” jego dolne wierzchołki w proste boki, i wytłocz wzdłuż osi Y (Rysunek 3.15.2b):
Rysunek 3.15.2 Uformowanie podstawowego kształtu owiewki
Kształt wiatrochronu zacznij formować od góry. Skopiuj wierzchołki grzbietu owiewki i powiel je (poprzez obrót) w trzy kolejne wręgi w kluczowych miejscach zaokrąglenia (Rysunek 3.15.3a). Połącz je następnie ścianami:
Rysunek 3.15.3 Uformowanie wiatrochronu
Dolną krawędź wiatrochronu uzyskasz poprzez wytłoczenie (wzdłuż obrysu szyby w rzucie z boku) ostatniej z wręg zaokrąglenia (Rysunek 3.15.3a). Powiększ nieco tę dolną wręgę (równo, względem wszystkich osi) względem środka leżącego na krawędzi wiatrochronu (Rysunek 3.15.3b). (Możesz łatwo tam umieścić kursor, zaznaczając na chwilę położony tam wierzchołek i wywołując polecenie Shift-S, Cursor to Selected). Wręgę powiększ tak, by krawędź przecięcia wiatrochronu z kadłubem nabrała kształtu widocznego na rysunkach i na zdjęciach samolotu. W końcowej fazie dopasowywania zacznij zmieniać skalę tylko wzdłuż osi X (przekształcając wręgę z łuku we fragment elipsy).
Przed ostatecznym dopasowaniem trzeba jednak uzupełnić ściany kadłuba o fragment, którego do tej pory nie uformowaliśmy. Wstaw (poprzez nacięcie - Knife) w siatkę kadłuba dodatkową wręgę, mniej więcej na wysokości ramki wiatrochronu (Rysunek 3.15.4a). (Przed nacięciem uprość układ ścian kadłuba przy skrzydle, łącząc na chwilę ścianę trójkątną z czworokątną). Wytłocz jednocześnie wzdłuż osi Y fragment narożnika kadłuba, tak by znalazł się dokładnie ponad naciętą wręgą (Rysunek 3.15.4a):
Rysunek 3.15.4 Uzupełnienie brakującego fragmentu kadłuba
Połącz przygotowane w ten sposób dwa odcinki wierzchołków w jedną wręgę, tworząc brakującą ścianę (Rysunek 3.15.4b). To obszar, na którym nastąpi przecięcie kadłuba z wiatrochronem.
Teraz możesz już dokładnie dopasować przednią krawędź wiatrochronu. Okazuje się, że największy wpływ na kształt linii przenikania z kadłubem ma pojedynczy wierzchołek (Rysunek 3.15.5a). To bardzo ułatwia dopasowanie — przesuń go wzdłuż osi X, aż uzyskasz odpowiedni efekt.
Rysunek 3.15.5 Dopasowywanie kształtu wiatrochronu i kadłuba
W ramach “końcowej kosmetyki” proponuję odrobinę rozsunąć (Edge Slide) dwie linie wierzchołków po obu stronach narożnika kadłuba (Rysunek 3.15.5b). W ten sposób zwiększysz w tym miejscu promień zaokrąglenia przekroju.
Ogólny kształt kabiny został uformowany, teraz czas na podział i szczegóły. Przygotowując się do tego etapu, odetnij (Knife) część wiatrochronu zasłoniętą przez kadłub (Rysunek 3.15.6a). Zrób to tak, by nie powstała żadna szczelina pomiędzy tymi dwoma powłokami. Po przecięciu uzyskasz dodatkowy wierzchołek, który warto przesunąć trochę do przodu (Rysunek 3.15.6a):
Rysunek 3.15.6 Przygotowywanie ramki wiatrochronu
Utwórz przednią krawędź przyszłej ramki kolejnym nacięciem (Knife) wzdłuż krawędzi łączącej wiatrochron i owiewkę (Rysunek 3.15.6b). Przy okazji zmień układ ścian u dołu powłoki, aby usunąć z niej przecięty trójkąt (ten odcinek nie był zakrzywiony, a dodatkowe wierzchołki niepotrzebnie komplikowałyby siatkę).
Odetnij (Knife) pod odpowiednim kątem tylną krawędź owiewki (była bardziej pochylona niż przednia). Kolejnym nacięciem nanieś w jej pobliżu krawędź pomocniczą, nieco węższą od przyszłej ramki (Rysunek 3.15.7a):
Rysunek 3.15.7 Nadawanie ostatecznego kształtu owiewce
Po nacięciu odsuń (Shrink/Fatten) do wnętrza tylną krawędź o przybliżoną grubość ramki (ok. 0.08 jedn. — 8mm). (Ramka owiewki P-40 miała z tyłu miała takie zagięcie). Potem dopasuj tylną krawędź do grzbietu kadłuba. Pozostaw pomiędzy owiewką i kadłubem szczelinę o grubości ok. 0.1 jednostki Blendera (1 cm). Wydaje mi się, że taki właśnie dystans jest widoczny na zdjęciach tego fragmentu samolotu.
Tylny przekrój owiewki był nieznacznie węższy i niższy od przedniego (dosłownie o kilka milimetrów). Na mniejszą wysokość wskazuje lekkie pochylenie górnej krawędzi szkła w rzucie z boku. (Wydaje się być także widoczne na zdjęciach). Na mniejszą szerokość — mała “falbanka” blachy wokół szyny, po której poruszała się owiewka (por. str. 189, Rysunek 3.15.1 oraz str. 196, Rysunek 3.15.15b)
Po dopasowaniu tylnej krawędzi owiewki do kadłuba nadszedł czas na podział uformowanej powłoki kabiny na dwie podstawowe części. Zaznacz i oddziel (Separate) owiewkę od wiatrochronu (Rysunek 3.15.8):
Rysunek 3.15.8 Podział oszklenia na wiatrochron i owiewkę
Rysunek 3.15.8 podaje, jakie nazwy nadałem obydwu obiektom. Po pogrubieniu będą pełnić rolę powierzchni ze szkła organicznego.
Czas przystąpić do formowania ramki wiatrochronu. Skopiuj (Duplicate) B.320.WindshGlass w nowy obiekt — B.330.WindshFrame. Potem usuń z tej nowej powłoki niepotrzebne ściany (Rysunek 3.15.9a). Ramkę wiatrochronu pogrub “na grubszą blachę” (0.02 jedn. Blendera — 2mm). Tylną krawędź potraktuj inaczej: wytłocz górny łuk tak, by wyglądał jak grubsze żebro, a boczne słupki — jak lite pręty, o przekroju klina i szerokości ok. 1 cm (Rysunek 3.15.9a). Dodaj też u góry spłaszczoną na obydwu końcach rurkę (Rysunek 3.15.9c). Sądzę, że lepiej zrobić z niej oddzielny obiekt (B.331.WindshTube). (Ze zdjęć wynika, że w odróżnieniu od reszty owiewki była w naturalnym kolorze metalu.)
Rysunek 3.15.9 Wydzielenie i uformowanie ramki wiatrochronu
Ramka wiatrochronu miała także dolną, niewidoczną część (Rysunek 3.15.10a). Ten fragment pełnił jednocześnie rolę wzmocnienia krawędzi poszycia kadłuba1. Aby ją uzyskać, wytłocz prostokątny przekrój wzdłuż krawędzi przenikania wiatrochronu i kadłuba. Każda wręga uzyskanej w ten sposób powłoki jest inaczej zorientowana w przestrzeni (Rysunek 3.15.10b):
Rysunek 3.15.10 Dodanie dalszych elementów ramki wiatrochronu
Jest z tym trochę roboty — przed każdym kolejnym wytłoczeniem trzeba zmieniać projekcję, ustawiając ją prostopadle do kolejnej ściany wiatrochronu. Potem trzeba jeszcze poprawić zewnętrzny obrys tak, by leżał dokładnie na płaszczyźnie szkła wiatrochronu. (Nie powinien ani wystawać, ani być szczególnie zagłębiony.) Uformowanie tego fragmentu, wraz z dopasowaniem do powierzchni wiatrochronu, zajęło mi jakąś godzinę. Być może istnieje łatwiejszy sposób, by uzyskać taką “pogiętą rurę”. Sądzę jednak, że straciłbym więcej czasu na eksperymenty, niż zużyłem na jej wykonanie opisaną metodą.
Po uformowaniu dolnej części ramy wiatrochronu wstaw w nią dwa wewnętrzne pręty (Rysunek 3.15.10a) . Wykonaj je jako oddzielne obiekty. Nadałem im nazwy B.333.R.WindshWire i B.333.L.WindshWire. Środkiem (tzn. punktem odniesienia — ang. origin) każdego pręta uczyń jego górny koniec. To ułatwi późniejsze dopasowywania do spodu ramki — wystarczy je obrócić wokół globalnej osi X.
Dla łatwiejszego odróżnienia od kadłuba nadałem ramce (na czas pracy) kontrastowy, sztuczny kolor przypisując jej czerwony materiał Artifical. Teraz zmodyfikuj kadłub: wkomponuj w jego siatkę krawędź przecięcia z wiatrochronem (Knife, a później reorganizacja ścian). Będzie to przednia krawędź otworu kabiny. Wytłocz także boczne zakończenia ścian kadłuba (wzdłuż boków owiewki — Rysunek 3.15.11):
Rysunek 3.15.11 Modyfikacja siatki kadłuba wokół kabiny
Przy okazji można zamknąć ścianą otwór, ziejący do tej pory z tyłu, za kabiną. Umieść tam (poprzez wytłoczenie, a potem zmianę skali nowej krawędzi wzdłuż osi X do zera) górną część pancernej płyty, osłaniającej pilota (Rysunek 3.15.11).
Wróćmy jeszcze na chwilę do wiatrochronu. Z analizy zdjęć wynika, że jego wewnętrzne pręty biegły równolegle do powierzchni szkła. Sprawdź to, przykładając w ich płaszczyźnie utworzoną na chwilę płaską powierzchnię (Rysunek 3.15.12a). W moim przypadku okazało się konieczne poprawienie kąta pochylenia słupka. W efekcie jego “gniazdo” stało się o wiele bardziej odległe od ramki. Trzeba było “wyciągnąć” tylną powierzchnię dolnej ramki wiatrochronu w masywne zgrubienie (Rysunek 3.15.12b) . Takie właśnie zgrubienie widać także na zdjęciach z wnętrza kabiny P-40 B/C. Na szczęście nie miało to wpływu na przednią krawędź ramy, dopasowaną do kadłuba. (Dopóki dodajesz nowe wierzchołki wyłącznie na tylnej krawędzi ramki, kształt ściany przedniej pozostaje niezmienny).
Rysunek 3.15.12 Szczegóły ramki wiatrochronu
Pozostaw pomiędzy ramką a powierzchnią kadłuba niewielką szczelinę — na grubość szkła wiatrochronu (Rysunek 3.15.12b). Zwróć także uwagę, że dolny koniec słupka wiatrochronu wystaje poza obrys kadłuba (tak właśnie było w P-36 i P-40B/C).
Aby ten wystający koniec zasłonić, konstruktorzy nałożyli na ten fragment niewielką “łatkę” z wygiętej blachy. Najprościej jest ją wykonać, zaczynając od uformowania płaskiej płytki o obrysie „łatki” z boku (Rysunek 3.15.13a). Potem wystarczy poprzesuwać wierzchołki tej powłoki wzdłuż osi X, “układając” je na powierzchni kadłuba (Rysunek 3.15.13b):
Rysunek 3.15.13 Dodanie “łatki”, zasłaniającej wystającą ramkę wiatrochronu
Kolejnym elementem jest szyna, po której przesuwała się owiewka kabiny pilota (B.337.CanopyRail) . Aby ją wyróżnić, przypisałem temu obiektowi, podobnie jak ramce wiatrochronu, czerwony materiał (Artifical —Rysunek 3.15.14a). Szyna owiewki miała przekrój w kształcie litery “T”2. Mimo naszych starań zachowania na poziomie dolnej krawędzi owiewki stałej szerokości kadłuba, w połowie oszklenia za kabiną pilota kadłub staje się nieco węższy. Koniec zupełnie prostej szyny odstaje jego powierzchni na jakiś centymetr. Na szczęście, na zdjęciach z rekonstrukcji P-36 widać, że szyna była lekko wygięta do dołu. (P-36 miał taki sam tył, jak P-40B/C). Geometrycznie to bardzo ważne, bo nawet 1-2 cm niżej kadłub był szerszy, i można w ten sposób zachować stałą odległość pomiędzy szynami (Rysunek 3.15.14b):
Rysunek 3.15.14 Szyna owiewki kabiny
Szynę owiewki już stworzyliśmy, teraz czas na jej ramkę. Utwórz nowy obiekt — B.335.CanopyFrame — poprzez powielenie (Duplicate) powierzchni “szkła”, czyli przygotowanego wcześniej (str. 192) obiektu B.225.CanopyGlass. Aby łatwiej było trafić liniami wierzchołków w układ ramek, zagęść siatkę nowo utworzonego obiektu (Subsurf:Apply, z Subdivisions ustawionym na 1). Rysunek 3.15.15a pokazuje rezultat. Uformowany jest tu już także dolny fragment ramki owiewki. (Wygląda mi to na coś w rodzaju osłony poruszającego się po szynach “wózka”, do którego była przyczepiona reszta konstrukcji3).
Rysunek 3.15.15 Ramka owiewki kabiny — początkowe etapy formowania
Zwróć uwagę na narastającą wzdłuż dolnej krawędzi ramki “falbankę”, kryjącą krawędź szyny (Rysunek 3.15.15b). Jest widoczna na wszystkich zdjęciach. (Świadczy o nieznacznym zawężeniu tyłu owiewki).
Po przygotowaniu siatki można na niej naciąć (Knife) wewnętrzne krawędzie ramek (Rysunek 3.15.16):
Rysunek 3.15.16 Przygotowanie zarysu wewnętrznych krawędzi ramki
Ukośne “fazki” w narożnikach ramek dodaj na samym końcu, zastępując znajdującą się w tych miejscach ścianę prostokątną dwoma trójkątnymi (J).
Teraz usuń wierzchołki ze środka otworów i pogrub (Solidify) całą ramkę do wewnątrz o jakieś 0.08 jednostki Blendera (8 mm) (Rysunek 3.15.17). Założyłem, że grubość całego “sandwicza”: ramka zewnętrzna, szkło organiczne, ramka wewnętrzna, miała grubość 8mm. Równie dobrze mogło to być 9, 10 czy 11mm — trudno to dokładnie ustalić na podstawie zdjęć.
Rysunek 3.15.17 Ramka po usunięciu wnętrza otworów i pogrubieniu
Owiewki P-36 i P-40 miały ciekawe rozwiązanie awaryjne — lewy segment oszklenia mógł być uchylony do góry4. Wyglądało to tak, że w lewą ścianę owiewki była wkomponowana druga, cieńsza ramka, do której przymocowano szybę boczną (Rysunek 3.15.18a) . Po przejrzeniu zdjęć doszedłem do wniosku, że ogólna szerokość “pasków” ramki z lewej i z prawej strony jest identyczna. Dzięki temu możemy pozostawić zastosowany do tej siatki modyfikator Mirror, i dalej kształtować tylko symetryczną połowę siatki. Zdecydowałem się nanieść (Loop Cut) dodatkowe linie wierzchołków tam, gdzie występowały krawędzie uchylanej ramki. Przydadzą się, gdybyś chciał uszczegółowić model.
Rysunek 3.15.18 Dalsze szczegóły ramki owiewki kabiny
Na przedniej krawędzi owiewki znajdowała się wręga, usztywniająca jej konstrukcję5. Nanieś (Loop Cut) na dolną powierzchnię dwa położone blisko siebie rzędy wierzchołków. Następnie wytłocz je (jako region) i odsuń do wnętrza owiewki (Shrink/Fatten) (Rysunek 3.15.18b).
Ramka owiewki jest już gotowa. Pozostało już tylko jest pogrubienie powłok oszklenia (B.320.WindshGlass i B.325.CanopyGlass). Zrób to za pomocą polecenia Solidify(Rysunek 3.15.19):
Rysunek 3.15.19 Ostatnia czynność — pogrubienie powierzchni szkła kabiny
Przyjąłem, że grubość szkła wynosiła 4mm (0.04 jednostki Blendera). Oczywiście, to tylko moje przypuszczenie — równie dobrze mogło to być 3 lub 6mm.
Rysunek 3.15.20 Gotowa osłona kabiny — wyliczenie elementów
Rysunek 3.15.20 pokazuje gotową osłonę kabiny. Na koniec każdego etapu warto uporządkować wzajemne przypisanie obiektów (relacje Parent) oraz przypisania do warstw. Powierzchnie szklane (B.320.WindscrGlass, B.325.CanopyGlass, B.310.L/R.RearGlass) umieść na odrębnej warstwie (M, str. 317) — aby, w razie potrzeby, szybko je ukryć. Proponuję, aby to była warstwa 16. Pozostałe elementy ramek kabiny (Rysunek 3.15.20) umieść na drugiej warstwie: 17.
Całość składa się z dziesięciu elementów, więc warto ją zawczasu połączyć w hierarchię, aby nic się nie “zgubiło”. Proponuję przypisać “szkła” do odpowiednich ramek (B.320.WindshGlass do B.330.WindshFrame, B.325.CanopyGlass do B.335.CanopyFrame, a B.310.L/R.RearGlass do B.315.L/R.RearFrame). Potem każdą z ramek przypisz do kadłuba (B.300.Fuselage). Do ramki wiatrochronu (B.330.WindshFrame) przypisz także jego wzmocnienia (B.333.L/R.WindshWire, B.332.WindscrTube). Bezpośrednio do kadłuba (B.300.Fuselage) przypisz “łatki” (B.331.L/R.Patch) oraz szyny owiewki (B.337.L/R.CanopyRail).
Przygotowując się do tematu następnej sekcji, powtórnie przeglądałem zdjęcia kabiny P-40. Im dłużej się w nie wpatrywałem, tym więcej dostrzegałem niedokładności w modelu, który wykonaliśmy. Nie są duże, a tego typu niewielkie poprawki są normą na każdym etapie pracy. Omawiam je dopiero teraz, abyście nie sądzili, że jestem nieomylny ☺. Zacznijmy od bocznej krawędzi kabiny: powinna być nieco wyżej (Rysunek 3.15.21a):
Rysunek 3.15.21 Podniesienie krawędzi kabiny i poprawki w ramce owiewki
(Ze zdjęć wynika, że szyna owiewki była niemal na takiej samej wysokości, co górna krawędź “łatki”, a w naszym modelu była niżej). Trzeba było więc podnieść do góry i szyny, i krawędź kadłuba o jakieś 0.08 jednostki Blendera. To z kolei spowodowało konieczność podniesienia do góry “stopki” ramki wiatrochronu — aby nadal opierała się o krawędź kadłuba, a nie “tonęła” w jego wnętrzu.
Poprawek wymagała także ramka owiewki kabiny (Rysunek 3.15.21b) . Zdjęcia pokazują, że “falbanka” ponad krawędzią szyny miała mniejszą grubość, niż jej początkowo nadaliśmy. Jej krawędzie były także raczej ostre, a nie zaokrąglone. Nie “rozmywała” się zupełnie z przodu owiewki, jak zamodelowaliśmy poprzednio. Poza tym dolna ramka oszklenia była położona nieco niżej (o ok. 0.1 jednostki Blendera). (Wyszło mi to z porównania proporcji wysokości ramki pod i ponad “falbanką”).
Zdjęcia pokazały także, że kształt dolnej ramki wiatrochronu, wykonany na wcześniejszych stronach tej sekcji, był prawidłowy — ale dla wersji poprzedzającej P-40B! Oznaczano ją jako P-40 (bez żadnej litery) lub Tomahawk I, i produkowano w 1940r. Podobnie jak P-36, nie miała opancerzenia. Wraz z dodaniem przedniej szyby pancernej w P-40B, ramka wiatrochronu uległa zmianie. Pojawiło się na niej wybrzuszenie, pokryte z zewnątrz wygiętym poszyciem kadłuba (Rysunek 3.15.22a) :
Rysunek 3.15.22 Poprawki w zespole wiatrochronu
Pojęcia nie mam, co mogło być przyczyną takiej modyfikacji: zwiększone obciążenie ramy przez szybę pancerną? Doświadczenia z eksploatacji? Trzeba jednak ten szczegół odwzorować. Zacząłem od wzmacniających wiatrochron prętów. Obserwując ich mocowanie w ramce, doszedłem do wniosku, że miały wygięte końce. Pozwoliło to przesunąć je nieco do przodu (Rysunek 3.15.22b), i zmniejszyć pochylenie ich “gniazd” w ramce. Dzięki temu zaczęły wyglądać jak na zdjęciu (Rysunek 3.15.23a).
Rysunek 3.15.23 Poprawki w wiatrochronu — zmiana kształtu ramki i kadłuba
Ze zmianą kształtu samej ramki było trochę roboty. Po przesunięciu odpowiednich sekcji do góry, należało je powtórnie dopasować do powierzchni wiatrochronu. Potem trzeba było bardziej wygiąć powłokę kadłuba, aby pokryć zmieniony kształt ramki (Rysunek 3.15.23a). W rezultacie zagięte poszycie kadłuba tworzy w rzucie z przodu linię prostą (Rysunek 3.15.23b).
Model z tej sekcji znajdziesz w pliku model\p40\history\P40B-4.15.blend (por. str. 18).
Podsumowanie
Osłona kabiny jest pierwszym przykładem zespołu, który jest złożony z większej liczby elementów. Pamiętaj, aby od razu zadbać o nadanie całości właściwej hierarchii (relacjami Parent — por. str. 198);
Oszklenie kabiny zawsze warto trzymać na osobnej warstwie. W trybie wyświetlania Solid, w którym zazwyczaj pracujesz, powłoka oszklenia jest nieprzejrzysta. Zasłania wiele szczegółów ramki, które często będziesz chciał widzieć, chociażby podczas prac nad wnętrzem kabiny. Co chwila będziesz potrzebował zmienić widoczność powłok oszklenia. Włączenie/wyłączenie widoczności warstwy jest tu najprostszym rozwiązaniem (por. str. 198);
W trakcie prac, opisanych w tej sekcji, wykorzystywaliśmy poznane wcześniej techniki formowania. Nie pojawiło się już nic nowego. To wskazuje, że zdobyłeś już dużo doświadczenia!
Wnętrze kabiny — fotel pilota, tablicę przyrządów, szybę pancerną, zagłówek — wykonamy później, na etapie uzupełniania drobnych części. Teraz przygotujmy ściany kabiny pilota. Wręgi i podłużnice, biegnące wewnątrz kabiny, spełnią rolę “kratki”, która pozwoli nam lepiej porównać ze zdjęciami wzajemne proporcje poszczególnych elementów jej wyposażenia. Gdy szkielet burt będzie wyglądać jak na fotografiach, umieszczone na nich detale także powinny mieć poprawne rozmiary.
Przebieg podłużnic i wręg najlepiej rozpoznać, śledząc linie nitów na kadłubie. Układ tych linii, narysowany na planach koniecznie skonfrontuj ze zdjęciami — czasami znajdziesz różnice! Rysunek 3.16.1 pokazuje linie podłużnic i wręg, jakie posiadał P-40B/C (i P-36):
Rysunek 3.16.1 Określanie przebiegu wręg i podłużnic na podstawie linii nitów na kadłubie
Wśród wręg, które narysowałem, są dwie oznaczone kolorem żółtym (Rysunek 3.16.1). Wręgi te są widoczne na zdjęciach wnętrza kabiny, ale nie mają “swojego” szwu nitów na zewnątrz. Przypuszczam, że był to rodzaj “ścianek wewnętrznych”, przymocowanych nie do poszycia, tylko do podłużnic kadłuba. Wewnątrz kabiny nie odróżniają się od innych wręg, więc zamodelujemy je w ten sam sposób, co pozostałe.
Skopiuj tył kadłuba (B.300.Fuselage) w nowy obiekt. Nadaj mu nazwę B.301.Cockpit.001 i umieść na warstwie nr 17 (na innej niż kadłub). Usuń z jego siatki niepotrzebne ściany, pozostawiając tylko otoczenie kabiny (Rysunek 3.16.2a):
Rysunek 3.16.2 Uproszczenie siatki wewnętrznej ściany kabiny
Uprość tę siatkę (usuwając niektóre wierzchołki i tworząc nowe ściany). Przygotuj ją tak, by zawierała wyłącznie ściany czworokątne (Rysunek 3.16.2b). Między innymi — odłącz na chwilę od siatki dolną krawędź i połącz ją na nowo, tym razem bez trójkątnych ścian.
W tak przygotowanej siatce natnij (Knife) kolejne wręgi tam, gdzie biegły linie nitów. Większość podłużnic jest niemal w poprawnym miejscu — skoryguj tylko niektóre z nich drobnymi przesunięciami (Edge Slide) (Rysunek 3.16.3):
Rysunek 3.16.3 Gotowy układ wręg i podłużnic wewnętrznych ścian kabiny
Sprawdź, czy kształt powłoki nie uległ deformacjom w wyniku wprowadzonych zmian. Włącz widoczność warstwy z powłoką kadłuba (B.300.Fuselage). Aby łatwiej dostrzec różnicę, zmień barwę obiektu B.301.Cockpit.001 na czerwoną (materiał Artifical) (Rysunek 3.16.4a):
Rysunek 3.16.4 Ściany wewnętrzne: uzgodnienie kształtu i odsunięcie od zewnętrznej powierzchni kadłuba
Gdy wszystko się zgadza, odsuń (Shrink/Fatten) powłokę wnętrza kabiny od powierzchni kadłuba o “grubość blachy” — 0.02 jednostki Blendera. Przyjrzyj się, patrząc wzdłuż krawędzi, czy odsunięcie nastąpiło rzeczywiście wszędzie, na taką samą odległość (Rysunek 3.16.4b). Potem można z powrotem ukryć warstwę z powłoką kadłuba. (Możesz to także zrobić poleceniem Solidify, ale wtedy trzeba usunąć zewnętrzną powłokę)
Ostatnia wręga kabiny była litą płytą pancerną. Górny fragment tej ściany uformowaliśmy wcześniej, podczas prac nad osłoną kabiny (por. str. 194). Oddziel go teraz (Separate) z siatki kadłuba i włącz do tej siatki. Dolną część płyty proponuję wytłoczyć z ostatniej krawędzi siatki kabiny. Potem wystarczy przekształcić wytłoczoną krawędź w linię prostą, zmieniając jej skalę wzdłuż osi X do zera (Rysunek 3.16.5a). Teraz można uzupełnić brakującą ścianę pomiędzy górną i dolną częścią tej wręgi (Rysunek 3.16.5b). Zwróć uwagę na wąską “zakładkę”, jaką pozostawiłem wzdłuż górnej krawędzi płyty pancernej. To zabezpieczenie przed powstaniem przypadkowej szczeliny pomiędzy wewnętrzną ścianą kabiny i poszyciem kadłuba.
Rysunek 3.16.5 Utworzenie tylnej ściany kabiny
Wzdłuż wewnętrznych ścian kadłuba biegły wręgi i podłużnice. Zacznijmy od wykonania podłużnic: skopiuj siatkę ścian kabiny w nowy obiekt (B.301.Cockpit.002). Powiel (poleceniem Loop Cut) linie podłużnic. Zrób to tak, by odpowiednie linie były od siebie odległe o grubość podłużnicy (Rysunek 3.16.6):
Rysunek 3.16.6 Kopia ścian kabiny, przygotowana do przekształcenia w podłużnice
Po zdublowaniu linii podłużnic należy sprawdzić, czy żadna jej część nie wystaje ponad powłokę kadłuba. Dwa rzędy wierzchołków, umieszczone blisko siebie, dają efekt podobny do ostrej krawędzi (Rysunek 3.16.7a). W związku z tym zazwyczaj trzeba trochę zsunąć boki siatki wzdłuż osi X (Rysunek 3.16.7b). (Nowe linie zmieniły jej kształt, stała się bardziej wypukła i widać je ponad powierzchnią zewnętrznego poszycia kadłuba):
Rysunek 3.16.7 Kopia ścian kabiny, przygotowana do przekształcenia w podłużnice
Siatka jest przygotowana, czas na wytłoczenie z niej podłużnic. Zaznacz odpowiednie ściany (Rysunek 3.16.8a). Następnie wytłocz je do wnętrza (Extrude) — i powstała w ten sposób podłużnica (Rysunek 3.16.8b):
Rysunek 3.16.8 Wytłaczanie podłużnicy
Można także wytłaczać kilka elementów jednocześnie. Przydatne jest wówczas wstawienie (Loop Cut) pomiędzy wytłaczanymi obszarami dodatkowych rzędów wierzchołków (bez jakiegokolwiek kształtowania — to tylko separatory) (Rysunek 3.16.9a):
Rysunek 3.16.9 Formowanie podłużnic
Te pomocnicze rzędy wierzchołków pozwalają poprawnie zaznaczyć naraz kilka rzędów ścian do wytłoczenia. Rysunek 3.16.9b) pokazuje jednoczesne wytłoczenie czterech podłużnic. Można tak to robić, jeżeli wszystkie są zorientowane w ten sam sposób, i miały taką samą szerokość. Potem wystarczy usunąć niepotrzebne krawędzie i wierzchołki (bardzo to ułatwiają dodane przed chwilą pomocnicze linie siatki) (Rysunek 3.16.9c).
W podobny sposób formujemy zespół wręg. Umieść ten obiekt na oddzielnej warstwie. Tu po wytłoczeniu wierzchołków lepiej jest je odsunąć od ścian poleceniem Shrink/Fatten (Rysunek 3.16.10):
Rysunek 3.16.10 Formowanie wręg
Rysunek 3.16.11a) pokazuje wytłoczone wręgi, po “uwolnieniu” od niepotrzebnych wierzchołków. Nie wygląda to specjalnie realistycznie, prawda? Ale chwileczkę: teraz włącz warstwę z podłużnicami (Rysunek 3.16.11b). Prawda, że to złożenie przypomina już szkielet prawdziwego samolotu?
Rysunek 3.16.11 Złożenie wręg i podłużnic
Włącz jeszcze warstwę z wewnętrzną i zewnętrzną ścianą kadłuba (Rysunek 3.16.12a) . (Zmieniłem kolor wewnętrznych ścian na neutralny, by szkielet był bardziej wyraźny. Prawda, że całość wygląda dość realistycznie?
Rysunek 3.16.12 Połączenie z wewnętrznymi ścianami kabiny
Proponuję tak ją już pozostawić. Gdybyś chciał dokładniej cyzelować ten fragment, należałoby dodać wzdłuż każdej podłużnicy i wręgi płaskie pasy blachy, za pomocą których były przynitowane do kadłuba. (Podłużnice miały przekrój poprzeczny w kształcie litery “L”, i były dość wąskie. Wręgi — miały przekrój w kształcie litery “U”, z dwoma dodatkowymi, poziomymi paskami u końców). Nim zabierzesz się za tę pracę, warto abyś wiedział, że wnętrze kabiny jest zawsze mało widoczne na ostatecznym renderze. Wynika to z stosunkowo niewielkich rozmiarów elementów wnętrza, obecności szyb, oraz typowych kątów ustawienia kamery. Jeżeli więc nie przewidujesz jakichś szczegółowych zbliżeń kabiny — nie ma sensu odtwarzać jej zbyt szczegółowo.
Rysunek 3.16.12b) pokazuje drobny szczegół, który pozostawiłem na sam koniec: w wyniku upraszczania układu ścian pozostała szczelina pomiędzy wewnętrzną ścianą kabiny, a ramą wiatrochronu. Teraz, po wydzieleniu (w obiekt B.301.Cockpit.001) i utworzeniu wręg i podłużnic, z powrotem można odrobinę skomplikować siatkę ścian wewnętrznych, by tę szczelinę “załatać”. Wystarczy dodać dwie ściany, oparte o dwa dodatkowe wierzchołki.
Skoro już o mowa o ramce wiatrochronu (B.320.WindscrFrame), to pozostała na niej do wykonania charakterystyczna “wypustka” (Rysunek 3.16.13). Ten element pojawił się wraz ze zmianą kształtu ramki w P-40B/C. Wyraźnie stanowi dodatkowe mocowanie ramki do wręgi kadłuba. Nie chciałem go dodawać “na ślepo” w poprzedniej sekcji, nie wiedząc do końca , gdzie się pojawi wręga i jaką będzie miała szerokość. Teraz już można było to zrobić:
Rysunek 3.16.13 Połączenie ramki wiatrochronu z wręgami kabiny
Rysunek 3.16.13 pokazuje uformowaną “wypustkę” ramy wiatrochronu. Jej kształt i rozmiar starałem się ustalić na podstawie nielicznych zdjęć z Internetu, na których widać ten fragment wnętrza kabiny P-40B/C. W ten sposób uzupełniliśmy o ostatni element część, rozpoczętą w poprzedniej sekcji. Swoją drogą — ta rama miała bardzo złożony kształt. Jej dolna część mogła być jakimś aluminiowym odlewem lub odkuwką.
Po zakończeniu formowania warto zadbać o zbudowanie odpowiedniej hierarchii części. Przypisz wręgi (B.301.Cockpit.003) i podłużnice (B.301.Cockpit.002) do wewnętrznych ścian kabiny (B.301.Cockpit.001). Same wewnętrzne ściany przypisz do kadłuba (B.300.Fuselage). Każdy ze składników — ściany, wręgi i podłużnice — podczas tworzenia był umieszczany na innej warstwie. Teraz umieść je na jednej — powiedzmy warstwie nr 17. (Zewnętrzna powierzchnia kadłuba jest na warstwie nr 7, wydaje mi się, że w ten sposób będziesz mógł wzrokowo zapamiętać, że wewnętrzne szczegóły są na warstwie “o rząd niższej”).
Na tym zakończyliśmy (na razie) prace nad kabiną. Powrócimy do niej, gdy będziemy uzupełniać nasz model o drobne detale1. Jak się domyślasz, kabina pilota może zawierać ich całe mnóstwo!
Model z tej sekcji znajdziesz w pliku model\p40\history\P40B-4.16.blend (por. str. 18).
Podsumowanie
Wewnętrzne ściany kabiny, wraz z wręgami i podłużnicami, warto uformować jednocześnie z kadłubem. Podczas pracy nad nimi często możesz dostrzec jakieś błędy w kształcie dotychczas uformowanych powłok. Lepiej poprawić je teraz, nim kadłub “obrośnie” w dalsze szczegóły i będzie jeszcze trudniejszy do zmiany!
W tej sekcji poznałeś szybki sposób formowania całych zespołów wręgi i podłużnic — poprzez wytłaczanie regionem. Elementy uformowane w ten sposób od razu są dokładnie dopasowane do zewnętrznych ścian konstrukcji. W przyszłości ta metoda może Ci pozwolić nie tylko tworzyć wnętrze kabiny, ale całą strukturę płatowca. (W Internecie można znaleźć kilka takich bardzo interesujących modeli z „przeźroczystym” poszyciem — np. Mitsubishi A6M2 “Zero” na http://www2.cc22.ne.jp/~harada, albo Fokker Dr.I z http://www.airart3d.com).
Rysunek 3.17.1 przedstawia osłony podwozia głównego P-40. Jest to element specyficzny dla linii rozwojowej P-36/P-40, i nie występuje chyba w żadnym innym myśliwcu z okresu II wojny światowej1.
Rysunek 3.17.1 Osłony goleni podwozia głównego
Pracę należy zacząć od ustalenia, jak dokładnie wygląda ta osłona. Korzystając z fotografii, doszedłem do wniosku, że przekrój poprzeczny “gondoli” podwozia był nieco inny, niż na planach, których używam. Wyglądał na dość regularną elipsę (Rysunek 3.17.2):
Rysunek 3.17.2 Poprawiony obrys osłony podwozia
Nowy obiekt zacznij od wstawienia okręgu (Circle), złożonego początkowo z 16 wierzchołków. Przekształć go w odpowiednią elipsę. Umieść także po trzy dodatkowe wierzchołki tam, gdzie będą biec krawędzie otworu w gondoli, zamykanego przez boczną pokrywę. Te dodane wierzchołki powinny leżeć blisko siebie, i na jednej linii prostej (Rysunek 3.17.3a):
Rysunek 3.17.3 Uformowanie i wytłoczenie podstawowego profilu
Po dodaniu nowych wierzchołków koniecznie popraw położenie pozostałych, by ogólny kształt konturu nadal był jak najbardziej zbliżony do elipsy. Następnie wytłocz ten profil w obydwu kierunkach wzdłuż osi Y. Z przodu wstaw kilka coraz mniejszych profili, formując w ten sposób podstawowy kształt osłony (Rysunek 3.17.3b). Nadaj nowemu obiektowi nazwę B.150.R.Cover. Nazwa zawiera przyrostek .R, gdyż rysunek referencyjny przodu gondoli umieściłem pod prawym skrzydłem, i tam też jest nasz obiekt. Czasami jednak zachodzi potrzeba przymierzenia tej siatki do płata. W tym celu utwórz drugą instancję obiektu (Alt-D — Duplicate Linked) i nazwij ją B.150.L.Cover. Obydwa obiekty używają tej samej siatki (B.150.Cover). Aby ją zmienić, wystarczy przejść w tryb edycji jednego z nich.
Po wytłoczeniu kształtu podstawowej bryły (“wrzeciona”) należy dodać “przybudówkę”. (Ukrywała we wnętrzu boczne zamocowania goleni podwozia). Zacznij od narysowania jej profilu (Rysunek 3.17.4a):
Rysunek 3.17.4 Uformowanie i wytłoczenie wybrzuszenia z boku owiewki
Po narysowaniu wytłocz profil wzdłuż osi Y (Rysunek 3.17.4b). Na razie siatka tego bocznego “dodatku” nie jest w żaden sposób połączona z główną bryłą (“wrzecionem”). To nie przypadek — na czas formowania warto wstawić ją do tego istniejącego obiektu, który zawiera podstawową siatkę gondoli. Pozwala to na umieszczenie profili w tych samych, lub niemal tych samych miejscach “przybudówki”, co profile głównej powłoki (por. Rysunek 3.17.5b). Do poprawnego połączenia obydwu powłok potrzebne jest wyznaczenie ich krawędzi przecięcia. Możesz ją wyznaczyć dodatkiem Interesection, który jest dostępny także w trybie edycji (por. str. 310). Wystarczy zaznaczyć ściany „przybudówki”, i wywołać to polecenie z menu Specials.
Rysunek 3.17.5a) przedstawia siatkę „przybudówki” wydzieloną na czas przecięcia w nowy obiekt. (Tę część tworzyłem zanim zmodyfikowałem skrypt Intersection). Przygotowując zaokrąglenie biegnące wzdłuż krawędzi obydwu powłok, natnij (Knife) na “wrzecionie” dodatkową linię. Podobną linię na “przybudówce” można dodać poleceniem Loop Cut (Rysunek 3.17.5b):
Rysunek 3.17.5 Przygotowanie krawędzi przecięcia i jej otoczenia
Połączenie obydwu powłok wykonaj w ten sam sposób, jak kształtowaliśmy szczegóły maski silnika: usuwając stare ściany i budując nowe wzdłuż krawędzi przenikania (Rysunek 3.17.6a):
Rysunek 3.17.6 Połączenie siatek wybrzuszenia i owiewki
Ta technika pozwala uzyskać całkiem poprawny kształt połączenia (Rysunek 3.17.6b). Nie należy także zapominać o przygotowaniu krawędzi otworów w gondoli. Jak pamiętasz, radziłem aby zawczasu w profil początkowy “wmontować” po dwa współliniowe odcinki, o środku w miejscu krawędzi przyszłego otworu (str. 208). Z tych odcinków powstały rzędy ścian. Oznacz teraz krawędzie biegnące przez ich środki jako “ostre” (Rysunek 3.17.7a). Przy okazji wyprostuj linię krawędzi obrotu pokrywy bocznej (Rysunek 3.17.7b):
Rysunek 3.17.7 Przygotowanie krawędzi otworów
Uformowanie zewnętrznych krawędzi owiewki podwozia zaczniemy od wyznaczenia linii przecięcia z płatem (Rysunek 3.17.8a):
Rysunek 3.17.8 Ograniczenie krawędzi owiewki do obrysu płata
Potem włącz tę krawędź w siatkę. Najprościej jest to zrobić usuwając wszystkie ściany wzdłuż starej krawędzi siatki, i budując w to miejsce nowe, łączące krawędź przenikania z płatem z resztą siatki (Rysunek 3.17.8b). Starą krawędź usuń, za wyjątkiem obszaru z przodu owiewki. Tam wykorzystaj ją do zbudowania kolejnego rzędu ścian, tworząc coś w rodzaju „kołnierza” (Rysunek 3.17.9a):
Rysunek 3.17.9 Formowania przedniej krawędzi blachy owiewki
Wierzchołki tego "kołnierza" przesuń do przodu, wzdłuż osi Y. Każdy z nich przemieść inną odległość. by "położyć” przednią krawędź owiewki na krawędzi natarcia płata (Rysunek 3.17.9b, c). Przy okazji zmień barwę owiewki na kontrastową czerwień (materiał Artifical), by łatwiej dopasować jej powierzchnię do powierzchni skrzydła. Boczne krawędzie owiewki także płynnie przylegały do powierzchni samolotu. Aby ten efekt uzyskać, zacznij od wytłoczenia wzdłuż osi X każdej z bocznych krawędzi (Rysunek 3.17.10a):
Rysunek 3.17.10 Formowanie krawędzi bocznej
Aby promień zaokrąglenia pomiędzy owiewką i płatem był w miarę stały, natnij (Knife) z boku owiewki dodatkową krawędź (Rysunek 3.17.10b). Zrób to tak, by była mniej więcej równo odległa od powierzchni skrzydła Potem usuń poprzednią podłużnicę, która biegła w pobliżu nowej linii (na ilustracji już została usunięta).
Wytłoczone, zewnętrzne krańce siatki dosuń do powierzchni płata (Rysunek 3.17.11a). Popraw także ich położenie poprzeczne, by biegły prosto wzdłuż wręg skrzydła (Rysunek 3.17.11b):
Rysunek 3.17.11 Nadanie powłoce ostatecznego kształtu
Po nadaniu owiewce ostatecznego kształtu, zaznacz na niej obszar, który mają zajmować odchylane osłony goleni podwozia (Rysunek 3.17.12):
Rysunek 3.17.12 Przygotowanie do wydzielenia z owiewki otwieranych pokryw goleni podwozia
Skopiuj (Shift-D, Duplicate) ten fragment, a następnie wydziel go (P, Separate) w nowy obiekt (Rysunek 3.17.13a) :
Rysunek 3.17.13 Podział pokrywy podwozia na dwie części (jak w prawdziwym P-40)
Z uzyskanej siatki wydziel w kolejny obiekt boczną pokrywę goleni podwozia (Rysunek 3.17.13b).
Powróćmy jeszcze na chwilę do owiewki. Wzdłuż wszystkich „wolnych” krawędzi (tzn. tych, do których nie są zamocowane zawiasy pokryw podwozia) miała “zakładki”, o szerokości ok. 1 cm. Aby je wykonać, zaznacz obszar przyszłego otworu, i wytłocz tę powierzchnię (Extrude, Shrink/Fatten) do wnętrza owiewki na jakieś 0.02 jednostki Blendera (2mm) (Rysunek 3.17.14a,b):
Rysunek 3.17.14 Wytłoczenie obszaru otworów owiewki
Na wytłoczonej powierzchni natnij (Knife) kontury “zakładek” — tak, jak wyglądały na zdjęciach (Rysunek 3.17.15a). Potem wystarczy usunąć wewnętrzne wierzchołki, i mamy krawędź “jak prawdziwą” (Rysunek 3.17.15b) :
Rysunek 3.17.15 Wycięcie “zakładek” wzdłuż krawędzi otworów w owiewce podwozia.
Kierując się zdjęciami, wstaw teraz do owiewki ściany wewnętrzne (Rysunek 3.17.16):
Rysunek 3.17.16 Dodanie wewnętrznych ścian owiewki
Na zdjęciach te “ściany” to typowe usztywnienia wewnętrzne: kawałki perforowanej blachy. Perforacji na razie nie wykonamy, aby nie mnożyć niepotrzebnie wierzchołków modelu na tak drobny i mało widoczny szczegół2. Ściany najprościej jest uzyskać przez skopiowanie odpowiednich linii wierzchołków zewnętrznej powłoki, i wytłoczenie ich wzdłuż osi Z. Po uformowaniu, łączymy je z krawędziami otworów. (Wcześniej wytłocz krawędzie “zakładek” na grubość blachy — 1 mm). W ten sposób powstaje wewnętrzna powłoka owiewki (Rysunek 3.17.17) :
Rysunek 3.17.17 Rezultat — owiewka po połączeniu ścian wewnętrznych i zewnętrznych
Nie sądzę, aby w prawdziwym samolocie blacha owiewki miała większą grubość niż 1 mm. Nasza wewnętrzna powłoka jest odsunięta od zewnętrznej o sumę grubości i wytłoczenia “zakładek” krawędzi: 1 mm + 2 mm. Razem daje to 3 mm (0.03 jedn. Blendera — Rysunek 3.17.17). To dlatego, że nie będziemy modelować wewnętrznych szczegółów konstrukcyjnych: zakończeń zakładek (były tylko paskami grubej blachy) i innych drobiazgów. Oczywiście, jeżeli chcesz, możesz to zrobić, ale od razu ostrzegam, że na ostatecznym modelu chyba nikt ich nie zauważy. Podobnie jak pogrubienia powłoki owiewki z 1 do 3 mm w naszym modelu.
Po każdej takiej operacji warto uważnie obejrzeć nowo utworzone krawędzie. Z tyłu owiewki (por. Rysunek 3.17.17) możesz się natknąć na brzydką “nadlewkę” powierzchni podziałowej (Rysunek 3.17.18a) :
Rysunek 3.17.18 Częściowe rozwiązanie problemu “nadlewki” na ostrej krawędzi
Coś takiego powstaje, gdy jedna krawędź płaskiej ściany jest łagodnym łukiem, a druga — ma ostry narożnik. Gdy “gładki” i “ostry” narożnik znajdą się bardzo blisko siebie — następuje nałożenie ścian “łagodnego łuku” na “ostry kant”. Jeżeli chcemy zachować krzywiznę łuku nie możemy użyć żadnych kombinacji z nadaniem ostrości dodatkowym krawędziom. Jedynym rozwiązaniem, jakie znalazłem, jest zagęszczenie siatki — wstawienie w pobliżu “nadlewki” dwóch nowych krawędzi (Rysunek 3.17.18b). To minimalizuje niepożądany efekt poniżej granicy tolerancji. Warto zdawać sobie sprawę z tej przypadłości powierzchni podziałowych.
Ostatni szczegół, który pozostał do wykonania na owiewce, to zakończenie zewnętrznych krawędzi “na grubość blachy”. Wytłocz je prostopadle do powierzchni płata (ze względu na bardzo wygięty kształt — oddzielnie przód i oddzielnie boki) na jakieś 2 mm (Rysunek 3.17.19):
Rysunek 3.17.19 Zakończenie zewnętrznych krawędzi owiewki
Pozostały jeszcze do uformowania ruchome pokrywy podwozia, których powłoki wydzieliliśmy wcześniej (str. 211). Zacznijmy od mniejszej: nadaj jej nazwę B.160.L.SideDoor. Pogrub ją (oczywiście — do wewnątrz) używając polecenia Solidify na “grubszą blachę” — 2 mm (Rysunek 3.17.20a) :
Rysunek 3.17.20 Formowanie bocznej pokrywy podwozia — cz. 1
W pewnej odległości od krawędzi pokrywy były do niej przynitowane prostopadłe wzmocnienia. Aby poprawnie wyznaczyć ich położenie (nie mogą przecież nachodzić na “zakładki” krawędzi otworu w owiewce), przyłóż pokrywę do owiewki (Rysunek 3.17.20b). Natnij (Knife) na wewnętrznej powierzchni pokrywy po dwie równoległe linie, biegnące wzdłuż zewnętrznych krawędzi. Zachowaj pomiędzy nimi niewielką odległość — rzędu grubości blachy (Rysunek 3.17.20b).
Następnie wytłocz (Extrude) ściany wewnątrz naciętych krawędzi w kierunku “do wnętrza” pokrywy, na jakieś 1.5 cm (0.15 jednostki Blendera) (Rysunek 3.17.21a). (Najłatwiej jest odsunąć nowe ściany poleceniem Shrink/Fatten).
Na koniec wygładź “wolne” krawędzie wytłoczeń, aby nie miały “kanciastego” zakończenia (wystarczy przesunąć kilka wierzchołków w płaszczyźnie XZ) (Rysunek 3.17.21b). Ze zdjęć wynika, że boczna pokrywa podwozia wzdłuż jednej z krawędzi także miała “zakładkę”, podobną do tych umieszczonych wzdłuż krawędzi otworu owiewki. Wytłocz ją z pionowej ściany wzmocnienia (Rysunek 3.17.21b). (Wcześniej natnij na jego ściance dodatkową, poziomą krawędź, abyś miał obszar o grubości blachy, który można wytłoczyć).
Rysunek 3.17.21 Formowanie bocznej pokrywy podwozia — cz. 2
Boczna pokrywa podwozia jest uformowana, czas zająć się pokrywą główną. Nadaj jej nazwę B.155.L.MainDoor. Formowanie zacznij od drobnej poprawki kształtu: zdjęcia wykazują, że tylna krawędź tej pokrywy miała w P-40 fantazyjne wygięcie. Przesuń więc odpowiednio wierzchołki (Rysunek 3.17.22):
Rysunek 3.17.22 Główna pokrywa podwozia — korekta kształtu tylnej krawędzi
Następnie pogrub tę pokrywę “na grubość blachy” (czyli 2 mm — Rysunek 3.17.23a):
Rysunek 3.17.23 Główna pokrywa podwozia — formowanie wnętrza
Wewnętrzne ścianki pokrywy utworzymy jako oddzielny obiekt (B.157.L.MainDoor), z uproszczonego, prostokątnego obrysu (Rysunek 3.17.23b). To usztywnienie pokrywy miało liczne otwory, tak jak inne żebra. Nie będziemy ich teraz modelować “w siatce” — łatwiej je uzyskać później, za pomocą tekstury. Na ostatecznym obrazie przez te otwory będzie widoczna wewnętrzna powłoka pokrywy.
Po przygotowaniu “zgrubnych” kształtów wewnętrznych usztywnień, nasuń je na pokrywę i wyznacz (Intersection) krawędzie przecięcia z jej powierzchnią (Rysunek 3.17.24a):
Rysunek 3.17.24 Główna pokrywa podwozia — dopasowanie zewnętrznych krawędzi usztywnień
Po wyznaczeniu tych linii wystarczy usunąć z siatki usztywnienia dotychczasowe krawędzie zewnętrzne, podstawiając na ich miejsce krawędzie przecięcia. Rysunek 3.17.24b) pokazuje rezultat operacji. Oczywiście, na koniec przypisz (relacją Parent) usztywnienie (B.157.L.MainDoor) do pokrywy (B.155.L.MainDoor), aby już zawsze były traktowane jako całość.
Pozostaje jeszcze dołączyć pokrywy podwozia do owiewki. Proponuję to zrobić za pomocą pomocniczych obiektów — osi. Tak się szczęśliwie składa, że nie musimy ich ukrywać. W prawdziwej konstrukcji zawiasy pokryw były przymocowane do poszycia i miały kształt cylindra. Ich średnicę można szacować na podstawie zdjęć na 8 do 10 mm. Wstaw więc podłużne “pręty” o tej średnicy tam, gdzie mają się znajdować zawiasy. Osi głównej pokrywy nadaj nazwę B.165.L.Axis, a bocznej — B.170.L.Axis (Rysunek 3.17.25a) :
Rysunek 3.17.25 Zamocowanie pokryw do owiewki za pomocą osi
Teraz przypisz (relacją Parent) pokrywy do osi, a osie — do owiewki. (Owiewki z kolei przypisz do płata, o ile nie zrobiłeś tego wcześniej). W efekcie, obrót każdej osi wokół lokalnej osi Z powoduje realistyczne odchylanie pokryw (Rysunek 3.17.25b). Nie stworzyliśmy jeszcze zespołu goleni podwozia, ale nie zaszkodzi przyłożyć ukończoną owiewkę do rzutu z przodu z rysunków fabrycznych, aby się upewnić, czy wszystko pasuje (Rysunek 3.17.25b). Wygląda na to, że tak. Dolna krawędź owiewki jest nieco ponad obrysem, narysowanym na podstawie zdjęć. To zapewne efekt pochylenia owiewki, wraz z całym płatem, o -1º względem osi X (skrzydło było zamocowane pod tym kątem)
Rysunek 3.17.26 pokazuje ukończoną owiewkę “w pełnej krasie” — z otwartymi pokrywami luku podwozia.
Rysunek 3.17.26 Gotowa owiewka podwozia
Model z tej sekcji znajdziesz w pliku model\p40\history\P40B-4.17.blend (por. str. 18).
Podsumowanie
Owiewka podwozia P-40 jest dobrym przykładem elementu, który na pierwszy rzut oka wydaje się prosty, a potem okazuje się bardzo pracochłonny. Pamiętaj, że podobną ilość pracy może pochłonąć wykonanie wnęki podwozia, wraz z pokrywami, w innych samolotach. Wszystko zależy od tego, czy zaczniesz odwzorowywać szczegóły wewnętrzne, czy nie!
Jeżeli wewnętrzna struktura (wręgi, podłużnice) ma prosty kształt, który nie zależy od kształtu powłoki — można ją wykonać “zgrubnie”, jako oddzielny obiekt złożony z prostych płaszczyzn. Potem wystarczy te płaszczyzny “przyciąć” poleceniem Intersection, by pasował do poszycia (str. 215-216). Z kadłubem nie mogliśmy tak postąpić, bo jego podłużnice biegną równolegle do powierzchni poszycia.
W tej sekcji wykonamy oprofilowanie połączenia kadłuba z usterzeniem pionowym i poziomym. Ten fragment ma skomplikowany kształt (Rysunek 3.18.1a). Nie dość, że jest gładkim połączeniem dwóch prostopadłych stateczników, to jego przód musi być płynną kontynuacją grzbietu kadłuba:
Rysunek 3.18.1 Oprofilowanie krawędzi stateczników i kadłuba
W dodatku całość nie jest symetryczna wzdłuż osi poprzecznej (X — Rysunek 3.18.1b). Tak być musi, gdyż statecznik pionowy był odchylony od osi samolotu o 1,5º (Rysunek 3.18.2):
Rysunek 3.18.2 Przyczyna asymetrii oprofilowania — skręcenie statecznika pionowego
Początkową powłoką, którą zaczniemy przekształcać w owiewkę, jest górny tylny fragment kadłuba (Rysunek 3.18.3a) . Skopiuj go (Shift-D, Duplicate) z oryginalnej siatki i wydziel (Separate) w oddzielny obiekt. Nadaj mu nazwę B.360.TailFillet. Stwórz także kopie (Duplicate) stateczników (to obiekty pomocnicze — po zakończeniu pracy zostaną usunięte). Umieść je wszystkie na nowej warstwie (np.18).
Rysunek 3.18.3 Symetryczne powielenie wierzchołków fragmentu kadłuba i wyznaczenie krawędzi przecięcia z usterzeniem
Aby wyznaczyć krawędzi przenikania stateczników i kadłuba, w siatce B.360.TailFillet i obydwu kopii stateczników “utrwal” modyfikatory Mirror (Mirror:Apply — Rysunek 3.18.3a pokazuje efekt). Teraz wyznacz (dodatkiem Intersection) ich linie przenikania (Rysunek 3.18.3b).
Z uzyskanych krawędzi usuń niepotrzebne wierzchołki (np. te leżące blisko siebie). Następnie porównaj układ pozostawionych punktów z liniami siatki B.360.TailFillet. Wstaw (Loop Cut) w tę siatkę dodatkowe wręgi tam, gdzie wierzchołkowi na krawędzi przecięcia nie odpowiadała żadna linia (Rysunek 3.18.4).
Zaczniemy od formowania tego, co jest w owiewce symetryczne: oprofilowania krawędzi statecznika poziomego. W związku z tym ukryj (H, albo Specials→Hide) na razie krawędź przenikania ze statecznikiem pionowym. Usuń pozostałe wierzchołki z prawej strony siatki i włącz ponownie modyfikator Mirror (względem osi X — Rysunek 3.18.5b).
Natnij (Knife) na siatce nową krawędź, odpowiadającą dolnej krawędzi owiewki (Rysunek 3.18.5a) . Możesz zaraz potem usunąć wierzchołki leżące na zewnątrz tej linii (Rysunek 3.18.5b):
Rysunek 3.18.5 Nacięcie zewnętrznej krawędzi zaokrąglenia wokół statecznika poziomego
Natnij także w siatce wewnętrzną granicę owiewki (Rysunek 3.18.5b). Z kolei zewnętrzna krawędź oprofilowania leży na powierzchni statecznika. Aby ją wyznaczyć, przygotuj dwie pionowe powierzchnie pomocnicze, wygięte tak jak obrys krawędzi owiewki dla górnej i dolnej powierzchni usterzenia (Rysunek 3.18.6a):
Rysunek 3.18.6 Wyznaczenie krawędzi owiewki na stateczniku poziomym
Wyznacz (dodatkiem Intersection) krawędzie przecięcia tych dwóch powierzchni ze statecznikiem (Rysunek 3.18.6b). Potem te powierzchnie pomocnicze są już niepotrzebne i możesz je usunąć.
Połącz górną i dolną krawędź przecięcia w jedną linię. Usuń z niej niepotrzebne wierzchołki (np. jednym z każdej pary położonych blisko siebie punktów) (Rysunek 3.18.7a):
Rysunek 3.18.7 Budowanie zaokrąglenia wokół statecznika poziomego
Usuń ściany z wnętrza obszaru ograniczonego naciętą krawędzią zaokrąglenia statecznika poziomego. Na ich miejsce stwórz nowe, w oparciu o trzy wyznaczone wcześniej krawędzie (Rysunek 3.18.7b). W ten sposób włączysz je w siatkę. Na koniec dodaj (Loop Cut) dodatkową linię wzdłuż krawędzi na stateczniku (Rysunek 3.18.8a):
Rysunek 3.18.8 Profilowanie zaokrąglenia wokół statecznika poziomego
Widzisz już, co uzyskaliśmy? Poprzeczne zaokrąglenie wokół statecznika jest oparte w zasadzie na trzech liniach (dwie dodatkowe w pobliżu krańców to tylko “wyrównanie na śruby”, którymi była przykręcona owiewka). Profil zaokrąglenia zależy przede wszystkim od linii wewnętrznej (oryginalnej linii przecięcia statecznika z kadłubem). Przesuń odrobinę tę linię na zewnątrz, wzdłuż osi X, by uzyskać łagodniejszy profil (Rysunek 3.18.8b).
Podobną techniką wykonamy zaokrąglenie wokół statecznika pionowego. Odsłoń z powrotem (Alt-H) ukryte krawędzie (por. str. 219) i „utrwal” modyfikator Mirror tej siatki (Mirror:Apply) (Rysunek 3.18.9a) :
Rysunek 3.18.9 Pierwsze etapy modelowania zaokrąglenia wokół statecznika poziomego
Powielenie symetrycznych wierzchołków jest już konieczne, bo statecznik pionowy jest umieszczony niesymetrycznie (str. 218). Pamiętaj, aby przed powieleniem wierzchołków owiewki do ostatniego szczegółu ukształtować zaokrąglenie wokół statecznika poziomego. (Jeżeli o czymś zapomnisz, to po tej operacji będziesz miał dwa razy więcej roboty z ewentualnymi poprawkami!).
Podobnie jak w przypadku usterzenia poziomego, do wyznaczenia krawędzi owiewki na stateczniku pionowym używam powierzchni wygiętej tak jak obrys z boku jej górnej krawędzi (Rysunek 3.18.9b). Tym razem obrys był z obydwu stron taki sam, więc można użyć jednej, a nie dwóch powierzchni pomocniczych. Po wyznaczeniu przecięcia tej powierzchni ze statecznikiem uprość tę krawędź, usuwając powielone lub umieszczone blisko siebie wierzchołki (Rysunek 3.18.10a). Usuń także samą powierzchnię pomocniczą.
Rysunek 3.18.10 Budowanie krawędzi wokół statecznika pionowego
Natnij (Knife) na górnej powierzchni owiewki granicę zaokrąglenia wokół statecznika pionowego (Rysunek 3.18.10a). Usuń wierzchołki z jej wnętrza, pozostawiając tylko dwie wyznaczone wcześniej krawędzie (Rysunek 3.18.11):
Rysunek 3.18.11 Budowanie nowych ścian wokół statecznika pionowego
W oparciu o te trzy krawędzie zacznij budować nowe ściany (Rysunek 3.18.11). Potem wstaw (Loop Cut) linię wierzchołków w pobliżu górnej granicy owiewki (to taki “pasek na śruby”) (Rysunek 3.18.12):
Rysunek 3.18.12 Wstawienie dodatkowej linii wierzchołków
Podnieś trochę do góry, wzdłuż osi Z, środkową linię wierzchołków (Rysunek 3.18.13a). W ten sposób sterujesz poprzecznym zaokrągleniem owiewki. Nadaj mu kształt łuku o dość dużym promieniu. (W prawdziwym P-36/40 owiewka zakrywała rząd śrub, którym statecznik pionowy był przymocowany do statecznika poziomego).
Rysunek 3.18.13 Wykończenie kształtu wokół statecznika pionowego
Rysunek 3.18.13b) pokazuje gotową owiewkę. Po zakończeniu pracy usuń kopie statecznika pionowego i poziomego, których używaliśmy do wyznaczenia krawędzi przenikania i dopasowaniu kształtu owiewki. (Stworzyliśmy je na początku tej sekcji — str. 218). Przenieś gotową owiewkę na tę samą warstwę, co tył kadłuba i nadaj jej zewnętrznym brzegom „grubość blachy” — tak jak to robiliśmy z osłoną goleni podwozia w poprzedniej sekcji (por. str. 214).
Model z tej sekcji znajdziesz w pliku model\p40\history\P40B-4.18.blend (por. str. 18).
Podsumowanie
Oprofilowanie połączenia usterzenia z kadłubem było w P-40 bardzo “pogiętym” kawałkiem blachy. Na szczęście w większości konstrukcji z okresu II Wojny Światowej ten fragment ma bardzo podobny kształt. Możesz je wykonać dokładnie w ten sam sposób.
Oprofilowanie połączenia kadłuba i płata było w P-40 całkiem sporym elementem: zajmowało prawie połowę długości samolotu! Inna sprawa, że takie wielkie owiewki były “modne” w pierwszej generacji dolnopłatów, opracowanych w połowie lat 30-tych1. (Rekomendowała je NACA, a P-40 odziedziczył je wraz z całym kadłubem po P-36, którego kształt wyłonił się na deskach kreślarskich jesienią 1934r).
Ze zdjęć wynika, że owiewka płata w P-40 miała w zasadzie okrągły przekrój poprzeczny (Rysunek 3.19.1a). Zmieniał się w nieco mniej regularny tylko w przedniej części, wzdłuż osłony silnika. Dolna powierzchnia owiewki była płaską kontynuacją dolnej powierzchni płata (Rysunek 3.19.1b):
Rysunek 3.19.1 Owiewka połączenia skrzydła z kadłubem
Owiewkę płata moglibyśmy wykonać taką samą techniką jak owiewkę usterzenia: zbudować ściany w oparciu o trzy krawędzie, potem zaokrąglić. Sądzę jednak, że ta metoda nie nadaje się do tak dużych elementów. Trudno za jej pomocą uzyskać regularny, okrągły, przekrój poprzeczny wzdłuż całej długości oprofilowania. Tę owiewkę wykonamy więc metodą dokładniejszą, choć nieco bardziej pracochłonną.
Zaczniemy od wyznaczenia zarysów granic tego elementu: krawędzi na kadłubie i na skrzydle. Linie te będą pełniły rolę pomocniczą, o czym przekonasz się za chwilę.
Zewnętrzną krawędź owiewki wyznaczamy tak, jak krawędzie w poprzedniej sekcji: tworząc pomocniczą powierzchnię, wygiętą tak, jak krawędź oprofilowania w rzucie z góry (Rysunek 3.19.2a).
Rysunek 3.19.2 Powierzchnia pomocnicza, do wyznaczenia krawędzi owiewki na płacie
Zwróć uwagę, że krawędź owiewki “zachodziła” na krawędź osłony goleni podwozia (Rysunek 3.19.2b).
Siatka płata jest na tyle gęsta, że przecięcia jej krawędzi z powierzchnią pomocniczą w zupełności wystarczą do wyznaczenia konturu owiewki. Oznacza to, że podczas użycia dodatku Intersection możesz wyłączyć opcję Use bothmeshes (por. str. 309). Rezultatem będzie linia wierzchołków, należąca do siatki skrzydła (Rysunek 3.19.3a):
Rysunek 3.19.3 Wyznaczenie krawędzi owiewki
Przenieś tę linię do siatki owiewki (B.170.L.WingFillet): wydziel ją (Separate) z siatki płata w tymczasowy obiekt i włącz (Join) do owiewki (Rysunek 3.19.3b).
Wyznaczenie przeciwległej, kadłubowej krawędź owiewki, zacznij od rzutu z boku. Skopiuj wyznaczoną przed chwilą krawędź na płacie, powiększ ją, i „spłaszcz” wzdłuż osi X. Następnie dopasuj położenie wierzchołków tej linii tak, by jak najlepiej odwzorowały krawędź owiewki na kadłubie w rzucie z boku (Rysunek 3.19.4).
Rysunek 3.19.4 Uformowanie obrysu (rzutu z boku) drugiego krańca owiewki
Wyznaczoną krawędź wytłocz wzdłuż osi X, i wyznacz jej linię przecięcia z kadłubem (Rysunek 3.19.5):
Rysunek 3.19.5 Wyznaczenie drugiej krawędzi owiewki
Krawędzie, wyznaczone przed chwilą, będą pełniły rolę linii pomocniczych podczas kształtowania powłoki owiewki. Pozostawimy je na razie jako odrębny obiekt. Powierzchnię oprofilownia zacznij ją od narysowania i umieszczenia we właściwym miejscu jego przekroju poprzecznego — okręgu (Rysunek 3.19.6a) :
Rysunek 3.19.6 Początek formowania właściwej powłoki owiewki
Następnie przekształć ten okrąg w stożek (poprzez wytłoczenie i powiększenie nowej wręgi). Podstawę tego stożka umieść na krawędzi spływu skrzydła (Rysunek 3.19.6b). Jej rozmiar i położenie w płaszczyźnie ZX dobierz tak, by pasowała do założonych krawędzi owiewki (Rysunek 3.19.7a):
Rysunek 3.19.7 Zasada formowania stożka powłoki owiewki
Granica przenikania kadłuba i płata z powierzchnią prostego stożka daleka jest jeszcze od założonego obrysu (Rysunek 3.19.7a). Aby tę sytuację poprawić, wstaw (Loop Cut) w środek powłoki kolejną wręgę, i powtórnie dopasuj do płata i kadłuba jej rozmiar (poprzez zmianę skali i położenia w płaszczyźnie ZX — Rysunek 3.19.7b). Rysunek 3.19.8a) pokazuje powierzchnię, jaką uzyskasz metodą takich kolejnych przybliżeń. Rysunek 3.19.8b) pokazuje wnętrze tej powłoki — widać regularny przebieg linii styku z kadłubem i płatem:
Rysunek 3.19.8 Gotowa powłoka stożkowa, dopasowana do kadłuba i płata
Powierzchnia owiewki mieści się w 1 / 4 powierzchni stożka, który stworzyliśmy. Formowaliśmy go, używając pełnych okręgów aby łatwiej było zmieniać rozmiar pojedynczym sekcjom. (Dla okręgu środek skalowania w trybie Bounding Box leży w jego geometrycznym środku). Teraz jednak należy się pozbyć tego nadmiaru ścian. Usuń niepotrzebne wierzchołki — czyli 3 / 4 powierzchni stożka (Rysunek 3.19.9a):
Rysunek 3.19.9 Przekształcanie stożka w powłokę owiewki
Kolejnym krokiem jest usunięcie ścian leżących poza krawędzią oprofilowania na kadłubie (Rysunek 3.19.9b). Natnij (Knife) linię wzdłuż docelowego przebiegu krawędzi (Rysunek 3.19.9b), a następnie usuń wszystkie leżące ponad nią wierzchołki.
Rysunek 3.19.10 przedstawia rezultat — powłokę, która zaczyna przypominać docelowy kształt owiewki. Na ilustracji są zaznaczone zarysy konturów, stworzone na początku tej sekcji. Pomocniczy kontur na kadłubie dokładnie pokrywa się z krawędzią powłoki. Kontur na skrzydle znajduje się jednak wewnątrz uzyskanej powierzchni (łączy się z nią dopiero na krawędzi spływu — Rysunek 3.19.10). Taki przebieg krawędzi musi wystąpić, jeżeli przekrój poprzeczny ma być okrągły, a krawędź na kadłubie ma kształt jak na planach. Prawa geometrii wykazały różnicę. I co teraz można z tym począć? Pozostaje ocenić, który wariant jest bardziej prawdopodobny. Kontur owiewki jest pewny, bo dobrze udokumentowany na zdjęciach. Okrągły przekrój poprzeczny? — no cóż, wydaje mi się że właśnie taki kształt ma na zdjęciach. Natomiast nie ma żadnego “drugiego świadka”, który potwierdziłby wiarygodność kształtu zewnętrznego konturu owiewki z planów. Stąd zdecydowałem, że kształt przedstawiony na planach jest błędny.
Następną czynnością jest odcięcie niepotrzebnej już na tym etapie dolnej części owiewki. Natnij (Knife) na siatce linię tam, gdzie oprofilowanie miało krawędź spływu (Rysunek 3.19.11a):
Rysunek 3.19.11 Usunięcie niepotrzebnej, dolnej części owiewki
Usuń wierzchołki umieszczone poniżej naciętej linii (Rysunek 3.19.11b).
Przyjrzyjmy się na chwilę wynikowi, zestawiając go z planami (z rzutem z boku — Rysunek 3.19.12). Linią przerywaną podkreśliłem na nim zarys krawędzi owiewki na oryginalnym rysunku. Jak widzisz, jest zdecydowanie poniżej tej, którą uzyskaliśmy w wyniku cięcia powłoki. Nie przejmuj się, to błąd często występujący na planach modelarskich: autor rysując rzut z boku zapomina, że rysowane skrzydło ma wznios!
Rysunek 3.19.12 Porównanie położenia krawędzi owiewki z planami (M. Łukasika)
Uzyskana krawędź wymaga niewielkich poprawek, aby pasowała do rzutu z góry. (Ten obrys mamy zweryfikowany ze zdjęciami, więc możemy mu zaufać). Zrób to, przesuwając poszczególne wierzchołki krawędzi wzdłuż osi X (Rysunek 3.19.13):
Rysunek 3.19.13 Drobne poprawki kształtu krawędzi
Czas zaokrąglić tę krawędź: wytłocz z niej kolejną (Rysunek 3.19.14a). Odsuń ją na niewielką odległość wzdłuż osi Z (dokładniej: na grubość, jaką nadałeś krawędzi spływu skrzydła). Potem obróć te wierzchołki o kilka stopni do dołu, wokół krawędzi spływu płata (Rysunek 3.19.14b) aby uzyskać na końcu owiewki odpowiednie zaokrąglenie:
Rysunek 3.19.14 Wytłoczenie nowych ścian wzdłuż krawędzi
Teraz wytłocz utworzoną przed chwila krawędź wzdłuż osi X (Rysunek 3.19.15a). “Spłaszcz” ją (poprzez zmianę skali do zera wzdłuż osi X — Rysunek 3.19.15b). Przesuń tę nową krawędź do dołu, tak by dotykała dolnej powierzchni płata (Rysunek 3.19.15c) :
Rysunek 3.19.15 Formowanie spodu tylnej części owiewki (1)
Stworzyliśmy w ten sposób dolne ściany owiewki. “Ściśnij” utworzoną linię wierzchołków (poprzez zmianę skali wzdłuż osi Y, względem ostatniego punktu), by krawędź oprofilowania biegła wzdłuż krawędzi spływu płata (Rysunek 3.19.16a). Teraz, aby ściany owiewki przylegały do dolnej powierzchni kadłuba, wyprostuj ostatnią krawędź w linię prostą (zmiana skali do zera wzdłuż osi Z i obrót) i odsuń ją od osi kadłuba (Rysunek 3.19.16b):
Rysunek 3.19.16 Formowanie spodu tylnej części owiewki (2)
Aby zmniejszyć promień zaokrąglenia krawędzi spływu oprofilownia, wstaw (Loop Cut) pomiędzy jej górną i dolną krawędź jeszcze jedną linię wierzchołków (Rysunek 3.19.16c). (Potem przesuń nieco do kadłuba wzdłuż osi X sąsiednie linie). Popraw także wierzchołki przy końcu linii, wyginając krawędź na zewnątrz (Rysunek 3.19.16c). “Nasuń” owiewkę na krawędź spływu płata poprzez wytłoczenie dodatkowej, wąskiej ściany na jego granicy (Rysunek 3.19.17a):
Rysunek 3.19.17 Formowanie spodu tylnej części owiewki (3)
Uformowaliśmy w ten sposób gotową tylną część oprofilowania. Zwróć uwagę, że jej dolna krawędź biegnie wzdłuż kadłuba inaczej niż założona (Rysunek 3.19.17b). Tym niemniej tak to miejsce wyglądało na zdjęciach (fragment rzutu z boku, według którego stworzyliśmy wzorcowy zarys, nie był dokładny).
Pora połączyć uzyskaną powłokę ze stworzonymi wcześniej krawędziami pomocniczymi (Rysunek 3.19.18a). Scalę te dwie siatki i usuń wszystkie wierzchołki krawędzi pomocniczych za wyjątkiem tych biegnących wzdłuż okapotowania silnika. Połącz je ścianami — uformujemy z nich przednią część oprofilowania, która nie miała okrągłego przekroju poprzecznego (Rysunek 3.19.18b):
Rysunek 3.19.18 Formowanie przedniej części owiewki (1)
Zacznij “zaokrąglać” ten odcinek powłoki. Wstaw (Loop Cut) w pobliżu zewnętrznej krawędzi nową linię wierzchołków (Rysunek 3.19.19a). Przysuń ją do kadłuba i spłaszcz (nie do końca — Rysunek 3.19.19b). Potem dopasuj do obrysu z góry, poprzez zmianę skali wzdłuż osi Y (Rysunek 3.19.19c):
Rysunek 3.19.19 Wstawianie nowej linii wierzchołków w owiewkę
Wstaw w ten sposób trzy kolejne linie (Rysunek 3.19.20a). Potem złącz ten fragment z resztą owiewki (Rysunek 3.19.20b):
Rysunek 3.19.20 Połączenie przedniej i tylnej części owiewki
Pozostaje jeszcze wstawić dodatkowy wierzchołek w okolicy połączenia z owiewką goleni podwozia. Należy uformować w tym miejscu narożnik, aby krzywizna oprofilowania ułożyła się wokół wybrzuszenia owiewki (Rysunek 3.19.21a):
Rysunek 3.19.21 Ostatnie szczegóły wykończenia owiewki
Na zakończenie pogrub wszystkie zewnętrzne krawędzie elementu “o grubość blachy” (2mm — czyli 0.02 jedn. Blendera) (Rysunek 3.19.21b). To nada bardziej realistyczny wygląd połączeniu z powierzchniami płata i kadłuba.
Rysunek 3.19.22 pokazuje rezultat — ukończoną owiewkę:
Rysunek 3.19.22 Gotowa owiewka płata
Model z tej sekcji znajdziesz w pliku model\p40\history\P40B-4.19.blend (por. str. 18).
Podsumowanie
Oprofilowanie połączenia płata i kadłuba P-40 to typowa konstrukcja z połowy lat 30-tych XXw, zgodna z rekomendacją NACA: duża owiewka o okrągłym przekroju, którego promień wzrasta w kierunku krawędzi spływu;
Ze względu na rozmiar, taką owiewkę płata dobrze jest uformować w bardziej dokładny (i, niestety, pracochłonny) sposób, niż owiewkę usterzenia. Różnica polega na wstawieniu w narożnik płata i kadłuba wygiętego stożka. Z tej powłoki wycinasz potem fragment, tworząc powierzchnię owiewki;
Zbliżamy się do końca formowania “blach”, z których był zbudowany nasz samolot. Umieściłem tu opis tworzenia kilku mniejszych elementów, którym nie warto było poświęcać odrębnej sekcji, a które jednak powinny być opisane w tym rozdziale. Jakoś tak się składa, że wszystkie znajdują się na spodzie samolotu.
Zaczniemy od chłodnic cieczy. W głębi kanałów wlotowych P-40 widać było ich powierzchnie czołowe. Warto więc je wykonać, aby model oglądany z przodu nie straszył nierealistyczną dziurą. Z rysunków fabrycznych i zdjęć wynika, że chłodnice wszystkich wersji z silnikiem Allison miały prosty, cylindryczny kształt. Dwie większe, umieszczone po bokach, chłodziły glikol, a mniejsza, centralna — olej. Okręgi, odpowiadające czołowym ścianom chłodnic, przygotowaliśmy już przy okazji formowania osłony spodu silnika (str. 165). Wyciągnijmy je z warstwy części pomocniczych (Rysunek 3.20.1a):
Rysunek 3.20.1 Utworzenie zespołu chłodnic cieczy
Utwórz nowy, zamknięty cylinder o średnicy odpowiadającej jednemu z okręgów. Powinien składać się z 8 wierzchołków. Włącz jego wygładzenie (Subsurf), aby przypominał walec. Chłodnice cieczy i glikolu różniły się tylko rozmiarem. Utwórz pozostałe chłodnice, stosując tę samą siatkę (Duplicate Linked) — (Rysunek 3.20.1b). Możesz ją uprościć, włączając symetrie (modyfikator Mirror) wzdłuż osi X i Z (Rysunek 3.20.1c). Na ścianie czołowej wstaw (Loop Cut) dodatkową linię wierzchołków i zmień ją w ostrą krawędź. To zarys granicy czynnego (“przelotowego”) obszaru chłodnicy. Sądzę, że przyda się przy nakładaniu tekstur.
Rysunek 3.20.2 pokazuje formowanie kanału wlotowego powietrza do chłodnicy. Zacznij od wydzielenia krawędzi wlotu i stworzenia okręgu wokół czoła chłodnicy (Rysunek 3.20.2a). Okrąg powinien mieć taką samą liczbę wierzchołków co wlot. Następnie połącz te krawędzie ścianami. Potem w środek wstaw (Loop Cut) dodatkowe wręgi, i przesuń je, nadając kanałom wygięcie (Rysunek 3.20.2b):
Rysunek 3.20.2 Kanał doprowadzający powietrze do chłodnic
Po uformowaniu kanałów wlotowych wykonaj także wewnętrzne ściany wokół wylotu powietrza z chłodnic. Tu już konstruktorzy nie musieli robić oddzielnych kanałów (powietrze i tak wylatywało kompletnie zaburzone). Zacznij od wydzielenia z siatki okapotowania ścian bocznych (Rysunek 3.20.3a). Potem dodaj do tej siatki okręgi wokół chodnic. Połącz je ścianami tworząc wręgę (Rysunek 3.20.3b):
Rysunek 3.20.3 Wewnętrzna powierzchnia wylotu powietrza z chłodnic cieczy
W środku wylotu powietrza była umieszczona dodatkowa, centralna powierzchnia. Miała dość złożony kształt, który teraz uformujemy. Zaczniemy od krawędzi, którą pozostawiliśmy podczas formowania kadłuba (str. 146). Wydziel ją w nowy obiekt (Rysunek 3.20.4a):
Rysunek 3.20.4 Centralna powierzchnia wylotu powietrza — formowanie
Następnie wytłocz z tej krawędzi powierzchnię i zmień ją w coś w rodzaju stożka (Rysunek 3.20.4b). Dodaj także nową linię wierzchołków: fragment okręgu, otaczającego chłodnicę glikolu. Połącz ją z resztą siatki ścianami, tworząc coś w rodzaju drugiego stożka (Rysunek 3.20.5a):
Rysunek 3.20.5 Centralna powierzchnia wylotu powietrza — formowanie
Na koniec wstaw (Loop Cut) w tę siatkę kolejna wręgę, nadając jej odpowiednią krzywiznę (Rysunek 3.20.5b).
W P-36 i P40 powierzchnia, która zaczyna się w wylocie powietrza z chłodnicy, ma swoje przedłużenie aż do krawędzi spływu płata. Co kryło się pod spodem? Niedużo — przewody paliwowe oraz instalacja awaryjnego zrzutu paliwa1. Formowanie dalszej części tej osłony zacznij od krawędzi, wydzielonej (Separate) z jej przedniej części (Rysunek 3.20.6a). Wytłocz potem tę linię w powłokę (Rysunek 3.20.6b):
Rysunek 3.20.6 Osłona awaryjnego zrzutu paliwa
Każda wręga tej osłony jest fragmentem łuku. Początkowy kat rozwarcia tych łuków wynosił ok. 120º. Zdjęcia i zarys w rzucie z dołu wskazują, że przekrój tej powłoki zmieniał się wzdłuż cięciwy profilu skrzydła i ostatnie wręgi miały już przekrój złożony z połówek okręgów (kąt rozwarcia ok. 180º). Płynne przejście pomiędzy tymi przekrojami najłatwiej jest osiągnąć, tworząc najpierw “stożek”, łączący wręgę początkową i końcową. Potem wystarczy wstawiać (Loop Cut) kolejne wręgi w środek takiej powłoki. Po wstawieniu przesuwaj je od razu wzdłuż osi Z, aby uzyskać właściwy kontur osłony w rzucie z boku (Rysunek 3.20.6b, Rysunek 3.20.7).
Rysunek 3.20.7 Dopasowanie osłony do zadanego konturu
Nie zapomnij dodaniu zaokrąglenia na czołowej części osłony, która zaczynała się od szczeliny (Rysunek 3.20.6b, Rysunek 3.20.7)2.
Ze zdjęć wynika, że końcówka osłony była oddzielną częścią. Odseparuj ją więc od reszty powłoki w nowy obiekt (Rysunek 3.20.8a). Potem pozostaje wytłoczyć z krawędzi bocznych “zakładki”, za pomocą których osłona była przymocowana do dolnej powierzchni płata (Rysunek 3.20.8a,b):
Rysunek 3.20.8 Podział osłony i wytłoczenie bocznej “zakładki”
Ostatnim elementem zespołu chłodnicy są ruchome klapy, sterujące natężeniem przepływu powietrza. Zaczniemy od wytłoczenia wręgi, do której były przymocowane wewnętrzne ściany wylotu (Rysunek 3.20.9a):
Rysunek 3.20.9 Przygotowanie do montażu klap — wzmocnienie krawędzi wylotu powietrza
Może to nie będzie specjalnie widoczne, ale nie mogłem się powstrzymać, by nie spłaszczyć wewnętrznych krawędzi tej wręgi wzdłuż osi obrotu klap (Rysunek 3.20.9b). (Takie spłaszczenie jest widoczne na zdjęciach).
Same klapy zacznij od wstępnej przymiarki — ich kształt wyznaczy „łuk” złożony z czterech odcinków, wytłoczony na odpowiednią długość (Rysunek 3.20.10a) :
Rysunek 3.20.10 Wstępna “przymiarka” do rozłożenia klap wokół wylotu powietrza
Aby nadać tym klapom grubość, dodaj do siatki drugą, wewnętrzną powłokę, oraz włącz jej wygładzanie (modyfikatorem Subsurf — Rysunek 3.20.10b).
Utrwal wygładzenie (Subsurf:Apply) powłoki klap, i pozostaw z niej tylko fragment odpowiadający pojedynczej klapie — 4 segmenty (Rysunek 3.20.11a). Na razie usuń wewnętrzną powłokę i użyj polecenia Solidify, upraszczając kształt obiektu do wygiętego kawałka blachy, o stałej grubości. Umieść go centralnie, obracając o połowę kąta rozwarcia (Rysunek 3.20.11a). (Na chwilę będzie wyrównana do globalnego układu współrzędnych). Przypisz jej nowy środek (Object→Transform→Origin to 3D Cursor— por. str. 314) tam, gdzie wystąpi oś obrotu (Rysunek 3.20.11b):
Rysunek 3.20.11 Wydzielenie i uformowanie pojedynczej klapy
Po zmianie środka obróć klapę wokół środka pierścienia wylotu z chłodnicy tak, by znalazła się w prawidłowym położeniu3. Zdjęcia pokazują pomiędzy rozchylonymi klapami dodatkowe “uszczelnienia”. Zamodeluj je jako dodatkową, lekko wygiętą płytkę, ustawioną równolegle do bocznej krawędzi klapy. “Przymocuj” ją do niej relacją Parent. Umieść także (Duplicate Linked) z boku drugą klapę (Rysunek 3.20.12a). Obróć płytkę uszczelniającą wokół lokalnej osi Y, aby przylegała płasko do jej powierzchni (Rysunek 3.20.12a).
Do tej pory modelowaliśmy klapę w pozycji zamkniętej (także w tej pozycji pozostawiały trochę przestrzeni na wylot powietrza). Czas sprawdzić, jak taki zespół się porusza.
Rysunek 3.20.12 Sprawdzanie działania klap jako zespołu (zamykanie i otwieranie)
Gdy obrócisz obydwie klapy wokół ich lokalnych osi X o 35º, ustawisz cały zespół w pozycji otwartej (Rysunek 3.20.12b). W tej pozycji sprawdź, czy przednie krawędzie klap nie przenikają powłoki osłony chłodnicy. Jeżeli tak jest — odsuń obydwie klapy odrobinę do tyłu. (Pomiędzy przednimi krawędziami klap i osłoną występuje szczelina szerokości 3-4 mm).
Gdy klapy są w pozycji otwartej, przyjrzyj się płytce uszczelniającej: w tym położeniu powstaje pomiędzy nią i powierzchnią klapy widoczna szczelina (Rysunek 3.20.13a):
Rysunek 3.20.13 Sprawdzanie zespołu klap w położeniu otwartym
Rysunek 3.20.13b) pokazuje, widok wzdłuż krawędzi klapy. Widać na nim, że płytka jest nieco zadarta do góry. Wystarczy ją obrócić wokół jej lokalnej osi Y o 6º, by to skorygować (Rysunek 3.20.13c). Na razie pozostaw jednak tę szczelinę. W dalszych rozdziałach opiszę, jak “zmechanizować” model. Wtedy zmusimy te płytki (za pomocą tzw. ograniczeń — Constrains) by same się dopasowywały w ten sposób (por. Tom IV).
Rysunek 3.20.14 Klapy — wykończenie
Praca nad zespołem klap zbliża się do zakończenia. Dodaj jeszcze krawędź wewnątrz płytki uszczelniającej, i wydłuż ją wzdłuż lokalnej osi Y. To nada płytce lekkie wygięcie (wg zdjęć miała taki właśnie kształt) (Rysunek 3.20.14a).
Wytłocz (Extrude) z wewnętrznych powierzchni klap “kieszeń”, w którą chowały się płytki uszczelniające (Rysunek 3.20.14b). Zwróć uwagę, że górne powierzchnie tej “kieszeni” były płaskie. (Spłaszcz je po wytłoczeniu, zmieniając skalę wzdłuż lokalnej osi Z do zera). Ustaw je na koniec tak, by przednia krawędź “kieszeni” biegła wzdłuż osi obrotu klapy.
Dodaj (Duplicate Linked) kolejne dwie klapy z płytkami. Umieść je na właściwych miejscach (obracając wokół środka pierścienia klap). Rysunek 3.20.15 pokazuje gotowy zespół regulujący przepływ powietrza w chłodnicach
Wnęka podwozia głównego nie miała w P-40 żadnej pokrywy, poza samym kołem. Być może producent umieszczał w niej tekstylną (skórzaną?) wykładzinę, zabezpieczającą przed przenikaniem zanieczyszczeń do wnętrza płata. (Widać ją w niektórych odrestaurowanych egzemplarzach tego samolotu.) Sądzę jednak, że jeżeli nawet takie wykładziny były stosowane, to w warunkach polowych szybko szły w strzępy. Stąd należy zamodelować fragment wewnętrznej struktury płata, tworzący komorę koła głównego. Najszybciej można go uzyskać wytłaczając wzdłuż osi Z kontur komory w rzucie z góry. Potem wyznacz krawędź przecięcia takiej powłoki ze skrzydłem (Rysunek 3.20.16a):
Rysunek 3.20.16 Wnęka koła podwozia
Przyznam się, że nie wytrzymałem, i wstawiłem wzdłuż ścian wnęki podwozia podłużnice, widoczne na rysunkach fabrycznych i zdjęciach (Rysunek 3.20.16b). Wiem dobrze, że tych dziesięć ceówek pod górnym poszyciem płata ma nikłe szanse pojawić się na renderze. (W rzucie na ziemi będą niewidoczne, a w powietrzu są zasłonięte schowanym kołem.) To po prostu moja natura modelarza redukcyjnego kazała mi je wykonać.
Skoro już odtwarzamy takie szczegóły, to chyba jednak warto zabrać się za wnętrze klap skrzydła. Początkowo (por. str. 110) sądziłem, że to dużo roboty, a klapy były zamykane wkrótce po wylądowaniu samolotu, więc i tak nigdy nie było widać ich wnętrza. Jednak przy okazji tego samego “uszczegóławiania”, które kazało mi wypełnić podłużnicami wnękę podwozia, zdecydowałem się wydzielić i zamodelować ten zespół. Pocieszam się tym, że nie muszę jednak stosować do ich żeber wygładzenia powierzchniami podziałowymi. Elementy klap były w P-40 “kanciaste”, i można je uformować za pomocą stosunkowo niewielkiej liczby ścian. Otwory, występujące w żebrach, naniesiemy później za pomocą tekstur.
Pracę nad klapą zacznij od wydzielenia (Separate) jej powierzchni z reszty płata (Rysunek 3.20.17a). Wnękę w skrzydle uformuj jako oddzielny obiekt, umieszczony na innej warstwie. (Aby można było szybko wyłączyć ja z renderu, gdy nie jest potrzebna). Rysunek 3.20.17b pokazuje początkowy etap formowania wnęki klapy: to klin z załamaną powierzchnią wewnętrzną. Natnij na tej powłoce (Loop Cut) linie żeber, które za chwilę utworzymy:
Rysunek 3.20.17 Początek formowania klap skrzydła
Dalszym krokiem w formowaniu wnęki klapy jest usunięcie spomiędzy linii żeber dotychczasowych, poziomych ścian wewnętrznych. Na ich miejsce utwórz, w oparciu o te same wierzchołki, pionowe ściany (Rysunek 3.20.18a):
Rysunek 3.20.18 Formowanie wnęki klap skrzydła
Stwórz tylko prawe ściany żeber, aby wyglądały jak blacha z wygiętymi zakładkami (Rysunek 3.20.18b). W tym przypadku te elementy są za mało widoczne, by opłacało się nadać im “grubość blachy”. Dodaj także (kierując się liniami nitów, przedstawionymi na planach) trzy podłużnice, biegnące wzdłuż górnego poszycia płata (Rysunek 3.20.18a). To oddzielne ściany, nie powiązane z resztą siatki.
Uformuj na powierzchni klapy uskok, “omijający” wzmocnienie górnej powierzchni płata (chodzi o wzmocnienie pokazywane przez Rysunek 3.20.18). Następnie skopiuj tę obiekt (Duplicate, aby miał własną kopię siatki), i odsuń go od powierzchni zewnętrznej “na grubość blachy” (jakieś 2 mm). Rysunek 3.20.19a pokazuje obydwie powierzchnie (wewnętrzna jest szara, a zewnętrzna — czerwona). Przypisz powierzchnię wewnętrzną do oddzielnej warstwy — tej samej, do której należy ukończona przed chwilą wnęka klapy skrzydła4.
Ze zdjęć wynika, że blacha na krawędziach klapy była zawinięta (zapewne wokół jakiegoś płaskiego wzmocnienia). Z tego powodu warto pozostawić w siatce powierzchni zewnętrznej wygładzanie (modyfikator Subsurf). Zamodeluj odpowiednie zgrubienia wzdłuż przedniej i tylnej krawędzi zewnętrznej powierzchni klapy (Rysunek 3.20.19b):
Rysunek 3.20.19 Formowanie poszycia klapy
Boczne krawędzie klapy pozostaw bez “zawinięcia”, gdyż były zamknięte pełnymi żebrami.
Podłużnice, biegnące wzdłuż klapy, wytłocz z powierzchni wewnętrznej (Rysunek 3.20.20). Zdjęcia pokazują, że klapa miała przynitowany jeden większy ceownik, i jeden mniejszy kątownik:
Rysunek 3.20.20 Podłużnice klapy | Rysunek 3.20.21 Pojedyncze żebro klapy |
Żebra klapy można by wykonać w podobny sposób, co żebra jej wnęki — poprzez wytłoczenie nacięć wykonanych w powłoce wewnętrznej. Proponuję jednak wykonać je alternatywną metodą: z jednego, wzorcowego obiektu. (Będziesz miał okazję ocenić, który sposób jest lepszy). Utwórz wzorcowe żebro w typowym położeniu — gdzieś w środku klapy. Zorientuj jego siatkę tak w przestrzeni, by środek znajdował się na przedniej krawędzi klapy, i lokalna oś X biegła wzdłuż tej krawędzi (Rysunek 3.20.21).
Następnie powiel wzorcowe żebro (Duplicate Linked) we wszystkie pozostałe miejsca. Korzystaj przy tym z możliwości przesunięcia kopii wzdłuż lokalnej osi X. Różnice rozmiarów, występujące np. tam, gdzie żebro jest ustawione ukośnie, skompensuj zmianą skali obiektu wzdłuż lokalnej osi Y.
Rysunek 3.20.22 Szkielet klapy
Rysunek 3.20.22 pokazuje powielone żebra, tworzące szkielet klapy. Trudno jednoznacznie ocenić, która metoda była bardziej pracochłonna. Podczas tworzenia żeber we wnęce (str. 238) najwięcej czasu zajęło nacinanie (Loop Cut) ich zarysów na powierzchni (każde z nich to dwie linie, umieszczone w stałej odległości). Potem było także trochę klikania przy reorganizacji ścian. Najwięcej czasu podczas tworzenia żeber jako oddzielnych obiektów zajęła ich dokładna orientacja w przestrzeni. Powierzchnia klapy jest nieco skręcona (w wyniku różnic w grubości profilu u nasady i w środku płata). Spowodowało to konieczność indywidualnego obrócenia każdego żebra o pewien niewielki kąt. Ogólny czas wykonania w każdym przypadku był podobny i wynosił kilkadziesiąt minut.
Rysunek 3.20.23 pokazuje ukończony zespół. Klapy zostały “przymocowane” do płata poprzez oś (B.115.L.Axis), która tu “udaje” zgrubienie oryginalnych zawiasów:
Rysunek 3.20.23 Uformowana klapa
Ostatnim szczegółem, który pozostał do uformowania, to zespół komory kółka ogonowego. Sam otwór i ruchomą pokrywę ukształtowaliśmy podczas formowania kadłuba (str. 151). Teraz nadaj tej pokrywie “grubość blachy” (2 mm) . Wewnętrzne usztywnienie wykonaj tak samo, jak osłony podwozia głównego (str. 215) — uformuj je jako niezależny obiekt, a potem przetnij powierzchnią pokrywy (Rysunek 3.20.24a).
Rysunek 3.20.24 Pokrywa i wnęka kółka ogonowego
Wnęka kółka ogonowego nie miała żadnych dodatkowych ścian. Na niektórych zdjęciach widać osłaniający ją tekstylny (skórzany?) pokrowiec. Podtrzymując jednak założenie o szybkim zniszczeniu tego rodzaju osłon, musimy zamodelować całe wnętrze tylnej części kadłuba. Jeżeli zrobisz to taką samą metodą, jak wnętrze kabiny (str. 201), to umiarkowanym wysiłkiem uzyskasz całkiem realistyczny szkielet (Rysunek 3.20.24b).
Utwórz symetryczną kopię (Duplicate Linked) pokrywy kółka ogonowego, i przymocuj je kadłuba dwoma osiami (Rysunek 3.20.25). Podobnie jak pozostałe osie, są to dwa cienkie walce, „udające” zgrubienie zawiasów, użytych w prawdziwej konstrukcji.
Wykonanie wnętrza całego obszaru ogona ma jeszcze dodatkową zaletę — przez wycięcia w sterze kierunku widać realistyczną konstrukcję (Rysunek 3.20.26). Te otwory były w P-40 na tyle duże, że w pewnych ujęciach “czarna dziura” w tym miejscu mogłaby razić!
Model z tej sekcji znajdziesz w pliku model\p40\history\P40B-4.20.blend (por. str. 18).
Podsumowanie
Do modelu warto wstawiać chłodnice (str. 231) — ich powierzchnie czołowe mogą być widoczne w głębi kanałów wlotowych.
Klapy wylotu chłodnicy w P-40 (str. 234) wykonane zostały tak samo, jak typowe klapy osłon silników gwiazdowych (np. w P-47 Thunderbolt, A6M2 Zero, i innych). Klapy takie mają zazwyczaj prostszą konstrukcję — bez płytek “uszczelniających”.
Jeżeli w swojej scenie zamierzasz przedstawić model na ziemi — zazwyczaj trzeba wykonać wnętrze wnęk podwozia, przynajmniej głównego (str. 237). Rzadko kiedy znajdziesz jego szczegóły na planach — pamiętaj o wcześniejszym zebraniu odpowiednich zdjęć!
Uformowanie klapy skrzydłowych typu “krokodylowego” (jak w P-40) wymaga odtworzenia wewnętrznych szkieletów samej klapy i jej wnęki w płacie (str. 238). Warto je wykonać, jeżeli planujemy scenę z wychylonymi klapami (lub gdy cierpimy na typowo modelarską obsesję szczegółów).
Porównaliśmy (przy okazji formowania klap skrzydłowych) dwie metody odwzorowania żeber szkieletu:
- poprzez wytłoczenie z powierzchni (str. 237);
- poprzez powielenie pojedynczego żebra (str. 239);
Czas wykonania w każdej z metod był podobny, ale metoda wytłoczenia sprawdzi się nawet dla zmiennych kształtów (np. wytłoczenia wręg w ogonie samolotu). W takim przypadku każde żebro ma inny kształt i po prostu nie można zastosować metody powielenia takiej samej siatki.
Pokrywę kółka ogonowego wykonujemy takimi samymi metodami, jak pokrywy goleni podwozia głównego (str. 215);
Wewnętrzną strukturę ogona samolotu — widoczną przez otwór kółka ogonowego — wykonujemy w taki sam sposób, jak wewnętrzna strukturę ścian kabiny (str. 201);
Po gwałtownym rozwoju modelu, który miał miejsce w tym rozdziale, pora trochę uporządkować rezultat. Na przykład — coś trzeba zrobić z różnymi pomocniczymi powłokami, np. wzorcem kształtu kadłuba czy okapotowania silnika (por. str. 171) (Rysunek 3.21.1):
Rysunek 3.21.1 Elementy wzorcowe, pozostałe po formowaniu modelu
Wątpię, aby były nadal potrzebne, ale zdrowa zapobiegawczość nakazuje je “upchnąć w jakiś zapomniany kąt”. Chodzi o miejsce, w którym te wzorce nie przeszkadzałyby w niczym, a w razie czego byłyby “pod ręką”. Coś takiego można w Blenderze zrobić. Dla ich przechowania proponuję utworzyć w naszym pliku oddzielną scenę, pełniącą rolę składziku na “różne różności” — Tools (jak to zrobić — patrz str. 287) . Przypisz do niej (poleceniem Objects→Make Links→To Scene...) wszystkie pomocnicze elementy, a potem je usuń z aktualnej sceny. (Scenę Tools wykorzystywałem już w plikach *.blend związanych z wcześniejszymi sekcjami tego rozdziału).
W czasie prac często umieszczaliśmy różne obiekty na różnych warstwach. Teraz przyszedł czas, aby ustalić ich docelowe miejsce. Pamiętaj, że włączenie/wyłączenie warstwy nie jest jedynym sposobem sterowania widocznością obiektów. Możesz także używać do tego celu polecenia Hide Selected (H, patrz str. 315). Rysunek 3.21.2 przedstawia propozycję przypisania elementów modelu do poszczególnych warstw:
Rysunek 3.21.2 Propozycja rozłożenia części modelu na poszczególne warstwy
Aby zmieścić wszystkie opisy na ilustracji, obróciłem symbole warstw o 90º. Zwróć uwagę, że nie wszystkie miejsca są zajęte. To rezerwa na przyszłość: podczas bieżącej pracy zawsze warto mieć do dyspozycji jedną lub dwie puste warstwy. Wymieniam tu także trochę elementów, których jeszcze w modelu nie ma (np. podwozie). Takie zestawienie zbiorcze to dobra okazja, by wyliczyć wszystkie planowane zespoły modelu. Elementy, które jeszcze nie są wykonane, oznaczyłem pochyłą czcionką.
Przejrzyjmy zawartość kolejnych warstw, abyś mógł się upewnić co dokładnie zawierają. Przy okazji uzupełnimy brakujące przypisania hierarchiczne. Gdybyś zauważył, że Twojej wersji tego modelu jakiś obiekt jest na innej warstwie — przypisz go teraz do tej, którą podaje Rysunek 3.21.2.
Na warstwie 1 znajduje się podstawowy zespół skrzydeł: płaty, lotki, klapy, oraz osłony goleni podwozia (Rysunek 3.21.3):
Rysunek 3.21.3 Warstwa 1: Skrzydło, lotki, klapy i owiewki podwozia
Do siatki skrzydła dodaj ostatni szczegół: kołnierz, biegnący wzdłuż pierwszego żebra (Rysunek 3.21.3a). Choć jest mało widoczny, będziemy go potrzebować we wnętrzu kabiny. (W P-40 górna powierzchnia płata była jednocześnie jej podłogą). Na zdjęciach widać na niej także fragment kołnierza, łączącego płaty. Konstruktorzy przymocowali do niego różne części wyposażenia, jak np. drążek sterowy.
Stwórz teraz prawe skrzydło — poprzez skopiowanie (Duplicate Linked) lewego. Gdy wykonasz to jedną operacją, kopiując płat wraz ze wszystkimi podzespołami, zachowasz wewnętrzną hierarchię tych obiektów. Podczas kopiowania wystarczy zmienić skalę wzdłuż lokalnej osi X na -1, aby płat znalazł się po prawej stronie. Nowemu obiektowi nadaj nazwę B.100.R.Wing. Zmień jeszcze jego obrót wokół osi Y z -6º na +6º, by skrzydło uzyskało prawidłowy wznios. Potem pozostaje poprawić nazwy jego elementów, zmieniając w nich człon “.L” na “.R”.
Na warstwie 11 umieść szczegóły, które mogą być przydatne w jakiejś scenie “na lotnisku”, z wysuniętym podwoziem i otwartymi klapami (Rysunek 3.21.4):
Rysunek 3.21.4 Warstwa 11: wnętrze klap oraz komór podwozia głównego
Początkowo na warstwie 11 chciałem także umieścić wnętrza komór klap (B.101.x.FlapBay). Gdy okazało się, że fragmenty tych obiektów wystają spod uskoku klap, przeniosłem je na warstwę 1.
Na warstwie 2 umieść podstawowe elementy kadłuba, oraz różne owiewki i osłony (Rysunek 3.21.5):
Rysunek 3.21.5 Warstwa 2: środkowa i tylna część kadłuba, wraz z owiewkami
Warstwa 12 zawiera wnętrza wybranych fragmentów kadłuba (kabiny pilota i kółka ogonowego). Powłoki wewnętrzne mają zawsze końcówkę .001, podłużnice — .002, a wręgi — .003 (Rysunek 3.21.6):
Rysunek 3.21.6 Warstwa 12: Wewnętrze kadłuba
Warstwa 3 zawiera elementy okapotowania silnika (Rysunek 3.21.7), a warstwa 16 — zespół śmigła (Rysunek 3.21.8). Zwróć uwagę, że kołpak jest przypisany do obydwu warstw (by nie wystawały “gołe” początki łopat).
Rysunek 3.21.7 Warstwa 3: okapotowanie silnika | Rysunek 3.21.8 Warstwa 16: śmigło |
Warstwa 13 zawiera elementy wewnętrzne: nkm Browing, chłodnice cieczy, ich tunele wlotowe i wylotowe (Rysunek 3.21.9):
Rysunek 3.21.9 Warstwa 13: wnętrze zespołu chłodnic, karabiny zamontowane w kadłubie
Warstwa 4 to ramki kabiny pilota (Rysunek 3.21.10), a warstwa 14 to jej oszklenie (Rysunek 3.21.11):
Rysunek 3.21.10 Warstwa 4: ramki osłony kabiny | Rysunek 3.21.11 Warstwa 14: oszklenie |
Oszklenie kabiny jest najwygodniej umieścić na oddzielnej warstwie, gdyż bardzo często potrzeba przełączać jego widoczność. Ramki kabiny są wydzielone po trosze także ze względu na stopień ich komplikacji. Na warstwie 4 umieścimy również elementy wyposażenia kabiny widoczne podczas lotu, jak zagłówek na płycie pancernej czy szkło odblaskowe celownika.
Usterzenie umieść na warstwie 6 (Rysunek 3.21.12). Na razie składa się tylko z podstawowych elementów. Statecznik pionowy jest “przymocowany” (relacją Parent) do statecznika poziomego. (W prawdziwym samolocie był do niego przykręcony dwoma rzędami śrub, ciągnącymi się pod owiewką.) W dalszych rozdziałach na tej warstwie przybędą kolejne szczegóły, jak popychacze trymerów, światła pozycyjne, czy okucia mocujące osie sterów do dźwigarów.
Jeżeli chodzi o najbardziej ogólną hierarchię, to statecznik poziomy (B.200.L.Stabilizer — podstawa całego usterzenia) przypisz do kadłuba (B.300.Fuselage). Do tego samego obiektu przypisz także obydwa płaty (w końcu skrzydła są dwa, a kadłub — tylko jeden). W ten sposób “początkiem” hierarchii zespołów samolotu zostanie obiekt B.300.Fuselage (Rysunek 3.21.13).
Rysunek 3.21.14 przedstawia postać, jaką osiągnął nasz model na tym etapie prac. Zaczyna już przypominać pierwowzór!
Rysunek 3.21.14 Wygląd ogólny modelu
I moglibyśmy na tym ten rozdział zakończyć, gdyby nie moja mania ciągłego poszukiwania materiałów w Internecie. Właśnie (tzn. w 2009r, gdy budowałem ten model) znalazłem nowość o P-40. To artykuł "Long Nose Hawks" (z www.hyperscale.com). Jego autor — Hume Bates — podaje wiele wymiarów P-40B, zmierzonych "z natury" na egzemplarzu P-40C z Naval Air Museum (w Pensacola, o ile się nie mylę). Okazuje się, że rozstaw luf karabinów kadłubowych wynosił 19 1 / 2 ", czyli 49.5 cm. To po 4 cm z każdej strony więcej, niż przyjąłem (i tak rozstawiając je szerzej niż na planach!) (Rysunek 3.21.15):
Różnica w położeniu jest zbyt duża, by dało się jakoś “przesunąć” osłonę karabinu po powierzchni pokrywy. W dodatku górny panel okapotowania silnika powinien być szerszy, aby zmieścić nieco większy chwyt powietrza do sprężarki.
To już oznacza nie kosmetyczną przeróbkę, a konieczność zbudowanie jeszcze raz górnej części okapotowania silnika (por. str. 169)! Całe szczęście, że “wymęczony” na podstawie zdjęć szkielet wiatrochronu przeszedł tę próbę zwycięsko — jest zgodny. Podobnie grzbiet kadłuba pod wiatrochronem. (Jego kształt jest efektem uzgadnianie ze zdjęciami linii przenikania wiatrochronu z kadłubem).
Nie miej złudzeń — jeżeli chcesz wykonać coś możliwie dokładnie, takie sytuacje będą się powtarzać. Postęp prac nad dobrym modelem czy planami można porównać do ruchu po spirali. Co jakiś czas musisz się cofnąć, by poprawić coś, co już zrobiłeś. Potem wykonasz nowy etap pracy, do którego najprawdopodobniej powrócisz po jakimś czasie, by znów coś poprawić. I tak dalej, dopóki nie uznasz modelu za skończony.
Prędzej czy później zawsze znajdziesz lepsze rysunki lub zdjęcia, z których wynikną jakieś rewelacje na temat samolotu, który robisz. Możesz je uwzględnić albo zignorować. Jak sądzisz, którą z tych dwóch możliwości teraz wybiorę? Tak, nie myliłeś się: przerabiamy model!
Artykuł Hume Batesa przytacza trochę nowych zdjęć z odbudowy egzemplarza P-40C. Wśród nich jest wyraźne ujęcie ściany ogniowej kadłuba. Jej kształt różni się od kształtu w naszym modelu. Zdecydowałem się to także poprawić. W efekcie zmianie uległ kształt poszycia od wiatrochronu kabiny do kołpaka śmigła. W rzutach z boku i z góry kontury samolotu są bez zmian. Zmianie uległ tylko przekrój poprzeczny kadłuba. Załamanie pokryw wzdłuż pierwszej wręgi stało się wyraźniejsze (Rysunek 3.21.16)1:
Rysunek 3.21.16 Poprawione górne panele osłony silnika
Rysunek 3.21.16 przedstawia także poprawiony chwyt powietrza do sprężarki i rozsunięte osłony km. Średnica chwytu została powiększona o 10%. Porównaj z tą ilustracją Rysunek 3.21.14. Prawda, że na pierwszy rzut oka nic się nie zmieniło? A jednak ja wiem, że teraz jest tak, jak w oryginale — a wcześniej męczyła mnie świadomość, że jest inaczej. To takie “modelarskie dobre samopoczucie” ☺.
Rysunek 3.21.17 Skracanie czoła osłony chłodnicy
Ta sama mania dokładności zmusiła mnie do kolejnej poprawki. Z opublikowanych przez Batesa pomiarów wynika, że osłona chłodnicy w naszym modelu ma poprawne wymiary, ale była położona o 5 cm bliżej nosa samolotu2. To także poprawimy. Ta zmiana na szczęście wymaga tylko drobnej “operacji plastycznej”, a nie ponownego tworzenia od podstaw.
Pierwszym krokiem poprawki jest “ściśnięcie” wzdłuż osi Y fragmentu, który w oryginalnym samolocie był o 5 cm krótszy (Rysunek 3.21.20). Zwróć uwagę, że wierzchołki wzdłuż zewnętrznych krawędzi osłony nie są poddane tej transformacji. Oszczędzimy sobie w ten sposób konieczności ponownego dopasowywania do sąsiednich paneli.
Po skróceniu czoła osłony chłodnicy, przesuń resztę jej siatki o 5 cm do przodu (Rysunek 3.21.18):
Rysunek 3.21.18 Przesunięcie osłony chłodnicy
Jeżeli nie podobają Ci się pochylone linie wręg w okolicach krawędzi siatki — możesz je wyprostować. Wystarczy je przesunąć (Edge Slide) po ścianach zagięcia “na grubość blachy”, umieszczonych wzdłuż krawędzi osłony chłodnicy (krawędź |32| — p. Rysunek 3.21.19):
Rysunek 3.21.19 Prostowanie końcówki wręgi
Z pozostałych poprawek — zmianie uległy szczegóły kształtu wylotu powietrza z chłodnicy (Rysunek 3.21.20). Trochę w nim nadal moich domysłów, bo brak jest dobrej jakości zdjęć tego fragmentu P-40 B/C.
Rysunek 3.21.20 Przerobiony wylot powietrza | Rysunek 3.21.21 Zmienione zakończenia osłon podwozia |
Zgodnie z sugestią Batesa, zmieniłem także końcówki osłon goleni podwozia (Rysunek 3.21.21) . Zakładałem, że wyglądały jak w P-40E, a tu okazuje się, że miały “pozostałości” po P-36.
Zwróć jeszcze uwagę na sztuczne przyciemnienia i przejaśnienia, które mogły się gdzieniegdzie pojawić na powierzchniach modelu (Rysunek 3.21.22a,b,c):
Rysunek 3.21.22 Artefakty na granicach ostrych krawędzi
W ferworze formowania poszczególnych części mogłeś nie zwrócić na nie uwagi. Takie artefakty powstają przy ostrej (Crease=1) krawędzi łączącej jakąś dłuższą, “gładką” (Shade Smooth) ścianę z drugą, o wiele mniejszą (por. str. 383). Aby eliminować taki kłopot, masz do dyspozycji kilka rozwiązań:
najprostsze: zmienić tryb cieniowania ściany z “gładkiego” (Shade Smooth) na “płaski” (Shade Flat). W przypadku powierzchni, które pokazuje Rysunek 3.21.22, lepiej jednak tego uniknąć. (Na powłokach, które teraz wyglądają jak gładkie, pojawiłyby się drobne krawędzie);
standardowe: włączyć dla siatki opcję Normals:Auto Smooth (por. str. 384). Ta opcja usuwa „cienie” z każdej krawędzi, w której ściany są połączone pod kątem większy niż graniczny kąt Normals:Angle (ustaw na jakąś wartość od 30º do 90º);
redukcyjne: dodać wzdłuż ostrych krawędzi dodatkowy rząd niewielkich ścian. To zmniejsza efekt do niedostrzegalnych rozmiarów. Z tym może się wiązać jednak trochę dodatkowej pracy.
W przyszłości może się zdarzyć, że będziesz chciał skorzystać z jakiegoś zewnętrznego programu renderującego albo zaadaptować ten model do jakiejś gry. Nie każdy format plików eksportu przenosi takie niuanse, jak odchylenia kierunków wektorów normalnych tworzone przez opcję Auto Smooth. Wtedy ten problem może się znowu pojawić. Dlatego proponuję usunąć z modelu co większe przebarwienia za pomocą dodatkowego rzędu ścian. W przypadku lotki sprawa jest bardzo prosta: wystarczy wstawić (Loop Cut) nową wręgę (Rysunek 3.21.23):
Rysunek 3.21.23 Usunięcie przyciemnienia krawędzi lotki poprzez dodanie rzędu nowych ścian
Wstawienie dodatkowych ścian wokół krawędzi sterów wymaga więcej pracy. Bardzo przydaje się tu technika nacinania (Knife). (Nie będę tutaj dokładnie pokazywał, jak je po kolei robić, myślę że sobie poradzisz). Mniejsze przebarwienia usuwaj opcją Normals:Auto Smooth lub modyfikatorem Edge Split (str. 384).
Model jest już uformowany (Rysunek 3.21.24). Mam nadzieję, że nie będą go czekały w przyszłości tak duże poprawki, jak te, które wprowadziłem po artykule Hume Batesa. Jedynym obszarem, co do kształtu którego nadal mam pewne wątpliwości, jest wylot powietrza z chłodnicy cieczy. Wylot jest bardzo dobrze “obfotografowany” dla wersji P-40E, istnieją także jego rysunki konstrukcyjne. Jak na złość, na temat wcześniejszych wersji (B,C) brak jest dobrych danych. Mam nadzieję, że w przyszłości dotrę do jakichś dokładniejszych zdjęć tego fragmentu3.
Rysunek 3.21.24 Kształt modelu, jaki osiągnęliśmy w trakcie tego rozdziału
Model z tej sekcji znajdziesz w pliku model\p40\history\P40B-4.21.blend (por. str. 18).
Podsumowanie
Po zakończeniu fazy “formowania blach” samolotu warto jest przejrzeć wszystkie warstwy i zaprowadzić w nich porządek (str. 242). Koniecznie zaplanuj zawczasu, gdzie umieścisz takie zespoły, jak podwozie, czy wnętrze kabiny. Zarezerwuj także co najmniej dwie warstwy do nieprzewidzianych, przyszłych zastosowań;
Na tym etapie warto także zadbać o uzupełnienie brakujących relacji hierarchii (Parent). Struktura samolotu powinna się “zaczynać” od jakiejś pojedynczej części, np. kadłuba (str. 246);
Zapisz w odrębnej scenie (str. 242) wszystkie pomocnicze obiekty, np. wzorce kształtu. Nie wiadomo, kiedy się przydadzą;
Przejrzyj krytycznie i popraw wszelkie “przebarwione” fragmenty siatki (str. 249). Występują na wygładzonych powłokach, w okolicach ostrych krawędzi;
Sprawdź na tyle dokładnie, na ile jesteś w stanie, wymiary modelu. Bądź jednak przygotowany na konieczność poprawek. (Postęp prac nad każdym dokładnym modelem odbywa się często wg zasady “dwa kroki naprzód, jeden krok w tył ”);
Zawartość tej części bardzo przypomina zawartość plików podpowiedzi do trzech programów: GIMP, Inkscape i Blendera. Są tu zestawione opisy tych poleceń, które zostały wykorzystane w poprzednich częściach książki. Z założenia będziesz z nich korzystał wyrywkowo (por. „Jak czytać tę książkę?”, str. 12). Nie doszukuj się więc w kolejności rozdziałów i sekcji tej części jakiejś przemyślanej metody wprowadzania w obsługę programu. Do tego służy część pierwsza — „Budowa modelu”. To tam specjalnie dobrałem kolejność prezentowanego materiału w ten sposób, byś mógł stopniowo poznawać wszystkie potrzebne zagadnienia.
Gdy zdecydujesz się wydrukować tę książkę dla własnych potrzeb, proponuję pozostawić tą część w postaci elektronicznej. W przeglądarce PDF szybciej znajdziesz podaną w części pierwszej stronę, niż kartkując gruby wydruk. (No i zużyjesz mniej drzew z lasów...).
W tym rozdziale przedstawione są zagadnienia, które dotyczą więcej niż jednego okna (edytora) Blendera lub więcej niż jednego trybu pracy.
Pomijam tu zagadnienia, które przedstawiłem wcześniej (Rozdział 2). Były to:
Ta sekcja opisuje instalację Blendera ze spakowanego pliku *.zip. Uważam, że ta metoda jest równie dobra co użycie programu instalacyjnego. Za to wiesz dokładnie, co i gdzie zostało zmienione na Twoim komputerze.
Zacznij od głównej strony tego programu: http://www.blender.org . Jest na niej umieszczony skrót do plików instalacyjnych (Rysunek 4.1.1):
Rysunek 4.1.1 Strona główna Blendera
Pobierz z jednego z dostępnych serwerów odpowiedni plik *.zip (Rysunek 4.1.2):
Rysunek 4.1.2 Pobieranie pakietu instalacyjnego
Pobrany w ten sposób plik rozpakuj do folderu C:\Program Files (może to być także inny folder) (Rysunek 4.1.3):
Rysunek 4.1.3 Rozpakowanie plików Blendera
Potem zmień nazwę rozpakowanego folderu ze specyficznej na jakąś „ogólną”: np. Blender (Rysunek 4.1.4):
Rysunek 4.1.4 Zmiana nazwy folderu Blendera
Aby uruchomić Blender, należy dwukrotnie kliknąć na pliku blender.exe, umieszczonym w tym katalogu (Rysunek 4.1.5):
Rysunek 4.1.5 Uruchomienie Blendera
Oczywiście, wygodniej będzie jeżeli skopiujesz skrót do tego pliku na pulpit i/lub do menu Start.
Warto także przypisać Blender jako domyślny edytor plików o rozszerzeniu *.blend 1.
Chwilę po uruchomieniu zobaczysz okno Blendera wraz z ekranem powitalnym (Rysunek 4.1.6):
Rysunek 4.1.6 Ekran po uruchomieniu Blendera
Wybierz z menu Blendera (nagłówek okna Info) polecenie File→Open (lub naciśnij Ctrl-O) (Rysunek 4.2.1):
Rysunek 4.2.1 Wybór polecenia z menu
Spowoduje to chwilowe wyświetlenie na całym ekranie Blendera w okno wyboru plików (File Browser) – Rysunek 4.2.2:
Rysunek 4.2.2 Okno wyboru pliku
Jak widać, Blender ma własne okno do wskazywania pliku – jest to konsekwencja decyzji o zastosowaniu własnego interfejsu użytkownika. Omówmy pokrótce jego obsługę. Z panelu System, po lewej stronie, można wybrać dysk. Z niżej położonego panelu Bookmarks można wybrać jeden z typowych folderów, a z panelu Recent — ostatnio otwierany folder (Rysunek 4.2.3):
Rysunek 4.2.3 Okno wyboru pliku — elementy interfejsu użytkownika
Pobierz towarzyszący tej książce plik la5.zip (por. str. 18). Jego zawartość rozpakowuje się do folderu o nazwie model\la5. Załóżmy że umieściłeś te pliki na jakimś dysku E:, więc teraz otworzymy w Blenderze plik E:\model\la5\la5.blend.
Otwórz w oknie wyboru plików dysk E:\ (Rysunek 4.2.4):
Rysunek 4.2.4 Nawigacja w oknie wyboru plików
Wystarczy kliknąć (LPM) w nazwę folderu model, aby go otworzyć. W podobny sposób przejdź do folderu la5 (Rysunek 4.2.5):
Rysunek 4.2.5 Zawartość folderu model
Kliknij w plik, który chcesz otworzyć – jego nazwa pojawi się w polu na nazwę pliku do otwarcia (Rysunek 4.2.6). (Można było, oczywiście, wpisać ją z klawiatury, ale komu by się chciało...):
Rysunek 4.2.6 Wybór i otworzenie pliku Blendera
Po naciśnięciu przycisku Open Blender File plik zostanie załadowany. W zależności od mocy obliczeniowej Twojego komputera, może to zająć Blenderowi od jednej do paru sekund.
Warto jeszcze wspomnieć o kilku innych poleceniach z menu File (okna Info), związanych z otwieraniem plików:
File→Open Recent: pozwala otworzyć jeden z dziesięciu ostatnio zapisywanych plików;
File→Recover Last Session: pozwala odzyskać plik, który był załadowany gdy ostatni raz zamykałeś Blender (np. poleceniem File→Quit). Podczas zamykania Blender nie ostrzega, że aktualny plik zawiera niezapisane zmiany. Zamiast tego po prostu zawsze go zapisuje w folderze tymczasowym, pod nazwą quit.blend. To polecenie otwiera właśnie ten plik. Pozwala to odzyskać niezapisane zmiany, o ile zorientowałeś się w porę i nie zamknąłeś Blendera po raz kolejny…
File→Recover Auto Save… Jeżeli masz w konfiguracji programu włączone okresowe zapisywanie kopii pliku, tym poleceniem możesz go otworzyć po np. zawieszeniu programu. Więcej o odtwarzaniu danych — p. str. 270.
Aby zapisać aktualnie otwarty plik, wybieramy polecenie File→Save (Rysunek 4.3.1). Alternatywnie możesz nacisnąć na klawiaturze Ctrl-S — to skrót do tego polecenia:
Rysunek 4.3.1 Polecenie - zapisanie pliku
Jeżeli chcesz zapisać plik pod inną nazwą, wybierz polecenie File→Save As. Analogicznie jak przy otwarciu pliku (por. str. 256), na ekranie pojawi się na chwilę okno wyboru pliku (Rysunek 4.3.2):.
Rysunek 4.3.2 Okno zapisu pliku
Zwróć uwagę, że w polu z nazwą do zapisania domyślnie pozostaje oryginalna nazwa pliku. Aby zapisać go pod nową nazwą, musisz ją zmienić — wpisując z klawiatury lub klikając w inny plik (który chcesz nadpisać). Zapis pod nową nazwą nastąpi po naciśnięciu przycisku Save As Blender File.
Osobiście używałem tego polecenia co najmniej raz dziennie – do zapamiętania kolejnej wersji pliku. Nazywałem to „wersją dzienną”. Takie wersje bywają przydatne. Na początku pracy z Blenderem, zdarzało mi się poprzestawiać dziesiątki parametrów i nie uzyskać oczekiwanego efektu. Czułem, że szukając rozwiązania zabrnąłem w „ślepą uliczkę”. Wycofanie dokonanych zmian do stanu początkowego wyglądało często na bardzo pracochłonne, a czasami na praktycznie niemożliwe. O wiele prościej było zacząć jeszcze raz od „czystej” wersji z poprzedniego dnia. Twórcy Blendera z myślą o takich jak ja, dodali do okna zapisu pliku (Rysunek 4.3.2) dodatkowy „gadżet”. Przyciski [+], [-] lub klawisze + i - z klawiatury numerycznej zwiększają lub zmniejszają cyfrę (numer wersji) na końcu nazwy pliku.
Z innych poleceń które mogą okazać się przydatne, warto wspomnieć:
SaveScreenshot: zapisuje obraz aktualnego ekranu Blendera. Polecenie dostępne tylko za pomocą skrótu: Ctrl-F3. Format obrazu (JPG, PNG, ...) — ustalamy w oknie właściwości (Properties), zestaw Render, panel Output (patrz str. 65);
Image→Save As Image (F3): Polecenie z nagłówka okna UV/Image Editor. Zapisuje wyrenderowany finalny obraz sceny do pliku o wskazanej nazwie. Domyślnie proponuje taki sam format pliku rastrowego, jak Save Screenshot, ale można go zmienić w panelu Save As Image okna File Browser.
Szczegóły wyglądu i działania środowiska Blendera są wynikiem złożenia dwóch grup ustawień. Są to:
ustawienia „ogólne” z okna User Preferences. Są one zapisywane do pliku o nazwie userpref.blend gdy naciśniesz w tym oknie przycisk Save User Settings. Oznacza to, że te ustawienia nie są związane z jakimkolwiek aktualnym rysunkiem. Traktuj je jako konfigurację Twojej instalacji Blendera;
ustawienia „lokalne”, przechowywane w każdym pliku Blendera. Dotyczą one przede wszystkim interfejsu użytkownika: układ okien, alternatywnych układów ekranu (screen layouts). Gdy nie załadowałeś jeszcze żadnego pliku lub gdy tworzysz nowy plik poleceniem File→New, Blender wykorzystuje tzw. plik startowy, o nazwie startup.blend. (Stąd zawartość tego pliku decyduje, jak wygląda ekranu programu zaraz po uruchomieniu. Możesz ją nadpisać poleceniem File→ Save Startup File) ;
W pliku source.zip (por. str. 18) umieściłem foldery z konfiguracją Blendera, której używałem pisząc tę książkę. Możesz je wgrać tak, jak jest to pokazane na str. 269.
Jeżeli jednak nie czujesz się w takich operacjach na folderach zbyt pewnie, istnieje inna metoda. Otwórz w Blenderze (File→Open, por. str. 256) wzorcowy plik source\config\startup.blend. A potem w oknie User Preferences naciśnij przycisk Save User Settings i wywołaj polecenie File→Save Startup File, aby zachować także układ ekranu (Rysunek 4.4.1):
Rysunek 4.4.1 Przeniesienie ustawień z pliku startup.blend, dostarczonego z tą książką
I to wszystko! Kopia tego pliku, wraz z plikiem userpref.blend zostanie zapisana w Twoim profilu użytkownika jako aktualna konfiguracja Blendera. Dodatkowo możesz jeszcze zainstalować dodatki (add-ons), z których będziemy korzystać. (por. str. 285). Pliki tych dodatków umieściłem w katalogu source\scripts\addons.
Blender jest już skonfigurowany do dalszej pracy. Pierwszą różnicą, którą zapewne zauważyłeś, są jaśniejsze okna 3D View (Rysunek 4.4.1). Domyślne, ciemne tło z Blendera 2.5/2.6 źle wyglądało na ilustracjach dla tej książki. Dlatego zdecydowałem się używać schematu barw, do którego przywykłem, używając Blendera 2.4.
Abyś jednak wiedział, co i dlaczego jeszcze zmieniłem, przejdę przez kolejne sekcje okna User Preferences. Pokażę na nich, jakie ustawienia standardowe zostały zmienione.
W sekcji Interface — włączyłem View Manipulation: Rotate Around Selection (Rysunek 4.4.2). To ułatwi obracanie widoku wokół detali. Oprócz tego wyłączyłem Manipulator (to taki pomocniczy „gadżet” w oknie 3D View). Niektórzy uważają, że ułatwia manipulację obiektami w przestrzeni trójwymiarowej. Ja jednak należę do „starej szkoły” Blendera, która takiego udogodnienia nie znała:
Rysunek 4.4.2 Ustawienia Blendera — sekcja Interface
Jak pokazuje to Rysunek 4.4.2, w sekcji Interface możesz opcjonalnie przełączyć jeszcze parę innych opcji.
W sekcji Editing — włączyłem New Objects:Align to:View (Rysunek 4.4.3). Dzięki temu każdy obiekt, który stworzysz, powstanie w płaszczyźnie równoległej do aktualnego widoku. (Inaczej, aby odpowiednio zorientować nowo powstały element, musiałbyś go dodatkowo obracać).
Rysunek 4.4.3 Ustawienia Blendera — sekcja Editing
W sekcji Input — włączyłem opcję Emulate Numpad (Rysunek 4.4.4). Choć jest to praktyczne przede wszystkim dla notebooków, może okazać się przydatne także na tradycyjnych komputerach. (Pozwoli utrzymywać lewą rękę ponad centrum klawiatury, a nie przesuwać ponad całą jej szerokością).
Rysunek 4.4.4 Ustawienia Blendera — sekcja Input
Zwróć uwagę, że w tej sekcji możesz zmienić konfigurację skrótów poleceń Blendera (Rysunek 4.4.5):
Rysunek 4.4.5 sekcja Input — rozwinięta grupa poleceń Window
Dwa dodatkowe klawisze w nagłówku okna tej sekcji pozwalają także zapisywać i odczytywać skróty do poleceń z pliku (Rysunek 4.4.6):
Rysunek 4.4.6 Przyciski w nagłówku okna w sekcji Input
W sekcji Add-Ons (programowe rozszerzenia Blendera) włączyłem Dynamic Spacebar Menu (Rysunek 4.4.7):
Rysunek 4.4.7 Ustawienia Blendera — sekcja Add-Ons
W sekcji Themes, jak już o tym wspominałem, pozmieniałem kolory widoku 3D View (Rysunek 4.4.8):
Rysunek 4.4.8 Ustawienia Blendera — sekcja Themes
Sekcja File zawiera domyślne ścieżki, na których Blender ma poszukiwać różnych rodzajów plików. Niczego w niej nie musiałem zmieniać. (Rysunek 4.4.9):
Rysunek 4.4.9 Ustawienia Blendera — sekcja File
Wreszcie sekcja System (Rysunek 4.4.10). Tu także niczego nie zmieniałem:
Rysunek 4.4.10 Ustawienia Blendera — sekcja System
Przy okazji omawiania sekcji System wspomnę o pewnym udogodnieniu. W domyślnej konfiguracji Blendera wysunięcie przybornika z boku okna 3D View powoduje zmniejszenie wyświetlanego obrazu (Rysunek 4.4.11):
Rysunek 4.4.11 Pomniejszanie obrazu przy otwarciu przybornika
Mówiąc szczerze, niezbyt lubię ten efekt. Na szczęście w Blenderze 2.66 pojawiła się alternatywa: zaznacz w zakładce System opcję Region Overlap i przełącz Window Draw Method na Triple Buffer (Rysunek 4.4.12):
Rysunek 4.4.12 Zmiana parametrów w sekcji User Preferences:System
W rezultacie tło przyborników stało się półprzejrzyste, i teraz „wysuwają się” ponad obrazem (Rysunek 4.4.13):
Rysunek 4.4.13 Półprzeźroczyste tło przybornika, zachowujące oryginalny rozmiar obrazu
W stosunku do oryginalnej wersji Blendera, wprowadziłem także parę zmian w domyślnym układzie ekranu. Nie było to niezbędne, ale często łapałem na tym, że ciągle w ten sam sposób poprawiam zawartość nowo utworzonego rysunku. Po co? Zapisałem raz poprawiony plik jako domyślny, i w ten sposób oszczędziłem sobie ciągłej roboty (Rysunek 4.4.14):
Rysunek 4.4.14 Trzy widoki robocze
Zwróć uwagę, że usunąłem ze sceny “pudełko”, które Blender domyślnie umieszcza pośrodku sceny. (Zawsze pierwszą rzeczą, którą robiłem, było pozbycie się tego obiektu). Przesunąłem także obiekty związane wyłącznie z renderingiem — kamerę i lampę — na warstwę 20 (Rysunek 4.4.15):
Rysunek 4.4.15 Warstwa obiektów związanych z renderingiem: kamery i lampy
To taka moja konwencja — oczywiście, możesz to sobie zorganizować inaczej.
Gdy choć raz wywołasz w Blenderze polecenie File→Save Startup File, lub naciśniesz w oknie User Preferences przycisk Save User Settings, Blender zapisze w Twoim profilu użytkownika zmienioną konfigurację. Stosunkowo trudno znaleźć folder, zawierający te dane. Jest tworzony (przynajmniej w Windows) w ukrytym katalogu Application Data. W różnych wersjach Windows Application Data znajduje się w różnych miejscach profilu użytkownika. W dodatku Eksplorator Windows w każdej wersji językowej systemu wyświetla nazwę tego folderu w lokalnym języku (podobnie jak My Documents) co pogłębia zamieszanie. (Nawet gdybym podał ścieżkę do tego folderu dla każdej wersji Windows, część użytkowników i tak by go nie znalazła).
Zamiast tego przygotowałem w pliku source.zip (por. str. 18) skrót Blender configuration. Wykorzystuje zmienną środowiskową Windows (APPDATA) by otworzyć w Eksploratorze Windows Twój folder z konfiguracją Blendera (Rysunek 4.5.1):
Rysunek 4.5.1 Otwarcie folderu na konfiguracje Blendera
Każda z wersji Blendera przechowuje tu swoje pliki w oddzielnym katalogu (Rysunek 4.5.1). Dzięki temu możesz z nich korzystać jednocześnie (np. aby sprawdzić, jak coś działało poprzednio). Gdy instalujesz nową wersję programu, przy pierwszym uruchomieniu Blender proponuje skopiowanie konfiguracji z wersji poprzedniej.
Wewnątrz katalogu każdej wersji znajdują się dwa podfoldery:
config\: zawiera dwa ważne pliki (Rysunek 4.5.2) Pierwszy z nich nazywa się userpref.blend. Są w nim przechowywane wszelkie ustawienia z okna User Preferences, zapisane przyciskiem Save User Settings. Drugim plikiem jest startup.blend. Zawartość tego pliku Blender wyświetla bezpośrednio po uruchomieniu, lub gdy wybierzesz polecenie File→New. Plik startup.blend determinuje m.in. domyślny układ ekranu Blendera Możesz go zastąpić jakimś bieżącym rysunkiem, wywołując polecenie File→Save Startup File.
scripts\addons\: w podfolderze addons Blender przechowuje dodatki (add-ons) zainstalowane przez użytkownika (Rysunek 4.5.3, por. także str. 285). Dzięki temu są przenoszone z całą konfiguracją przy aktualizacji do nowej wersji programu.
W operowaniu konfiguracją Blendera nie ma żadnej „ukrytej magii” . Wystarczy zmieniać odpowiednie pliki. Na przykład, instalację grupy dodatków (add-on), możesz wykonać na dwa sposoby:
łatwy: używając GUI Blendera (tak jak to jest opisane na str. 285) — ale wtedy musisz wgrywać po kolei każdą wtyczkę;
zaawansowany: jednym ruchem skopiować wszystkie pliki wtyczek do podkatalogu scripts\addons\ folderu z konfiguracją Blendera. Wymaga to tylko wiedzy, gdzie ten folder się znajduje, i za pierwszym razem należy po prostu tam założyć takie podkatalogi;
Podobnie możesz się przełączać pomiędzy się różnymi konfiguracjami Blendera — wystarczy przechowywać pod inną nazwą lub w innym miejscu alternatywne pliki userpref.blend i startup.blend. Gdy skopiujesz do folderu config\ ich nowe wersje — Blender posłuży się nimi przy najbliższym uruchomieniu .
Abyś mógł podążać za przykładami, umieszczonymi w tej książce, w pliku source.zip dostarczyłem podkatalogi config i scripts z odpowiednią konfiguracją Blendera. Na wszelki wypadek najpierw skopiuj wszystkie pliki z Twoją oryginalną konfiguracją w jakieś inny miejsce. Potem po prostu przenieś odpowiednie te dwa podkatalogi z source.zip do folderu z konfiguracją Twojej aktualnej wersji Blendera (Rysunek 4.5.4):
Rysunek 4.5.4 Przeniesienie konfiguracji Blendera, wymaganej dla tej książki
W tej sekcji opiszę sposób „awaryjnego” odzyskiwaniu pliku. Uczciwie mogę powiedzieć, że przez długi czas (pierwszych 7-8 miesięcy pracy) Blender zachowywał mi się bardzo stabilnie. Na palcach jednej ręki mógłbym policzyć sytuacje, gdy straciłem choć trochę pracy z powodu niespodziewanego zakończenia przez błąd w programie. Potem, gdy model przekroczył ok. 500 tys. ścian, a ja zacząłem używać różnych zaawansowanych funkcji, bywało, że czasami Blender mi się nagle „wysypał”. W każdym razie – istnieje pewien sposób, pozwalający odzyskać choć część pracy od ostatniego zapisu.
W oknie User Preferences przejdź do sekcji File (Rysunek 4.6.1):
Rysunek 4.6.1 Włączenie automatycznego zapisu
Ważne są tu dwie kontrolki:
Opcja Auto Save Temporary Files: moja rada: pozostaw ją zawsze włączoną, jak na ilustracji;
Pole numeryczne Timer: tu wpisz, co ile minut ma być zachowywany stan pliku;
Gdy Blender nagle zgłosił „fatalny” błąd i został zamknięty przez system operacyjny, nie popadaj w rozpacz. Jeżeli miałeś włączony Auto Save, możesz jeszcze odzyskać swoją pracę. Uruchom ponowie Blender, a następnie wywołaj polecenie File→Recover Auto Save (Rysunek 4.6.2):
Rysunek 4.6.2 Przejście do odzyskiwania pliku
Blender otworzy wówczas w oknie wyboru plików Twój folder tymczasowy (Rysunek 4.6.3):
Rysunek 4.6.3 Wybór pliku do odzyskania
Dużo tutaj plików Blendera, prawda? I w dodatku nazwy wszystkich to jakieś niezrozumiałe, numeryczne nazwy! To właśnie efekty automatycznego zachowywania. Blender zapisuje plik pod nazwą, która jest tzw. „identyfikatorem procesu” (ang. process ID — skrót: PID). Co prawda — nie wiesz, jaki numer procesu miała sesja Blendera, która zakończyła się tym fatalnym błędem. Nie przejmuj się jednak tym: znajdziemy potrzebny plik, posługując się czasem jego modyfikacji. Włącz w nagłówku okna wyświetlanie szczegółów opisu plików (Rysunek 4.6.3). Następnie uporządkuj je malejąco według daty. Przypuszczalnie pierwszy od góry plik pochodzi z ostatnich kilkunastu minut — i to jest ten, którego szukamy! Zaznacz go (kliknięciem) i otwórz w Blenderze. Gdy się przekonasz, że to jest właściwy rysunek, zapisz go pod inną nazwą w tym samym folderze, w którym trzymasz poprzednie wersje swoich prac. Potem po prostu pracuj dalej. Robiłem tak niejeden raz. Pliki, odzyskane w ten sposób, są zupełnie normalne — bez żadnych luk w danych, czy skaz w zapisie.
Kursor 3D (3D Cursor) jest w Blenderze specjalnym punktem w przestrzeni. Wyznacza “aktualną pozycję”, która jest używana podczas dodawania do sceny nowych obiektów. Może być także wykorzystany jako punkt odniesienia podczas obrotu, zmiany skali, lub odbicia lustrzanego (Mirror).
Położenie kursora 3D jest oznaczane niewielkim krzyżem, otoczonym czerwono-białą obwódką (Rysunek 4.7.1):
Rysunek 4.7.1 Kursor 3D na scenie
Kliknięcie LPM można traktować jako pierwszą, przybliżoną metodę wskazania położenia kursora. Z oczywistych przyczyn nie jest specjalnie dokładnie. Potem możesz zawsze dosunąć kursor do najbliższego węzła “kratki pomocniczej” (grid), która jest naniesiona na płaszczyznę widoku. Naciśnij w tym celu Shift-S (Object→Snap), i wybierz z menu Snap polecenie Cursor to Grid (Rysunek 4.7.2):
Rysunek 4.7.2 Dosunięcie kursora do węzła siatki pomocniczej (grid)
W podobny sposób możesz także wybrać polecenie Cursor to Selected. W trybie obiektu (Object Mode) kursor zostanie umieszczony w środku (tzn. punkcie odniesienia) aktualnie zaznaczonego obiektu. W trybie edycji siatki (Edit Mode) kursor przesunie się do aktualnie zaznaczonego wierzchołka
Podczas modelowania prawie przez cały czas używam kursora 3D.
Polecenie Snap→Cursor to Selected, w połączeniu ze zmianą skali do zera (często tylko wzdłuż jednej osi) pozwala szybko ustawić obiekty lub wierzchołki dokładnie w takim położeniu, jakie jest potrzebne.
Przykład wykorzystania kursora 3D do dokładnego pozycjonowania wierzchołków znajdziesz na str. 335.
Dokładne położenie kursora 3D można także po prostu wpisać. Wywołaj przybornik Properties (N, albo View→Properties). W przyborniku, w panelu 3D Cursor znajduje się sekcja Location (Rysunek 4.7.3):
Rysunek 4.7.3 Ustalanie położenia kursora w przyborniku Properties:View
Możesz z niej bezpośrednio odczytać lub wpisać liczbowe wartości współrzędnych X, Y, Z kursora.
Warto wspomnieć o jeszcze jednej możliwości. Pokażę ją na przykładzie modelu walca (Rysunek 4.7.4):
Rysunek 4.7.4 Przykładowy model walca
Gdy klikniesz gdzieś w oknie 3D View LPM, Blender umieści tam kursor 3D, nie zmieniając jednak jego położenia wzdłuż osi prostopadłej do ekranu (Rysunek 4.7.5):
Rysunek 4.7.5 Zwykłe przenoszenie kursora 3D za pomocą myszki
Włącz jednak oknie User Preferences włączysz opcję Cursor Depth (Rysunek 4.7.6, por. także str. 262, Rysunek 4.4.2):
Rysunek 4.7.6 Włączenie opcji Auto Depth
Wówczas, gdy klikniesz LPM w jakieś miejsce na powierzchni modelu, kursor zostanie umieszczony tuż ponad jego powierzchnią (Rysunek 4.7.7):
Rysunek 4.7.7 Przenoszenie kursora 3D z włączoną opcją Cursor Depth
Niestety, w tym trybie kursor nigdy nie jest umieszczany dokładnie na powłoce klikniętej siatki. W dodatku jego odległość od ściany wydaje się zależeć od kąta pochylenia do płaszczyzny widoku. Wydaje mi się, że ten brak dokładności praktycznie uniemożliwia wykorzystanie tego trybu do modelowania konstrukcji, takich jak samolot.
Podczas budowy modelu prezentowanego w tej książce, tryb Cursor Depth był wyłączony.
Zdecydowałem się jednak wspomnieć o tej opcji. Nie mogę bowiem wykluczyć, że przy innym stylu pracy może okazać się bardzo przydatna.
Aby podstawić plany samolotu jako tło, scal najpierw wszystkie okna 3D View w jedno (Rysunek 4.8.1). Następnie otwórz przybornik Properties (N). Włącz w niej panel Background Images:
Rysunek 4.8.1 Przygotowanie do ustawiania tła okna 3D View
Następnie naciśnij przycisk Add Image (Rysunek 4.8.1). W panelu pojawi się nowa sekcja, początkowo bez obrazu (Not Set — Rysunek 4.8.2):
Rysunek 4.8.2 Wczytanie obrazu z rzutem samolotu
Przypisz tej sekcji obraz (przyciskiem Open). Ustaw też oś widoku (Axis) , odpowiednio do wczytanego obrazu.
W środku układu współrzędnych widoku 3D powinieneś zobaczyć załadowany obraz (Rysunek 4.8.3). (Jeżeli miałeś włączone duże powiększenie, obraz może być mały):
Rysunek 4.8.3 Wczytany obraz
Jeżeli na swoim ekranie nie widzisz obrazu w tle okna 3D View, sprawdź:
czy masz włączony widok z tej samej strony, jaki wybrałeś z listy Axis (por. Rysunek 4.8.2)? Jeżeli nie — ustaw go;
czy widzisz na ekranie środek układu współrzędnych (przecięcie dwóch kolorowych osi)? Jeżeli nie — naciśnij Home, aby go zobaczyć;
czy masz ustawione odpowiednie powiększenie? (Obraz może być obecnie zbyt mały, abyś go zobaczył). Spróbuj zmienić powiększenie;
Blender domyślnie ustawia rozmiar wczytanego rysunku (Size) na 5.0 jednostek, a jego środek umieszcza w centrum układu współrzędnych (Rysunek 4.8.3). Wartość, wpisywana w pole Size, określa rozmiar połowy szerokości obrazu. Zakładając, że 1 jednostka Blendera to 10 cm rzeczywistego samolotu, powinniśmy zwiększyć Size do 50.0. (Długość kadłuba P-40C wynosiła 967cm, a nasz cały obraz będzie się w tej skali rozciągał na niewiele więcej — 100 jednostek, czyli 1000cm). Jednocześnie przesuń obraz (wartości X, Y) tak, by oś kadłuba pokryła się z osią Y, a czubek kołpaka śmigła dotykał osi Z (Rysunek 4.8.4).
Rysunek 4.8.4 Obraz tła — wyrównanie do dokładnego ustalenia rozmiaru
Najłatwiej jest posługiwać się tu polami X i Y jak suwakami — przesuwając myszkę (z LPM) ponad taką kontrolką (por. str. 65). Możesz wtedy obserwować, jak dynamicznie przesuwa się obraz tła.
Zwróć uwagę, że kontrolki X i Y z panelu Background Images to lokalne współrzędne obrazu, a przestrzeni widoku. Warto także uczynić obraz tła częściowo przejrzystym, by było widać umieszczoną pod spodem siatkę. Służy do tego suwak Opacity (Rysunek 4.8.4).
Aby wyznaczyć punkt, do którego ma sięgać koniec kadłuba samolotu, w panelu View ustaw 3D Cursor Location na współrzędne: X = 0.0, Y = 96.7 (odpowiada 967 cm rzeczywistej długości kadłuba), Z = 0.0. Spowoduje to pojawienie się kursora 3D w odpowiednim miejscu na osi Y (Rysunek 4.8.5). (Potem możesz zmienić współrzędną Z na nieco większą, by kursor znalazł się dokładnie tam, gdzie leży koniec kadłuba — trochę ponad osią Y).
Rysunek 4.8.5 Przymiarki do ustalenia końca kadłuba
Teraz ustaw w panelu Background Images trochę mniejszą wartość Size — aby krawędź steru kierunku przybliżyć na mniej więcej połowę początkowego dystansu, wyznaczonego przez kursor 3D (Rysunek 4.8.6a):
Rysunek 4.8.6 Dopasowywanie rysunku tła do zadanych wymiarów
Pamiętaj, że zmiana rozmiaru zachodzi względem środka obrazu — w obydwu kierunkach! Po każdej zmianie skali przesuń się w pobliże środka układu współrzędnych. Zobaczysz tam, że nos samolotu z obrazu uległ odsunięciu w prawo (Rysunek 4.8.6b). Musisz to skorygować przesunięciem obrazu w lewo (zmianą współrzędnej X). Następnie znów zajrzyj na koniec kadłuba, i powtórnie zmień skalę tak, by znów zmniejszyć dystans pomiędzy krawędzią steru i kursorem 3D o połowę. Potem znów to skoryguj przesunięciem (kontrolką X) nosa w lewo. Po kilku takich przybliżeniach powinieneś osiągnąć założone położenie rzutu z lewej (Rysunek 4.8.7):
Rysunek 4.8.7 Rysunek dopasowany
Po wyskalowaniu obrazu pozostaje przesunąć go w docelowe położenie. W praktyce końcówka nosa samolotu nie jest najlepszą powierzchnią odniesienia. Proponuję ustawiać obrazy tak, by przez środek układu współrzędnych przechodziła jakaś inna, “ważniejsza” dla konstrukcji powierzchnia. Użyjmy do tego celu podstawowej wręgi kadłuba, do której były zamocowane: silnik i przedni dźwigar płata1. Przesuń obraz (zmieniając wartość X obrazu) tak, by środek układu współrzędnych znalazł się w tym miejscu (Rysunek 4.8.8):
Rysunek 4.8.8 Ostateczne położenie obrazu tła — ściana ogniowa będzie powierzchnią bazową
Po widoku z boku załaduj widok z góry i dopasuj go do rozpiętości skrzydeł. Potem dostosuj współrzędną Y tego obrazu tak by dopasować początek i koniec kadłuba. Przypisz odpowiednią oś (Axis) do każdego widoku.
Uwaga: wartość Size dotyczy dłuższego boku każdego obrazu, więc będzie inna dla rzutów z boku, i inna dla rzutów z góry/dołu!
W tym przykładzie posługiwałem się rysunkami P-40, których przygotowanie opisałem w pierwszej części tej książki (Tom I). Jeżeli jednak chcesz już skorzystać ze zweryfikowanych rysunków, użyj planów z pliku source.zip (por. str. 18). W jego podkatalogu source\plans znajdziesz dwa pełne zestawy rzutów P-40B. Rysunek 4.8.9 przedstawia okno z przypisanymi wszystkimi widokami z zestawu p40b-lowres\:
Rysunek 4.8.9 Okno z zestawem obrazów przypisanym do każdego widoku (zestawu planów do tej książki)
Nadałem tym planom odcień pomarańczowy, by odróżniały się od domyślnej szarości modelowanych siatek.
Gdy wszystkie widoki samolotu są już przypisane do okna, podziel je na kilka rzutów, których będziemy używać podczas modelowania (Rysunek 4.8.10):
Rysunek 4.8.10 Układ ekranu po ostatecznym podziale
Zwróć uwagę, że Blender będzie podstawiał pod ekran obraz tła tylko wtedy, gdy wybierzesz jeden z widoków ortogonalnych: z lewej, z prawej, z góry, z dołu… (Decyduje o tym przypisana obrazowi oś Axis).
Na słabszych komputerach lepiej jest stosować wersje obrazów o mniejszej rozdzielczości, bo wtedy wszystkie polecenia Pan i Zoom działają szybciej. Zestaw takich obrazów znajdziesz w folderze plans\p40b-lowres\. Mała rozdzielczość wiąże się jednak z pewnym mankamentem: zanikaniem lekko ukośnych linii (Rysunek 4.8.11):
Rysunek 4.8.11 Problem z lekko ukośnymi liniami na obrazach o małej rozdzielczości
Możesz to jednak na chwilę skorygować — wystarczy że w panelu obrazu wskażesz plik z wersją o wyższej rozdzielczości (Rysunek 4.8.12). Potem w ten sam sposób z powrotem przestaw go na wersję lowres\.
Rysunek 4.8.12 Przełączenie na obraz o większej rozdzielczości
Na zakończenie chciałbym wspomnieć o innej metodzie „podstawienia” rysunków samolotu. Zamiast obrazów tła można w tym celu wykorzystać obiekty typu Empty (por. str. 298), którym przypiszesz odpowiednie obrazy (Rysunek 4.8.13):
Rysunek 4.8.13 Alternatywne rozwiązanie — podstawienie obrazów samolotu za pomocą trzech obiektów typu Empty
Tak wyświetlane obrazy lepiej wyglądają w mniejszych powiększeniach (Rysunek 4.8.14):
Rysunek 4.8.14 Obrazy wyświetlane w obiektach Empty lepiej wyglądają w mniejszych powiększeniach
Jednak gdy powiększysz obraz tła (Rysunek 4.8.14b) do projekcji w której zazwyczaj formujesz elementy modelu, stanie się tak samo ostry i wyraźny jak obraz wyświetlany przez obiekt Empty.
Obrazy wyświetlane przez obiekty Empty mają jednak inną wadę: nie są przejrzyste! Popatrz na model kołpaka śmigła, przedstawiony przez Rysunek 4.8.15a):
Rysunek 4.8.15 Obrazy Empty zasłaniają modelowany obiekt
Stworzyłem go w oparciu o rzut z boku (Rysunek 4.8.15a). Potem obróciłem trochę widok, aby sprawdzić, jak wygląda w przestrzeni (Rysunek 4.8.15b). Jednak gdy chciałem go zobaczyć z przodu — płaszczyzna z obrazem skutecznie go zasłoniła (Rysunek 4.8.15c). Można to jednak częściowo skompensować, zmieniając wartość parametru Transparency we właściwościach obiektu Empty (por. Rysunek 4.8.13).
Innym problemem może także być wydajność — szczególnie gdy zdecydujesz się przez cały czas używać obrazów o wyższej rozdzielczości. O ile obrazy wyświetlane jako Background Image pojawiają się tylko wtedy, gdy włączysz „ich” rzut, to obrazy związane z obiektami Empty są rysowane przez cały czas — także w widoku przestrzennym, kiedy są raczej bezużyteczne.
Oczywiście, można ten problem rozwiązać umieszczając obiekty Empty na oddzielnej warstwie, którą będziesz w razie potrzeby wyłączał. Po co jednak to robić, skoro Background Image oferuje tę funkcjonalność „w standardzie”?
Uważam, że w praktyce modelowania lepiej się sprawdza podstawiania rysunków referencyjnych za pomocą funkcji Background Image. Opisałem je jednak tutaj, gdyż możesz mieć inny styl pracy, lub po prostu preferować taką formę prezentacji, jaką oferują obrazy wyświetlane za pomocą obiektów Empty.
Background Image pomaga także w kompozycji sceny: zdjęcie tła można zamapować w trybie Camera (Rysunek 4.8.16):
Rysunek 4.8.16 Nałożenie zdjęcia tła w trybie Background Image:Camera
Blender domyślnie proponuje kilka różnych układów ekranu, przygotowanych do różnych faz pracy nad projektem. Możesz się pomiędzy nimi przełączać za pomocą listy Screen lay-out (Rysunek 4.9.1a):
Rysunek 4.9.1 Lista Screen lay-out: Zespół kontrolek do zarządzania układem ekranu
Lista układów ekranów (Rysunek 4.9.1b) to jednocześnie dobry przykład typowej kontrolki Blendera do zarządzania referencjami tzw. bloków danych (np. materiałami, teksturami, itp.)1. Po wybraniu z listy Screen lay-out np. układu do pracy nad teksturami (UV Editing) , zobaczysz zupełnie inne okna (Rysunek 4.9.2):
Rysunek 4.9.2 Inny układ ekranu — (UV Editing)
Jeżeli nie jesteś zadowolony z domyślnych ustawień Blendera — możesz tu wszystko pozmieniać. Oprócz zmiany istniejącego układu, istnieje możliwość dodania nowego. Wystarczy nacisnąć przycisk , umieszczony z lewej strony okna (Rysunek 4.9.3a):
Rysunek 4.9.3 Dodanie własnego układu ekranu
Potem możesz już go pozmieniać, jak chcesz (Rysunek 4.9.4):
Rysunek 4.9.4 Nowy układ ekranu: Modeling
Nowy układ już figuruje na liście (Rysunek 4.9.5). Oczywiście, jeżeli nie będziesz zadowolony ze swojego układu — zawsze możesz go usunąć, naciskając przycisk , umieszczony po prawej stronie listy Screen lay-out. Gdy to zrobisz, znajdziesz się w poprzednim układzie (w tym przykładzie byłby to „Default”).
Blender przed usunięciem układu ekranów nie zadaje żadnego pytania typu „jesteś pewien?”. Usuwa i już!
Układy ekranów są zapamiętywane oddzielnie w każdym pliku Blendera. Dlatego np. w pliku pochodzącym z Blendera 2.4 będą miały inne nazwy, niż pokazane na ilustracjach w tym przykładzie. Aby stworzyć układ, którego będziesz używać we wszystkich swoich rysunkach, musisz zapisać go do pliku startowego, poleceniem File→Save User Settings (por. str. 261).
Benderowi towarzyszy dużo dodatków1, rozszerzających jego funkcjonalność. Są to skrypty napisane w języku programowania Python, zazwyczaj przez samych użytkowników. Dodatki to zazwyczaj niewielkie pliki z rozszerzeniem *.py. Oprócz tych, które są dostarczane wraz z Benderem, możesz znaleźć inne np. na forach Blendera w Internecie. Także do tej książki dodałem kilka narzędzi, które wykorzystuję od lat i uważam za bardzo przydatne i godne polecenia (znajdziesz je w pliku source.zip, w scripts\addons — por. str. 18). Instalacja dodatku Blendera może polegać po prostu na wgraniu pliku wtyczki do odp. podkatalogu w folderze z konfiguracją programu (por. str. 268). Jeżeli jednak nie czujesz się w tej materii zbyt pewnie, pokażę tutaj inną, mniej „hakerską” metodę. W oknie User Preferences, sekcji Add-Ons, naciśnij przycisk Install Add-On… (Rysunek 4.10.1):
Rysunek 4.10.1 Wywołanie instalacji dodatku (okno User Preferences)
Blender wyświetli wówczas okno File Browser. Przejdź w nim do katalogu, w którym umieściłeś dodatki do zainstalowania, wskaż jeden z nich, i naciśnij przycisk Install Add-On (Rysunek 4.10.2):
Rysunek 4.10.2 Wybór pliku skryptu do zainstalowania
W oknie File Browser wskazuj zawsze tylko jeden skrypt! Choć Blender w tym oknie pozwala zaznaczyć wiele plików dodatków, to zainstaluje tylko jeden – ten, który zaznaczyłeś jako ostatni.
Dodatek jest już zainstalowany. Abyś ją dostrzegł wśród innych, Blender przełączył wyświetlane kategorie na All i w polu filtra wpisał jego nazwę (Rysunek 4.10.3):
Rysunek 4.10.3 Wygląd okna User Preferences po zainstalowaniu dodatku (Handle Panel)
W razie czego nie bądź przerażony, że z Blendera znikły wszystkie pozostałe dodatki. Wystarczy usunąć filtr (Rysunek 4.10.4):
Rysunek 4.10.4 Wygląd okna User Preferences po usunięciu filtra
Aby usunąć dodatek z Blendera, po prostu naciśnij jej przycisk Remove (Rysunek 4.10.5):
Rysunek 4.10.5 Usuwanie dodatku
Plik Blendera może zawierać wiele scen. Każda z nich to odrębna “przestrzeń”, w której można umieszczać obiekty (więcej na ten temat — str. 397). Domyślnie w nowym rysunku istnieje tylko jedna, o nazwie Scene. Do zarządzania scenami służy zespół kontrolek umieszczony w nagłówku okna Info (Rysunek 4.11.1). Składa się z pola, pokazującego nazwę aktualnej sceny, przycisku rozwijającego listę scen, oraz przycisku usuwającego aktualną scenę.
Aby zmienić nazwę aktualnej sceny, kliknij LPM w jej nazwę, i wpisz nową (Rysunek 4.11.1):
Rysunek 4.11.1 Zmiana nazwy aktualnej sceny
Aby stworzyć nową scenę, naciśnij przycisk , umieszczony z prawej strony nazwy (Rysunek 4.11.2):
Rysunek 4.11.2 Dodanie nowej sceny
Spowoduje to pojawienie się menu New scene, z którego możesz wybrać jedną z opcji:
New: tworzy nową, pustą scenę (z globalnymi ustawieniami jak w pliku startowym);
Copy Settings: tworzy nową, pustą scenę, kopiując globalne ustawienia ze sceny aktualnej;
Link Objects: wypełnia nową scenę referencjami do obiektów z aktualnej sceny. (Ten sam obiekty będzie “użyty” przez obydwie sceny. Więcej na ten temat — str. 397);
Link Object Data: tworzy w nowej scenie kopie obiektów z aktualnej sceny, które współdzielą z obiektami aktualnej siatki, materiały, itp. (To tak, jak gdybyś wszystkie powielił poleceniem Alt-D — Duplicate Linked — str. 302);
Full Copy: cała zawartość nowej sceny będzie niezależną kopią aktualnej;
W praktyce stosuję zazwyczaj opcję Copy Settings (pojedyncze obiekty można później dodać do innej sceny poleceniem Object→Make Links→To Scene). Nowa scena otrzyma taką nazwę, jak scena oryginalna, z dodanym na końcu “.001”. Zmień ją na właściwą.
Aby usunąć aktualną scenę, naciśnij przycisk [x] z prawej strony nazwy (Rysunek 4.11.3):
Blender nie zadaje już żadnego pytania „czy jesteś pewien”: po naciśnięciu przycisku [x] scena znika. Jeżeli usunąłeś ją przez pomyłkę — możesz się z tej operacji wycofać, wywołując polecenie Undo (Ctrl-Z)
W niektórych panelach okna Properties znajdują się listy. Służą do zarządzania materiałami, grupami wierzchołków, alternatywnymi rozwinięciami UV i dziesiątką innych rzeczy. Obsługę listy Blendera pokażę na przykładzie panelu zarządzającego grupami wierzchołków siatki. Inne listy mogą nie mieć niektórych z opisanych tu kontrolek.
Rysunek 4.12.1 opisuje funcje kontrolek widocznych na i wokół listy:
Rysunek 4.12.1 Elementy typowej listy (zawartość panelu Vertex Groups z okna Properties)
Aby zmienić nazwę elementu listy, należy kliknąć ten element myszką (LPM), z wciśniętym na klawiaturze klawiszem Ctrl (Rysunek 4.12.2):
Rysunek 4.12.2 Zmiana nazwy pozycji listy
W etykiecie pozycji pojawia się karetka, i możesz wtedy zmienić wpisany tam tekst. Ta funkcja nie jest związana z żadnym widocznym przez cały czas elementem, ani z żadnym elementem menu kontekstowego1. W podpowiedzi można przeczytać że w celu zmiany nazwy należy kliknąć dwukrotnie na pozycję listy. W praktyce nie zawsze to działa, bo np. pozycje na liście wierzchołków należy kliknąć czterokrotnie (2 x podwójne kliknięcie) aby przełączyła się w ten tryb.
Aby wyszukać na długiej liście element zawierający w nazwie jakiś charakterystyczne słowo, rozwiń sekcję wyszukiwania i wpisz to słowo w polu Search, a następnie naciśnij Enter (Rysunek 4.12.3):
Rysunek 4.12.3 Wyszukiwanie pozycji na liście
Listy Blendera można uporządkować „ręcznie” lub alfabetycznie. Uporządkowanie „ręczne” polega na ustaleniu pozycji kolejnych elementów za pomocą przycisków z prawej strony listy (Rysunek 4.12.4a):
Rysunek 4.12.4 Zmiana uporządkowania listy
Za pomocą przycisku w obszarze wyszukiwania możesz się przełączyć na uporządkowanie w kolejności alabetycznej (Rysunek 4.12.4b). Dodatkowy przycisk z prawej strony pozwala przełączyć się pomiędzy kolejnością rosnącą i malejącą.
Niektóre listy mają dodatkowy przycisk, rowzwijający menu kontekstowe jej elementów (Rysunek 4.12.5). Jego zawartość zależy od rodzaju elementów listy — inne menu zobaczysz dla grup wierzchołków, a inne dla alternatywnych współrzędnych UV. Polecenia z menu kontekstowego mogą dotyczyć całej zawartości listy (np. Lock All) albo aktywnego (podświetlonego) elementu (np. Mirror Vertex Group).
Z edytorem obiektów miałeś już okazję się zetknąć (Rozdział 2, “Blender – pierwsze kroki”). W tym rozdziale omówimy podstawowe pojęcia, które się z nim wiążą.
Pominę tu zagadnienia, które przedstawiał już Rozdział 2. Chodzi tu o:
Tryb edycji obiektów włączasz naciskając przycisk Tab. Alternatywnie możesz także zrobić to za pomocą listy rozwijalnej z nagłówka okna widoku (Rysunek 5.1.1):
Rysunek 5.1.1 Okno widoku: przełączenie w trybu obiektu (Object Mode)
Powtórne naciśnięcie Tab przełączy Cię z powrotem do poprzedniego trybu (np. edycji — Edit Mode). Możesz także wybrać inny tryb z listy rozwijalnej Mode.
Nagłówek okna 3DView w trybie Object Mode ma wiele przydatnych kontrolek (Rysunek 6.2.2) :
Rysunek 5.1.2 Okno widoku: kontrolki dostępne w trybie obiektów
Najpierw umieść kursor 3D w miejscu, gdzie ma być środek okręgu (Rysunek 5.2.1a). (Każdy nowa siatka jest umieszczana tam, gdzie aktualnie jest kursor 3D). Następnie wywołaj polecenie Add→Mesh→Circle (Rysunek 5.2.1b):
Rysunek 5.2.1 Stworzenie okręgu (wieloboku)
Po wywołaniu tego polecenia Blender zawsze wstawia do rysunku okrąg o promieniu = 1 jednostki. Jego siatka składa się z 32 wierzchołków, połączonych w pojedynczą krawędź (Rysunek 5.2.2a).
Możesz także stworzyć okrąg wykorzystując Tool shelf (T): w jego zakładce Create, panelu Add Primitive, naciśnij przycisk Circle (jest w sekcji Mesh).
Aby zmienić te domyślne wartości, zaraz po stworzeniu okręgu naciśnij F6. W oknie dialogowym, które się pojawi (Rysunek 5.2.2b), zmień liczbę wierzchołków i promień okręgu. Nie staraj się wybierać zbyt wielu wierzchołków (pole Vertices). Za chwilę zobaczysz, że 8 zupełnie wystarczy. Zwróć uwagę, że Blender przy każdej zmianie wartości w oknie parametrów polecenia na bieżąco zmienia nowo utworzony obiekt (Rysunek 5.2.2c):
Rysunek 5.2.2 Ustalanie parametrów okręgu
Nasz obiekt to już właściwie ośmiokąt, a nie okrąg. Teraz jednak wygładzimy go w sposób „odwracalny”. Przełącz okno Properties na zestaw Modifiers. Z listy rozwijalnej Add Modifier wybierz modyfikator Subdivision Surface (Rysunek 5.2.3):
Rysunek 5.2.3 Dodanie do obiektu modyfikatora Subdivision Surface
Dodałeś w ten sposób do siatki modyfikator, który w sposób dynamiczny zmienia jej właściwości. Modyfikator Subsurf posiada parametry, które możesz zmienić w jego panelu (Rysunek 5.2.4). Ustaw wartości Subdivisions: View i Render na 2. Zobacz rezultat wygładzenia:
Rysunek 5.2.4 Okrąg wygładzony za pomocą modyfikatora Subdivision Surface
Do wygładzania okręgu i elips najlepiej jest używać schematu obliczeniowego o nazwie Catmull-Clark. Nie zmieniaj tego ustawienia w modyfikatorze Subsurf (Rysunek 5.2.4). Schemat Catmulla-Clarka całkiem dokładnie odwzorowuje takie krzywizny już dla oryginalnej siatki złożonej z 6-8 wierzchołków, i dla niewielkiego poziomu podziału (Subdivisions:View = 2).
Rysunek 5.2.5 Linia podziałowa, uzyskana z 8 wierzchołków linii bazowej i poziomu podziału (Subdivisions) = 3
W przypadku, gdy stworzone koło ma być podstawą do utworzenia jakiegoś niewielkiego, mało istotnego elementu (np. rurek, kabli) — możesz zmniejszyć poziom podziału do 1. Zmniejszy to ogólną liczbę ścian modelu. Gdy chodzi o duży obiekt, jak kołpak śmigła — możesz zwiększyć poziom podziału do renderowania do 3 (aby na pewno wyeliminować nawet małe “nierówności” na obwodzie okręgu).
Jeżeli chcesz dowiedzieć się więcej o krzywych i powierzchniach podziałowych — p. “Powierzchnie podziałowe”, str. 399.
Najpierw umieść kursor 3D w miejscu, gdzie ma być środek kwadratu (Rysunek 5.3.1a). (Każdy nowa siatka jest umieszczana tam, gdzie aktualnie jest kursor 3D). Następnie wywołaj polecenie Add→Mesh→Plane (Rysunek 5.3.1b):
Rysunek 5.3.1 Stworzenie kwadratu
Po wywołaniu tego polecenia Blender wstawia do rysunku kwadrat o boku = 2 jednostki (Rysunek 5.3.2a). Aby zmienić ten domyślny rozmiar, naciśnij F6. W oknie parametrów zmień pole Radius na nową wartość (Rysunek 5.3.2b). (To długość połowy boku kwadratu):
Rysunek 5.3.2 Rezultat i parametry polecenia Plane
Gdy następnym razem wywołasz polecenie Add→Mesh→Plane, Blender stworzy kwadrat o takim rozmiarze jak stworzony ostatnio (program „pamięta” ostatnią wartość Radius i stosuj ją jako domyślną).
Rozmiar każdego obiektu można także zmieniać w inny sposób: zaraz po utworzeniu naciśnij S (Scale) i powiększ go do odpowiedniej skali .
Możesz także stworzyć kwadrat wykorzystując Tool shelf (T): w jego zakładce Create, panelu Add Primitive, naciśnij przycisk Plane (jest w sekcji Mesh).
Umieść kursor 3D w miejscu, gdzie ma być umieszczony nowy walec (Rysunek 5.4.1a). (Każdy nowy obiekt jest umieszczany tam, gdzie aktualnie jest kursor). Następnie wywołaj polecenie Add→Mesh→Cylinder (Rysunek 5.4.1b):
Rysunek 5.4.1 Stworzenie walca
Na scenie pojawi się domyślny walec, o promieniu = 1, wysokości 2 i 32 ścianach bocznych (Rysunek 5.4.2a). (W Twoim przypadku może być inny, bo Blender „pamięta” ostatnio użyte parametry). Stworzony cylinder możesz teraz interaktywnie pozmieniać, otwierając zaraz po stworzeniu Tool Shelf (T). W jego dolnej części znajdziesz panel Add Cylinder, z parametrami tego polecenia:
Rysunek 5.4.2 Vertices: zmiana liczby boków
Rysunek 5.4.2b) pokazuje walec o liczbie boków (Vertices) zredukowanej do 8 (to właściwie graniastosłup). Z kolei przełącznik Cap Ends steruje obecnością ścian podstaw walca (Rysunek 5.4.3):
Rysunek 5.4.3 Cap Ends:włączanie i wyłączanie ścian podstaw walca
Czasami, w małym oknie 3D View, dolna część Tool Shelf z parametrami ostatnio wywołanego polecenia może być „zwinięta”. Możesz ją „wyciągnąć” za pomocą małego uchwytu z ikonką „+”, wystającego z nagłówka okna 3D View. Możesz także nacisnąć F6, by otworzyć na ekranie okno z tym samym panelem Add Cylinder, który jest wyświetlane w Tool Shelf (tylko na innym tle — Rysunek 5.4.4):
Rysunek 5.4.4 Alternatywne okno, pozwalające na interaktywną modyfikację parametrów ostatniego polecenia
Podobnie jak okrąg, walec można jeszcze wygładzić. Wystarczy, że w panelu Modifiers wybierzesz z listy Add Modifier modyfikator Subdivision Surface (Rysunek 5.4.5):
Rysunek 5.4.5 “Wygładzenie” walca
Ustaw parametry Subdivisions: View i Subdivisions: Render na 2. To wartość wystarczająca do uzyskania całkiem porządnego przybliżenia okręgu.
Do wygładzania okręgu i elips najlepiej jest używać schematu obliczeniowego o nazwie Catmull-Clark. Nie zmieniaj tego ustawienia w modyfikatorze Subsurf. Schemat Catmulla-Clarka całkiem dokładnie odwzorowuje takie krzywizny już dla oryginalnej siatki złożonej z 6-8 wierzchołków, i dla niewielkiego poziomu podziału (Subdivisions = 2).
Jeżeli chcesz dowiedzieć się więcej o krzywych i powierzchniach podziałowych — patrz “Powierzchnie podziałowe”, dodatek „Powierzchnie podziałowe”str. 399.
Możesz także stworzyć walec wykorzystując Tool shelf (T): w jego zakładce Create, panelu Add Primitive, naciśnij przycisk Cylinder (jest w sekcji Mesh).
Czasami, podczas pracy z ogranicznikami (constrains) przydają się pomocnicze elementy, służące wyłącznie jako „punkty odniesienia” w przestrzeni. Takie obiekty określane są w Blenderze jako „puste” (Empty), gdyż nie zawierają żadnej siatki. To samo „opakowanie”: środek (położenie), obrót, a także skala. (Skala nie ma wpływu na sam obiekt Empty, ale może mieć na inne, zwykłe elementy „siatkowe”, dla których jest „rodzicem”).
Aby dodać do rysunku nowy obiekt Empty, umieść kursor 3D w miejscu, gdzie ma być jego środek. Następnie wywołaj polecenie Add→Empty (Rysunek 5.5.1):
Rysunek 5.5.1 Stworzenie pustego obiektu
Spowoduje to stworzenie nowego obiektu. Aby w ogóle był widoczny, każdy obiekt typu Empty w trybie Arrows ma włączoną opcję rysowania osi lokalnego układu współrzędnych.
Umieść kursor 3D w miejscu, gdzie ma być umieszczona nowa kamera. (Każdy nowy obiekt jest umieszczany tam, gdzie aktualnie jest kursor). Następnie wywołaj polecenie Add→Camera (Rysunek 5.6.1):
Rysunek 5.6.1 Wstawienie nowej kamery
Jeżeli dodajesz do sceny drugą kamerę, tylko jedna z nich może być kamerą aktywną — czyli taką, z której widok będzie renderowany. Aby uczynić zaznaczoną kamerę aktywną, użyj polecenia View→Cameras→Set Active Object as Camera (Rysunek 5.6.2):
Rysunek 5.6.2 Przełączanie aktywnej kamery
Kamera aktywna jest oznaczana na rysunku wypełnioną „strzałką”.
Możesz także stworzyć kamerę wykorzystując Tool shelf (T): w jego zakładce Create, panelu Add Primitive, naciśnij przycisk Camera (jest w sekcji Other).
Zaznacz obiekt, które chcesz powiększyć/pomniejszyć, oraz ustal środek transformacji (lista Pivot). Praktycznie stosuję jeden z dwóch rodzajów środka: Bounding Box Center albo Cursor 3D. Bounding Box Center to środek najmniejszego “pudełka”, które zawiera środki wszystkich zaznaczonych obiektów. Zacznijmy od przypadku, gdy środkiem skalowania jest właśnie Bounding Box Center (możesz go ustawić z klawiatury — ,), a zaznaczony jest pojedynczy obiekt (Rysunek 5.7.1a):
Rysunek 5.7.1 Skalowanie obiektu
Naciśnij S (Object→Transfrom→Scale). Przełączysz się w ten sposób w tryb skalowania. Na rysunku pojawi się kreskowana linia od kursora myszy do środka transformacji. Każde przesunięcie myszy będzie powodować zmianę skali zaznaczonego obiektu — proporcjonalnie do zmiany długości kreskowanej linii. Dokonywane zmiany są pokazywane na bieżąco we wszystkich oknach Blendera.
W nagłówku aktywnego okna jest wyświetlana aktualna zmiana skali wzdłuż każdej osi. Aby zatwierdzić nowe wymiary obiektu (zakończyć transformację), należy kliknąć LPM. Aby zrezygnować z operacji, możesz w każdej chwili nacisnąć Esc .
Jeżeli w trakcie przesuwania naciśniesz X, Y, lub Z — ograniczysz zmianę skali do jednej z tych osi. W pozostałych kierunkach żaden rozmiar nie ulegnie zmianie. Po pierwszym naciśnięciu klawisza wybrana jest oś globalna. Jeżeli jednak jeszcze raz naciśniesz ten sam klawisz — przełączysz się na lokalną oś obiektu. To rozróżnienie pomiędzy osią globalną i lokalną ma swój sens wtedy, gdy obiekt jest w jakiś sposób obrócony.
Podobne reguły obowiązują przy wyłączaniu ze skalowania jednej z osi: Shift-X, Shift-Y, lub Shift-Z zablokują transformację wzdłuż jednej z globalnych osi (odpowiednio: X, Y lub Z). Aby ograniczyć skalowanie wzdłuż lokalnej osi obiektu, naciśnij taki skrót jeszcze raz.
Podczas zmiany skali możesz dodatkowo trzymać wciśnięty klawisz Ctrl. Spowoduje to skokową zmianę proporcji (np. co 0.1). Jeżeli będziesz trzymał wciśnięty klawisz Shift — zmiana skali na ekranie “wyhamuje”, pozwalając na dokładniejsze ustalenie. Wreszcie kombinacja obydwu — Shift-Ctrl — umożliwia skokową zmianę skali o niewielkie odległości (np. co 0.01).
Zwróć uwagę, że gdy zaznaczysz pojedynczy obiekt, całe to Bounding Box Center wypada po prostu w środku obiektu (Rysunek 5.7.1b). To dlatego, że dla jednego punktu Bounding Box ma zerowy rozmiar.
A jak działa Bounding Box Center dla grupy obiektów? Spróbuj zmienić w tym trybie skalę dwóm obiektom naraz (Rysunek 5.7.2):
Obydwa obiekty jednocześnie oddalają się od siebie i zmieniają rozmiar. Dzieje się tak dlatego, że środkiem transformacji jest punkt w połowie odległości pomiędzy środkami tych obiektów.
Bounding Box Center dla obiektów leży w środku ich punktów odniesienia, a nie siatek (tzn. kształtu)
W Blenderze istnieją dwa polecenia do tworzenia duplikatów obiektu:
Duplikat jest stworzony jako kopia “powiązana” (Object→Duplicate Linked, Alt-D). Kopia może mieć oddzielną skalę, położenie, obrót, ale korzysta nadal z tej samej siatki, co wzorzec. (W efekcie ma zawsze ten sam kształt, co oryginał);
Duplikat jest stworzony jako zwykła kopię (Object→Duplicate, Shift-D). Kopia jest obiektem, który w żaden sposób nie zależy od oryginału.
Wywołanie i obsługa obydwu poleceń jest identyczna, więc opiszę je na przykładzie tworzenia kopii “powiązanej”. Rysunek 5.8.1 pokazuje sytuację początkową. Zaznaczyliśmy obiekt — wzorzec: łopatę śmigła. Utworzymy jej dwie powiązane kopie, tworząc trójłopatowe śmigło.
Rysunek 5.8.1 Łopata śmigła, do której dodamy dwie dalsze — jako powiązane kopie
Naciśnij teraz Alt-D (Object→Duplicate Linked). To stworzyło nowy obiekt. Blender nadaje mu unikalną nazwę poprzez doklejenie do nazwy oryginału końcówki w rodzaju “.001”. Od razu także proponuje dokonać jego przesunięcia (Rysunek 5.8.2a):
Rysunek 5.8.2 Powielenie (poprzez obrót)
Jeżeli nie chcesz przesunąć nowego obiektu, a np. obrócić, wystarczy nacisnąć Esc. To przerwie przesuwanie kopii, ale pozostawi ją jako zaznaczoną. Teraz wystarczy wybrać polecenie dowolnej innej transformacji, którą chcesz zastosować — na przykład R, by nowy obiekt obrócić1 (Rysunek 5.8.2b).
Zwykłą kopię obiektu tworzysz identycznie, tyle tylko że zaczynasz poleceniem Shift-D (Object→Duplicate)
Jaka jest w takim razie praktyczna różnica pomiędzy kopią zwykłą, a kopią powiązaną? Pokażę to na przykładzie śmigła (w którym dodałem już także trzecią łopatę). Wszystkie trzy łopaty wykorzystują tą samą siatkę. Gdy zmodyfikujesz jedną z nich, i powrócisz do trybu obiektu (Object Mode) — zmiana stanie się widoczna we wszystkich trzech instancjach (Rysunek 5.8.3):
Rysunek 5.8.3 Obiekty powiązane — siatka jest zmieniana we wszystkich równocześnie
Więcej na ten temat — patrz “Struktura danych modelu i sceny w Blenderze”, str. 393.
Każdy element rysunku Blendera musi mieć unikalną nazwę. Blender nadaje pewne nazwy domyślne, ale w bardziej złożonym modelu konieczne jest wprowadzenie nazewnictwa w sposób bardziej kontrolowany. Stąd, po utworzeniu każdego nowego obiektu powinieneś nazwać go na nowo.
Aby zmienić nazwę obiektu zaznacz go, i w zestawie Object okna Properties wpisz odpowiedni tekst (Rysunek 5.9.1a). W podobny sposób w zestawie Object Data możesz ustalić nazwę siatki (Rysunek 5.9.1b). Zazwyczaj obydwie nazwy są identyczne, ale czasami może być inaczej (por. nazwa siatki i obiektu pokazywanej przez Rysunek 5.9.1b).
Rysunek 5.9.1 Przykłady nazw obiektów i siatki
Zacznijmy od zasad: jaki system nazewnictwa przyjąć dla elementów naszego modelu? Nazwa nie powinna być długa, zazwyczaj nie powinna przekraczać 20 znaków. Proponuję w związku z tym stosować tekst składający się z następujących segmentów:
segment pełniący rolę unikalnego identyfikatora: składa się z 2 lub 3 części, oddzielonych kropkami:
1 znak: znak, który będzie pełnił rolę wyróżnika wersji samolotu. Wszystkie części w pojedynczym pliku Blendera będą używać takiej samej litery. Na przykład w modelu P-40B nazwy będą zaczynać się od “B”. Okaże się to przydatne później1. Wyjątkiem są elementy specjalne: uchwyty i inne artefakty, używane wyłącznie do animacji modelu. Te mają przedrostek „X”
3 znaki: unikalny numer części. Wydaje mi się, że dobrze jest wydzielić główne podzespoły za pomocą pierwszego znaku. Pozostałe dwa — może to być cyfra, określająca numer części w obrębie zespołu. Oczywiście, także można starać się, aby elementy podzespołów miały zbliżone numery. W takim przypadku radziłbym zwiększać numerację nie co 1, a co 5 (np. “A05”, “A10”, “A15”, “A20”,...). W ten sposób pozostawiamy sobie miejsce w numeracji na ewentualne dodatkowe elementy. (Podczas pracy często się okazuje, że trzeba przekonstruować gotowy zespół. Takie luki w numeracji są wtedy jak znalazł!);
1 znak: opcjonalny znacznik “powielenia”. Może to być “L” lub “R” dla części lewej lub prawej, które są symetryczne. Może także być “nr kolejny”, np. dla 3 łopat śmigła jest to “A”, “B”, “C”;
segment z dodatkową, “ludzką” nazwą. Rola tego fragmentu jest pomocnicza — ma ułatwić identyfikację przez użytkownika. Sądzę, że w związku z tym, że nigdy nie wiesz, do kogo trafi Twoja praca, najlepiej jest stosować nazwy angielskie.
Zgodnie z powyższymi regułami, siatka łopaty śmigła (Rysunek 5.9.1b) nosi nazwę “B.010.Blade”:
“B” — przedrostek, którego będę używał do wszystkich części P-40B;
“010” — numer tej części: “0” będę używać dla podzespołu śmigła, a “10” — to numer kolejny, nadany z zachowaniem zasady “odstępu w numerach co 5”;
segment nazwy: “Blade”.
Zwróć uwagę, że obiekty poszczególnych łopat śmigła, pokazywanych przez Rysunek 5.9.1, różnią się znacznikiem „powielenia”. Dodatkowo, nazwa siatki (B.010.Blade) i nazwa obiektu (B.010.B.Blade) różnią się od siebie. Stało się tak dlatego, że wszystkie trzy łopaty śmigła (B.010.A.Blade, B010.B.Blade, B.010.C.Blade) używają jednej i tej samej siatki, o nazwie B.010.Blade. Są one tzw. kopiami powiązanymi, które, w wyniku użycia tej samej siatki, będą miały zawsze ten sam kształt. (Więcej szczegółów na temat kopii powiązanych — str. 302).
Dlaczego trzeba nadawać oddzielne nazwy obiektowi i siatce? Skąd w ogóle taki podział, i czym w Blenderze jest w takim razie “obiekt”? Jeżeli nurtują Cię takie pytania, zajrzyj na str. 393, do sekcji “Struktura danych modelu i sceny w Blenderze”.
Najpierw zaznacz obiekty, które chcesz uczynić podrzędnymi. Gdy wszystkie już zaznaczysz, włącz do selekcji obiekt, który ma być ich obiektem nadrzędnym. Koniecznie upewnij się, że jego nazwa pojawiła się w lewym, dolnym narożniku ekranu, (tzn. że stał się obiektem aktywnym). Następnie naciśnij Ctrl-P (Object→Parent→Set→Object). Rysunek 5.10.1 pokazuje ten moment w przypisywaniu trzech łopat śmigła (B.010.*.Blade) do kołpaka (B.005.Hub):
Rysunek 5.10.1 Tworzenie powiązań hierarchicznych
Gdy wybierzesz z menu Set Parent To, które pojawi się na ekranie, polecenie Object (Rysunek 5.10.1), nic właściwie widocznego na scenie się nie zmieni. Dopiero w podglądzie struktury sceny zobaczysz różnice (Rysunek 5.10.2):
Rysunek 5.10.2 Utworzone powiązanie hierarchiczne
Bezpośrednim efektem przypisania łopat do kołpaka jest ułatwienie w manipulacji obiektami na scenie. Wcześniej, aby obrócić czy przesunąć ten zespół, musiałbyś dokonać odpowiedniej transformacji oddzielnie na każdym obiekcie. Przypisując łopaty do kołpaka, “skleiłeś” je ze sobą. Od tej chwili, gdy tylko obrócisz lub przesuniesz kołpak, łopaty będą także się obracać i przesuwać — jak w prawdziwym śmigle.
Nic nie stoi na przeszkodzie, aby później uczynić kołpak śmigła obiektem podrzędnym kadłuba. W ten sposób tworzysz bardzo istotną hierarchię części modelu.
Do wyznaczenia przecięcia dwóch powłok proponuję użyć dołączonego do tej książki dodatku o nazwie Intersection 1. Powinieneś go znaleźć w oknie User Preferences, sekcji Addons:Object (Rysunek 5.11.1):
Rysunek 5.11.1 Aktywacja dodatku do wyznaczenia krawędzi przecięcia siatek dwóch obiektów
Zaznacz najpierw dwa obiekty, dla których chcesz znaleźć krawędź przecięcia (Rysunek 5.11.2):
Rysunek 5.11.2 Zaznaczenie obiektów i wywołanie polecenia
Kolejność zaznaczania jest ważna: najpierw wskaż obiekt który pełni rolę „narzędzia tnącego”, a potem obiekt do którego siatki skrypt doda krawędź przecięcia. Następnie naciśnij klawisz W, by otworzyć menu Specials, i wybierz z niego polecenie Intersection (Rysunek 5.11.2).
Po uruchomieniu na ekranie pojawi się okno dialogowe z opcjami polecenia (Rysunek 5.11.3a):
Rysunek 5.11.3 Wyznaczenie krawędzi przecięcia
Na razie niczego w nim nie zmieniaj, tylko naciśnij przycisk OK. W zależności od liczby ścian przecinanych siatek operacja może potrwać sekundę lub dwie. Intersection dodaje wyznaczoną krawędź przecięcia do siatki aktywnego obiektu, zaznacza jej wierzchołki, i przełącza Blender w tryb Edit Mode, abyś mógł je od razu zobaczyć (Rysunek 5.11.3b). Jeżeli nie jesteś zadowolony z rezultatów — wystarczy nacisnąć X, aby je usunąć, po czym powrócić (Tab) do Object Mode i spróbować wywołać polecenie jeszcze raz, z innymi ustawieniami.
Pierwsza z opcji operacji — Use selected faces — ma znaczenie tylko wtedy, gdy wcześniej w Edit Mode zaznaczyłeś jakieś ściany przecinanych siatek. Dodatek Intersection ograniczy wówczas zakres operacji tylko do tego zaznaczonego obszaru. Jeżeli nic nie jest na siatkach zaznaczone — sprawdzane są ich wszystkie ściany.
Gdy druga opcja — Use both meshes — jest włączona, skrypt buduje rezultat z punktów przecięcia krawędzi obydwu siatek (Rysunek 5.11.4a):
Rysunek 5.11.4 Wpływ opcji Use both meshes na krawędź przecięcia
Gdy ją wyłączysz, rezultat będzie zawierać wyłącznie punkty przecięcia aktywnego obiektu ze ścianami obiektu „tnącego” (Rysunek 5.11.4b). Taki efekt może być przydatny przy odpowiednio gęstych siatkach.
Skrypt Intersection wyszukuje punkty przecięcia krawędzi jednej z siatek ze ścianami drugiej i łączy je we wspólną linię. Podczas obliczeń każda czworokątna ściana jest dzielona przekątną (diagonal), aby zamienić ją na dwie ściany trójkątne. Zazwyczaj punkty przecięcia tych tymczasowych przekątnych ze ścianami drugiej siatki są pomijane.
Jeżeli jednak włączysz opcję Use diagonals, zobaczysz je wszystkie (Rysunek 5.11.5a):
Rysunek 5.11.5 Wpływ opcji Use diagonals na krawędź przecięcia
Rysunek 5.11.5b) przedstawia przekątną wybranej ściany i jej punkty przecięcia ze ścianami drugiej siatki. Opcję Use diagonals pozostawiłem tylko na wszelki wypadek — zazwyczaj jej nie używam.
Ta sama operacja dostępna jest także w Edit Mode, pod nazwą Intersect. W tym trybie służy do przecinania zaznaczonych ścian z pozostałymi ścianami siatki (Rysunek 5.11.6):
Rysunek 5.11.6 Wywołanie polecenia Intersect w trybie edycji siatki
W tej wersji polecenia jego opcje są dostępne w panelu przybornika (Toolshelf, T). Możesz je tu przestawiać, interaktywnie zmieniając rezultat. Jeżeli chcesz wykluczyć jakieś ściany z przecinania — ukryj je (H) przed tą operacją, a po jej zakończeniu „odkryj” powtórnie (Alt-H).
Dodatek Intersection jest od 2009r. udostępniany na zasadach Open Source (jak wszystkie dodatki do Blendera, które napisałem). Sądząc z liczby pobrań, wielu użytkowników uznało go za przydatny. Przypuszczam, że jest „przodkiem” polecenia Intersect, dodanego do Blendera w 2014 roku prez jedego z jego głównych programistów (Campbella Bartona). W odróżnieniu od mojego Intersection, który tworzy pojedynczą krawędź niepowiązaną z resztą siatki, ten Intersect dzieli jej ściany.
Zasada działania jest bardzo podobna: zaznacz w Edit Mode siatkę, którą chcesz przeciąć (Rysunek 5.11.7), a następnie wywołaj Mesh→Faces→Intersect:
Rysunek 5.11.7 Wywołanie standardowego polecenia Intersect (Blender 2.72)
W rezultacie uzyskujesz taką krawędź przecięcia, jak w dodatku Intersection dla włączonej opcji Use both faces (por. Rysunek 5.11.4). Zwróć uwagę opcję Separate. Gdy jest wyłączona — Faces→Intersect scala siatkę wzdłuż znalezionej krawędzi przenikania. Gdy opcja Separate jest włączona — ściany siatki są dzielone przez krawędź przecięcia na dwie rozłączne części (Rysunek 5.11.8):
Rysunek 5.11.8 Efekt działania opcji Separate
W takim przypadku każda z początkowych powłok (zaznaczona i nie zaznaczona) jest podzielona na dwie części (Rysunek 5.11.8b). Pod każdym z widocznych wierzchołków krawędzi przenikania znajdują się trzy inne. Aby szybko zaznaczyć każdą z wynikowych powłok, zanacz jeden z jej zewnętrznych wierzchołków, a następnie wywołaj polecenie Select→Linked (Ctrl-L, Rysunek 5.11.8a). Potem możesz łatwo odsunąć taką powłokę, „oczyszczając” w ten sposób uszyskaną krawędź z niepotrzebnych ścian.
Używaj dodatku Intersection gdy chcesz uzyskać tylko krawędź przenikania, a polecenia Faces→Intersect — gdy potrzebujesz odciętych ścian.
Scalenie dwóch obiektów oznacza scalenie ich siatek. Jednocześnie wszystkie wskazane obiekty, poza obiektem aktywnym, przestają istnieć.
Operację tę wykonuję często by przenieść uzyskaną krawędź przecięcia (p. str. 308) do drugiej siatki. Rysunek 5.12.1 przedstawia jedną z takich sytuacji. Pomocniczy obiekt (B.115.T.Main Wheel) to obrys (nie wygładzony) otworu na koło główne. Jego siatka zawiera także krawędź przecięcia z powierzchnią płata:
Rysunek 5.12.1 Pomocniczy obiekt — zawiera krawędź przecięcia ze skrzydłem
Tylko ta krawędź jest potrzebna do dalszej pracy. Powinna się jednak znaleźć w siatce skrzydła, aby można z niej było stworzyć otwór na podwozie główne. W tym celu należy scalić obydwa obiekty.
Zaznacz najpierw obiekt, który zniknie, a na koniec — obiekt, który ma pozostać po tej operacji. (Podczas scalania obiekt aktywny “wchłania” pozostałe). Następnie naciśnij Ctrl-J (Object→Join — Rysunek 5.12.2):
Rysunek 5.12.2 Połączenie siatek dwóch obiektów
Jedyną widoczną zmianą wywołania tego polecenia jest wygładzenie krawędzi pomocniczego obiektu.
Jeżeli jednak przełączysz się w tryb edycji (naciśnij Tab), zobaczysz że siatki tych dwóch obiektów uległy scaleniu (Rysunek 5.12.3):
Rysunek 5.12.3 Rezultat — połączone siatki
Pomocniczy obiekt (B.115.T.Main Wheel) przestał istnieć. Możesz teraz usunąć niepotrzebne wierzchołki z tej pomocniczej siatki, pozostawiając w płacie krawędź do wykonania otworu.
Operacją odwrotną do scalenia siatek obiektów jest wydzielenia siatki (Separate, str. 363).
Punkt odniesienia obiektu, używany dla określenia położenia, obrotu, i skali, nazywany jest w Blenderze środkiem obiektu. To polskie tłumaczenie angielskiego terminu origin wywołuje czasem niewłaściwe skojarzenia, bo środek obiektu często wcale nie leży w jego środku geometrycznym.
Stosunkowo często pojawia się konieczność zmiany położenia środka obiektu względem jego siatki. Najszybciej możesz to zmienić w następujący sposób (Rysunek 5.13.1):
zaznacz obiekt;
umieść kursor 3D w miejscu, w którym chcesz umieścić nowy środek obiektu;
Wywołaj polecenie Origin to 3D Cursor. Możesz to zrobić listy rozwijalnej Set Origin zakładki Tools przybornika Toolshelf (T — jak pokazuje to Rysunek 5.13.1) albo z menu Object→Transform;
Rysunek 5.13.1 Zmiana położenia środka obiektu
W efekcie środek obiektu znajdzie się w miejscu wskazanym przez kursor 3D. Zmiana położenia środka obiektu jest “jego wewnętrzną sprawą”. Nie powinna wpłynąć na jego rozmiar ani położenie w przestrzeni (chyba, że obiekt jest obrócony w jakiś specyficzny sposób!).
Czasami, podczas pracy, przydatna jest możliwość ukrycia na jakiś czas niektórych obiektów. Jest to szczególnie ważne wtedy, gdy jedna część zasłania drugą.
Aby ukryć zaznaczony obiekt (lub obiekty), po prostu naciśnij H (Object→Show/Hide→Hide Selected). To sprawi, że zaznaczenie zniknie (Rysunek 5.14.1):
Rysunek 5.14.1 Ukrycie wybranego obiektu
Aby ukryte obiekty stały się z powrotem widoczne — naciśnij Alt-H (Object→Show/Hide→Show Hidden).
Podczas pracy nad modelem potrzeba czasami ustawić płaszczyznę widoku (czyli płaszczyznę, po której możemy przesuwać obiekty) prostopadle do wybranego obiektu. Aby to zrobić, zaznacz obiekt, do którego chcesz się “wyrównać” (Rysunek 5.15.1a). Następnie rozwiń menu View→Align View→Align View to Selected (Rysunek 5.15.1b):
Rysunek 5.15.1 Wyrównanie aktualnego widoku do wybranego obiektu
Z menu Align View to Selected możesz wybrać jedną z sześciu “kardynalnych” płaszczyzn obiektu (Rysunek 5.15.1b). Efekt zobaczysz natychmiast (Rysunek 5.15.1c). W razie czego, jeżeli za pierwszym razem wybrałeś złą płaszczyznę kardynalną - wywołaj to polecenie jeszcze raz, i wybierz właściwą. Zwróć uwagę, że poszczególnym poleceniom z menu Align View to Selected przypisano skróty klawiatury. Są łatwe do zapamiętania: wystarczy poprzedzić skrót, którym zmieniasz projekcję względem globalnego układu współrzędnych klawiszem Shift. I tak, jeżeli normalnie wybierałeś widok z góry klawiszem 7, to na widok z góry w lokalnej płaszczyźnie aktywnego obiektu przełączy Cię Shift-7. Podobnie na lokalny rzut z boku przełączysz się skrótem Shift-3, a z powrotem na „globalny” rzut z boku — klawiszem 3.
Aby sprawdzić, na jakiej warstwie jest pojedynczy obiekt: zaznacz go, i przejdź do zestawu przycisków Object. Tam, w panelu Relations zobaczysz warstwę, do której należy wybrany element (Rysunek 5.16.1):
Rysunek 5.16.1 Warstwy, do których jest przypisany aktywny obiekt.
Klikając w kontrolki Layers (Rysunek 5.16.1) zmienisz przypisania obiektu do warstwy. Zwróć uwagę, że w Blenderze obiekt może być równocześnie na wielu warstwach (gdy będziesz klikał w warstwy z wciśniętym klawiszem Shift). Jeżeli włączysz widoczność którejkolwiek z nich — obiekt także stanie się widoczny.
Aby zmienić warstwę dla wielu obiektów jednocześnie: zaznacz je i naciśnij M (Object→Move to Layer…). Rysunek 5.16.2 pokazuje, jak to masz zrobić:
Rysunek 5.16.2 Zmiana warstwy dla grupy obiektów
Na kontrolce, pokazanej w oknie dialogowym (Rysunek 5.16.2) także możesz wskazać naraz wiele warstw. Pamiętaj, że jeżeli przypiszesz wybrane obiekty do warstwy, która jest aktualnie niewidoczna, znikną z ekranu!
Domyślnie Blender przypisuje materiał do siatki (por. str. 262, Rysunek 4.4.3, i str. 378). Czasami jednak potrzebujemy czegoś odwrotnego. Dotyczy to, na przykład, różnych drobnych części o identycznym kształcie — śrub, bolców, jakichś standardowych okuć. Zobacz ten trójkątny element okucia z otworem na oś, który pokazują: Rysunek 5.17.1a) i Rysunek 5.17.2a). Każde okucie składa się z dwóch takich blaszek. Wszystkie blaszki używają tej same siatki, o nazwie B.519.Nest. (Są to jej „klony”). Siatce jest przypisany materiał wyglądający jak „gładka stal” — B.Steel.Smooth. To barwa, w której te płaskowniki występowały najczęściej. Dopóki obiekt ma w kontekście Material włączoną opcję Data (Rysunek 5.17.1b), dopóty „dziedziczy” materiał swojej siatki:
Rysunek 5.17.1 Materiał przypisany do siatki
W innym miejscu — prowadnicy cięgna, przymocowanej do wręgi kadłuba (Rysunek 5.17.2a) — te same blaszki powinny być „pomalowane” na kolor reszty szkieletu: B.Skin.Inner. Czy można ten efekt osiągnąć bez powielania siatki? Tak, wystarczy przełączyć tryb kontekstu Material z Data na Object, i wybrać odpowiedni materiał (Rysunek 5.17.2b):
Rysunek 5.17.2 Materiał przypisany do obiektu
Co właściwie ten przełącznik Object robi? Informuje Blender, że dla tej konkretnej części należy użyć materiału przypisanego do obiektu, a nie do siatki (Data).
Podczas pracy nad modelem często powstaje sytuacja, gdy jakiś obiekt należy umieścić w dokładnie określonym miejscu. Jego aktualne położenie może być przypadkowe, a w każdym razie nieistotne. Robimy to dość często gdy modelujemy zespół złożony z wielu części — np. podwozie lub wnętrze kabiny. Ta sekcja pokazuje szybką i dokładną metodę wykonania takiej operacji.
Rysunek 5.18.1 przedstawia typowy przypadek opisanego powyżej problemu. Właśnie sklonowaliśmy dwie śruby (2 i 3). Śruba 3 ma się znaleźć w osi korbki 1, a śruba 2 — w centrum jej rączki. Jak to zrobić najszybciej i najłatwiej?
Rysunek 5.18.1 Typowy problem: jak najszybciej/najłatwiej osadzić śruby w osiach korbki?
Środek (punkt odniesienia — origin) korbki leży w jej osi obrotu. W tym samym miejscu ma się znaleźć śruba 3. Skorzystajmy z tego faktu i umieśćmy w tym punkcie kursor 3D. Aby to zrobić: zaznacz korbkę (Rysunek 5.18.2a) i naciśnij Shift-S, by rozwinąć podręczne menu Snap (Rysunek 5.18.2b). Wybierz z niego polecenie Cursor to Selected:
Rysunek 5.18.2 Przeniesienia kursora 3D do punktu odniesienia obiektu (origin)
W rezultacie, kursor 3D znajdzie się w środku (punkcie odniesienia) korbki (Rysunek 5.18.2c).
Teraz trzeba jeszcze odpowiednio ustawić tryb transformacji:
przełącz tryb Pivot na 3D Cursor (Rysunek 5.18.3a),
włącz Manipulate center points (Rysunek 5.18.3b):
Rysunek 5.18.3 Ustawienie odpowiednich trybów dla punktu odniesienia i transformacji
Zaznacz śrubę 3, i naciśnij S, rozpoczynając operację zmiany skali. Gdy jest włączony tryb Manipulate center points, rozmiar śruby nie ulegnie zmianie. Gdy podczas zmiany skali tylko jej środek zacznie zmierzać w kierunku środka transformacji — kursora 3D. I o to chodzi! (Rysunek 5.18.4a):
Rysunek 5.18.4 Umieszczenie śruby w zadanym punkcie (poprzez zmianę skali)
Aby szybko zmniejszyć skalę do zera, po prostu naciśnij klawisz 0 (por. str. 57). Dla tej wartości środek śruby 3 znajdzie się dokładnie w tym samym miejscu, co kursor 3D — czyli w osi korbki (Rysunek 5.18.4b). Tyle tylko, że został „zagłębiony” w materiale (Rysunek 5.18.4c).
To na szczęście można szybko skorygować: wystarczy przesunąć śrubę wzdłuż jej lokalnej osi Z (G,Z,Z) dopóty, dopóki jej łeb nie „wynurzy” się z korbki (Rysunek 5.18.5):
Rysunek 5.18.5 Finalne dopasowanie (przesunięcie wzdłuż osi śruby)
Śrubę 2 umieścimy w korbie w ten sam sposób. Musimy tylko umieścić w innym miejscu kursor 3D. W tym celu przełączymy się na chwilę w tryb edycji siatki (Tab), i zaznaczymy wierzchołek leżący w centrum uchwytu (Rysunek 5.18.6a):
Nie zapomnij wyłączyć opcji Manipulate center points po zakończeniu tej operacji. W przeciwnym razie nie będziesz mógł obrócić żadnego obiektu w tej scenie!
Rysunek 5.18.6 Przeniesienia kursora 3D do środka uchwytu
Potem postępujemy tak samo, jak poprzednio: Shift-S, by przywołać menu Snap, i wybrać z niego polecenie Cursor to Selected. W efekcie kursor 3D zostanie umieszczony w podświetlonym wierzchołku.
Wierzchołki siatki bardzo się przydają do ustawienia kursora 3D w różnych kluczowych miejscach. Na przykład, jeżeli nawet nie masz wierzchołka w środku otworu, wystarczy zaznaczyć dwa przeciwległe wierzchołki na jego obwodzie. Polecenie Cursor to Selected umieści kursor 3D dokładnie pomiędzy nimi.
Gdy mamy już kursor 3D w odpowiednim miejscu, można się znowu przełączyć w Object Mode (Tab). Potem ze śrubą 2 postępujemy tak samo, jak ze śrubą 3: zmiana skali do zera (Rysunek 5.18.7a, b):
Rysunek 5.18.7 Umieszczenie śruby w centrum uchwytu
Na koniec dosuwamy łeb śruby do powierzchni korbki, przesuwając ją wzdłuż lokalnej osi Z. Rysunek 5.18.7c) przedstawia gotową korbkę, z dwoma śrubami osadzonymi we właściwych miejscach.
We wprowadzeniu do Blendera omówiliśmy podstawowe metody wyboru obiektów — kliknięcie PPM i zaznaczanie obszarem prostokątnym (B — por. str. 49). W tej sekcji przedstawię kilka innych metod selekcji, które mogą przydać się w trakcie dalszej pracy.
Często wygodniejszą od „prostokąta” metodą zaznaczenia grupy obiektów jest użycie okręgu (C, albo Select→Circle Select — Rysunek 5.19.1):
Rysunek 5.19.1 Zaznaczanie obiektów za pomocą okręgu
Rozmiar okręgu wyboru możesz zmieniać obracając KM. Obiekty wewnątrz okręgu wybierasz pojedynczym kliknięciem LPM. Zwróć uwagę, że podczas wybierania kształt obiektu nie ma żadnego znaczenia — liczy się tylko to, czy jego środek (punkt odniesienia, niekoniecznie środek geometryczny) znajduje się wewnątrz czy na zewnątrz okręgu. Jeżeli chcesz wykluczyć zaznaczone obiekty — zamiast LPM kliknij SPM. Kolejne kliknięcia okręgiem zaznaczają/wykluczają z zaznaczenia grupy obiektów. Wybór kończysz naciśnięciem Esc.
W Blenderze wybierasz środki obiektów (origin), a nie ich kształty!
Powyższa reguła dotyczy każdej metody selekcji — także zwykłego kliknięcia PPM w pojedynczy obiekt. Gdy klikniesz w ten sposób gdzieś pomiędzy środkami dwóch obiektów, Blender zaznaczy ten, którego środek jest bliżej kursora myszki.
A co w sytuacji, gdy pod kursorem klikniętej myszki znajduje się wiele różnych obiektów? Domyślnie Blender wybierze jeden z nich. Abyś mógł świadomie zdecydować, który z takich obiektów ma być wybrany, trzymaj podczas kliknięcia PPM wciśnięty klawisz Alt (Rysunek 5.19.2):
Rysunek 5.19.2 Wybór jednego spośród wielu możliwych obiektów
Gdy klikniesz w ten sposób w grupę obiektów, Blender wyświetla listę ich nazw. Możesz z niej wybrać właściwy element.
Skoro już wybieramy obiekty według nazw: możesz także użyć w tym celu okna Outliner (Rysunek 5.19.3):
Rysunek 5.19.3 Wybór obiektów w oknie Outliner
Kliknięcie LPM w nazwę obiektu w tym oknie działa tak samo, jak kliknięcie obiektu w 3D View: zaznacza obiekt i czyni go obiektem aktywnym. Dodatkowo wciśnięty Shift pozwala dodawać do zbioru selekcji kolejne elementy. Z menu kontekstowego obiektu (kóre otwierasz w oknie Outliner kliknięciem PPM) możesz także wybrać polecenia Select/Deselect (Rysunek 5.19.3). Ciekawym narzędziem w tym menu jest polecenie Select Hierarchy: zaznacza kliknięty obiekt i wszystkie obiekty potomne.
W oknie Outliner można także wyszukiwać obiekty według nazw (Rysunek 5.19.4):
Rysunek 5.19.4 Wybór obiektów według nazwy
W Blenderze każdy kształt odwzorowany jest za pomocą ścian, połączonych w tzw. „siatkę” (mesh). Tryb Edit Mode służy do zmiany siatki pojedynczego obiektu.
Siatka (Mesh) w Blenderze to zbiór elementarnych ścian (face), ich krawędzi (edge) i wierzchołków (vertex). Rysunek 6.1.1 pokazuje przykład takiej siatki:
Rysunek 6.1.1 Elementy siatki (mesh)
Począwszy od wersji 2.63 ściany w Blenderze mogą mieć więcej niż cztery boki. Staraj się jednak używać w modelu ścian czworobocznych, a w miejscach gdzie jest to niemożliwe — trójkątnych. W ten sposób unikniesz wielu problemów podczas eksportu swoich modeli do innych programów lub silników gier. W szczególnych przypadkach mogą w siatce mogą także istnieć krawędzie bez ścian, czy wręcz “osamotnione” wierzchołki bez krawędzi.
W Blenderze występuje także pojęcie “linii wierzchołków” (edgeloop — Rysunek 6.1.1). Najłatwiej wskazać je na siatkach o ścianach prostokątnych. Blender potrafi jednak także znaleźć takie linie także na siatkach o ścianach trójkątnych.
Tryb edycji siatki włączasz naciskając przycisk Tab. Alternatywnie możesz także zrobić to za pomocą menu z nagłówka okna widoku (Rysunek 6.2.1):
Rysunek 6.2.1 Okno widoku: włączenie trybu edycji
Powtórne naciśnięcie Tab przełączy Cię z powrotem do poprzedniego trybu (np. obiektu — Object Mode). Możesz także wybrać inny tryb z nagłówka widoku, listy rozwijalnej Mode.
Nagłówek okna View 3D ma w trybie edycji wiele przydatnych kontrolek:
Rysunek 6.2.2 Okno widoku: kontrolki dostępne w trybie edycji
Mankamentem tego nagłówka jest brak możliwości włączania i ukrywania warstw. (Aby to zrobić, musisz się przełączyć w Object Mode)
W zasadzie, wierzchołki można zaznaczać tak samo, jak całe obiekty (por. str. 49). Gdy klikniesz w jeden z nich PPM — stanie się zaznaczony, i zmieni swój kolor na żółty (Rysunek 6.3.1):
Rysunek 6.3.1 Zaznaczenie pojedynczego wierzchołka
Zwróć uwagę, że kolor krawędzi, wychodzących z zaznaczonego wierzchołka także ulega stopniowej zmianie. Im bliżej zaznaczenia, tym bardziej są żółte. Taka konwencja ułatwia szybkie odnalezienie zaznaczonego na siatce obszaru.
Aby wybrać wiele wierzchołków, jeden po drugim: trzymaj wciśnięty klawisz Shift i klikaj w nie po kolei PPM (Rysunek 6.3.2):
Rysunek 6.3.2 Wybór wielu wierzchołków
Kombinacja Shift - PPM działa jak przełącznik stanu zaznaczenia: pierwsze kliknięcie w wierzchołek włącza go do wybranych wierzchołków. Następne kliknięcie — wyklucza z tego zbioru.
Jeżeli chcesz szybko zrezygnować z aktualnego zaznaczenia — naciśnij klawisz A (Select→Select/Deselect All). Jeżeli chcesz zaznaczyć wszystko — naciśnij ten klawisz powtórnie. (Polecenie to działa jak przełącznik: “wszystko - nic”).
Na siatce złożonej z czworoboków można także szybko wskazać cały rząd wierzchołków, tworzących topologicznie linię (edgeloop) . Trzymając wciśnięty Alt, kliknij PPM w jedną z krawędzi siatki (Rysunek 6.3.3):
Rysunek 6.3.3 Zaznaczanie linii wierzchołków
Analogicznie, jak w przypadku pojedynczych wierzchołków, możesz wyłączać/wykluczać z selekcji całe linie. Trzymaj na klawiaturze wciśnięte Alt-Shift, i klikaj PPM w krawędzie odpowiednich linii (Rysunek 6.3.4):
Rysunek 6.3.4 Wykluczanie z wyboru linii wierzchołków
Możesz także odwrócić aktualną selekcję (tzn. wybrać to, co nie jest zaznaczone): wystarczy nacisnąć na klawiaturze I (to skrót od Select→Inverse).
W Blenderze jest także dostępne wybieranie obszarem prostokątnym. Naciśnij B (Select→Border Select) (Rysunek 6.3.5).
Rysunek 6.3.5 Zaznaczanie obszarem prostokątnym
Zaznaczone w ten sposób wierzchołki są dodawane do wybranych poprzednio. Pozwala to zaznaczać jakieś złożone kształty „kawałek po kawałku”.
Osobiście wolę jednak posługiwać się inną odmianą wyboru obszarem: wyborem okręgiem. Aby włączyć ten tryb, naciśnij klawisz C (Select→Circle Select) . Wokół kursora na ekranie pojawi się okrąg (Rysunek 6.3.6):
Rysunek 6.3.6 Zaznaczanie okręgiem
W tym trybie, gdy klikniesz LPM, zaznaczysz wierzchołki, które są wewnątrz okręgu. Rozmiar okręgu możesz zwiększać lub zmniejszać, obracając KM. Klikając w różne miejsca, możesz włączać kolejne wierzchołki do zbioru selekcji.
Każdy z tych trybów wyboru możesz przerwać (zrezygnować), naciskając Esc.
Na koniec chciałbym przypomnieć, jak ważne podczas zaznaczania jest właściwe dobranie widoku. Rysunek 6.3.7 pokazuje, co się może stać, gdy zaznaczamy obszarem wierzchołki, za którymi są jeszcze dalsze punkty siatki:
Rysunek 6.3.7 Zaznaczanie obszarem — projekcja dobrana niewłaściwie
Rysunek 6.3.8 pokazuje, jak wygląda projekcja lepiej dobrana do tej sytuacji. Gdy nic nie leży poza zaznaczanymi wierzchołkami, nie ma możliwości przypadkowego zaznaczenia czegokolwiek dodatkowego:
Rysunek 6.3.8 Zaznaczanie obszarem — projekcja dobrana właściwie
Do tej pory omówiłem szczegółowo tryb wybierania wierzchołków. Ale na tym możliwości programu się nie kończą. W nagłówku okna widoku mamy do dyspozycji jeszcze dwa dalsze tryby (Rysunek 6.3.9):
Rysunek 6.3.9 Włączony tryb selekcji wierzchołków w nagłówku okna View 3D
W każdym z trzech dostępnych trybów selekcji (wierzchołków, krawędzi, ścian) możesz stosować wszystkie metody zaznaczania, które opisałem na poprzednich stronach.
Gdy włączysz tryb zaznaczania krawędzi, zmieni się sposób wyświetlania siatki (Rysunek 6.3.10):
Rysunek 6.3.10 Tryb zaznaczania krawędzi
Tryb zaznaczania krawędzi jest przydatny np. wtedy, gdy chcesz usunąć ich grupę bez usunięcia wierzchołków. W trybie zaznaczania wierzchołków masz dwa razy więcej do “klikania”!
Ostatnim trybem zaznaczania jest zaznaczanie całych ścian (Rysunek 6.3.11):
Rysunek 6.3.11 Tryb zaznaczania ścian
W przypadku wybierania ścian obszarem prostokątnym (B) lub okręgiem (C) — wybrane zostaną te, których środki będą się znajdować wewnątrz zaznaczonych obszarów.
Zaznacz wierzchołki, które chcesz przesunąć, a następnie naciśnij G (Mesh→Transfrom→Grab/Move) (Rysunek 6.4.1a):
Rysunek 6.4.1 Zaznaczenie wierzchołków
Przełączysz się w ten sposób w tryb przesuwania. Każdy ruch myszy będzie powodować przemieszczenie zaznaczonych wierzchołków. Dokonywane zmiany w kształcie siatki są pokazywane na bieżąco we wszystkich oknach Blendera. W nagłówku aktywnego okna jest wyświetlane bieżące przesunięcie (Rysunek 6.4.1b). Aby zatwierdzić nowe położenie (zakończyć operację), należy kliknąć LPM. Aby zrezygnować, możesz w każdej chwili nacisnąć Esc .
Jeżeli w trakcie przesuwania naciśniesz X, Y, lub Z — ograniczysz swój ruch tylko do translacji wzdłuż jednej z tych osi. Po pierwszym naciśnięciu klawisza jest to oś globalna. Jeżeli jednak naciśniesz ten sam klawisz po raz drugi — przełączysz się na lokalną oś obiektu. Takie rozróżnienie pomiędzy osią globalną i lokalną ma znaczenie wtedy, gdy obiekt jest w jakiś sposób obrócony. Rysunek 6.4.2 pokazuje przykład takiej sytuacji. Łopata śmigła została najpierw (jako obiekt) obrócona o 120º w prawo. Następnie przełączyłem się w tryb edycji, zaznaczyłem kilka wierzchołków siatki, i nacisnąłem G, X. W efekcie mogę przesuwać wierzchołki wzdłuż globalnej osi X — na bok (Rysunek 6.4.2b). Jeżeli nacisnę jeszcze raz X — przełączę się na przesunięcie wzdłuż lokalnej osi X obiektu (Rysunek 6.4.2c):
Rysunek 6.4.2 Przesuwanie wzdłuż globalnej osi X (X) i lokalnej osi X (X, X)
W związku z tym, że obiekt został wcześniej obrócony, jego lokalna oś X jest pochylona. Przesunięcie “na bok” zaznaczonych wierzchołków oznacza w tym przypadku przemieszczenie pod kątem!
Podczas przesuwania możesz dodatkowo trzymać wciśnięty klawisz Ctrl. Spowoduje to skokową zmianę odległości (np. co 0.1 jednostki). Jeżeli będziesz trzymał wciśnięty klawisz Shift — przesunięcia na ekranie “wyhamują”, pozwalając na dokładniejsze ustalenie pozycji. Wreszcie kombinacja obydwu — Shift-Ctrl — umożliwia skokową zmianę położenia o niewielkie wartości (np. co 0.01 jednostki).
Zaznacz grupę wierzchołków, które chcesz powiększyć/pomniejszyć, oraz ustal środek transformacji (na liście Pivot — Rysunek 6.5.1). Praktycznie stosuję dwa — trzy rodzaje środków: Bounding Box Center, Median Point oraz Cursor 3D. Bounding Box Center to środek „pudełka” nadpisanego na zaznaczonych wierzchołkach. Median Point to wypadkowy środek wszystkich zaznaczonych wierzchołków. (W przypadku trójkąta leży w “środku ciężkości” tej figury). W ostatnim z wymienionych trybów środkiem transformacji jest 3D Cursor. Zacznijmy od trybu w którym środkiem skalowania jest Median Point (możesz go także ustawić używając skrótu Shift-,).
Naciśnij S (Mesh→Transfrom→Scale). Przełączysz się w ten sposób w tryb skalowania. Na rysunku pojawi się kreskowana linia od kursora myszy do środka transformacji. Każde przesunięcie myszy będzie powodować zmianę skali zaznaczonych wierzchołków — proporcjonalnie do zmiany długości kreskowanej linii. Dokonywane zmiany w kształcie siatki są pokazywane na bieżąco we wszystkich oknach Blendera (Rysunek 6.5.1):
Rysunek 6.5.1 Skalowanie względem środka zaznaczonych wierzchołków
W nagłówku aktywnego okna jest wyświetlana aktualna zmiana skali wzdłuż każdej osi. Aby zatwierdzić nowe położenie wierzchołków (zakończyć transformację), należy kliknąć LPM. Aby zrezygnować z operacji, możesz w każdej chwili nacisnąć Esc .
Podczas zmiany skali możesz dodatkowo trzymać wciśnięty klawisz Ctrl. Spowoduje to skokową zmianę proporcji (np. co 0.1). Jeżeli będziesz trzymał wciśnięty klawisz Shift — zmiana skali na ekranie “wyhamuje”, pozwalając na dokładniejsze ustalenie. Wreszcie kombinacja obydwu — Shift-Ctrl — umożliwia skokową zmianę skali o niewielkie wartości (np. co 0.01).
Jeżeli w trakcie przesuwania naciśniesz X, Y, lub Z — ograniczysz zmianę skali do jednej z tych osi. W pozostałych kierunkach żaden rozmiar nie ulegnie zmianie. Po pierwszym naciśnięciu klawisza jest wybrana oś globalna. Jeżeli jednak jeszcze raz naciśniesz ten sam klawisz — przełączysz się na lokalną oś obiektu. To rozróżnienie pomiędzy osią globalną i lokalną ma swój sens wtedy, gdy obiekt jest w jakiś sposób obrócony.
Aby ograniczyć skalowanie do jednej płaszczyzny, użyj skrótu Shift-[blokowana oś]. Np. Shift-Z blokuje zmiany wzdłuż globalnej osi Z. Gdy naciśniesz taki skrót jeszcze raz, zablokujesz skalowanie wzdłuż lokalnej osi obiektu. (Dlatego aby zablokować zmiany wzdłuż lokalnej osi Z, naciśnij powtórnie Shift-Z).
Pokażę to na przykładzie modyfikacji krawędzi spływu końcówki skrzydła (Rysunek 6.5.2):
Rysunek 6.5.2 Wykluczenie jednej osi ze zmiany skali
Za pomocą zmiany skali chcę przesunąć zaznaczone wierzchołki bliżej konturu końcówki, narysowanego na płaszczyźnie X,Y na czerwono (Rysunek 6.5.2a). Zależy mi jednak na tym, aby współrzędne Z krawędzi spływu i pozostałych zaznaczonych wierzchołków (Rysunek 6.5.2d) nie uległy podczas tej operacji zmianie.
Po naciśnięciu S naciskam skrót Shift-Z aby zablokować oś Z (Rysunek 6.5.2b). W ten sposób współrzędne Z skalowanych wierzchołków nie ulegają zmianie (porównaj Rysunek 6.5.2d i Rysunek 6.5.2e). Gdy skończysz transformację, w opcjach wykonanego polecenia Resize możesz się upewnić, że przełącznik Constraint Axis: Z jest wyłączony (Rysunek 6.5.2c).
Rysunek 6.5.3a) pokazuje inny przykład — krawędź, którą „spłaszczymy” skalując wzdłuż jednej osi. Punktem odniesienia będzie tu 3D Cursor. Umieszczam go na płaszczyźnie, gdzie chcę mają się znaleźć wszystkie wybrane wierzchołki. Na tym przykładzie część krawędzi leży we właściwym miejscu. Zaznaczyłem więc jeden z poprawnych wierzchołków i przeniosłem w to miejsce kursor 3D (Shift-S, 3 — Rysunek 6.5.3b,c):
Rysunek 6.5.3 Spłaszczenie krawędzi — ustawienie kursora 3D w odpowiednim miejscu
Przełączyłem typ punktu odniesienia na 3D Cursor (na klawiaturze: .) i zaznaczyłem wszystkie wierzchołki krawędzi. Nacisnąłem S, Y. Następnie naciśnij klawisz 0 (por. str. 57) by zmniejszyć odległość wierzchołków od środka skalowania do zera (Rysunek 6.5.4):
Rysunek 6.5.4 Spłaszczenie krawędzi — poprzez zmianę skali do zera
Zmianę skali do zera wzdłuż jednej lub wszystkich osi można także stosować do dokładnego “spłaszczania” lub ustalania pozycji wierzchołków.
W czasie modelowania bardzo często używam skalowania do realizacji tych dwóch zadań.
Zaznacz grupę wierzchołków, które chcesz obrócić, oraz ustal środek transformacji (Pivot) (Rysunek 6.6.1). Praktycznie stosuję jeden z dwóch rodzajów środka: Bounding Box Center albo 3D Cursor . W tym przypadku, środkiem obrotu będzie 3D Cursor. Możesz go ustawić za pomocą klawiatury — naciśnij klawisz . (kropka):
Rysunek 6.6.1 Przygotowanie operacji
Naciśnij R (Mesh→Transfrom→Rotate). Przełączysz się w ten sposób w tryb obrotu. Na rysunku pojawi się kreskowana linia od kursora myszy do środka transformacji. Każde przesunięcie myszy będzie powodować obrót zaznaczonych wierzchołków — proporcjonalnie do zmiany kąta kreskowanej linii. Dokonywane zmiany w kształcie siatki są wyświetlane na bieżąco we wszystkich oknach Blendera (Rysunek 6.6.2):
Rysunek 6.6.2 Obrót grupy wierzchołków
Domyślnie obrót następuje w płaszczyźnie aktywnego widoku. W nagłówku aktywnego okna jest wyświetlany aktualny kąt obrotu.. Aby zatwierdzić nowe położenie wierzchołków (zakończyć transformację), należy kliknąć LPM. Aby zrezygnować z operacji, możesz w każdej chwili nacisnąć Esc .
Jeżeli w trakcie obrotu naciśniesz X, Y, lub Z — przełączysz się na obrót wokół jednej z tych osi. Po pierwszym naciśnięciu klawisza jest wybrana oś globalna. Jeżeli jednak jeszcze raz naciśniesz ten sam klawisz — przełączysz się na lokalną oś obiektu. To rozróżnienie pomiędzy osią globalną i lokalną ma swój sens wtedy, gdy obiekt jest w jakiś sposób obrócony.
Podczas obrotu możesz dodatkowo trzymać wciśnięty klawisz Ctrl. Spowoduje to skokową zmianę proporcji (co 5º). Jeżeli będziesz trzymał wciśnięty klawisz Shift — zmiana obrót na ekranie “wyhamuje”, pozwalając na dokładniejsze ustalenie. Wreszcie kombinacja obydwu — Shift-Ctrl — umożliwia skokową zmianę obrotu o niewielkie kąty (np. co 0.5º).
Aby wytłoczyć wybraną krawędź, zaznacz ją. Następnie naciśnij E (Mesh→Extrude Region). W tym momencie została utworzona kopia zaznaczonej krawędzi. Kopia ta będzie podążać za ruchem myszki “ciągnąc” za sobą będzie krawędzie poprzeczne, łączące jej wierzchołki z wierzchołkami oryginału. Kliknij LPM w miejscu, gdzie nowa krawędź ma zostać ostatecznie umieszczona (Rysunek 6.7.1):
Rysunek 6.7.1 Wytłaczanie krawędzi
Podczas przesuwania wytłoczonych elementów możesz ograniczyć ich ruch do osi X, Y, lub Z — te skróty działają tak samo, jak w standardowym poleceniu przesunięcia (por. str. 332).
Aby wytłoczyć wybrany obszar, zaznacz go. Następnie naciśnij E (Mesh→Extrude Region). W tym momencie wzdłuż krawędzi zaznaczonego obszaru zostały dodane dodatkowa ściany. Sam obszar będzie podążać za ruchem myszki, zupełnie jak podczas przesuwania. Kliknij LPM w miejscu, gdzie ma zostać ostatecznie umieszczony (Rysunek 6.7.2):
Rysunek 6.7.2 Wytłaczanie obszaru
Domyślnie kierunek przesunięcia jest ograniczony do linii prostopadłej do płaszczyzny przesuwanego obszaru.
Jeżeli zaraz po wywołaniu polecenia Extrude naciśniesz Esc — przerwana zostanie (tylko!) druga część operacji. Mimo, że tego zazwyczaj nie widać, odpowiednie krawędzie/ ściany/ wierzchołki uległy już powieleniu, i są zaznaczone. W razie czego musisz je usunąć dodatkowym poleceniem (Delete).
Gdy zaraz po wywołaniu Extrude naciśniesz S — wytłaczane elementy będą skalowane, a nie przesuwane. (Podobnie gdy naciśniesz R, będą obracane). W taki przypadku uważaj na punkt odniesienia! Lepiej jest używać w tym charakterze kursora (tryb 3D Cursor) — bo to punkt, nad którym w pełni panujesz. Zdanie się na wypadkową środków (Median Point, Bounding Box Center) może prowadzić do niespodziewanych deformacji! (Chyba że zaznaczonych wierzchołki są rozłożone symetrycznie).
Czasami zachodzi także konieczność wytłoczenia wybranych wierzchołków (np. po to, by utworzyć “ręcznie” nową ścianę). Operację zaczynasz tak, jak zazwyczaj — zaznacz wierzchołki do powielenia. Następnie naciśnij Alt-E (to wersja polecenia Extrude pozwalająca wybrać ręcznie tryb pracy). Z menu rozwijalnego, które się pojawi, wybierz Vertices Only. W tym momencie została utworzone kopie zaznaczonych wierzchołków. Kopie te będzie podążać za ruchem myszki. “Ciągnąć” za sobą będą krawędzie, łączące je z oryginałami. Tym razem jednak te krawędzie nie są połączone ścianami. Kliknij LPM w miejscu, gdzie nowe wierzchołki mają zostać ostatecznie umieszczone (Rysunek 6.7.3):
Rysunek 6.7.3 Wytłaczanie pojedynczych wierzchołków w krawędzie
W oknie Properties przejdź do zestawu Modifiers i rozwiń tam listę Add Modifier. Spośród dostępnych “modyfikatorów” siatki wybierz Subdivison Surface (Rysunek 6.8.1):
Rysunek 6.8.1 Dodanie modyfikatora wygładzenia siatki (Subdivision Surface)
Dodanie modyfikatora spowodowało wygładzenie powierzchni - wszystkie narożniki uległy zaokrągleniu “do środka”. Faktura powierzchni zdradza, że teraz zamiast 8 ścian siatka składa się z 32 ścian. Jest to tak zwana “powierzchnia podziałowa”. Wierzchołki oryginalnej siatki pełnią rolę tzw. punktów sterujących (control points). Możesz zmienić kształt powłoki, zmieniając ich położenie. Jednocześnie w zestawie Modifiers pojawiła się panel z parametrami modyfikatora (Rysunek 6.8.2):
Rysunek 6.8.2 Modyfikator Subdivision Surface
Proponuję ustalać liczbę podziałów powierzchni (Subdivisions) na 1-2, w wyjątkowych przypadkach 3. To zapewni odpowiednio małą liczbę ścian przy wystarczającej “gładkości”. Poziom podziału do renderowania (Render) można ustawić o 1 większy. (Choć na pewno w jakimś stopniu wydłuży to czas obliczania finalnego obrazu). Jeżeli chcesz dowiedzieć się więcej o powierzchniach podziałowych — por. “Powierzchnie podziałowe”, str. 399.
Zwróć uwagę, że możesz w każdej chwili zmienić liczbę podziałów powierzchni. To może mieć znaczenie, gdy dla potrzeb gry chcesz mieć model o jak najmniejszej liczbie ścian. Dzięki Subdivision Surfaces możesz używać tego samego modelu raz w roli “dokładnego” (większa liczba ścian). Innym razem — możesz go użyć w roli modelu “uproszczonego” (zmniejszając liczbę ścian poprzez zmniejszenie liczby podziałów).
Subsurf jest modyfikatorem siatki — oznacza to, że zmiany, jakie wprowadził, są odwracalne. Wystarczy że usuniesz ten modyfikator, klikając w mały przycisk w jego lewym, górnym narożniku (Rysunek 6.8.2) . Wygładzona siatka zniknie, i pozostaniesz z powrotem z podstawowym zestawem ścian.
Możesz także “utrwalić” podział siatki — naciskając przycisk Apply (Rysunek 6.8.2). Spowoduje to zniknięcie modyfikatora i trwałe przyjęcie przez siatkę kształtu powierzchni podziałowej.
Początkowo cienie na wygładzonej siatce zdradzają przebieg krawędzi elementarnych ścian (Rysunek 6.8.1). Aby temu zaradzić, zmienimy model cieniowania. Zaznacz wszystkie wierzchołki siatki (naciskając A — Select→Select All). Następnie z menu Specials (W) wybierz Shade Smooth (Rysunek 6.8.3):
Rysunek 6.8.3 Zmiana modelu cieniowania na “gładki”
Efekt nie całkiem odpowiada naszym oczekiwaniom: co to za ciemne cienie, biegnące wzdłuż oryginalnych krawędzi? To rezultat niewłaściwego skierowania wektorów normalnych w niektórych wierzchołkach! Na szczęście poprawienie tego nie jest kłopotliwe. Naciśnij Ctrl-N (Mesh→Normals→Recalulate Outside). Rysunek 6.8.4 przedstawia rezultat:
Rysunek 6.8.4 Uporządkowanie kierunku normalnych
I tym razem rezultat (Rysunek 6.8.4) jest już tym, o co nam chodziło — gładką powierzchnią, bez załamań i cieni w miejscu podziału ścian.
Aby uzyskać z powrotem powierzchnię z pocieniowanymi ścianami — zaznacz całość i wywołaj Specials→Shade Flat.
Zmianę metody cieniowania możesz ustalać oddzielnie dla różnych fragmentów siatki. W zależności od tego, jakie wierzchołki zaznaczysz, część powierzchni może być “smooth”, a część — “flat”.
Zaznacz wierzchołki, które powinny zostać scalone w jeden. Muszą być położone blisko siebie, lub dokładnie w tym samym miejscu. Czasami, aby ten warunek zapewnić, zmniejszałem ich skalę do zera (z włączonym środkiem typu Median Point - p. str. 334).
Następnie naciśnij W, by przywołać menu Specials. Wybierz z niego polecenie Remove Doubles (Rysunek 6.9.1a).
Rysunek 6.9.1 Scalanie wierzchołków
Alternatywnie wybrać to polecenie głównego menu (Mesh→Vertices→Remove Doubles), ale to znacznie dłuższa droga. W efekcie operacji zaznaczone wierzchołki są zamienione w jeden wierzchołek. W oknie 3D View nic się nie zmieniło (bo te punkty i tak były w tym samym miejscu). Jedyną różnicę zauważysz podczas selekcji wierzchołków i krawędzi.
W razie potrzeby aby zmienić parametry tolerancji tego scalania, otwórz przybornik Tool Shelf. Znajdziesz tam pole Merge Distance (Rysunek 6.9.1b). (Ten sam parametr możesz także zmienić naciskając po wywołaniu operacji klawisz F6, by otworzyć jej okno dialogowe).
U góry ekranu, w nagłówku okna Info, po wywołaniu polecenia Remove Doubles program przez kilka sekund wyświetla informację o liczbie usuniętych wierzchołków (Rysunek 6.9.2):
Rysunek 6.9.2 Informacja o rezultacie operacji w oknie Info
Jeżeli nie zdążyłeś go dostrzec — możesz ją zawsze znaleźć we wnętrzu okna Info, gdzie są odnotowywane wszystkie wywoływane polecenia i ew. komunikaty programu. (Wystarczy je powiększyć w pionie, by oprócz nagłówka była widoczna także reszta okna).
Narzędzie Knife pozwala stworzyć w siatce nowe krawędzie. Powstają one poprzez przecięcie zaznaczonych ścian, w kierunku prostopadłym do aktualnego widoku (tzn. płaszczyzny ekranu). Rolę “krawędzi tnącej” pełni narysowana w oknie 3D View pomocnicza linia łamana. Funkcji Knife można używać na wiele różnych sposobów. Do modelowania samolotów używam jej zazwyczaj w trybie cut through, i taki tryb opisuję poniżej.
Zaznacz na siatce krawędzie, które mają zostać przecięte (Rysunek 6.10.1a). W tym przykładzie zaznaczyłem obszarem (B) ściany po obydwu stronach skrzydła (Rysunek 6.10.1b):
Rysunek 6.10.1 Zaznaczenie ścian do przecięcia
Naciśnij Shift-K (Knife) Zwróć uwagę, że kursor myszy zmienił się teraz na mały “skalpel”. Narysuj teraz krawędź tnącą. Kliknij LPM w miejsce ekranu, gdzie ma się znaleźć pierwszy punkt tej krawędzi (Rysunek 6.10.2a). Za kursorem myszy zaczęła teraz podążać linia, pokazująca przebieg pierwszego segmentu cięcia.
Rysunek 6.10.2 Cięcie siatki za pomocą narzędzia Knife
Kliknij LPM w drugi punkt — w ten sposób zakończysz rysowanie pierwszego segmentu (Rysunek 6.10.2b). Blender automatycznie ciągnie od ostatnio narysowanego punktu do kursora myszy kolejną linię (Rysunek 6.10.2c). Jeżeli nie chcesz niczego więcej przecinać — naciśnij Enter lub Spację. To zakończy rysowanie linii i spowoduje dodanie proponowanych krawędzi do siatki. (Jeżeli chcesz zrezygnować z polecenia, w każdym momencie możesz nacisnąć Esc lub PPM).
Rezultat operacji przedstawia Rysunek 6.10.3. Gdy przyjrzysz się temu rezultatowi w przestrzeni, dostrzeżesz że powstała linia biegnąca na górnej i dolnej powierzchni skrzydła (Rysunek 6.10.3b):
Rysunek 6.10.3 Rezultat dwustronnego cięcia — w rzucie z góry i w przestrzeni
Za pomocą Knife można przypadkowo stworzyć ściany o liczbie boków większej niż 4. W grafice komputerowej określa się je jako n-gony. Takie ściany są bardzo przydatne w trakcie formowania siatki. Potem jednak staraj się je zastąpić zespołami kwadratów i trójkątów (por. str. 371).
Zwróć uwagę na informację, wyświetlaną w nagłówku okna w trakcie polecenia Knife. Program wyświetla tam bieżące wartości wewnętrznych flag i klawisze, którymi możesz je przełączyć (Rysunek 6.10.4):
Rysunek 6.10.4 Skróty klawiatury i bieżący stan narzędzia Knife, wyświetlane w pasku stanu
Flagi te odpowiadają następującym trybom działania noża:
ignore snap: wyłączenie wszelkich skoków do punktów charakterystycznych (trochę pokrętnie, bo stan Off oznacza że skok jest aktywny);
angle constrain: prowadź linię cięcia pod „równymi” kątami: 0º, 30º, 45º, 60º, 90º…;
cut through: przecinanie wszystkich zaznaczonych ścian — także gdy są zasłonięte przez inne;
Gdy podczas pracy z modelem zależy Ci na cięciu dokładnie wzdłuż linii poziomej lub pionowej, wówczas przydaje się możliwość włączenia trybu angle constrain (C).
Możesz wywołać Knife za pomocą dwóch skrótów: K (cut through nieaktywne) i Shift-K (cut through aktywne). Gdy tryb cut through jest aktywny, Knife przecina wszystkie zaznaczone ściany, nawet gdy są zasłonięte przez inne. Kiedy cut through jest nieaktywny, cięte są tylko widoczne ściany (niezależnie od tego, czy będą zaznaczone, czy nie).
Tryb cut through miał w Blendere 2.6 kilka błędów, które powodowały że czasami krawędź przecięcia zawierała częściwo odłączone wierzchołki i krawędzie1. Na szczęście w Blenderze 2.70 zostało to poprawione i teraz działa poprawnie.
Zaznacz wierzchołki, które chcesz skopiować (Rysunek 6.11.1):
Rysunek 6.11.1 Zaznaczenie wierzchołków do powielenia
Następnie naciśnij Shift → D (Mesh→Duplicate). W rezultacie w siatce pojawią się nowe wierzchołki. Są one od razu zaznaczone (Rysunek 6.11.2):
Rysunek 6.11.2 Odsunięcie powielonych wierzchołków
Powielony fragment siatki możesz od razu odsunąć od oryginału — zupełnie jak podczas polecenia Grab/Move (por. str. 332). (Na przykład, naciśnij klawisz Z, aby przesunąć je wzdłuż osi Z, i trzymaj wciśnięty klawisz Ctrl, jeżeli mają zostać przesunięte na jakąś równą odległość).
Zaznacz krawędź, które chcesz podzielić. Naciśnij następnie W, by otworzyć menu Specials. Wybierz stamtąd polecenie Subdivide (Rysunek 6.12.1):
Rysunek 6.12.1 Wywołanie z menu Specials polecenia Subdivide
W środku zaznaczonej krawędzi pojawi się nowy wierzchołek. (To samo polecenie znajduje się także w “zwykłym” menu: Mesh→Edge→Subdivide).
Gdy otworzysz przybornik Toolshelf (T) lub naciśniesz F6, zobaczysz parametry tego polecenia (Rysunek 6.12.2):
Rysunek 6.12.2 Paramery polecenia Subdivide
Paramter Number of Cuts steruje liczbą podziałów. To opcja szczególnie użyteczna dla liczb parzystych, których nie możesz uzyskać w wyniku kolejnych wywołań polecenia. Subdivide zazwyczaj zmienia przyległe ściany w n-gony, chyba że włączysz Quad/Tri Mode. Ta opcja zmusza Blendera do podziału przyległych ścian siatki na kwadraty i czworokąty (Rysunek 6.12.2).
Możesz także użyć Subdivide do podziału ścian siatki. Polecenie dzieli ściany czworokątne na cztery lub więcej czworokątów, a trójkątne — na cztery lub więcej trójkątów.
Operacja polega na przesunięciu po ścianach siatki jednej z jej linii wierzchołków (egdeloop) w nowe położenie.
Zaznacz rząd wierzchołków, który ma być przesunięty. (Musi to być konkretny rząd, a nie dowolny zbiór wierzchołków — zaznaczaj więc używając Alt - PPM). Następnie naciśnij Ctrl - E, i z menu Edge Specials wybierz polecenie Edge Slide (Rysunek 6.13.1). (Możesz je także wywołać jako Mesh→Edges→Edge Slide):
Rysunek 6.13.1 Rozpoczęcie przesuwania linii wierzchołków
Od tej chwili każde przesunięcie myszy powoduje wybranej linii wierzchołków. U nagłówku okna Blender wyświetla względne położenie krawędzi w stosunku do linii sąsiednich. Gdy Edge Slide = 0.0, przesuwana krawędź znajduje się w oryginalnym położeniu. Gdy zbliżymy ją do linii z prawej (Rysunek 6.13.1), kształt będzie zmieniał, aż w końcu stanie się identyczny z lewym rzędem (Edge Slide = -1.0). Gdy zbliżymy zaznaczoną linię do linii z lewej, kształt będzie proporcjonalnie się zmniejszał, aż stanie się taki sam jak lewa krawędź (Edge Slide = +1.0) . Kończymy całą operację, naciskając LPM. W każdej chwili możesz z niej zrezygnować, naciskając Esc.
Aby przesunąć pojedynczy wierzchołek wzdłuż jednej z krawędzi które łączy, zaznacz go (Rysunek 6.14.1a) i naciśnij Shift-V (Mesh→Vertices→Vertex Slide):
Rysunek 6.14.1 Przesuwanie wierzchołka po krawędzi
Po wywołaniu tego polecenia Blender zaczyna przesuwać wierzchołek podążając za ruchem kursora myszki. Ten ruch odbywa się po krawędzi, do której jest zbliżony kursor. (Podczas operacji jest zaznaczona grubszą linią — Rysunek 6.14.1b). W nagłówku okna jest wyświetlane jego względne położenie od pozycji początkowej (Vert Slide = 0.0) do końcowej (przy przeciwległym wierzchołku Vert Slide = 1.0). Gdy przesuniesz wierzchołek w nowe miejsce, zakończ operację kliknięciem LPM. (Możesz także w każdej w chwili z niej zrezygnować, naciskając Esc).
Możesz także przesuwać kilka wierzchołków naraz – każdy po „swojej” krawędzi (Rysunek 6.14.2):
Rysunek 6.14.2 Przesuwanie kilku wierzchołków jednocześnie
Zgodnie z podpowiedzią wyświetlaną w nagłówku okna: gdy naciśniesz C przełączając flagę Clamp na OFF, możesz przesunąć wierzchołek poza koniec wybranej krawędzi.
Operacja polega na wstawieniu nowej linii wierzchołków (egdeloop) pomiędzy istniejące linie siatki.
Naciśnij T aby otworzyć przybornik Toolshelf, i z sekcji Add panelu Tools:Mesh Tools wybierz polecenie Loop Cut and Slide (Rysunek 6.15.1):
Rysunek 6.15.1 Wywołanie polecenia Loop Cut
Aby to polecenie wywołać, możesz także użyć skrótu Ctrl-R. Teraz masz wybrać, w jakim kierunku, i pomiędzy którymi liniami chcesz wstawić nowy rząd wierzchołków. W zależności od tego, gdzie ustawisz mysz, Blender pokazuje aktualną możliwość za pomocą fioletowej linii.
Dla uproszczenia tłumaczenia, nazwijmy okręgi na siatce stożka „równoleżnikami”, a krawędzie do nich poprzeczne — „południkami”. Rysunek 6.15.2a) pokazuje, że gdy zbliżysz kursor do jakiegoś „południka” siatki, Blender zaproponuje utworzenie nowego „równoleżnika”. Ta nowa linia zostanie utworzona pomiędzy dwoma sąsiednimi „równoleżnikami”, które są najbliższe kursora. Jeżeli z kolei zbliżysz kursor w pobliże „równoleżnika” — Blender zaproponuje nowy „południk” (Rysunek 6.15.2b):
Rysunek 6.15.2 Wybór kierunku i pary sąsiednich linii
Wybór kierunku i sąsiednich linii siatki zatwierdzasz kliknięciem LPM.
Powiedzmy, że wybraliśmy opcję stworzenia nowego “równoleżnika” (Rysunek 6.15.2a). Po kliknięciu LPM Blender wstawił w zaznaczony obszar nową linię wierzchołków (Rysunek 6.15.3). Od tej chwili każde przesunięcie myszy powoduje przesuwanie wybranej linii wierzchołków po powierzchni siatki — tak jak w poleceniu Edge Slide (por. str. 349). W nagłówku okna 3D View program wyświetla % dystansu pomiędzy sąsiednimi krawędziami. (0% odpowiada krawędzi leżącej dokładnie pośrodku). Kończymy całą operację, naciskając powtórnie LPM. W każdej chwili możesz z niej zrezygnować, naciskając Esc.
Ostateczny efekt pokazuje Rysunek 6.15.4 — możesz porównać ze stanem początkowym (Rysunek 6.15.1):
Rysunek 6.15.4 Wstawiony nowy rząd wierzchołków
Blender pozwala na zmianę ostrości wybranych krawędzi “wygładzonej” siatki. Możesz ten efekt płynnie stopniować. Sprowadza się to do tego, że każda krawędź ma dodatkowy parametr — Crease — który może przyjmować wartości od 0.0 (zupełnie gładka) do 1.0 (zupełnie ostra). Zmianę ostrości pokażę na przykładzie zwiększenia ostrości krawędzi podstawy stożka. (Analogicznie możesz wygładzić ostrą krawędź).
Zaznacz krawędzie, które chcesz wyostrzyć. Następnie naciśnij Shift-E (Mesh→Edges→Edge Crease) (Rysunek 6.16.1):
Rysunek 6.16.1 Stan początkowy: krawędź “naturalnie zaokrąglona”
Spowoduje to pojawienie się pomocniczej, przerywanej linii, biegnącej od środka zaznaczonych wierzchołków do aktualnej pozycji kursora myszy (Rysunek 6.16.2):
Rysunek 6.16.2 Wyostrzanie krawędzi
Od tej chwili położenie kursora określa poziom wyostrzenia (Crease) . Jego wartość jest pokazywana na bieżąco w nagłówku aktywnego okna (Rysunek 6.16.2). Do dyspozycji masz zakres wartości od Crease = 0 (naturalna, gładka powierzchnia), do Crease = 1.0 (ostra krawędź). Rysunek 6.16.2 pokazuje, na ile wyostrzyła się krawędź przy Crease = 0.4.
Podczas zmiany ostrości krawędzi możesz także wykorzystywać klawisz Ctrl — powoduje skokową zmianę parametru Crease o 0.1.
Gdy zwiększysz ostrość (crease) do poziomu = 1.0, uzyskasz absolutnie ostrą krawędź (Rysunek 6.16.3):
Rysunek 6.16.3 Krawędź ostra (crease = 1.0)
Zwróć uwagę, że krawędź jest ostra tylko w jednym kierunku. W kierunku poprzecznym nadal jest gładka, dzięki czemu zachowała kształt okręgu. (Gdybyś chciał uzyskać kształt ośmiokąta — powinieneś wyostrzyć także krawędzie “południków” tego stożka) .
Zmianę ostrości krawędzi zatwierdzamy kliknięciem LPM. Jeżeli chcesz zrezygnować z operacji — naciśnij Esc.
Na koniec czynność kosmetyczna — krawędź będzie lepiej wyglądać, gdy zmienimy sposób cieniowania ścian podstawy z “gładkiego” na “płaski”. Zaznacz ściany podstawy i naciśnij klawisz W, by otworzyć podręczne menu siatki (Specials) . Wywołaj stamtąd polecenie ShadeFlat (Rysunek 6.16.4):
Rysunek 6.16.4 Zmiana sposobu cieniowania ścian podstawy na “płaski” (Flat)
Usuwanie linii wierzchołków różni się od wszystkich innych “usunięć” w trybie edycji. Różnica polega na tym, że zachowuje ciągłość ścian siatki. Jest to operacja odwrotna do wstawienia nowej linii wierzchołków poleceniem Loop Cut (str. 351).
Zaznacz linię wierzchołków, którą zamierzasz usunąć (najlepiej — użyj PPM i klawisza Alt, aby na pewno zaznaczyć całą linię). Następnie naciśnij X (lub Mesh→Delete...) i z menu Delete, które się pojawi, wybierz opcję Edge Loops (Rysunek 6.17.1):
Rysunek 6.17.1 Usuwanie linii wierzchołków
W efekcie rząd wierzchołków, który chcieliśmy usunąć, znikł z siatki. Ciągłość powierzchni została jednak zachowana — sąsiadujące wzdłuż usuwanej krawędzi ściany uległy scaleniu.
Gdy chcesz usunąć tylko część jakiegoś ciągu krawędzi, możesz także zastosować opcję Limited Dissolve (Rysunek 6.17.2):
Rysunek 6.17.2 Usuwanie części linii wierzchołków
Zauważ że dwa ostatnie zaznaczone wierzchołki (oznaczone jako A i B – por. Rysunek 6.17.2) nie zostały usunięte.
Rezultat Limited Dissolved zależy od wartości parametru Max Angle (dostępnego w oknie otwieranym przez klawisz F6, patrz Rysunek 6.17.3). Kiedy zmniejszysz go do 0º, nic nie zostanie usunięte!
Zaznacz wierzchołki, które chcesz usunąć, a następnie naciśnij Delete (lub X). Z menu Delete wybierz Vertices (Rysunek 6.18.1):
Rysunek 6.18.1 Usuwanie wierzchołków z siatki
W rezultacie usunięcia wierzchołka znikną także wszystkie krawędzie i ściany, do których należał. Stąd zazwyczaj rezultatem takiej operacji jest “dziura” w siatce. (Oczywiście, to “twórcza destrukcja”. Zazwyczaj w ten sposób przygotowuje się miejsce na nowe ściany, otaczające np. otwór).
Aby usunąć wierzchołek bez usuwania ścian, użyj polecenia Dissolve Vertices (Rysunek 6.18.2):
Rysunek 6.18.2 Usuwanie wierzchołków z siatki (bez usuwania ścian)
Usuwając wierzchołek poleceniem Dissolve tworzysz ścianę o liczbie boków większej niż 4. Pamiętaj, aby po zakończeniu modelowania wyeliminować wszystkie takie ściany (więcej na ten temat — patrz str. 371).
Zaznacz krawędź/krawędzie, które chcesz usunąć (wygodniej to zrobić w trybie wyboru krawędzi, a nie wierzchołków — p. str. 331). Następnie naciśnij Delete (lub X). Z menu Delete wybierz opcję Edges (Rysunek 6.19.1):
Rysunek 6.19.1 Usuwanie wierzchołków z siatki (wraz ze ścianami)
W rezultacie usunięcia krawędzi znikną także wszystkie ściany, które dzieliła.
Aby usunąć krawędź bez usuwania ścian, użyj polecenia Dissolve Edges (Rysunek 6.19.2):
Rysunek 6.19.2 Usuwanie krawędzi z siatki (bez usuwania ścian)
Usuwając krawędź poleceniem Dissolve często możesz stworzyć ścianę o liczbie boków większej niż 4. Pamiętaj, aby po zakończeniu modelowania wyeliminować wszystkie takie ściany (więcej na ten temat — patrz str. 371).
Zaznacz ścianę/ściany, które chcesz usunąć (wygodniej to zrobić w trybie wyboru ścian, a nie wierzchołków — p. str. 331). Następnie naciśnij Delete (lub X). Z menu Delete wybierz Only Faces (Rysunek 6.20.1):
Rysunek 6.20.1 Usuwanie ścian z siatki
Zaznacz wierzchołki (lub krawędzie), na których chcesz “rozpiąć” nową ścianę. Następnie naciśnij F — Mesh→Make Edge/Face (Rysunek 6.21.1):
Rysunek 6.21.1 Dodanie trójkątnej ściany do siatki
Gdy zaznaczysz trzy wierzchołki i naciśniesz F, powstanie ściana trójkątna. Gdy zaznaczysz cztery wierzchołki i naciśniesz F — powstanie ściana czworokątna (Rysunek 6.21.2):
Rysunek 6.21.2 Dodanie czworokątnej ściany do siatki
Wraz z nową ścianą utworzone są nowe krawędzie (tam, gdzie ich brakowało).
Gdy użyjesz więcej niż 4 wierzchołków, Blender także stworzy z nich pojedynczą ścianę (tzw. n-gon) — tak jak to pokazuje Rysunek 6.21.3:
Rysunek 6.21.3 Stworzenie ściany liczącej więcej niż 4 boki
Ściany liczące więcej niż 4 boki mogą być bardzo przydatne podczas formowania siatki. Jeżeli jednak istnieje szansa, że Twój model będzie wykorzystywany np. w jakiejś grze — lepiej na koniec pracy pozamieniaj takie ściany w czworokąty lub trójkąty (por. str. 371).
By stworzyć cały ciąg ścian pomiędzy dwoma zaznaczonymi rzedami wierzchołków, użyj polecenia Mesh→Edges→Bridge Edge Loops. Znajdziesz je także w menu Specials (W) (Rysunek 6.21.4):
Rysunek 6.21.4 Łączenie dwóch krawędzi poleceniem Bridge Edge Loops
Można także wskazać więcej rzędów wierzchołkow — polecenie połączy je wszystkie. Jeżeli będą miały taką samą liczbę elementarnych krawędzi, Blender stworzy pomiędzy nimi regularne, czworoboczne ściany (Rysunek 6.21.4). W przeciwnym razie ściany będą trójkątne.
Bridge Edge Loops ma wiele dodatkowych opcji. Znajdziesz je po wywołaniu tego polecenia w jego panelu Option Tools (lub naciskając F6). Nie używałem ich podczas budowy tego modelu, bo w tym czasie jeszcze nie istniały. Myślę, że czasami mogą być przydatne. Na przykład: gdy zwiększysz wartość parametru Number of Cuts, Blender stworzy wygładzone przejście pomiędzy łączonymi sekcjami siatki (Rysunek 6.21.5):
Rysunek 6.21.5 Przykład dodatkowych opcji polecenia Bridge Edge Loops: efekt zwiększenia wartości Number of Cuts
Aby stworzyć nową krawędź na pomiędzy wierzchołkami nie należącymi do tej samej ściany: zaznacz dwa wierzchołki, a następnie naciśnij F (Mesh→Make Edge/Face — Rysunek 6.22.1):
Rysunek 6.22.1 Dodanie do siatki nowej krawędzi (bez ściany)
Aby stworzyć nową krawędź na pomiędzy wierzchołkami ścian: zaznacz dwa wierzchołki, a następnie naciśnij J (Mesh→Vertices→Vertex Connect — Rysunek 6.22.2):
Rysunek 6.22.2 Dodanie do siatki nowej krawędzi poprzez podział istniejącej ściany
To samo polecenie może być użyte do stworzenia krawędzi łączącej dwa wierzchołki należące do różnych ścian (Rysunek 6.22.3):
Rysunek 6.22.3 Dodanie do siatki nowej krawędzi łączącej dwa odległe wierzchołki
Zaznacz dwie trójkątne ściany, które chcesz złączyć ze sobą (muszą mieć wspólną krawędź). Następnie naciśnij Alt-J — Mesh→Faces→Tris to Quads (Rysunek 6.23.1):
Rysunek 6.23.1 Scalenie dwóch ścian trójkątnych w jedną ścianę czworokątną
Polecenie Tris to Quads nie działa, gdy trójkąty nie tworzą wypukłego czworokąta (Gdy kąt rozwarcia krawędzi w jakimkolwiek z wierzchołków byłby > 180º). To może się również zdarzyć gdy scalane ściany zawierają powielone wierzchołki (częsty przypadek w modelach importowanych z innych systemów).
Aby scalić dwie ściany o dowolnym kształcie, usuń ich wspólną krawędź poleceniem Delete→Dissolve (por. str. 357).
Zaznacz fragment siatki, który chcesz przekształcić w nowy obiekt. Następnie naciśnij P — Mesh→Vertices→Separate. Z menu opcji, które się pojawiło, wybierz Selection (Rysunek 6.24.1):
Rysunek 6.24.1 Wydzielenie zaznaczenia (lotki) w nową siatkę
W rezultacie zaznaczone ściany znikają z oryginalnej siatki. Nie są usuwane jednak tak samo, jak gdybyśmy wybrali polecenie Delete (str. 356). W tym przypadku krawędzie zaznaczonego obszaru pozostaną na swoim miejscu (Rysunek 6.24.2):
Rysunek 6.24.2 Siatka po wydzieleniu lotki
Gdzie się podział zaznaczony fragment siatki? Stał się siatką nowego obiektu (Rysunek 6.24.3):
Rysunek 6.24.3 Lotka, wydzielona z siatki
Nowy obiekt otrzymał taką samą nazwę jak ten, z którego powstał, zakończoną jednak dodatkową końcówką typu “.001”. Na przykład lotka, wydzielona w ten sposób z płata B.100.Wing, otrzymuje początkową nazwę B.100.Wing.001. Oczywiście, zmień ją zaraz na prawidłową (str. 304).
Operacją odwrotną do wydzielenia siatki jest scalenie siatek obiektów (Join Objects, str. 312).
Siatki obiektów symetrycznych można tworzyć w uproszczony sposób — modelując tylko jedną połowę. Kształt drugiej strony można uzyskać, stosując modyfikator Mirror.
Aby stworzyć lustrzane odbicie siatki, w zestawie Modifiers naciśnij przycisk Add Modifier. Spowoduje to rozwinięcie listy dostępnych “modyfikatorów” siatki. Wybierz spośród nich Mirror.
Rysunek 6.25.1 Zastosowanie modyfikatora Mirror
Środkiem lustrzanego odbicia, wykonywanego przez modyfikator Mirror, jest domyślnie środek obiektu (tzn. jego punkt odniesienia — nie mylić ze środkiem geometrycznym). Stąd też zawczasu należy zadbać, aby znajdował się we właściwym miejscu (por. str. 314). Odbicie dokonuje się wzdłuż lokalnych osi X, Y, Z obiektu. Oś odbicia ustalasz przełącznikami w panelu modyfikatora (X, Y, Z — Rysunek 6.25.1). Możliwe jest jednoczesne włączenie odbicia wzdłuż dwóch, a nawet wszystkich trzech osi.
Naciśnięcie przycisku Apply spowoduje “utrwalenie” siatki tworzonej przez modyfikator, tzn. stworzenie nowych wierzchołków i usunięcie modyfikatora Mirror (Rysunek 6.25.2):
Rysunek 6.25.2 „Utrwalenie” modyfikatora Mirror
Gdy stosujesz ten modyfikator dla powierzchni podziałowych — razem z modyfikatorem Subsurf — pamiętaj, aby Mirror był zawsze powyżej Subsurf. Szczególnie ważne w przypadku powierzchni podziałowych jest także ustawienie wartości Merge Limit (Rysunek 6.25.1). Dwa wierzchołki — oryginał i jego odbity obraz — leżące w odległości mniejszej niż Merge Limit, są traktowane jakby były jednym wierzchołkiem. Dzięki tej właściwości wygładzone modyfikatorem Subsurf powierzchnie nie mają w płaszczyźnie symetrii ostrej krawędzi, ani przerwy. Zazwyczaj nie musisz zmieniać wartości Mege Limit.
Transformacja polega na odsunięciu1 wybranych wierzchołków od aktualnej powierzchni. Każdy wierzchołek jest przemieszczony w kierunku prostopadłym (normalnym) do powierzchni, na odległość określoną przez użytkownika. Za pomocą odsunięcia można łatwo uzyskać takie efekty, jak nadanie powłoce grubości, czy wytłoczenie regularnych wgłębień (np. żeber lub podłużnic).
Operację zaczynamy od zaznaczenia wierzchołków, które mają być odsunięte. Często zaznaczone wierzchołki tworzę za pomocą wcześniejszego wytłoczenia (E — Extrude), podczas którego rezygnuję z proponowanego domyślnie przesunięcia (naciskając Esc). Rysunek 6.26.1a), b) pokazuje przykład zaznaczonych ścian po takiej właśnie operacji wytłoczenia “bez przesunięcia”:
Rysunek 6.26.1 Przygotowanie do operacji — zaznaczenie ścian, które mają być odsunięte
Następnie naciskamy Alt-S (Mesh→Transform→Shrink/Fatten) (Rysunek 6.26.3):
Rysunek 6.26.2 Przebieg operacji — wierzchołki przesuwają się wzdłuż normalnych do oryginalnej powłoki
Sterujesz dystansem odsunięcia przesuwając myszkę w górę i w dół. W trakcie ustalania tej odległości możesz się także posłużyć standardowymi klawiszami “modyfikującymi” Blendera. Trzymanie wciśniętego Ctrl powoduje, że dystans zmienia się skokowo, a Shift — zwiększa dokładność ruchu.
Rysunek 6.26.3 pokazuje efekt, który może wystąpić w przypadku odsuwania wierzchołków od płaskich ścian z ostrymi narożnikami:
Rysunek 6.26.3 Deformacja płaskich ścian w wyniku odsunięcia
Wierzchołki, które leżały w środku płaskich ścian, zostały odsunięte “głębiej” od oryginalnej powierzchni niż wierzchołki narożne. Mimo pozorów, wszystkie wierzchołki zostały przemieszczone na tę samą odległość (0.2 jedn. Blendera). Dysproporcja wynika wyłącznie z różnych kierunków normalnych. Wektory normalne w narożnikach są pochylone pod katem 45º, więc wierzchołki narożne przesunęły się o 0.2 jedn. pod kątem 45º. Punkty środkowe miały normalne skierowane prostopadle do przesuwanych ścian, więc odsunęły się na pełen dystans. W efekcie powstała deformacja, którą trzeba skorygować, “spłaszczając” z powrotem ściany. (Poprzez zmianę skali wzdłuż jednej z osi: X lub Y).
Transformacja Shrink/Fatten o wiele lepiej sprawdza się na mniej kanciastych kształtach. Rysunek 6.26.4a) przedstawia typowy przypadek takiej powierzchni — symetryczną połowę jakiejś powłoki:
Rysunek 6.26.4 Odsunięcie ścian na typowej, obłej powierzchni
W środku powłoki znajdują się dwa żebra. Zaznaczyłem ściany pomiędzy nimi i wytłoczyłem je (poleceniem Extrude). Zrezygnowałem z przesuwania (Esc) i wywołałem odsunięcie (Alt-S).
Rysunek 6.26.4b) pokazuje, jak należy przygotować krawędzie siatki, by odsunięcie przebiegło zgodnie z naszymi intencjami. Wykorzystałem tu fakt, że na krańcach powierzchni kierunek odsunięcia jest zawsze prostopadły do ostatniej ściany. Aby przebiegał wzdłuż płaszczyzny lustrzanego odbicia siatki, umieściłem na tym krańcu powierzchni niewielką, poziomą ściankę (Rysunek 6.26.4c). Jej istnienie wymusza odsunięcie krańcowego wierzchołka pionowo do dołu. Dla porównania przyjrzyj się drugiemu, “wolnemu” końcowi powierzchni (Rysunek 6.26.4d). Tu niczego specjalnego nie przygotowywałem, więc zaznaczony wierzchołek jest odsunięty pod pewnym katem.
Aby zobaczyć, jak skierowane są wektory normalne wierzchołków, przełącz w przyborniku Properties (N), w panelu Mesh Display, przełącznik Normals ze „ścian” na „wierzchołki”.
Operacja odsunięcia jest jednorazową. Po odsunięciu fragmentu powłoki zmienia się układ normalnych. Jeżeli chcesz wrócić do poprzedniego stanu — użyj polecenia Undo (Ctrl-Z).
Alternatywną metodą odsunięcia powierzchni jest użycie polecenia Solidify — p. str. 377.
Zaznacz ścianę, do której chcesz dopasować bieżący widok okna 3D View (Rysunek 6.27.1a). Potem naciśnij Shift-7 (View→Align View→Align View to Selected→Top) :
Rysunek 6.27.1 Ustawienie widoku na wprost zaznaczonej ściany
W rezultacie Blender ustawi płaszczyznę ekranu równolegle do zaznaczonej ściany (Rysunek 6.27.1b).
Warto pamiętać skróty, wywołujące te polecenia. Znajdziesz je w menu Align View to Selected. Są takie same jak skróty zmiany widoku globalnego, tyle że z dodatkowym klawiszem Shift (Rysunek 6.27.2):
Rysunek 6.27.2 Dostępne polecenia z submenu Align View to Selected
Widok można dopasowywać także do pojedynczej krawędzi siatki (Rysunek 6.27.3):
Rysunek 6.27.3 Rezultaty poleceń Align View dla pojedynczej krawędzi
Podczas różnych modyfikacji siatki można przypadkowo stworzyć ściany o liczbie boków większej niż 4. W grafice komputerowej określa się je jako n-gony. Takie ściany są bardzo przydatne w trakcie formowania. Potem jednak staraj się je zastąpić zespołami kwadratów i trójkątów, aby nie utrudnić ewentualnego eksport Twojego modelu do innych programów (np. silników gier). Pokażę tutaj, jak to zrobić.
Wyłącz wszelkie dotychczas zaznaczone ściany siatki. Następnie wywołaj polecenie Select→By Number of Verts. Zaraz potem naciśnij F6 i ustaw parametry tego polecenia jak jest to pokazuje Rysunek 6.28.1:
Rysunek 6.28.1 Odnajdowanie w siatce n-gonów
Potem obejrzyj ze wszystkich stron siatkę — program podświetli na niej n-gony. Eliminuj je po kolei, tak jak pokazuje to Rysunek 6.28.2:
Rysunek 6.28.2 Podział pięcioboku na trójkąt i kwadrat
Zaznacz dwa wierzchołki, które chcesz połączyć krawędzią i naciśnij J (Mesh→Vertices→Vertex Connect). Wstawiony w ten sposób odcinek podzielił pięciobok na trójkąt i czworokąt.
Dodając nowe krawędzie za pomocą skrótu J (Vertex Connect) możesz szybko wyeliminować n-gony z siatki. Operacją odwrotną jest Dissolve (por. str. 357)
Kadłub proponuję formować metodą “ewolucyjną”. Polega to na:
wytłoczeniu na całą długość jakiegoś dużego, jednorodnego elementu;
stopniowej modyfikacji takiej “rury” poprzez wstawianie w środek kolejnych wręg. Nadaję za ich pomocą niezbędną wypukłość, tam, gdzie powinna wystąpić.
W tej sekcji chcę pokazać typowe postępowanie podczas dodawania kolejnej wręgi. Przedstawię to na przykładzie formowania górnej części ogona P-40. Kształtujemy ją niezależnie od części środkowej i dolnej. Zacznij od wytłoczenia całej długości, do statecznika pionowego (Rysunek 6.29.1):
Rysunek 6.29.1 Wytłoczony zarys ogona P-40
Uzyskany obrys “odstaje” od rzutu z boku w środku długości (mam na myśli czerwoną, poprawioną linię — p. Rysunek 6.29.1). Wstaw więc w tym miejscu nową wręgę (Rysunek 6.29.2a):
Rysunek 6.29.2 Dodanie i dosunięcie do obrysu nowej wręgi
Po wstawieniu przesuń ją do góry (wzdłuż osi Z) tak, by obrys kadłuba z boku pokrył się z obrysem na planach (Rysunek 6.29.2b).
Teraz umieść kursor 3D w najwyższym wierzchołku wręgi. Najszybciej i najdokładniej jest to zrobić zaznaczając ten wierzchołek, i wywołując polecenie Shift-S (Snap), Cursor to Selected (Rysunek 6.29.3):
Rysunek 6.29.3 Umieszczenie kursora 3D w najwyższym wierzchołku wręgi
(Zakładam, że najwyższy punkt wręgi leży jednocześnie w osi kadłuba samolotu. Zazwyczaj tak jest). Teraz możesz wygodnie zmienić, poprzez zmianę skali względem kursora 3D, wysokość i szerokość wręgi (Rysunek 6.29.4a,b):
Rysunek 6.29.4 Dopasowanie wysokości szerokości wręgi do reszty kadłuba
Środek transformacji leży na górnej krawędzi kadłuba. Dzięki temu zmiana skali wzdłuż osi Z nie zagraża zgodności z obrysem z boku.
Poprawność uformowania wręgi warto jest także ocenić w rzucie z przodu (Rysunek 6.29.5). Podłużnice, które na nim widzimy, powinny wykazywać stopniowe przekształcanie, bez żadnych nagłych załamań.
Na koniec wstaw brakujące ściany, łączące górną i dolną część kadłuba.
Czasami podczas formowania otworu trzeba wstawić w narożnik pomocniczą linię łamaną, której wszystkie wierzchołki będą leżeć dokładnie na powierzchni oryginalnej ściany. Przykładem takiej sytuacji jest przygotowywanie otworu na kółko ogonowe w kadłubie. Otwór ten miał duży promień zaokrąglenia narożników (Rysunek 6.30.1). Musimy ten efekt odtworzyć:
Rysunek 6.30.1 Zaokrąglenie narożnika otworu w kadłubie
Wykorzystamy do tego kilka poleceń z tego rozdziału, które poznałeś już wcześniej.
Zacznijmy od podziału lewej krawędzi (zaokrąglenie ma się zacząć gdzieś w połowie — Rysunek 6.30.2):
Rysunek 6.30.2 Podział przedniej krawędzi
Wykorzystując nowy wierzchołek, podziel sąsiednie ściany (Rysunek 6.30.3):
Rysunek 6.30.3 Dodanie nowych krawędzi
Podziel wewnętrzną krawędź ściany narożnika na dwie (ewentualnie trzy) części (Rysunek 6.30.4):
Rysunek 6.30.4 Podział wewnętrznej krawędzi na trzy części
Następnie ustaw widok w bieżącym oknie 3D View prostopadle do ściany narożnej (Top — Rysunek 6.30.5):
Rysunek 6.30.5 Ustawienie płaszczyzny widoku równolegle do ściany
W płaszczyźnie ściany można łatwo przesunąć wewnętrzne wierzchołki krawędzi w kierunku narożnika, nadając krawędzi wygięcie (Rysunek 6.30.6):
Rysunek 6.30.6 Formowanie kształtu narożnika
Następnie zamień ten pięciobok na trzy trójkąty. (Robimy to wyłącznie po to, by ta ściana nie sprawiła nikomu kłopotu podczas ewentualnego importu do innego programu lub silnika gier).
Rysunek 6.30.7 przedstawia gotowe zaokrąglenie narożnika:
Rysunek 6.30.7 Gotowe zaokrąglenie
Polecenie Solidify różni się od Shrink/Fatten (str. 367) tym, że odsuwa od zaznaczonych ścian ich kopie, i łączy je ze sobą dodatkowymi poprzecznymi ścianami (nadając rezultatowi „grubość”).
Zaznacz najpierw obszar, dla którego chcesz uzyskać ten efekt (to nie musi być cała powłoka). Następnie wywołaj polecenie Mesh→Faces→Solidify (Rysunek 6.31.1):
Rysunek 6.31.1 Nadanie siatce grubości za pomocą polecenia Solidify
Blender odsunie od zaznaczonych ścian ich kopie wzdłuż wektorów normalnych siatki. Parametrem polecenia jest szerokość pogrubienia (thickness — Rysunek 6.31.2):
Rysunek 6.31.2 Sterowanie szerokością pogrubienia
Szerokości ujemne oznaczają odsunięcie “na zewnątrz” powłoki.
Aby przypisać pojedynczą siatkę do jakiegoś istniejącego materiału, należy zaznaczyć obiekt, który ją zawiera (tak, aby się stał obiektem aktywnym — Rysunek 6.32.1a). Następnie w oknie Properties, zestawie Material rozwiń listę z lewej strony przycisku New, i wybierz z niej jeden z widocznych tam materiałów (Rysunek 6.32.1b). Blender przypisuje domyślnie materiał do siatki1, a nie obiektu, stąd zmianie ulegnie nie tylko aktywny obiekt, ale także wszystkie inne obiekty, które używają tą samą siatkę (Rysunek 6.32.1c):
Rysunek 6.32.1 Przypisanie materiału do pojedynczej siatki
Aby szybko przypisać materiał do wielu obiektów (siatek) naraz, zaznacz je i wykorzystaj polecenie Copy Material to Others (Rysunek 6.32.2):
Rysunek 6.32.2 Skopiowanie przypisania materiału do wielu siatek naraz
Zwróć uwagę że w menu, które przedstawia Rysunek 6.32.2b), są także polecenia Copy Material i Paste Material. Możesz ich także użyć do przypisania pojedynczego materiału, jeżeli nie chcesz wybierać go co chwila z listy. Polecenie Copy Material to Others znajduje się także pod inną nazwą — Material — w menu Object→Make Links… (dostępnym pod skrótem Ctrl-L).
A jak przypisać do różnych fragmentów pojedynczej siatki różne materiały ?
W Blenderze materiały są przypisane do ścian siatki za pośrednictwem tzw. łączy materiałów (material slots — Rysunek 6.32.3).
W każdej siatce możesz stworzyć wiele łączy materiałów. Każda ściana jest przypisana tylko do jednego z nich. Niektóre z takich łączy mogą nie mieć przypisanych ścian. Mogą także nie mieć przypisanych materiałów. (Takie “puste” łącza nie mają wpływu na rendering).
Przypisanie fragmentu siatki do innego materiału pokażę na przykładzie gondoli podwozia głównego (obiektu B.150.R.Cover). Rysunek 6.32.4 przedstawia „sytuację wyjściową”:
Rysunek 6.32.4 Siatka, której fragmentowi chcemy przypisać inny materiał
Wszystkie ściany siatki owiewki ma już przypisany materiał odpowiedni dla powierzchni zewnętrznych: B.Skin.Camouflage. Teraz chcemy ścianom wewnętrznym przypisać materiał B.Skin.Inner.
Zaczynamy od utworzenia nowego, pustego łącza materiału. To „miejsce” na nowy materiał (Rysunek 6.32.5):
Rysunek 6.32.5 Dodanie do siatki nowego, pustego łącza materiału.
Naciśnij przycisk z prawej strony listy łączy materiałów. Blender doda na koniec listy nowe, puste łącze. Przesunie także na nie podświetlenie, czyniąc je łączem aktywnym.
Tak jak można się spodziewać, przycisk usuwa aktywne (tzn. podświetlone na liście) łącze materiału. Można jednak to robić tylko w Object Mode!
Teraz przypisujemy do naszego łącza materiał — w tym przypadku B.Skin.Inner (Rysunek 6.32.6):
Rysunek 6.32.6 Przypisanie materiału do łącza.
Na koniec przypisz do łącza ściany. Zaznacz je w oknie View 3D, a następnie naciśnij w panelu Material przycisk Assign (Rysunek 6.32.7):
Rysunek 6.32.7 Przypisanie ścian do nowego indeksu materiału.
Nie musisz zaznaczać od razu wszystkich ścian. Możesz tę operację przypisania powtórzyć kilka razy (w przypadku bardzo złożonych kształtów tak jest prościej).
Zwróć uwagę, by obszar siatki przypisany do łącza materiału nie zawierał żadnej nie powiązanej ze ścianą krawędzi lub wierzchołka. Takie miejsca mogą powodować różne artefakty na ostatecznym renderze.
Możesz używać ścian przypisanych do łączy do selekcji wierzchołków siatki w trakcie jej edycji. (Służą do tego umieszczone poniżej listy łączy przyciski Select i Deselect)
W Blenderze każda ściana ma stronę „wewnętrzną” i „zewnętrzną”. O tym, która jest zewnętrzna, decyduje zwrot1 wektora normalnego (tzn. prostopadłego), który jest przypisany do każdej ściany.
Aby włączyć wyświetlanie normalnych do ścian siatki, otwórz Properties Shelf (N) i przejdź do panelu Mesh Display (Rysunek 6.33.1):
Rysunek 6.33.1 Włączenie wyświetlania kierunków normalnych do ścian siatki
Włącz w nim opcję Normals:Face, w środkach każdej ściany pojawią się błękitne kreski (Rysunek 6.33.1). Zazwyczaj będziesz musiał je nieco wydłużyć, korzystając z kontrolki Normal Size.
Gdy zwrot normalnych na sąsiadujących ścianach jest różny, w trybie cieniowania Shade Smooth zobaczysz na siatce brzydkie, czarne cienie. Ale gdy wszystkie normalne siatki wskazują w niewłaściwą stronę, podczas modelowania w oknie 3D View możesz nie zauważyć niczego podejrzanego. Będzie to jednak przyczyną dziwnego „lustrzanego” efektu na renderze, gdy użyjesz w materiale połyskliwego shadera Glosssy BSDF.
Zaradzenie temu efektowi jest bardzo proste: w trybie edycji siatki zaznacz wszystkie ściany (Select All — A) i naciśnij Ctrl-N (Mesh→Normals→Recalculate Outside — Rysunek 6.33.2):
Rysunek 6.33.2 Przeliczenie kierunku normalnych
Zazwyczaj Blender poprawnie zrozumie twoje intencje, i przerzuci wszystkie normalne na jedną stronę ścian siatki.
A co jeżeli jednak nie zrozumie? Rysunek 6.33.3a) przedstawia taki złożony przypadek. To siatka modelująca wewnętrzną powierzchnię kabiny pilota. Jak widzisz, część jej ścian jest skierowana poprawnie, a część nie. Polecenia Recalculate Outside nie można tu użyć, bo te ściany trzeba skierować „do wewnątrz”. W Blenderze istnieje także polecenie Recalculate Inside (Shift–Ctrl-N). Nie możemy go jednak tutaj użyć, bo część tylnych ścian kabiny ma pozostać skierowana „ na zewnątrz”. Jedynym rozwiązaniem jest zaznaczyć wszystkie nieprawidłowe ściany i wywołać polecenie Mesh→Normals→Flip Normals (Rysunek 6.33.3b)
Rysunek 6.33.3 Przełączenie kierunków normalnych dla wybranych ścian siatki
(Polecenie Flip Normals masz dostępne także w menu Specials — wywoływanym skrótem W).
Na zakończenie warto wspomnieć, że Blender potrafi także wyświetlać drugi rodzaj normalnych: w wierzchołkach (Rysunek 6.33.4) . Są one wypadkową normalnych do ścian, które łączy każdy wierzchołek. To, czy wolisz operować na normalnych ścian czy wierzchołków jest kwestią gustu. W istocie są to dwie alternatywne metody reprezentacji tych samych wartości.
Kierunek normalnych do powierzchni wpływa na to, w jaki sposób wyświetlane są na ekranie krawędzie siatki. Program może wyznaczyć wektor normalny dla każdej płaskiej, elementarnej ściany. Każdy komputerowy model oświetlenia wymaga określenia kierunku normalnego dla dowolnego miejsca powierzchni. Jeżeli przyjmiemy najprostsze założenie, że na kierunek normalny na całym obszarze ściany jest stały (Rysunek 6.34.1a), uzyskamy efekt jak dla trybu Shade Flat (Rysunek 6.34.1b):
Rysunek 6.34.1 Wektory normalne w trybie Shade Flat
Cieniowanie Shade Flat jest nieodpowiednie dla obłych powierzchni, takich jak opływowe kształty współczesnych samolotów. Musiałbyś bardzo zagęścić ich siatki, by wyglądały na gładkie!
Na szczęście nie musimy tak komplikować modelu, bo mamy do dyspozycji drugi tryb cieniowania: Shade Smooth (Rysunek 6.34.2):
Rysunek 6.34.2 Wektory normalne w trybie Shade Smooth
W tym trybie kierunek normalny w dowolnym punkcie powierzchni jest interpolacją (uśrednieniem) kierunków normalnych najbliższych ścian (Rysunek 6.34.2a). Do interpolacji wykorzystuje się tzw. metodę Phonga, bardzo popularną w grafice komputerowej. Używając jej, za pomocą niewielu ścian można uzyskać wrażenie gładkiej powierzchni (Rysunek 6.34.2b).
Element, który przedstawia Rysunek 6.34.2b), to oszklenie owiewki kabiny pilota. Na powiększeniu ilustracji pokazuję, że ma ona niewielką grubość. Jej siatka oryginalnie wygładzona powierzchnią podziałową. Krawędź, biegnącą wzdłuż jej brzegu oznaczyłem jako “ostrą” (Crease), by owiewka wyglądała jak wygięty arkusz szkła organicznego. Spowodowało to pojawienie się na ścianach sąsiadujących z tą ostrą krawędzią dziwnych cieni (Rysunek 6.34.2b).
Jeżeli zignorujesz te cienie, staną się przyczyną dziwnych efektów na renderze (Rysunek 6.34.3):
Rysunek 6.34.3 Efekt ostrej krawędzi oszklenia powierzchni i cieniowania Shade Smooth na renderze
To rezultat zastosowania interpolacji normalnych metodą Phonga dla ostrej krawędzi. Na szczęście remedium jest bardzo proste: włącz dla tej siatki opcję Auto Smooth i ustaw kąt graniczny na 30º- 90º (Rysunek 6.34.4):
Rysunek 6.34.4 Opcja Auto Smooth — automatyczne korygowanie ostrych krawędzi
Gdy opcja Auto Smooth z paneluNormals jest włączoną, Blender poprawia kierunki normalne wzdłuż wszystkich krawędzi siatki, które łączą ściany pod kątem większym niż określony graniczny kąt Angle. (Kierunki normalnych wzdłuż takiej krawędzi są rozdzielone, jak pokazywał to Rysunek 6.34.1a).
Dla powierzchni nieprzejrzystych interpolacja normalnych wzdłuż krawędzi nie powoduje tak drastycznych skutków, jak dla szkła. Przyjrzyj się na przykład tej owiewce skrzydła (Rysunek 6.34.5):
Rysunek 6.34.5 Odblask wzdłuż nieskorygowanej krawędzi
Tutaj taka krawędź wygląda jak zaokrąglona i nadaje elementowi wrażenie grubości (Rysunek 6.34.5b).
Co jednak robić w takim przypadku, jaki pokazuje Rysunek 6.34.6? Powiedzmy, że chcielibyśmy zachować wrażenie zaokrąglonych krawędzi przy szkle kabiny. Jednocześnie warto usunąć brzydkie cienie na zewnętrznych krawędziach tej ramki:
Rysunek 6.34.6 Nieskorygowane krawędzie ramki | Rysunek 6.34.7 Ramka po automatycznej korekcie |
Zastosowanie Auto Smooth z wartością Angle do 90º „spłaszcza” wszystkie ostre krawędzie. A nam chodzi, aby tak poprawić tylko zewnętrzną krawędź ramki — tak, jak pokazuje Rysunek 6.34.7.
Taki wybiórczy efekt jest do osiągnięcia. Trzeba tylko najpierw oznaczyć krawędzie, które mają być skorygowane, specjalną flagą Sharp. Upewnij się, że przyborniku właściwości tej siatki masz włączoną opcję Mesh Display:Overlays:Sharp — Rysunek 6.34.8a). Potem zaznacz korygowane krawędzie:
Rysunek 6.34.8 Oznaczanie wybranych krawędzi jako Sharp
Z menu Mesh→Edges (Ctrl-E) wywołaj polecenie Mark Sharp. W efekcie Blender podświetli zaznaczone krawędzie na czerwono (Rysunek 6.34.8b). (Taki kolor jest przypisany fladze Sharp). Potem wystarczy przestawić kąt graniczny Normals:Angle na 180º (Rysunek 6.34.9a):
Rysunek 6.34.9 Rezultat — selektywna korekta krawędzi
Tak duży kąt graniczny powoduje, że „ostre” są tylko krawędzie oznaczone flagą Sharp (Rysunek 6.34.9b).
Oznaczanie krawędzi flagą Sharp można także wykonać w inny sposób (Rysunek 6.34.10):
Rysunek 6.34.10 Alternatywna metoda oznaczanie krawędzi flagą Sharp
Niestety, flaga Sharp nie może mieć wartości pośrednich, tak jakie ma dla powierzchni podziałowych flaga Crease. Czasami więc możesz natknąć się na taki przypadek, jak dla kołpaka śmigła, który przedstawia (Rysunek 6.34.11). Bez korekty kierunku normalnych krawędź kołpaka wygląda na zbyt zaokrągloną:
Rysunek 6.34.11 Krawędź nieskorygowana | Rysunek 6.34.12 Krawędź skorygowana |
Działanie Auto Smooth jest w tym przypadku nieco za mocne: część krawędzi kołpaka zlewa się zupełnie z osłoną silnika (Rysunek 6.34.12).
W takim przypadku pozostaje tylko jedno: wstawienie w pobliżu „ostrej” krawędzi dodatkowego rzędu wierzchołków (np. poleceniem Loop Cut and Slide — Rysunek 6.34.13a):
Rysunek 6.34.13 Zmniejszenie cienia na powłoce poprzez wstawienie dodatkowej krawędzi
Nowa krawędź przy brzegu kołpaka zdecydowanie zmniejsza efekt zaokrąglenia (Rysunek 6.34.13b).
Jak widzisz, Blender nie pozwala na bezpośrednią manipulację kierunkami normalnych siatki. Możesz to robić pośrednio, aby uzyskać na renderze poprawny efekt ostrej krawędzi. Służą do tego opcje z panelu Normals.
Dopóki można, staraj się eliminować zaburzenia kierunku normalnych wzdłuż ostrych krawędzi opcją Auto Smooth i — ewentualnie — modyfikatorem Bevel. Dodanie nowej krawędzi do siatki nie eliminuje, a tylko zmniejsza te zaburzenia.
Aby uniknąć poważnych kłopotów na renderze (por. str. 384, Rysunek 6.34.3b), do elementów „szklanych” zawsze stosuj opcje Auto Smooth z kątem granicznym = 30º. Można go także używać do większości innych siatek z ostrymi krawędziami (np. siatki płata). Tylko w szczególnych przypadkach warto używać zaznaczania pojedynczych krawędzi flagą Sharp, tak jak to pokazałem na str. 385.
Czasami decydowałem się — ale jeszcze na etapie modelowania — wstawiać dodatkowe krawędzie aby usunąć duże zaburzenia kierunku normalnych (por. str. 249). Zrobiłem to „na wszelki wypadek”. Sądzę, że w ten sposób te siatki sprawią mniejszy kłopot przy imporcie do jakiegoś programu, za pomocą formatu danych który nie uwzględnia informacji o kierunkach normalnych. Dodanie nowej krawędzi na późniejszych etapach prac nad modelem może być dość kłopotliwe. Gdy siatki modelu są już rozwinięte w przestrzeni UV (por.Tom III) każda nowa krawędź wymaga dodatkowej korekty tego rozwinięcia.
Na koniec warto wspomnieć o pewnym zaskakującym efekcie ubocznym opcji Auto Smooth. Gdy stworzyłem pierwszy render samolotu, obiekty, zobaczyłem że prawe skrzydło jest zupełnie czarne (Rysunek 6.34.14a). Taki efekt dotknął wszystkich obiektów, które powstały w wyniku „lustrzanego odbicia” (operacji Mirror — tzn. takich, które mają co najmniej jeden ze współczynników skali ujemny):
Rysunek 6.34.14 Niespodziewany efekt opcji Auto Smooth (dla „starszych” siatek)
Wystarczyło jednak wyłączyć opcję Auto Smooth, aby wszystko wróciło do normy (Rysunek 6.34.14b).
Takie samo działanie jak opcja Normals:Auto Smooth ma modyfikator Edge Split (Rysunek 6.34.15). Należy tylko pamiętać, że modyfikatory są związane z obiektem, a nie z siatką. W modelu przedstawionym powyżej ta sama siatka połowy skrzydła jest użyta dwa razy (i to dlatego prawe skrzydło ma ujemną skalę). Aby uniknąć na płatach sztucznych „przebarwień”, po wyłączeniu opcji Auto Smooth dodałem modyfikator Edge Split do obiektów prawego i lewego skrzydła.
Tu umieściłem wszystkie polecenia Blendera, które nie pasują do pozostałych rozdziałów.
W tym przykładzie poznasz stworzenie najprostszego z możliwych materiałów. Nazwiemy go Artifical i będzie miał kolor czerwony. Materiału Artifical będziemy używać do wszystkich obiektów pomocniczych, które nie mają się pojawić na ostatecznym obrazie. (Intensywny kolor czerwony pozwoli nam je łatwiej dostrzec w Object Mode). Tej barwy potrzebujemy już na etapie modelowania, więc wprowadzam go jako materiał domyślnego silnika renderującego Blendera (Blender Renderer, znany także jako Blender Internal). Wszystkie pozostałe materiały tego modelu będę już tworzył dla alternatywnego renderera: Cycles (por. Tom III).
Zacznijmy od sytuacji wyjściowej: wybraliśmy aktywny obiekt (B.310.T.Cowling — Rysunek 7.1.1a). Jest to obiekt pomocniczy, który nie ma się pojawić na jakimkolwiek renderingu. W oknie Properties wybierz zestaw Material, i naciśnij przycisk New (Rysunek 7.1.1b):
Rysunek 7.1.1 Obiekt (a właściwie — siatka) bez przypisanego materiału
W rezultacie Blender stworzył nowy materiał (o domyślnej nazwie Material) i przypisał go do siatki aktywnego obiektu. W zestawie Material zaroiło się od paneli (Rysunek 7.1.2a):
Rysunek 7.1.2 Zmiana nazwy nowego materiału
Najlepiej od razu zmienić temu materiałowi nazwę — w tym przypadku na Artifical (Rysunek 7.1.2b).
W konfiguracji, jaką wybraliśmy (por. Rysunek 4.4.3, str. 262 — okno User Preferences, przełącznik Link Materials To:) materiał jest przypisany do siatki, a nie do obiektu. Stąd obok nazwy materiału widzisz wybrany tryb Data (por. Rysunek 7.1.2b). To skrót od Object Data. Blender umożliwia przypisanie różnym fragmentom pojedynczej siatki różnych materiałów, które wybiera się z listy umieszczonej ponad nazwą. (Szczegółowy opis wykorzystania wielu materiałów w jednej siatce znajdziesz na str. 378).
Wróćmy jednak do naszego materiału Artifical. Aby zmienić jego kolor na czerwony, rozwiń kontrolkę barw klikając na pole w panelu Diffuse (Rysunek 7.1.3):
Rysunek 7.1.3 Zmiana barwy materiału
Aby uzyskać jaskrawą czerwień, zmniejsz w niej wartości G i B do 0.0, a R zwiększ do 1.0 (Rysunek 7.1.3a). Zwróć uwagę, że okienko w panelu Preview (Rysunek 7.1.3b) na bieżąco reaguje na każdą zmianę, jaką wykonasz w kontrolce. W rezultacie nasz obiekt w oknie 3D View będzie wyświetlany właśnie w tym kolorze (Rysunek 7.1.4)
Raz utworzony materiał można przypisać wielu obiektom/siatkom. Służy do tego lista rozwijalna (zestawie Material — Rysunek 7.1.5). W Blenderze możesz także przypisać materiał wielu obiektom naraz. O tym, jak to zrobić, możesz przeczytać na str. 378.
Czytając wcześniejsze rozdziały, zapewne przekonałeś już się, że uwielbiam umieszczać u dołu strony przypisy z dodatkowymi informacjami. Ta część książki to właściwie wybór takich “uwag na marginesie”, które w trakcie pisania urosły do rozmiaru całej sekcji ☺.
Jak w każdym dodatku, są to informacje, z których nie musisz korzystać, aby stworzyć e-model samolotu. Czasami jednak mogą się przydać, by coś wyjaśnić lub ułatwić. Mam jednak nadzieję, że znajdziesz tu rozwinięcie wielu zagadnień, które świadomie skracałem w głównym tekście książki.
W tym rozdziale umieściłem informacje “dla dociekliwych”. Znajdują się tu szczegółowe wyjaśnienia wybranych zagadnień, nad którymi nie chciałem się rozwodzić w części głównej. (Aby nie zbaczać z tematu).
Zapewne wiele razy, podczas pracy z Blenderem, mignęło Ci przed oczami tajemnicze słowo “datablock” (“blok danych”). Pojawia się w różnych miejscach i znaczeniach. Gdy zrozumiesz, czym w istocie jest dla Blendera “blok danych”, zrozumiesz także zasady, rządzące elementami rysunku (pliku). Pozwoli Ci to poprawnie przewidywać zachowanie programu, i bardzo ułatwi pracę1.
Każdy model, który stworzyłeś w Blenderze, złożony jest z obiektów (Object) . Obiekt możesz traktować jak doskonale przejrzyste “pudełko”: ma określony rozmiar, środek (punkt odniesienia), położenie, obrót, skalę. Obiekt “sam z siebie” nie ma żadnego kształtu. Kształt określa siatka (Mesh) . Siatka właśnie jest pewnym rodzajem “bloku danych” (datablock). Zawiera złożone informacje o wierzchołkach, krawędziach, ścianach powłoki, która ma być rysowana na ekranie. Zazwyczaj każdy obiekt ma przypisaną “własną” siatkę2 (Rysunek 8.1.1):
Rysunek 8.1.1 Obiekt i jego siatka
Czasami ten sam blok danych — siatka — może być użyta przez kilka różnych obiektów. Przykładem takiej sytuacji jest śmigło modelu P-40 (Rysunek 8.1.2).
To śmigło składa się z trzech identycznych łopat. Rysunek 8.1.2 przy każdym z tych obiektów pokazuje kontekst, wyświetlany w oknie Properties. Dwie nazwy, które są na nim widoczne, to odpowiednio:
poprzedzona ikoną : nazwa obiektu;
poprzedzona ikoną : nazwa siatki;
Poprzedzająca je ikona symbolizuje aktywną scenę, w której znajduje się obiekt. Nazwa aktywnej sceny nie jest tu wyświetlana, bo zazwyczaj widać ją przez cały czas u góry ekranu, w nagłówku okna Info (por. str. 287).
Przyjrzyj się dokładnie opisom, wyświetlanym przez konteksty, które pokazuje Rysunek 8.1.2, a stwierdzisz, że każda z łopat jest obiektem o nazwie wyróżnionej środkową literą. (B.010.A.Blade, B.010.B.Blade, B.010.C.Blade). Zwróć także uwagę, że każdy z tych obiektów używa tej samej siatki — B.010.Blade. Gdy zmodyfikujesz kształt siatki w którymkolwiek z nich — zmienisz kształt wszystkich trzech łopat.
Rysunek 8.1.2 Łopaty śmigła — przykład jednej siatki współdzielonej przez trzy obiekty
Przypisanie bloku danych — w tym przypadku siatki do obiektu — jest na panelach Blendera obsługiwane przez typowy zestaw kontrolek (Rysunek 8.1.3) :
Rysunek 8.1.3 Kontrolki, zarządzające przypisanym blokiem danych
Poniżej opisu kontekstu zestawu Object Data (por. str. 63) wyświetlana jest nazwa siatki, aktualnie przypisanej do obiektu. Aby ją zmienić, należy wybrać inną z listy rozwijalnej, otwieranej przyciskiem po lewej. Jeżeli wybierzesz w tym miejscu siatkę o innym kształcie — zmieni się kształt obiektu.
Po prawej stronie nazwy bloku danych umieszczony jest licznik “użycia” (referencji). Siatka B.010.Blade jest przypisana do trzech obiektów, stąd na ilustracji widoczna jest liczba 3. Kiedy klikniesz w ten przycisk — Blender utworzy duplikat aktualnej siatki. Duplikat nosi taką samą nazwę jak pierwowzór, z dodatkową końcówką “.001”. Duplikat zastępuje oryginalną siatkę, przypisaną do obiektu.
Licznik referencji (“użycia”) bloku danych jest w Blenderze niezwykle ważny. Gdy siatka nie jest “użyta” przez żaden obiekt — jej licznik spada do zera. Wszelkie bloki danych o liczniku równym zero są pomijane przy zapisie pliku na dysk. Kołpak śmigła w naszym przykładzie — B.005.Hub — miał własną siatkę, o identycznej nazwie: B.005.Hub. Gdy usuniemy ten obiekt (Delete), siatka B.005.Hub nadal będzie istnieć, ale jej licznik “użycia” spadnie do zera.
Taki nie używany blok danych Blender oznacza na liście literą “O” (Rysunek 8.1.4) :
Rysunek 8.1.4 Siatka usuniętego kołpaka śmigła
Wszystkie bloki danych, które nie są wykorzystywane (“osierocone”), Blender pomija przy zapisie na dysk. Są w ten sposób, z opóźnieniem, usuwane z pliku.
Mimo wszystko, jeżeli tego chcesz, możesz uchronić siatkę B.005.Hub, przed “czystką” podczas zapisu. Trick polega na włączeniu przełącznik F (Fake user) przed usunięciem obiektu, który zawiera ten blok danych (Rysunek 8.1.5):
Rysunek 8.1.5 Zabezpieczenie bloku danych przed usunięciem — “Fałszywe” (Fake) użycie
Włączenie F powoduje zwiększenie licznika “użycia” o 1. (Oczywiście, zawsze możesz go z powrotem wyłączyć). Dzięki przełącznikowi F, licznik użycia bloku danych zawsze jest > 0.
Blok danych z atrybutem F nigdy nie będzie usunięty z pliku Blendera. (Nawet wtedy, gdy nie jest użyty przez jakikolwiek obiekt, jego licznik użycia jest = 1).
Blokiem danych w Blenderze jest praktycznie wszystko, z czym pracujesz tworząc scenę. W szczególności są to takie typowe elementy, jak:
siatki (meshes — o nich już mówiliśmy): nadają obiektom kształt. Zawierają także inne szczegóły, m.in. współrzędne mapowania tekstury dla każdego wierzchołka;
kamery (cameras): pomocniczy rodzaj obiektu, definiujący projekcję. Używany podczas renderowania;
lampy (lamps): źródła światła, używane podczas renderowania
obiekty ( objects): to „obudowa”, której zawartość (określana jako Object Data — por. str. 63) jest referencją do jednego z bloków danych wyliczonych powyżej;
materiał(y) (materials), przypisane do siatek: nadają powierzchniom podstawową barwę, oraz określają inne ich parametry, takie jak przejrzystość, połyskliwość, itp.;
tekstury (textures), przypisane do materiałów: wzbogacają jednolitą barwę materiału elementy w innych kolorach, zabrudzenia. Pozwalają także uzyskać efekt drobnych nierówności;
obrazy (images), przypisane do tekstur: zawierają obraz, wykorzystywany przez teksturę;
Prezentowany wcześniej model kołpaka śmigła składa się z czterech obiektów: kołpaka śmigła (B.005.Hub) i trzech łopat (B.010.x.Blade) (Rysunek 8.1.6a). Łopaty są przypisane (relacją parent) do kołpaka (Rysunek 8.1.6b):
Rysunek 8.1.6 Śmigło i jego struktura (w oknie Outliner)
Kołpak ma przypisany materiał B.005.Hub (nadający mu żółty kolor). Łopaty wykorzystują materiał B.010.Steel, który ma przypisaną teksturę B.010.Dirt. Tekstura B.010.Dirt korzysta z obrazu B.010.Blade, nakładając na łopatę żółte końcówki i zabrudzenia. Rysunek 8.1.7 przedstawia to na tzw. schemacie Oops:
Rysunek 8.1.7 Inny sposób przedstawienia struktury modelu śmigła (schemat Oops z Blendera 2.49)
Schemat Oops był dostępny w Blenderze 2.4, w wersji 2.5 z niego zrezygnowano. Pozostawiłem go tutaj, gdyż dobrze obrazuje strukturę pliku Blendera. Każdy prostokąt, który na nim widzisz, to jakiś blok danych. Każda z linii oznacza pojedyncze zwiększenie licznika bloku danych, z którego wychodzi. Na przykład: tekstura B.010.Dirt jest używana tylko raz. Jeżeli usuniesz ją z materiału B.010.Steel, zostanie pominięta przy najbliższym zapisaniu pliku. “Osierocony” zostanie wówczas używany przez tę teksturę obraz B.010.Blade. Ten obraz zostanie pominięty przy kolejnym zapisie. (Stąd uwaga praktyczna: czasami trzeba dwa — trzy razy zapisać, zamknąć i otworzyć plik, by wszelkie niepotrzebne “śmieci” zostały z niego usunięte).
W prawym górnym narożniku schematu (Rysunek 8.1.7) widać trzy obrazy, które nie są “powiązane” z niczym. Dlaczego nie zostały usunięte? Ponieważ są to tła poszczególnych widoków 3D: rysunki samolotu w rzucie z góry, lewej i przodu. Każdy z nich ma w istocie licznik użycia = 1, bo jest przypisany do konkretnego okna 3D View (jako Background Image — por. str. 275). Schemat Oops nie pokazywał wszelkich połączeń w pliku Blendera, obrazował tylko strukturę sceny. Np. innym rodzajem bloku danych są teksty, które można przeglądać w oknie Text Editor. To także bloki danych “używane” przez plik, a nie konkretną scenę.
Rysunek 8.1.7 pokazuje, że obiekty — B.005.Hub, B.010.x.Blade, a także Lamp i Camera — są także blokami danych. Ich “użytkownikiem”, dzięki któremu mają przypisane “użycia”, jest scena.
Rysunek 8.1.8 demonstruje strukturę pliku Blendera, w którym utworzyłem drugą scenę (por. str. 283) — nazwałem ją Spares.
Rysunek 8.1.8 Dwie oddzielne sceny w jednym pliku
Scena — to brzmi dumnie. W tym przypadku jednak to tylko nowa, pusta przestrzeń, w której umieściłem drugi raz kołpak śmigła3. Popatrz na schemat Oops (Rysunek 8.1.8) — obiektowi B.005.Hub przybyła jeszcze jedna linia, czyli jeszcze jedno “użycie”. Jeżeli teraz nawet usunę ten obiekt ze sceny Scene, to pozostanie w drugiej scenie — Spares. Zawsze mogę go stamtąd przywołać. W ten sposób można używać drugiej sceny jak “podręcznego składziku”. W przestrzeni Spares można przechowywać różne obiekty, które się jeszcze przydadzą, a których nie chcę widzieć w podstawowej scenie.
Obiekt, który jest użyty na wielu scenach, w każdej z nich ma to samo położenie, obrót, skalę. W końcu nic dziwnego — każda ze scen zawiera tylko odnośnik do jednego bloku danych, opisującego obiekt.
Rysunek 8.1.9 przedstawia strukturę pliku po usunięciu ze sceny Scene kołpaka śmigła (obiektu B.005.Hub). Usunięcie spowodowało zmniejszenie licznika użycia obiektu B.005.Hub o 1. Gdyby występował tylko na jednej scenie — zostałby pominięty przy najbliższym zapisie na dysk4. Tak się jednak nie stanie, gdyż B.005.Hub nadal występuje w drugiej scenie, i jego licznik jest nadal większy od 0.
Rysunek 8.1.9 Struktura pliku po usunięciu obiektu B.005.Hub ze sceny Scene
Plik Blendera może zawierać wiele scen. Te same elementy modelu może występować w każdej z nich. Można ich także użyć tylko w jednej ze scen.
Za pomocą scen można przechowywać w jednym pliku różne wersje samolotu. Części wspólne dla wszystkich wersji są wówczas współdzielone pomiędzy scenami. Części specyficzne — występują tylko w jednej scenie.
Nim opowiem o powierzchniach podziałowych, zacznijmy od przypadku prostszego — linii (krzywej) podziałowej. Linia taka powstaje w Blenderze wówczas, gdy zastosujesz modyfikator Subdivision Surface (określany także skrótem Subsurf) do siatki, składającej się tylko z jednego rzędu wierzchołków. Subsurf w pojedynczym kroku dzieli każdą krawędź oryginalnego wieloboku na dwie, tworząc nową, bardziej “gładką” linię.
Rysunek 8.2.1 pokazuje przykład podziału. Sześciokąt (Rysunek 8.2.1a) jest linią przed wygładzeniem. Będę go określał dalej jako wielobok oryginalny. Każda zmiana położenia któregokolwiek z jego wierzchołków (A1 ..A6 ) zmieni kształt wyznaczanej linii podziałowej. Z tego powodu wielobok oryginalny jest także nazywany wielobokiem sterującym (ang. control polyygon)1 . Punkty A1 ..A6 to punkty sterujące.
Rysunek 8.2.1 Linie podziałowe sześciokąta — wyjściowa i po kolejnych podziałach
Każda kolejna linia podziałowa to wielobok, który ma dwa razy więcej wierzchołków niż ten, z którego powstał. Rysunek 8.2.1b) przedstawia rezultat pierwszego podziału sześciokąta. (W Blenderze, w ustawieniach modyfikatora Subdivison Surface, odpowiada to wartości Level = 1). Jest to regularny wielobok, o dwunastu wierzchołkach. Rysunek 8.2.1c) przedstawia rezultat kolejnego podziału, tym razem dwunastoboku z rysunku b). (W ustawieniach modyfikatora Subdivision Surface, odpowiada to wartości Level = 2). Jest to obrys o 24 wierzchołkach, bardzo zbliżony do okręgu!
Krzywa, którą stałaby się linia podziałowa w wyniku nieskończonej liczby podziałów, nazwijmy krzywą “ostateczną”. Zazwyczaj już po dwóch - trzech podziałach oryginalnego wieloboku, linie podziałowe osiągają kształt niewiele różniący się od ostatecznego. Dzięki tej właściwości, w wyniku niewielkiej liczby obliczeń można uzyskać jego dobre przybliżenie. To duża zaleta tego modelu matematycznego.
Według jakich reguł są wyznaczane wierzchołki krzywych podziałowych? Przedstawię je na przykładzie wyznaczania nowych punktów wokół pojedynczego wierzchołka oryginalnego sześciokąta (Rysunek 8.2.2). (Taki sam proces podziału zachodzi dla każdego wierzchołka wieloboku).
Analizowany wierzchołek oryginalnego wieloboku oznaczmy jako A (Rysunek 8.2.2a). Sąsiednie wierzchołki oznaczyłem jako E1 i E2 . (Każdy z nich odegra identyczną rolę jak wierzchołek A, wobec “swojego” fragmentu linii podziałowej. Dla wierzchołka A są jednak tylko “sąsiadami”).
Co drugi wierzchołek linii podziałowej leży w środku boku oryginalnego wieloboku. W przykładzie (Rysunek 8.2.2b) to sześć wierzchołków (wśród nich punkty e1 , e2 , związane z wierzchołkiem A). Nazwijmy je “krawędziowymi”, bo leżą na krawędziach wieloboku sterującego.
Rysunek 8.2.2 Wyznaczenie wierzchołków e — “krawędziowych” punktów linii podziałowej
Aby znaleźć pozostałe wierzchołki, wyznacz najpierw pomocnicze punkty ok , leżące w połowie odległości pomiędzy odpowiednimi punktami krawędziowymi ek i ek+1 . (Rysunek 8.2.3a pokazuje jeden z nich jako punkt o , umieszczony w połowie odcinka |e1 e2 |).
Pozostałe sześć punktów linii podziałowej — a, “wierzchołkowych” — leży w połowie odpowiednich odcinków |A o| (Rysunek 8.2.3b). Łącząc wierzchołki a i e uzyskamy linię podziałową:
Rysunek 8.2.3 Wyznaczenie wierzchołków a — “wierzchołkowych” punktów linii podziałowej
Rysunek 8.2.3b pokazuje, że z wierzchołka A oryginalnej siatki powstały:
wierzchołki e1 i e2 (współdzielone z rezultatami podziału sąsiednich wierzchołków);
wierzchołek a, który można traktować jako odwzorowanie oryginalnego wierzchołka A na nowym wieloboku.
W każdym kolejnym podziale można wskazać taki punkt wierzchołkowy a, który jest bezpośrednim odwzorowaniem oryginalnego wierzchołka wieloboku sterującego A (Rysunek 8.2.4):
Rysunek 8.2.4 Segmenty linii podziałowej dla różnych poziomów podziału
Te “bezpośrednie odwzorowania” punktów A pozwalają wyróżnić na linii podziałowej tyle segmentów, ile boków ma wielobok sterujący (Rysunek 8.2.4).
Rysunek 8.2.2 i Rysunek 8.2.3 podały “wykreślną” metodę wyznaczenia nowej linii podziałowej. Komputery nie jest jednak maszyną “geometryczną”, tylko “algebraiczną”. Jego procesor oblicza linie i powierzchnie podziałowe w oparciu o współrzędne wierzchołków wieloboku sterującego. W porównaniu z innymi krzywymi stosowanymi w grafice komputerowej (Beziera, B-sklejanymi), wzory te są bardzo proste. Sądzę, że pozwalają dostrzec zależności linii podziałowej od wieloboku sterującego, które nie są oczywiste w metodzie “wykreślnej”:
; (por. Rysunek 8.2.2)
Wyr 8.1 Współrzędne punktów krawędziowych2
(por. Rysunek 8.2.3)
Wyr 8.2 Współrzędne punktów wierzchołkowych
Matematycy dowiedli, że krzywa ostateczna, do której zmierzają linie podziałowe opisane Wyr 8.1 i Wyr 8.2, to tzw. jednorodna linia B-sklejana (uniform B-spline — UB), trzeciego stopnia (cubic) . Oznacza to tyle, że linie podziałowe są dobrym przybliżeniem pewnej odmiany stosowanych od lat w grafice komputerowej krzywych NURBS3.
Linie podziałowe zachowują właściwości NURBS, m.in. :
ciągłość promienia krzywizny wzdłuż całej linii (dzięki temu krzywa wydaje się być bardziej “płynna” od np. połączenia kilku łuków);
sterowanie kształtem linii poprzez zmianę położenia wierzchołków oryginalnego wieloboku (punktów sterujących);
“lokalność” zmian: przesunięcie pojedynczego punktu sterującego wywołuje zmianę kształtu linii podziałowej tylko w pobliżu tego punktu.
Ta ostatnia z wyliczonych właściwości — ograniczony zasięg wpływu punktu sterującego na kształt krzywej — bardzo się przydaje w praktyce. Ale co to właściwie znaczy “w pobliżu punktu sterującego”? Otóż z Wyr 8.1 i Wyr 8.2 wynika, że położenie każdego wierzchołka linii podziałowej zależy od (co najwyżej) trzech sąsiednich punktów sterujących (E1 ,A, E2 ). Ta reguła dotyczy pojedynczego podziału. A gdzie się kończy wpływ punktu A na krzywą podziałową, która powstała w wyniku dwóch lub więcej podziałów? Rysunek 8.2.5a) pokazuje rozszerzanie się obszaru wpływu oryginalnego wierzchołka A na kolejne linie podziałowe. Wygląda na to, że wpływ ten nigdy nie osiągnie granicy drugiego segmentu linii:
Rysunek 8.2.5 Granica wpływu punktu sterującego na kształt krzywej
Rysunek 8.2.5b) pokazuje tę właściwość w praktyce. Zmieniłem położenie wierzchołka A oryginalnego sześciokąta. Krzywa podziałowa zmieniła swój kształt z “prawie idealnego okręgu” (por. Rysunek 8.2.4b) na coś mniej regularnego. Przyjrzyj się temu kształtowi dokładnie. Zauważ że zmianie uległ kształt tylko 4 segmentów najbliższych wierzchołkowi A (po dwa z każdej strony). Segmenty bardziej odległe (mierząc wzdłuż linii) są bez zmian!
Wpływ każdego punktu sterującego na kształt linii podziałowej jest ograniczony tylko do czterech najbliższych segmentów tej linii (po dwa z każdej strony punktu).
* * *
Podczas modelowania różnorodnych konstrukcji mechanicznych trzeba tworzyć różne okrągłe elementy, lub otwory. Im mniej punktów ma ich wielobok sterujący, tym lepiej (szybszy rendering, mniej pracy z modelowaniem). Z drugiej strony rezultat podziału powinien być jak najbardziej zbliżony do okręgu. Warto więc sprawdzić, na ile dokładne “koło” można uzyskać z podziału jakiejś figury o niewielkiej liczbie boków, np. sześciokąta.
Aby sprawdzić odchylenia od regularnego kształtu, porównamy kształt kilku linii podziałowych, wpisanych w okrąg o promieniu 1000 jednostek. Zmierzymy dwa rodzaje różnic:
max. odległość wierzchołka linii podziałowej do okręgu (idealnie — powinna być =0);
max. odległość boku linii podziałowej do okręgu (zależy od liczby wierzchołków linii);
Rysunek 8.2.6 i Rysunek 8.2.7 pokazują wartości odchyleń dla podziału sześciokąta:
Rysunek 8.2.6 Odchylenie od okręgu dwukrotnego podziału sześciokąta
Rysunek 8.2.7 Odchylenie od okręgu trzykrotnego podziału sześciokąta
Linia podziałowa regularnego wielokąta jest nieco spłaszczona w środku każdego segmentu. Stąd w tym miejscu występują największe odchylenia (p. Rysunek 8.2.6 i Rysunek 8.2.7). Należy zdawać sobie sprawę, że odsunięcie wierzchołka linii podziałowej od okręgu wynika wyłącznie z różnicy kształtu krzywej ostatecznej. Drugie odchylenie, które mierzyliśmy — odległość środka boku od okręgu — zależy także od liczby wierzchołków linii podziałowej. Będzie zawsze większe od odchylenia wierzchołka. (Im linia ma więcej wierzchołków, tym jest mniej “graniasta”). Błąd położenia wierzchołków przy zwiększeniu poziomu podziału sześciokąta z 2 (Rysunek 8.2.6) do 3 (Rysunek 8.2.7) zmniejszył się tylko o kilkanaście procent (z 0.274% do 0.224%). W związku jednak z dwukrotnym wzrostem liczby boków, trzykrotny podział sześciokąta ma dwukrotnie mniejsze odchylenie ściany (0.66% dla podziału dwukrotnego, 0.315% dla trzykrotnego).
Czy trzykrotny podział sześciokąta jest dobrym kandydatem na siatkę, którą warto stosować do modelowania okręgów? Niestety nie: w praktyce naszego modelowania nie stosujemy trzykrotnych powierzchni podziałowych. Mają zbyt wiele ścian, a kształt, który uzyskamy, nie jest zdecydowanie lepszy od powierzchni dwukrotnych. Podział dwukrotny sześciokąta, z poziomem odchyleń w granicy 0.7%, jest dobry do modelowania małych elementów. (Wyposażenie kabiny, drobne otwory, różnego rodzaju rury). Aby dokładnie zamodelować większe okręgi — o średnicy ok. 80 cm (kołpak śmigła, koła podwozia głównego) — potrzebne jest odchylenie rzędu 0.3%. Powinna je posiadać jakaś dwukrotna linia podziałowa. Cóż, skoro sześciokąt nie spełnił naszych oczekiwać, sprawdźmy dwukrotny podział ośmiokąta (Rysunek 8.2.8):
Rysunek 8.2.8 Odchylenie od okręgu dwukrotnego podziału ośmiokąta
Wygląda na to, że dwukrotny podział ośmiokąta jest zadowalająco dobrym przybliżeniem okręgu. Odchylenia wierzchołków są na poziomie 0.07%, a odchylenie boku też leżą w zakresie tolerancji: 0.27%.
Do zamodelowania mniejszych okręgów wystarczy użyć dwukrotnego podziału sześciokąta (max. odchylenie kształtu rzędu 0.66%). Do większych okręgów lepiej użyć dwukrotnego podziału ośmiokąta (max. odchylenie kształtu rzędu 0.27%).
Do tej pory zajmowaliśmy się wyłącznie krzywymi podziałowymi, które powstały poprzez podział jakiejś linii zamkniętej. Skoncentrowałem się na nich, gdyż większość linii podziałowych, które napotkasz w Blenderze, to krzywe zamknięte. (Linią podziałową jest kraniec każdej powierzchni podziałowej, a granica każdej powierzchni musi być obrysem zamkniętym).
Na koniec jednak, dla porządku, wspomnę o krzywych podziałowych opartych o siatkę, której końce nie są ze sobą połączone (Rysunek 8.2.9):
Rysunek 8.2.9 Linia podziałowa dla obrysu otwartego — wyznaczanie punktów końcowych
Dla końca otwartego wieloboku sterującego A nie można wyznaczyć punktu wierzchołkowego a według Wyr 8.2 (str. 401). Brak jest kolejnego wierzchołka, który powinien istnieć z lewej strony A — jakiegoś punktu E1 (por. Rysunek 8.2.9a) i Rysunek 8.2.3). Autorzy Blendera przyjęli, że w takim przypadku brakujący punkt E1 leży w tym samym miejscu, co E2 . W tym przypadku krańcowy punkt wierzchołkowy a leży na 1 / 4 boku |A E2 |:
Wyr 8.3 Współrzędne końca linii podziałowej (ostatni punkt wierzchołkowy)
Zwróć uwagę, że z każdym kolejnym podziałem koniec linii podziałowej będzie się zbliżał do środka ostatniego boku oryginalnej linii. Rysunek 8.2.9b) pokazuje wyznaczenie punktu b — ostatniego punktu wierzchołkowego dla drugiego podziału. Punkt b leży na 1 / 4 boku |a e2 |.
Końce otwartej linii podziałowej mają następujące właściwości:
w trakcie kolejnych podziałów oryginalnego wieloboku długość ostatniego boku linii podziałowej szybko się skraca;
leżą zawsze pomiędzy 1 / 4 (pierwszy podział) a 1 / 3 (krzywa ostateczna) ostatniego boku oryginalnego wieloboku;
krzywa ostateczna jest na końcach styczna do krańcowych boków oryginalnego wieloboku.
* * *
Powierzchnie podziałowe powstają w wyniku podziału oryginalnej powłoki (siatki). Wierzchołki oryginalnej powłoki to punkty sterujące powierzchni podziałowej. Podczas podziału każda czworokątna ściana dzieli się na cztery nowe ściany, a trójkątna - na trzy. Rysunek 8.2.10 przedstawia kolejne podziały powłoki, “rozpiętej” na wierzchołkach czterech ośmiokątów. (Z powodu układu ścian, biegnących jak południki i równoleżniki, nazwałem ją “globusem”):
Rysunek 8.2.10 Podział 32-ściennego “globusa”
Rysunek 8.2.10a) przedstawia oryginalną powłokę, złożoną z 32 ścian. Jej 26 wierzchołków (zbyt wiele, aby je na tej ilustracji zaznaczać) to punkty sterujące powierzchni podziałowej. Rysunek 8.2.10b) przedstawia rezultat pierwszego podziału tej siatki. Zwróć uwagę na kształt podziału ścian w okolicach “biegunów” oryginalnej powłoki. Rysunek 8.2.10c) to wynik dwukrotnego podziału. Kształt powłoki stał się już zbliżony do kształtu powierzchni ostatecznej. W przypadku naszego “globusa” wcale nie jest to kula, tylko elipsoida. (Przekrój w płaszczyźnie równoleżnika jest okręgiem, a w płaszczyźnie południka - elipsą)
Istnieje wiele metod (nazywanych także “schematami”) podziału powierzchni. Blender wykorzystuje schemat Catmulla - Clarka. Opublikowany po raz pierwszy w 1978r, przeleżał “na półce” ponad dwadzieścia lat, zanim go “odkurzono” i zastosowano4. Reguły wyznaczania wierzchołków powierzchni podziałowej w tym schemacie podam na przykładzie pojedynczego punktu sterującego A i sąsiednich wierzchołków (Rysunek 8.2.11):
Rysunek 8.2.11 Punkt sterujący A i jego otoczenie
Wierzchołek A łączy kilka krawędzi. Na ilustracji — Rysunek 8.2.11 — są to cztery krawędzie, na których leżą punkty E1 , E2 , E3 , E4 . Otacza go także kilka innych punktów, z którymi nie jest bezpośrednio połączony. Są to pozostałe wierzchołki ścian, do których należy A. Na ilustracji oznaczyłem cztery takie punkty: F1 , F2 , F3 , F4 .
Pierwszą grupa wierzchołków powierzchni podziałowej leży w pośrodku każdej ze ścian powłoki kontrolnej. Oznaczymy je jako punkty “środkowe” (Rysunek 8.2.12):
Rysunek 8.2.12 Wyznaczanie wierzchołków f — “środkowych” punktów powierzchni podziałowej
Punkty środkowe można wyznaczyć wg Wyr 8.4:
dla ścian czworokątnych:
dla ścian trójkątnych:
gdzie5 k = 1,2,..,n; and n — to liczba ścian wokół wierzchołka A.
Wyr 8.4 Współrzędne punktów środkowych ścian wokół wierzchołka A
Kolejne wierzchołki powierzchni podziałowej to punkty krawędziowe — ek . Każdy z nich leży w połowie odległości pomiędzy środkiem odcinka |AEk |, a środkiem odcinka |fk,fk+1 | (Rysunek 8.2.13):
Rysunek 8.2.13 Wyznaczanie wierzchołków e — punktów “krawędziowych” pow. podziałowej
Każdy z punktów krawędziowych — e1 , e2 , e3 , e4 — może być wyznaczony wg Wyr 8.5:
gdzie k = 1,2,..,n; and n — to liczba ścian wokół wierzchołka A.
Wyr 8.5 Współrzędne punktów krawędziowych wokół wierzchołka A
Punkty środkowe fk i krawędziowe ek wyznaczają zewnętrzną krawędź nowych ścian, które powstają wokół wierzchołka A (Rysunek 8.2.14). (Ta krawędź jest “współdzielona” ze ścianami podziałowymi sąsiednich wierzchołków). Do zakończenia wyznaczenia czterech ścian brakuje już tylko ostatniego punktu — a. Punkty a, tak jak w przypadku krzywych, nazywamy punktami wierzchołkowymi:
Rysunek 8.2.14 Punkt a — punkt “wierzchołkowy” pow. podziałowej
Punkt wierzchołkowy a leży zawsze pomiędzy punktem A, końcami krawędzi oryginalnej powłoki Ek , oraz punktami środkowymi fk . Dokładną zależność pomiędzy nimi opisuje Wyr 8.6:
gdzie n — to liczba ścian wokół wierzchołka A
Wyr 8.6 Współrzędne punktu wierzchołkowego a — odwzorowania punktu sterującego A
Powstanie powierzchni podziałowej pokazałem na przykładzie wierzchołka łączącego cztery czworokątne ściany. Dla tak zbudowanych powierzchni sterujących, powłoka ostateczna, do której zmierzają kolejne podziały Catmull-Clarka, jest jednorodną powierzchnią B-sklejaną, trzeciego stopnia6.
Powierzchnie podziałowe potrafią jednak utworzyć gładką powłokę z dowolnej kombinacji ścian, z których każda może mieć inną liczbę boków7. Przykładem takiego “trudnego” wierzchołka są chociażby “bieguny” siatki o układzie “globusa” (Rysunek 8.2.15). Co prawda w okolicach takich punktów nie jest gwarantowana ciągłość promienia krzywizny (w tych miejscach powierzchnia ostateczna nie jest powłoką B-sklejaną). Na pewno jednak powierzchnie podziałowe pozostają “gładkie”. (Wokół wierzchołków “specjalnych” zachowują przynajmniej ciągłość stycznych do powierzchni).
Rysunek 8.2.15 Zwykłe i “specjalne” wierzchołki powłoki sterującej
Wyrażenia opisujące powierzchnie podziałowe (Wyr 8.4,Wyr 8.5, Wyr 8.6) są podane w sposób ogólny, dla dowolnej liczby ścian wokół wierzchołka oryginalnej powłoki. Używając ich, można także wyznaczyć wierzchołki siatki wokół takich “specjalnych” wierzchołków jak punkt B (Rysunek 8.2.15).
Na każdej powłoce podziałowej Catmull-Clarka można wskazać krawędzie, stanowiące bezpośrednie odwzorowanie (“ślad”) krawędzi powłoki sterującej (Rysunek 8.2.16):
Rysunek 8.2.16 Segment powierzchni podziałowej | Rysunek 8.2.17 Blender: przełącznik wyświetlania segmentów powierzchni podziałowych |
Fragment powierzchni podziałowej ograniczony “śladami” krawędzi powłoki sterującej nazwiemy segmentem. Każda powłoka podziałowa ma tyle segmentów, ile ścian ma jej powierzchnia sterująca. (Jest to analogia do segmentów krzywych podziałowych — p. str. 401).
W Blenderze, podczas edycji siatki, możesz się swobodnie przełączać pomiędzy ścianami powłoki sterującej i jej segmentami. Służy do tego niepozorny przełącznik w panelu modyfikatora Subdivision Surface (Rysunek 8.2.17).
Zakres wpływu pojedynczego punktu sterującego na kształt powierzchni podziałowej jest ograniczony. Zmiany nigdy nie przekroczą obszaru sąsiednich 4 x 4 segmentów. (Po dwa segmenty w każdą stronę, licząc od odwzorowania zmienionego wierzchołka — p. Rysunek 8.2.18).
Rysunek 8.2.18 Granica wpływu punktu sterującego A na kształt powierzchni podziałowej
Wspomniałem wcześniej, że siatki typu “globus”, na których do tej pory eksperymentowaliśmy, pozwalają uzyskać elipsoidę, a nie kulę. Są dwie drogi, aby uzyskać za pomocą powierzchni podziałowych kształt kuli:
zastosować jako powłokę sterującą jakiś wielościan foremny (powierzchnię, której wszystkie ściany są jednakowe);
zwiększyć liczbę, oraz zmienić położenie “równoleżników” na powłoce typu “globus”;
Najprostszym przykładem pierwszej metody — użycia wielościanów foremnych — jest sześcian Rysunek 8.2.19a). Innym, lepszym przybliżeniem jest powłoka o większej liczbie ścian (Rysunek 8.2.19b):
Rysunek 8.2.19 Powłoki, pozwalające uzyskać powierzchnie podziałowe zbliżone do kuli
Rysunek 8.2.19c) przedstawia przykład drugiego rozwiązania — modyfikację siatki typu “globus”. Mimo, że okolice “biegunów” mają w takiej powłoce największe odchylenie od kształtu kuli, w praktyce często stosuję właśnie to rozwiązanie. Dlaczego? Zazwyczaj modelujemy nie pełną kulę, ale jej fragment — jakieś zaokrąglenie. Fragment siatki typu “globus”, zawierający punkt biegunowy, łatwo jest “wyprowadzić” z fragmentów innych siatek. A odchylenie w okolicy bieguna? Cóż, jest to pewien problem, ale zazwyczaj wystarcza dodać jeden - dwa dodatkowe równoleżniki, i kształt staje się wystarczająco “kulisty”.
Do tej pory demonstrowałem wyłącznie powierzchnie zamknięte. Rysunek 8.2.20 pokazuje przykłady powierzchni podziałowych dla powłok, które są otwarte:
Rysunek 8.2.20 Powierzchnie podziałowe dla powłok otwartych
Rysunek 8.2.20a) przedstawia efekt usunięcia połowy “globusa”. Powstała powłoka sterująca w kształcie czaszy. Jej krawędź jest krzywą podziałową — taką jaką analizowaliśmy w pierwszej części tej sekcji. O kształcie tej linii decydują wyłącznie punkty krawędzi powłoki sterującej. (W tym przypadku jest okręgiem, powstałym w wyniku podziału ośmiobocznej krawędzi czaszy) .
Czasza z przypadku a) ma nieco większą średnicę, niż elipsoida, z której powstała. Ten efekt widać dobitniej w drugim przykładzie. Rysunek 8.2.20b) przedstawia powierzchnię, która także powstała z siatki “globusa”. Tym razem nie usunęliśmy żadnego wierzchołka. Usunięta została tylko pojedyncza ściana — i powstał w powłoce otwór. Jego krawędź zależy tylko od wierzchołków tej usuniętej ściany, więc leży w ich płaszczyźnie. W efekcie krawędź otworu znalazła się powyżej oryginalnej powłoki, i “pociągnęła” za sobą inne ściany z otoczenia. Wygląda to trochę jak brzeg formującego się wulkanu. Dla powłok o niewielkim zaokrągleniu ten efekt jest praktycznie niewidoczny. Może stanowić problem, gdy będziesz próbował wykonać większy otwór w bardziej zaokrąglonej powierzchni — np. kadłuba (por. Rysunek 8.2.28, str. 415).
Abyś nie odniósł mylnego wrażenia, że krawędź powierzchni podziałowej zawsze jest jakimś płaskim obrysem, przygotowałem ostatni, trzeci przykład. Rysunek 8.2.20c) pokazuje nieregularną powierzchnię, w której jedne ściany są trójkątne, a inne — czworokątne. Krawędź takiej powłoki jest także krzywą podziałową — tyle, że tym razem przestrzenną8.
Krawędzią powierzchni podziałowej jest zawsze krzywa podziałowa. Wielobokiem sterującym tą krzywą jest krawędź powłoki sterującej.
Krawędzie otwartych powłok podziałowych przyjmują opisany powyżej kształt, bo zastosowano do ich podziału inne wyrażenia, niż dla pozostałych wierzchołków powierzchni. Ich punkty krawędziowe są wyznaczane według Wyr 8.1 (str. 401) a nie Wyr 8.5 (str. 407). Podobnie punkty wierzchołkowe — ich współrzędne opisuje Wyr 8.2, a nie Wyr 8.6. W sumie to program obliczający wierzchołki podejmuje decyzję, według jakiego wyrażenia podzieli daną krawędź. W związku z tym programiści stworzyli dodatkową możliwość: użytkownik może sam oznaczyć niektóre krawędzie oryginalnej powłoki jako “ostre” (creases). Zostaną wówczas potraktowane jak gdyby były krawędziami zewnętrznymi, mimo że leżą pośrodku powierzchni. Ich odwzorowaniem na powłoce podziałowej jest ostra krawędź, o kształcie krzywej podziałowej (Rysunek 8.2.21):
Rysunek 8.2.21 Ostre krawędzie wewnątrz powierzchni podziałowych
Rysunek 8.2.21 a) przedstawia sytuację wyjściową — zwykłą, gładką powłokę. Rysunek 8.2.21 b) pokazuje, jak zmieni się ten kształt, gdy “równik” powłoki sterującej został oznaczony jako “ostry” (crease). Pojawiło się w tym miejscu ostre załamanie kształtu powłoki podziałowej (nie jest zachowana ciągłość stycznych). Kształt końcowych krawędzi powłoki nie uległ zmianie, mimo że mają wspólny punkt przecięcia z “ostrą” krawędzią.
Rysunek 8.2.21c) demonstruje efekt przecięcia się dwóch krawędzi oznaczonych jako “ostre”. Oprócz “równika”, oznaczyłem jako “ostry” jeden z południków. Punkt, w którym przecięły się te dwie krawędzie, znalazł się na powłoce sterującej.
Jeżeli z punktu sterującego wychodzą co najmniej trzy “ostre” krawędzie, to taki wierzchołek także nazywamy “ostrym”, albo “narożnym”. Każda powierzchnia podziałowa (dowolnego poziomu) ma w takim punkcie odpowiedni punkt wierzchołkowy.
Na pierwszy rzut oka powyższa reguła wydaje się nie obowiązywać na przecięciu “ostrej” krawędzi z krawędzią powłoki (Rysunek 8.2.22a) . W punkcie A, gdzie krawędź zewnętrzna styka się z równoleżnikiem, oznaczonym jako “ostry” (krawędź |AE3 |), powinien się pojawić wierzchołek narożny. Nic takiego jednak nie wystąpiło — ostra krawędź płynnie “rozmywa” się w krawędzi powłoki. Punkt wierzchołkowy a leży nadal na nie zdeformowanym okręgu podstawy. Dlaczego?
Rysunek 8.2.22 Uzyskanie narożnika na krawędzi powłoki
Krawędź powłoki jest wyznaczana w taki sam sposób (według tych samych wzorów), co krawędzie “ostre”. Sposób obliczeń nie czyni z niej jednak samoczynnie krawędzi “ostrej”. Dopóki użytkownik nie oznaczy jej w ten sposób, będzie przez program traktowana jak gładka. Dlatego z wierzchołka A wychodzi tylko jedna ostra krawędź — |AE3 |, i nie ma tu narożnika (Rysunek 8.2.22a)9. Aby uzyskać w punkcie A narożnik, należy oznaczyć krawędzie |AE2 | i |AE4 | jako “ostre” (Rysunek 8.2.22b).
Faktycznym wyjątkiem od reguły “punktu narożnego” jest narożnik prostokątnej ściany, leżący na krawędzi powłoki. Rysunek 8.2.23 przedstawia taki punkt A: “gładka” krawędź powłoki omija go szerokim łukiem. Gdy jednak “wyostrzymy” jego obydwie krawędzie — stanie się narożnikiem:
Rysunek 8.2.23 Uzyskanie narożników na zewnętrznej krawędzi powłoki prostokątnej
Wyostrzenie krawędzi umożliwia także uzyskanie prostokątnego otworu wewnątrz powłoki podziałowej. W takim przypadku wystarczy “wyostrzyć” tylko dwie przeciwległe krawędzie otworu (Rysunek 8.2.24). Spowoduje to uzyskanie ostrych narożników, mimo że nie są to punkty narożne, i nie leżą na powierzchni siatki sterującej. Zazwyczaj taki efekt oznacza mniejsze deformacje oryginalnego kształtu siatki, i jest często bardzo pożądany. (Wyostrzenie krawędzi zawsze zmienia kształt powłoki — różnica polega tylko na tym, jak duża jest to deformacja)
Rysunek 8.2.24 Uzyskanie narożników na krawędzi wewnętrznego, prostokątnego otworu
“Ostra” krawędź ogranicza także wpływ punktów sterujących na kształt powierzchni. Punkty sterujące po jednej stronie “ostrej” krawędzi nie mają żadnego wpływu na kształt powierzchni po drugiej stronie.
Rysunek 8.2.25 ilustruje, jaką “barierą dla zmian” jest ostra krawędź. Przedstawiona powłoka zawiera dużą deformację, wywołaną przesunięciem punktu sterującego A. Przypadek a) to kształt gładkiej, zdeformowanej powierzchni. Przypadek b) — powierzchni, w której wpływ punktu A został ograniczony przez “ostrą” krawędź.
Rysunek 8.2.25 Ograniczenie wpływu punktu sterującego A przez “ostrą” krawędź
Krawędzie nie muszą być zawsze “całkiem ostre” lub “całkiem gładkie”. W istocie Blender pozwala na płynną regulację “ostrości” w zakresie od 0 (zwykła, gładka krawędź) do 1 (krawędź ostra) (Rysunek 8.2.26) :
Rysunek 8.2.26 Stopniowa zmiana ostrości krawędzi
Wierzchołek ag leży na zwykłej, gładkiej powierzchni, ao — na zupełnie ostrej (Rysunek 8.2.26). Jak wyznaczany jest a — wierzchołek krawędzi o “częściowej” ostrości (crease = 0.5)? Współrzędne punktów krawędziowych i wierzchołkowych wzdłuż takiej krawędzi są “średnią ważoną” współrzędnych punktów ag i ao . “Wagą” w tej średniej jest wartość “ostrości” — od 0.0 do 1.0:
Wyr 8.7 Współrzędne punktów wierzchołkowych a dla krawędzi “półostrych”
Wyr 8.8 Współrzędne punktów krawędziowych e dla krawędzi “półostrych”
Pamiętasz, jak podkreślałem, że współrzędna X każdego punktu powłoki podziałowej zależy tylko od współrzędnej X odpowiednich punktów sterujących (str. 401)? Podobnie współrzędna Y takiego wierzchołka zależy od Y, a Z od współrzędnej Z punktów sterujących.
Kształt rzutu powierzchni podziałowej na płaszczyznę zależy tylko od kształtu rzutu jej punktów sterujących na tej płaszczyźnie.
Ta reguła nie wygląda dość przejrzyście, ale jej znajomość bardzo ułatwia modelowanie. Postaram się ją pokazać na przykładzie. Rysunek 8.2.27 pokazuje lekko wygiętą powłokę, w której wykonałem otwór. Krawędź otworu w płaszczyźnie XY jest okręgiem (Rysunek 8.2.27c):
Rysunek 8.2.27 Okrągły otwór w lekko wygiętej powłoce
Jak się zmieni kształt tej powierzchni w rzucie z góry (płaszczyźnie XY), gdy wygnę tę powierzchnię (Rysunek 8.2.28)? Wygięcie uzyskałem, przesuwając punkty sterujące w kierunku prostopadłym do XY (wzdłuż osi Z). Rysunek 8.2.28c) pokazuje, że jej rzut z góry nie uległ żadnej zmianie! (Porównaj Rysunek 8.2.28c i Rysunek 8.2.27c.)
Ta właściwość jest nieoceniona szczególnie w przypadku konieczności dokonania jakichś niewielkich poprawek kształtu. Możesz je zazwyczaj zaplanować jako przesunięcia wierzchołków wzdłuż pojedynczej osi. W ten sposób masz gwarancję, że kształt obiektu w kierunku prostopadłym nie ulegnie żadnej zmianie.
Na koniec mała dygresja o otworach w powierzchniach o małym i dużym promieniu krzywizny. Każda krawędź otworu w wygiętej powłoce podziałowej wywołuje lokalne zaburzenia kształtu. Wspomniałem to zjawisko na str. 410 (Rysunek 8.2.20b), używając nieco romantycznego określenia “efekt krawędzi wulkanu”. Efekt ten jest praktycznie do zaniedbania na powierzchniach o małej krzywiźnie, jakiej przykład pokazuje Rysunek 8.2.27. Taką niewielką krzywiznę ma np. skrzydło samolotu (poza krawędzią natarcia). Stąd bardzo łatwo w skrzydle wykonać różnego kształtu otwory i wycięcia.
Problem jednak narasta, gdy rośnie krzywizna powierzchni. Na powłoce wygiętej tak, jak bywa często wygięty przekrój kadłuba, wypukłości wokół otworu stają się widoczne (Rysunek 8.2.28a). Jak napisałem wcześniej, nie wpływają na kształt powierzchni w rzucie prostopadłym, ale na pewno nie można ich tak zostawić. Z tym problemem możesz sobie poradzić, zagęszczając siatkę punktów sterujących w okolicy deformacji. Takie odchylenia powłoki szybko znikają. Już przy dwukrotnym zwiększeniu liczby ścian w takim miejscu deformacja jest o wiele mniejsza.
Rysunek 8.2.28 Okrągły otwór w bardzo wygiętej powłoce
Podsumowanie
Oryginalna siatka, z której powstaje powłoka podziałowa, nazywa się siatką sterującą, a jej wierzchołki — punktami sterującymi (control points — str. 399).
Krzywe i powłoki podziałowe można podzielić na segmenty. Każdy segment odpowiada krawędzi (dla krzywych) lub ścianie (dla powłok) siatki sterującej (str. 401).
Wpływ przesunięcia pojedynczego punktu sterującego na kształt krzywej / powłoki podziałowej nie przekracza dwóch segmentów (w każdym kierunku) (str. 402, str. 409).
Do dobrego odwzorowania okręgu wystarczy dwukrotny podział sześciokąta. Dla bardzo dokładnego okręgu — dwukrotny podział ośmiokąta (str. 404)
Krawędzią każdej powierzchni otwartej jest krzywa podziałowa (str. 410).
Powierzchnie podziałowe mogą zawierać krawędzie oznaczone jako “ostre” (str. 411). Możliwa jest także ostrość częściowa (str. 413)
Ostra krawędź jest “barierą” dla propagacji zmiany kształtu powłoki (str. 413)
Rzut powierzchni podziałowej na płaszczyznę zależy wyłącznie od rzutu jej punktów sterujących na tę płaszczyznę (str. 414). Dzięki tej właściwości można bez problemu “wycinać” okręgi w powierzchniach, które nie są zbyt wygięte. przy większym wygięciu pojawią się deformacje na brzegu otworu.
Wśród konstruktorów lotniczych funkcjonuje powiedzenie “the wing is the king”. Ma to znaczyć, że geometria płata ma decydujący wpływ na wszelkie charakterystyki samolotu. Na przykład — P-40E “Warhawk” i P-51A “Mustang” miały niemal identyczną powierzchnię płata. Używały takich samych silników Allison, miały bardzo podobną powierzchnię czołową — chłodnic, kadłuba, skrzydeł. Różniły się jednak drastycznie oporem, jaki stawiały podczas lotu. Współczynnik oporu P-40E wynosił 0.02421. Ten sam współczynnik dla P-51A wynosił 0.0176. Co powodowało tę różnicę? Przede wszystkim profil płata! W wyniku zastosowania skrzydła o profilu laminarnym pierwsze “Mustangi” był o 45 km/h szybsze od “Warhawków” 2.
Profil płata jest odwzorowywany w lotnictwie bardzo dokładnie — nawet nieznaczne różnice kształtu mogą w znaczny sposób zmienić np. charakterystyki przeciągnięcia. Rysunek 8.3.1 wyjaśnia podstawowe pojęcia, używane w opisie geometrii profili lotniczych:
Rysunek 8.3.1 Geometria profilu lotniczego
Tradycyjnie profile lotnicze rysuje się w płaszczyźnie XY. Z lewej strony, w punkcie (X=0, Y=0), znajduje się zawsze tzw. nos profilu, określający kształt krawędzi natarcia płata. Nos jest zazwyczaj zaokrąglony. Czasami jest podawany promień tego zaokrąglenia. Profil jest zawsze zakończony w punkcie (X=100, Y=0). Linia profilu jest często dzielona na dwie części: obrys górny i obrys dolny. Obrysy łączą się na krańcach profilu (w X = 0 i X=100).
Prosty odcinek, łączący nos z krawędzią spływu nazywamy cięciwą. Drugą linią charakterystyczną jest szkieletowa. Punkty tej linii leżą w równej odległości od górnej i dolnej krawędzi profilu. Można ją sobie wyobrazić jako linię przechodzącą przez środki okręgów, wpisanych w obrys profilu (Rysunek 8.3.1).
Dla profilu podawana jest często także:
maksymalną grubość (informacyjnie — chodzi tu o wysokość, mierzoną wzdłuż osi Y);
punkt maksymalnego ugięcia linii szkieletowej (Rysunek 8.3.1).
Gdzieś tak do lat dwudziestych XX wieku profile płatów opracowywali sami konstruktorzy. Robili to metodą prób i błędów. Na przykład popularny profil Clark Y powstał właśnie w tym czasie (opracował go w 1922 r. Virginius A. Clark). Użyto go w dziesiątkach samolotów z lat dwudziestych. Aby inżynierowie na całym świecie byli w stanie poprawnie odtworzyć kształt profili, zaczęto publikować współrzędne ich obrysów (Tabela 8.3.1, Rysunek 8.3.2):
| 0 | 1.25 | 2.5 | 5 | 7.5 | 10 | 20 | 30 | 40 | 50 | 60 | 70 | 80 | 90 | 100 | |
| Yg | 3.49 | 5.53 | 6.50 | 7.87 | 8.86 | 9.63 | 11.35 | 11.73 | 11.40 | 10.52 | 9.18 | 7.72 | 5.54 | 3.32 | 0.25 |
| Yd | 3.49 | 1.94 | 1.46 | 0.94 | 0.61 | 0.40 | 0.04 | 0.00 | 0.00 | 0.00 | 0.00 | 0.00 | 0.00 | 0.00 | 0.00 |
Tabela 8.3.1 Współrzędne profilu Clark Y
Rysunek 8.3.2 Profil Clark Y, wykreślony na podstawie współrzędnych z Tabela 8.3.1
Gdzieś w latach dwudziestych coraz szerzej zaczęto używać profili, opracowanych przez placówki naukowe. Na przykład publikował je niemiecki uniwersytet w Getyndze. (Były oznaczane np. “Götingen - 623”, albo “Götingen - 543”.) W 1933 r. finansowana przez rząd USA NACA opublikowała istotny raport, zawierający geometrię i charakterystyki 78 profili lotniczych. Były to tak zwane “profile rodziny 4-cyfrowej”. Od tamtej pory profile te były szeroko wykorzystywane w wielu konstrukcjach lotniczych, nie tylko amerykańskich3. Do rodziny tej należą także profile płata P-36 i P-40: NACA 2215 i NACA 2209.
Czy wiesz, że numer profilu NACA nie jest wcale numerem kolejnym? Tak naprawdę zawiera opis jego kluczowych parametrów geometrycznych:
1 cyfra: największe ugięcie szkieletowej (czyli wartość Y max. ugięcia w %).
2 cyfra: odległość punktu o największym ugięciu szkieletowej od nosa profilu, podzielona przez 10. Na przykład — “2” oznacza, że max. ugięcie szkieletowej znajduje się 20% od krawędzi natarcia.
3 i 4 cyfra: grubość profilu (%).
Tak więc symbol profilu P-40 — “NACA 2215” — oznacza profil o grubości 15% i maksymalnym ugięciu szkieletowej 2%, w X = 20% cięciwy. W istocie kształty NACA 2215 i NACA 2209 różnią się tylko grubością. Gdy przeskalujesz rysunek NACA 2209, rozciągając go w pionie, uzyskasz NACA 2215. (Na odwrót to także działa!)
Co więcej — NACA opublikowało wzory matematyczne, które pozwalają odwzorować kształt profilu z dowolną dokładnością. (Trzydzieści punktów, jakie Tabela 8.3.1 dla profilu Clark Y, pozostawia jeszcze pole do pewnej dowolności).
NACA opublikowała parametry także tzw. “rodziny 5-cyfrowej”, ale nie będziemy się nią tu zajmować. Poza tym istnieją także profile NACA, noszące inne oznaczenia. Na przykład — laminarny profil płata “Mustanga” to NACA 45-100. A profil skrzydła Messerschmitta Bf 109 jest podany jako NACA 2R 1 14.2 (to oznacza podwójne załamanie szkieletowej).
Gdy zaczniesz szukać w Internecie hasła “NACA, airfoil”, znajdziesz szybko kilka stron podających współrzędne wielu różnych profili lotniczych. Uważam, że godny polecenia jest w szczególności serwis dostępny pod adresem http://www.ppart.de/programming/java/profiles/NACA4.html :
Rysunek 8.3.3 Serwis internetowy — generator współrzędnych 4-cyfrowych profili NACA
Rysunek 8.3.4 Wygenerowane współrzędne profilu NACA 2215
Gdy ustawisz na tej stronie odpowiednio parametry:
Maximum Camber: ugięcie szkieletowej (1-sza cyfra);
Max. Camber Pos: pozycja ugięcia szkieletowej (2-ga cyfra);
Thickness: grubość profilu (dwie ostatnie cyfry).
i naciśniesz przycisk Show Points, w polu po prawej stronie ekranu zobaczysz współrzędne. Wygenerowano je dla profilu o długości cięciwy = 1.0. (Po 100 pkt na obrys).
Zaznacz całą zawartość pola tekstowego ze współrzędnymi (Ctrl-A) i skopiuj ją do schowka (Ctrl-C).
Co dalej zrobić z tymi współrzędnymi? Będziemy pracowicie rysować w Inkscape ten profil, “punkcik po punkciku”? Na szczęście nie — istnieje szybsza droga.
Otwórz arkusz kalkulacyjny, który przygotowałem specjalnie tym celu (Source\Tools\airfoil.xls z pliku source.zip, por. str. 18 — Rysunek 8.3.5):
Rysunek 8.3.5 Arkusz kalkulacyjny — przygotowanie wyrażenia SVG
Teraz przełącz się do Inkscape, i: narysuj w nim dowolną linię prostą. Następnie przełącz się na tryb selekcji i otwórz okno edytora XML (Edit→XML Editor...)
Rysunek 8.3.6 Linia na rysunku i jej definicja w edytorze XML (SVG)
Wklej zawartość schowka (kopię obszaru SVG z arkusza airfoil.xls — por. Rysunek 8.3.5) jako nową wartość atrybutu d 4(Rysunek 8.3.7):
Rysunek 8.3.7 Wartość atrybutu d (wierzchołki linii) przeniesiona z arkusza airfoil.xls
Gdy naciśniesz przycisk Set, wprowadzisz nowe wartości do dokumentu Inkscape (Rysunek 8.3.8):
Rysunek 8.3.8 Uzyskany w Inkscape profil NACA 2215
W ten sposób nasza linia nagle zmieniła się w gotowy rysunek profilu NACA 2215! Pozostaje teraz tylko zmienić jego skalę i przesunąć w odpowiednie miejsce rysunku.
Na koniec warto wspomnieć o odmianie profili NACA, z końcówką “T”. Są to wersje o zmniejszonym promieniu noska. Profile “T” mają o 75% zmniejszony promień noska w stosunku do promienia użytego w serii NACA 00xx (bez końcowej litery). Odpowiednio do tego jest także zmodyfikowany cała kształt przedniej sekcji - na “ostrzejszą”. “T” w zamyśle twórców mogło to znaczyć tyle, co angielskie “thinner”, czyli “cieńszy” (albo, równie dobrze, “tapered”). Przykładem profilu “T” jest NACA 0018T (Rysunek 8.3.9):
Rysunek 8.3.9 Profil NACA 0018T (“T” oznacza zmieniony przód — zmniejszony promień noska)
Nigdzie nie znalazłem opisu, jaki przekrój miało usterzenie P-40. Przymierzałem do rysunków fabrycznych (np. owiewki usterzenia) wiele profili. Ostatecznie doszedłem do wniosku, że była to właśnie rodzina NACA 00xxT. W P-40 wykorzystano “cieńsze” wersje profilu, jaki pokazuje Rysunek 8.3.9:
usterzenie pionowe, u nasady: NACA 0008T;
usterzenie poziome, u nasady: NACA 0010T;
usterzenie poziome, u końca: NACA 0009T.
Tabela 8.3.2 określa współrzędne obrysu profilu NACA 0018 T dla piętnastu punktów. Wykorzystałem je do wyznaczenia obrysu profilu. Aby uzyskać z tych współrzędnych cieńszą wersję, wystarczy przeskalować je w kierunku pionowym. Na przykład, po “ściśnięciu” NACA 0018T o 50% uzyskamy NACA 0009T, wykorzystywany w końcówce usterzenia poziomego.
| 0 | 1.25 | 2.5 | 5 | 7.5 | 10 | 20 | 30 | 40 | 50 | 60 | 70 | 80 | 90 | 100 | |
| Yg | 0.00 | 1.87 | 2.83 | 4.28 | 5.41 | 6.32 | 8.46 | 9.00 | 8.62 | 7.67 | 6.44 | 5.09 | 3.65 | 2.05 | 0.00 |
| Yd | 0.00 | -1.87 | -2.83 | -4.28 | -5.41 | -6.32 | -8.46 | -9.00 | -8.62 | -7.67 | -6.44 | -5.09 | -3.65 | -2.05 | 0.00 |
Tabela 8.3.2 Współrzędne profilu NACA 0018T (cieńsze wersje profilu są używane w usterzeniach).
Aby znaleźć w książce jakieś słowo lub wyrażenie możesz użyć narzędzia wyszukiwania wbudowanego w czytnik, którego używasz. Jednak ta metoda może nie być zbyt efektywna w przypadku pojęć koncepcyjnych. (O wiele łatwiej znaleźć takie wyrażenie w skorowidzu drukowanej książki, niż poszukując go poprzez powiązane polecenia lub słowa kluczowe). Co więcej, niektóre aplikacje do czytania publikacji elektronicznych w formacie EPUB na komputerach PC w ogóle nie umożliwiają wyszukiwania w całej książce. Dlatego zdecydowałem się włączyć do tej publikacji skorowidz z wersji "stronicowanej" (PDF). Wystarczy kliknąć na jeden z numerów stron po prawej stronie hasła, by przejść do odpowiedniego fragmentu książki.
Po prawej stronie nagłówka każdego hasła umieściłem skroty do pozostałych nagłówków. Użyj ich, aby nie przewijać zbyt wielu stron przechodząc np. od litery Z do C.
Nazwy poleceń, skróty klawiatury, podane w skorowidzu, dotyczą Blendera, o ile w haśle nie jest zaznaczone inaczej: „(GIMP)”, „(Inkscape)”.
GPL, licencja — General Public Licence, udostępniająca produkt za darmo wszystkim odbiorcom. Licencja ta jest sformułowana w ten sposób, aby uniemożliwić komercyjne rozpowszechnianie produktu.
materiał — to w Blenderze zestaw cech, używanych przy nanoszeniu obiektu na ostateczny obraz (renderowaniu). Cechy materiału to: barwa, połyskliwość, tekstura, i dziesiątki innych parametrów. Z materiałem może być związanych wiele tekstur (nierówności, barwy), zmieniających “ogólne” właściwości materiału dla pojedynczych pikseli renderowanego obrazu.
NURBS (N on- U niform R ational B - s plines) — inny sposób wygładzania powłoki, złożonej z jednorodnych ścian. Powierzchnie NURBS stawiają wygładzanym powłokom wyższe wymagania. Muszą mieć jednorodne ściany (zazwyczaj czworokątne), a zespół ścian powinien także być regularnym czworokątem. NURBS jest starszym o ponad 30 lat modelem obliczeniowym od powierzchni podziałowych. Przez ten czas stał się standardem w systemach CAD/CAM. Osobiście sądzę, że okres jego świetności ma się ku końcowi (choć wielu specjalistów może się ze mną nie zgodzić).
rastrowy, obraz — popularna metoda reprezentacji, polegająca na zapisie obrazu jako zbioru kolorowych lub czarno-białych punktów (pikseli). Tak jest np. wyświetlany obraz na ekran telewizyjnym, monitorze komputera. Wadą reprezentacji rastrowej jest pogorszenie jakości obrazu w dużych powiększeniach — gdy zaczynają być wyraźnie widoczne pojedyncze piksele. Zaletą jest stosunkowo prosty algorytm wyświetlania zawartości. Istnieje wiele różnorodnych sposobów zapisu (formatów) przechowywania obrazów rastrowych w plikach. Najpopularniejsze to *.jpg, *.png, *.bmp, *.tif.
renderowanie (ang. rendering) — w tej książce oznacza tworzenie ostatecznego obrazu (lub sekwencji obrazów — animacji) przygotowanej wcześniej trójwymiarowej sceny. W pierwszych wersjach Autodesk 3D Studio (początek lat 90-tych XX wieku) było przetłumaczone na polski jako powlekanie, ale ta nazwa się nie przyjęła.
shear (ang.) — przekoszenie (określane także jako “ścinanie”). Transformacja obrazu w GIMP. Przekształca kształt prostokąta w rąb (przeciwległe boki zachowują równoległość).
subdivision surface (pol.: powierzchnia podziałowa) — sposób wygładzania kształtu oryginalnej powłoki, złożonej z dowolnych ścian. W Blenderze występuje jako modyfikator siatki Subsurf (p. str. 341). Szczegółowy opis powierzchni (i linii) podziałowych znajdziesz na str. 399.
tekstura — obraz (zazwyczaj rastrowy), nakładany na trójwymiarową powierzchnię. Stosowany w grafice komputerowej do “urealniania” obiektów (nieregularności barw, napisy, itp.). Zastosowanie tekstur wykracza poza odwzorowanie barw — są stosowane także do zamodelowania drobnych nierówności powierzchni obiektów (tzw. bump maps).
wektorowy, obraz — metoda reprezentacji, polegająca na zapisie obrazu jako zbioru kolorowych linii i obszarów. Każdy element obrazu ma określone współrzędne i kształt (prosta, łuk, koło, krzywa Beziera, ...). W ten sposób są zapisywane stworzone na komputerze rysunki techniczne. Zaletą reprezentacji wektorowej jest zachowanie dokładności przy dowolnym powiększeniu. Wadą jest złożony algorytm wyświetlania (gdyż oznacza przekształcenie na postać rastrową). Jednym ze sposobów zapisu danych wektorowych jest format *.svg, stosowany m.in. przez Inkscape.
wireframe (pol.: siatka?) — oznacza sposób reprezentacji modelu w którym nie rysowane są żadne ściany, tylko krawędzie łączące poszczególne wierzchołki. Jest ich zazwyczaj dużo i są cienkimi liniami. Stąd obrazowo w literaturze anglojęzycznej taka reprezentacja jest nazywana “drucianą siatką” czyli “wireframe”.
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